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Solid state equipment has operational characteristics differing from those of
electromechanical equipment. “Safety Guidelines for the Application,
Installation and Maintenance of Solid State Controls” (Publication SGI-1.1)
describes some important differences between solid-state equipment and
hard-wired electromechanical devices. Because of this difference, and also
because of the wide variety of uses for solid-state equipment, all persons
responsible for applying this equipment must satisfy themselves that each
intended application of this equipment is acceptable.

In no event will the Allen-Bradley Company be responsible or liable for
indirect or consequential damages resulting from the use or application of
this equipment.

The examples and diagrams in this manual are included solely for
illustrative purposes. Because of the many variables and requirements
associated with any particular installation, the Allen-Bradley Company
cannot assume responsibility or liability for actual use based on the
examples and diagrams.

No patent liability is assumed by Allen-Bradley Company with respect to
use of information, circuits, equipment, or software described in this
manual.

Reproduction of the contents of this manual, in whole or in part, without
written permission of the Allen-Bradley Company is prohibited.

Throughout this manual we use notes to make you aware of safety
considerations.

ATTENTION: Identifies information about practices or
circumstances that can lead to personal injury or death, property
damage or economic loss.

Attentions help you:

 identify a hazard
 avoid the hazard
 recognize the consequences

IMPORTANT:  Identifies information that is especially important for
successful application and understanding of the product.

PanelBuilder and PanelView are trademarks, and PLC is a registered trademark of Allen-Bradley
Company, Inc.
Intel is trademark of Intel Corp.
IBM, PC, XT, AT, PS/2, EGA, VGA and PC-DOS are registered trademarks of International Business
Machines Corporation
Epson is a registered trademark of Seiko Epson Corporation
Microsoft is a registered trademark of Microsoft Corporation
Mouse Systems is a trademark of MSC Technologies, Inc.
LOGITECH is a trademark of Logitech, Inc.
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Preface

This manual explains how PanelBuilder  Development Software is used
to design screens for PanelView  terminals.

The manual provides information and examples for:

 developing application files for PanelView terminals using the
PanelBuilder Development Software

 troubleshooting the completed system

This manual is written to help those who want to develop PanelView
screens for use with PLC control applications.

Before you begin designing PanelView screens, familiarize yourself with
your plant’s PLC system, especially the PLC controller’s program and data
table. Acquire a clear understanding of how the PanelView terminal will be
used to control and monitor your PLC controllers.

The following terms are used throughout this manual.

Application File:  A PanelView terminal application file contains a series
of screens and configurations which, when interpreted and executed by
PanelView, replace the functions of a control panel of buttons, switches
and indicators. The screens are created on a development computer
running PanelBuilder Development Software and then saved in an
application file on the development computer’s disk. The application file is
then downloaded to a PanelView terminal where it stays in battery-backed
RAM.

Battery-Backed RAM: Application files are stored in the PanelView
terminal’s random access memory (RAM). The RAM is backed by an
internal battery so that the application file and the status of the retentive
objects are maintained even when AC power is switched off.

Hex Files: Application files which have been converted into Intel  Hex
format for transfer to user PROMs.

Manual Overview

Intended Audience

Glossary of Terms
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Object: An object is an individual component of a PanelView screen. Each
object takes the function of a button, switch or indicator on a control panel.
The objects can be dynamic—they can change color or value and can
display information. Each object is defined by the developer of the
PanelView screen. Examples of objects include Push Buttons, Selectors,
Bar Graphs, Numeric Displays, etc.

PanelBuilder Development Software: The program runs on the
development computer to develop application files for PanelView
terminals.

PanelView Terminal: A type of Allen-Bradley terminal with a touch
screen or rugged keypad, designed for easy operator interaction with a
PLC system over the Remote I/O link.

RAM:  Static Random Access Memory. A type of memory that can
maintain its contents through the use of a battery. It does not require
continuous refreshing to maintain its contents.

Retentive: An object is described as retentive when it “retains” its PLC
value in the PanelView terminal after a screen change, an operator’s object
action, and even after the terminal’s power cycle. For example, when a
maintained push button is pressed, the corresponding PLC input is set to 1
and will not change until the button is pressed a second time. Retentive
objects always display their current states or values.

Screen: A display containing objects (such as push buttons or bar graphs)
which can monitor and control a PLC system. Screens are created with the
PanelBuilder Development Software.

System Memory: The read-only memory that contains the operating
firmware for the PanelView terminal.

Upload/Download: Downloading is the process of transferring an
application file from a development computer running the PanelBuilder
Development Software, to a PanelView terminal. Uploading is the process
of transferring an application file from the terminal back to the
development computer.

User PROM: The read-only memory chip that can be used to contain a
back-up copy of an application file, or to increase the memory available for
the application file from 64K to 128K. The chip can be either an EPROM
or an EEPROM.

There are two types of user PROM chips that can be used in PanelView
terminal: EPROMs and EEPROMs. EPROMs are Electrically
Programmable Read Only Memory chips. EEPROMs are Electrically
Erasable Programmable Read Only Memory chips.
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The user PROMs store application files in memory that is protected from
power failure and failure of the internal battery. A PROM burner is
required to copy application files into EPROMs.

If your system includes EEPROMS, application files downloaded through
the Upload/Download cable will be stored in both battery-backed RAM
and in the EEPROMS. No PROM burner is required.

Window:  An area on the screen containing information. These windows
are triggered by the PLC controller and overlay any screen that is
displayed.

The following related publications provide additional information on
programmable controllers and I/O scanners.

Table P.A
Allen�Bradley Remote I/O Scanner Module User's Manuals

Publication Pub. No.

1772�SD/SD2 Remote I/O Scanner/Distribution Panel 1772�2.18

1775�S4A I/O Scanner�Programmer Interface Module User's Manual 1775�6.5.1

1775�S5, 1775�SR5 I/O Scanner�Communication Adapter Module User's
Manual

1775�6.5.5

5150�RS PI Start�up and Integration Manual 5000�6.5.1

6008�SI IBM� PC I/O Scanner User's Manual 6008�6.5.3

6008�SV VME I/O Scanner User's Manual 6008�6.5.2

6008�SQ Q�Bus I/O Scanner Utility Software User's Manual 6008�6.4.1

1771�SN Sub I/O Scanner Module Data Sheet 1771�2.91

1747�SN RIO Scanner User's Manual 1747�NM005

Table P.B
Allen�Bradley Programmable Controller User's Manuals

Publication Pub. No.

1772�LP2 PLC�2/20 Programming and Operations Manual 1772�6.8.1

1772�LP3 PLC�2/30 Controller Programming and Operations Manual 1772�6.8.3

PLC�3 Family Controller Programming Reference Manual 1775�6.4.1

PLC�5 Family Programmable Controllers Hardware Installation Manual 1785�6.6.1

PLC�5 Programming Software 6200�6.4.7

5250�LP1, LP2 PLC�5/250 Programming Manual 5000�6.4.8

SLC 500 Family of Programmable Controllers Advanced Programming
Software User's Manual

1747�NM002

Related Publications



Preface

P-4

To identify the manuals referring to these programmable controllers,
consult the Publications Index, Publication SD499, available from
Allen-Bradley.

Table P.C
Allen�Bradley Application Notes

Publication Pub. No.

Using a Mouse with PanelBuilder Development Software 2711�2.4

If you need help with your PanelBuilder Development Software, contact:

Allen-Bradley 
Software Support
6680 Beta Drive
Mayfield Village, Ohio 44143

Inside USA and Canada: 1-800-289-2279

Outside USA and Canada, contact your local Allen-Bradley office or call
USA (216) 646-6800.

The serial number for your software is on the card in the front of the User
Manual. Please have this number ready when you call for technical
support.

Please register your software by mailing the registration card to the address
above, or by FAXing the card to (216) 646-6770.

After�Sales Support
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Introduction to PanelBuilder

This chapter provides an overview of the PanelBuilder Development
Software. It describes:

 the features of PanelBuilder Development Software

 available objects, windows and PLC controlled options

Fast, Easy, Offline Configuration

PanelBuilder displays easy-to-use menus and fill-in-the-blank windows.
With arrow keys or a mouse, you choose options from the menus, and
position objects on the screens.

Even a monochrome display can be used to design screens for a color
PanelView terminal. On color computers, the colors are displayed as they
will appear on the PanelView terminal.

Changes and additions to application files are fast and easy: the original
file can be edited, or a copy uploaded from the PanelView terminal to the
development computer.

Application files can be created without a PanelView terminal connected.
To run the application file, however, it must first be downloaded to the
PanelView terminal.

Direct or Data Highway Downloading

Application files can be downloaded from the development computer to
the terminal via the Upload/Download cable (an RS-232 connection), or
via a Data Highway Plus, using the PLC-5 Pass-Through feature.

By using the Data Highway for downloading, you can download to several
terminals from a single development computer without having to go from
terminal to terminal, connecting the Upload/Download cable for each one.

PanelBuilder Features
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List Selection of Objects

Creating screens is made simple with PanelBuilder. To create a screen, you
choose the kind of object you want from a list and position it on the screen.
You then adjust its shape, size, color, text labels, PLC address, etc., and
continue adding objects until the screen is done.

If you are designing screens for a Keypad terminal, you assign custom
soft-key labels to each of the Keypad buttons. If you are configuring a
Touch Screen terminal, you position the labels over touch cell areas. Most
of the remaining functions are identical for Keypad and Touch Screen
terminals.

Dynamic Memory Display

As you develop or edit an application, PanelBuilder displays the amount of
memory the application will require in a PanelView terminal. As each
object is edited, the display is updated with the current application file size.
This makes it easy to be sure that your application file will fit in the
amount of memory in your terminal(s).

Security

With PanelBuilder Development Software, any PanelView screen can be
assigned a security classification. Before PanelView will display a screen
with assigned security, the operator must enter a 5-digit access code. Up to
8 operators can be allowed access to a designated screen.

Alternatively, up to 8 levels of access can be defined for each screen. You
can even change access codes or enable and disable security directly from
a PanelView terminal in Configuration Mode.

Security cannot be assigned to the Alarm History or Alarm Status Screens,
since they must be available to every operator. The terminal also ignores
security for the Powerup screen and for screens requested by the PLC
controller.

Printed Documentation

A wide variety of reports can be printed from PanelBuilder. These include
all screens, functions and PLC addresses configured for specific
application files.
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Message and Alarm Handling Utilities

A PanelView application can be configured with stored messages that can
be triggered by the PLC controller. There are three kinds of message
displays:

 Local Message Displays can appear in any free location on a specific
screen (875 messages maximum)

 Information Windows can pop up regardless of the screen currently
displayed (496 messages maximum)

 Alarm Windows can pop up regardless of the screen currently displayed
(496 messages maximum)

For each type of message displayed—local, information, or alarm—there is
a message list. You can add or edit messages using PanelBuilder software,
or you can create your messages in any text editor and import (and export)
the text as an ASCII file. Messages are numbered and listed in numerical
order in the message list.

See Chapter 7, Information and Alarm Windows, for more information.

Optional hardware that you may find convenient to use with the
PanelBuilder Development Software and the PanelView terminal is
available. For catalog numbers see Table 1.A in the PanelView Operator
Terminals User Manual.

Additional Upload/Download Cable

The Development Kit includes an Upload/Download cable that connects
the development computer’s RS-232 Port to the PanelView terminal’s
RS-232 Port. An additional Upload/Download Cable may be convenient if
you have a number of terminals, or if you want a spare.

Optional Remote Keyswitch & RS�232 Port Assembly

On the back of all PanelView terminals is a Mode Select Keyswitch and
RS-232 Port. The Remote Keyswitch and RS-232 Port Assembly allows
you to mount the port and keyswitch to the front of your control panel
while maintaining a NEMA 4X seal. This is convenient if you don’t have
easy access to the rear of the PanelView terminal. See Chapter 3, Installing
Your PanelView Terminal, for details on mounting and dimensions.

Options and Accessories
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Optional EEPROM or EPROM for Back�up or Additional Application
Memory

Earlier PanelView terminals contained two sockets for optional EPROM or
EEPROM chips. Series D and E PanelView terminals have only one socket
for an optional EPROM/EEPROM, called the user PROM.

 an EPROM can be used for application file back-up, which is useful for
keeping the application file safe, even in the event of a battery failure.
The application file is programmed into the EPROM with a PROM
burner. Once programmed, they cannot be erased or overwritten.

An application file must be burned into the EPROM by connecting an
EPROM burner to the development computer. The PanelBuilder
Development Software has been tested with the Data I/O Model 29A
EPROM burner. PanelBuilder downloads application files to the
EPROM burner in Intel Hex Format. Your EPROM burner must be able
to accept a simple dump of Intel Hex format data and use 27C512 or
28C512 type PROMs without special commands or operations.

PanelBuilder can also translate your application file to a DOS file with
the Intel Hex Format. This allows you to use other EPROM burners
(with their own software drivers) for the IBM PC�.

 an EEPROM can be used for application file back-up or for extra
application memory.

 when the EEPROM is used for application back-up, the
downloaded application file is automatically copied to the
EEPROM during the download operation.

 the EEPROM can also be used to increase the memory available
for application file storage from 64K to 128K. If the EEPROM is
used in this way, it cannot be used as back-up for the application
file.

Mouse

The mouse provides an optional convenience in PanelBuilder. The Mouse
menu allows you to set a damping factor to control how quickly the screen
cursor reacts to mouse movement. You can use the mouse instead of the
arrow and Enter keys, when developing screens. See Chapter 3, Using
PanelBuilder for information on configuring the mouse.
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Printer

Any standard text printer can print out reports. A printer that supports the
IBM extended character set is required for screen printouts. Specific
cabling instructions depend on your computer and printer.

The objects, windows and PLC controlled options are listed in three
groups: those used on both Keypad and Touch Screen terminals, those used
for Keypad terminals only, and those used for Touch Screen terminals only.

You will note that the objects are identified as either dynamic or static.
Dynamic objects interact with the PLC controller; static objects do not.

See Chapter 10, The Objects, for complete details on all objects. Chapter 7,
Information and Alarm Windows, describes the windows. Chapter 9, PLC
Controlled Options, describes the options that can be controlled from the
PLC controller.

Objects, Windows, and PLC
Controlled Options
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Table 1.A
PanelView Objects

Object Terminal Type

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Momentary Push Button (Normally Open) ÁÁÁÁÁ
ÁÁÁÁÁ

Both ÁÁÁÁÁ
ÁÁÁÁÁ

Dynamic

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Momentary Push Button (Normally Closed) ÁÁÁÁÁ
ÁÁÁÁÁ

Both ÁÁÁÁÁ
ÁÁÁÁÁ

Dynamic

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Latched Input Push Button ÁÁÁÁÁ
ÁÁÁÁÁ

Both ÁÁÁÁÁ
ÁÁÁÁÁ

Dynamic

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Maintained Push Button ÁÁÁÁÁ
ÁÁÁÁÁ

Both ÁÁÁÁÁ
ÁÁÁÁÁ

Dynamic

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Interlocked Push Button ÁÁÁÁÁ
ÁÁÁÁÁ

Both ÁÁÁÁÁ
ÁÁÁÁÁ

Dynamic

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Control List Selector with Enter ÁÁÁÁÁ
ÁÁÁÁÁ

Both ÁÁÁÁÁ
ÁÁÁÁÁ

Dynamic

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Control List Selector without Enter ÁÁÁÁÁ
ÁÁÁÁÁ

Both ÁÁÁÁÁ
ÁÁÁÁÁ

Dynamic

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Go To Screen Button ÁÁÁÁÁ
ÁÁÁÁÁ

Both ÁÁÁÁÁ
ÁÁÁÁÁ

Static

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Return to Previous Screen Button ÁÁÁÁÁ
ÁÁÁÁÁ

Both ÁÁÁÁÁ
ÁÁÁÁÁ

Static

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Screen List Selector ÁÁÁÁÁ
ÁÁÁÁÁ

Both ÁÁÁÁÁ
ÁÁÁÁÁ

Static

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Multi�State Indicator ÁÁÁÁÁ
ÁÁÁÁÁ

Both ÁÁÁÁÁ
ÁÁÁÁÁ

Dynamic

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

List Indicator ÁÁÁÁÁ
ÁÁÁÁÁ

Both ÁÁÁÁÁ
ÁÁÁÁÁ

Dynamic

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Set Value Button ÁÁÁÁÁ
ÁÁÁÁÁ

Both ÁÁÁÁÁ
ÁÁÁÁÁ

Dynamic

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Increment Value Button ÁÁÁÁÁ
ÁÁÁÁÁ

Both ÁÁÁÁÁ
ÁÁÁÁÁ

Dynamic

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Decrement Value Button ÁÁÁÁÁ
ÁÁÁÁÁ

Both ÁÁÁÁÁ
ÁÁÁÁÁ

Dynamic

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Numeric Data Display ÁÁÁÁÁ
ÁÁÁÁÁ

Both ÁÁÁÁÁ
ÁÁÁÁÁ

Dynamic

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Text ÁÁÁÁÁ
ÁÁÁÁÁ

Both ÁÁÁÁÁ
ÁÁÁÁÁ

Static

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Line ÁÁÁÁÁ
ÁÁÁÁÁ

Both ÁÁÁÁÁ
ÁÁÁÁÁ

Static

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Box ÁÁÁÁÁ
ÁÁÁÁÁ

Both ÁÁÁÁÁ
ÁÁÁÁÁ

Static

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Arc ÁÁÁÁÁ
ÁÁÁÁÁ

Both ÁÁÁÁÁ
ÁÁÁÁÁ

Static

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ISA Symbol ÁÁÁÁÁ
ÁÁÁÁÁ

Both ÁÁÁÁÁ
ÁÁÁÁÁ

Dynamic

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Bar Graphs (vertical or horizontal) ÁÁÁÁÁ
ÁÁÁÁÁ

Both ÁÁÁÁÁ
ÁÁÁÁÁ

Dynamic

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Time Display ÁÁÁÁÁ
ÁÁÁÁÁ

Both ÁÁÁÁÁ
ÁÁÁÁÁ

Dynamic

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Date Display ÁÁÁÁÁ
ÁÁÁÁÁ

Both ÁÁÁÁÁ
ÁÁÁÁÁ

Dynamic

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Screen Print Button ÁÁÁÁÁ
ÁÁÁÁÁ

Both ÁÁÁÁÁ
ÁÁÁÁÁ

Static

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Local Message Display ÁÁÁÁÁ
ÁÁÁÁÁ

Both ÁÁÁÁÁ
ÁÁÁÁÁ

Dynamic

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

ASCII Display ÁÁÁÁÁ
ÁÁÁÁÁ

Both ÁÁÁÁÁ
ÁÁÁÁÁ

Dynamic

ASCII Input Both Dynamic

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Numeric Input Cursor Point ÁÁÁÁÁ
ÁÁÁÁÁ

Keypad ÁÁÁÁÁ
ÁÁÁÁÁ

Dynamic

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Numeric Keypad�Enable Button ÁÁÁÁÁ
ÁÁÁÁÁ

Keypad ÁÁÁÁÁ
ÁÁÁÁÁ

Dynamic

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Screen Keypad�Enable Button ÁÁÁÁÁ
ÁÁÁÁÁ

Keypad ÁÁÁÁÁ
ÁÁÁÁÁ

Static

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Set Bit Cursor Point ÁÁÁÁÁ
ÁÁÁÁÁ

Keypad ÁÁÁÁÁ
ÁÁÁÁÁ

Dynamic

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Keypad Screen Selector ÁÁÁÁÁ
ÁÁÁÁÁ

Touch ScreenÁÁÁÁÁ
ÁÁÁÁÁ

Static

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Numeric Keypad ÁÁÁÁÁ
ÁÁÁÁÁ

Touch ScreenÁÁÁÁÁ
ÁÁÁÁÁ

Dynamic

Scrolling List Object Both Dynamic
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The following objects can be displayed on both the Keypad terminal and
the Touch Screen terminal:

 Momentary Push Button (Normally Open) turns on (sets to 1) a PLC
input control bit, as long as the button is held.

 Momentary Push Button (Normally Closed) resets a PLC input
control bit that is normally set to 1. This bit stays off as long as the
button is pressed.

 Latched Input Push Button turns on a PLC input control bit and holds
the bit on until the PanelView terminal sees a PLC output bit (handshake
bit) turn on.

 Maintained Push Button turns on a specific PLC input control bit until
the button is pressed a second time.

 Interlocked Push Buttons are several push buttons which function as a
group. When you press one of the buttons, it cancels the other buttons
and makes the selection. The PLC controller is informed—via a
common PLC input address—which button in the group is the currently
selected option.

 Control List Selector with Enter contains a vertical list of operator
choices. An operator can use the object’s Up Cursor and Down Cursor
buttons to move an arrow through the available selections. The selection
is only sent to the PLC controller when the Enter button is pressed.

 Control List Selector without Enter contains a vertical list of choices.
The operator uses the object’s Up Cursor and Down Cursor buttons to
move through the available selections. The current selection is
automatically sent to the PLC controller via the object’s PLC input
control address.

 Go To Screen Button allows the operator to switch to an assigned
screen.

 Return to Previous Screen Button switches back to the previous
screen.

 Screen List Selector allows an operator to choose a screen from a list.

 Multi-State Indicator  is a display area with up to sixteen different
display states, each with a unique combination of text, colors and
attributes. The value in the PLC address determines which state is
displayed.

Objects Common to All
PanelView Terminals
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 List Indicator  displays a list of PLC states and highlights the current
state. The value of the PLC address determines the item that will be
highlighted in the list.

 Set Value Button transfers a pre-defined value to the PLC controller via
the assigned PLC input address.

 Increment Value Button increases the PLC input value each time the
button is pushed. If the button is held down the PLC input value
continues to increase to a pre-assigned upper limit.

 Decrement Value Button decreases the value stored at a PLC input
address each time the button is pushed. If the button is held down the
PLC value continues to decrease to a pre-assigned bottom limit.

 Numeric Data Display displays the current value of an assigned PLC
address (binary, BCD, or integer). Scaling (Y=Mx+b) and other options
can be used to display the number in appropriate units.

 Text is used for screen titles, to provide instructions, or for any text that
is not bound to an object.

 Lines (Horizontal, vertical and diagonal) are used to illustrate, and to
separate sections of screens.

 Boxes are graphic objects like lines, which can surround other objects or
simply illustrate.

 Arcs are used to illustrate quarter, semi, and three quarter circles, as
well as circles. They can also be used to connect line objects to form
rounded corners.

 ISA Symbols (32 in total) allow you to assign display attributes to four
possible states for each symbol object. The symbols have two sizes:
large and small. See Appendix D, ISA Symbols, for symbol illustrations.

 Bar Graphs can be used to monitor changing conditions, such as
temperature or fluid levels. Each graph can be up to 80 characters wide
and 24 characters high.

 Time Display can be located anywhere on the screen.

 Date Display can be located anywhere on the screen.

 Screen Print Button allows an operator to print any screen currently
displayed on the PanelView terminal.
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 Local Message Display can be defined as a rectangular area of any size,
and placed in any location on the PanelView screen. A PLC control
address is assigned to the object, allowing the PLC controller to trigger
any one of up to 875 local messages to appear in this area.

 ASCII Display is used to display a character string, sent from the PLC
controller, directly on the PanelView terminal. The display is updated
whenever the string changes.

 ASCII Input  objects are on-screen keyboards which allow you to create
a text string and send it to the PLC controller.

 Scrolling List object is an extended and enhanced control list
selector/list indicator that is not limited by the number of lines on the
screen. The Scrolling List object can consist of any combination of local
message display, multi-state indicator, and numeric display lists, with up
to 999 items in each list. The Scrolling List object reduces PLC ladder
logic and addressing typically needed to display and edit large amounts
of data.

The Scrolling List object can be used to control and monitor sequential
operations in both auto and manual modes or to provide operators with a
selection list.

The following objects can be displayed only on a Keypad terminal:

 Numeric Input Cursor Point  consists of a numeric display and a
cursor character. This object can be used to enter numbers into an array
of numeric fields similar to an array of thumb-wheel switches on a
control panel. This object has an associated PLC input address in which
the value is communicated to the PLC controller.

 Numeric Keypad-Enable Button pops up the Numeric Entry
Scratchpad in which the operator can enter a number. The number is
then stored in the specified PLC input address.

 Screen Keypad-Enable Button pops up the Numeric Entry Scratchpad
in which the operator can enter a screen number. The screen with that
number is displayed.

 Set Bit Cursor Point consists of a bit and a cursor character. This
object is used to “point” to a screen character. Several set bit cursor
points can be in the same screen. Each one can have a different (user
defined) pointer; only the current pointer is visible and blinking. The
current cursor point’s input bit is always on, so the PLC controller
always “knows” the current selection.

Objects for the Keypad
Terminal
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Both the set bit and numeric input cursor points can be used on the same
screen.

The following objects can be displayed only on a Touch Screen terminal:

 Numeric Keypad is used to send a value to the PLC controller. A
unique PLC input address is assigned to each Numeric Keypad; the
value that the operator enters is stored at this address. The keypad is
available in large and small sizes.

 Keypad Screen Selector allows an operator to display a screen by
entering the screen number. The selector is available in large and small
sizes.

The Information and Alarm Windows can pop up on the screen at any time
to display important information:

 Information Window  displays a message when triggered by the PLC
controller. The window remains until the operator presses the
Clear/ACK  button, or until the PLC controller clears it. There can be as
many as 496 different messages for the Information Window.

 Alarm Window  is similar to the Information Window but with many
additional features. Each message can be configured to sound the audio
indicator (beeper), trip the alarm relay or print a message on a printer.

Alarms are time and date stamped and listed in the order they occur. The
operator can acknowledge the alarm, clear the display, silence the alarm,
view the Alarm History Screen, or view the Alarm Status Screen. There
can be as many as 496 different messages for the Alarm Window.

The following options can be controlled by the PLC controller:

 PLC Controlled Audio  allows the PLC controller to control the
PanelView terminal’s audio beeper. A PLC bit address is assigned; when
the PLC controller sets this bit, the terminal’s beeper is activated. This
does not interfere with the Alarm Window’s use of the beeper.

 PLC Controlled Alarm Relay allows the PLC controller to control the
PanelView terminal’s alarm relay. A PLC bit address is assigned, and
when the PLC controller sets this bit, the terminal’s alarm relay is
energized. This does not interfere with the Alarm Window’s use of the
relay.

Objects for the Touch Screen
Terminal

Information and Alarm
Windows

Summary of PLC Controlled
Options
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 PLC Controlled Alarm Quantity/Accum Time Reset allows the PLC
controller to reset the alarm count and the accumulated time in-alarm
total. These totals are shown in the Alarm Status screen.

 PLC Controlled Screen Number allows the PLC controller to control
which screen is displayed. When the PLC controller puts a screen
number in an assigned address, PanelView displays the screen. This
PLC controlled screen change always has precedence over
operator-controlled screen changes, and operator-generated screen
changes are only allowed if the PLC address contains 0.

 PLC Controlled Screen Print allows the PLC controller to trigger a
printout of the screen displayed on the PanelView terminal.

 PLC Controlled Time and Date allows the PanelView terminal to read
the time and date from the PLC controller and set its internal clock.

 PLC Controlled Clear Window clears the alarm window, the alarm
beeper and the alarm relay when a 0 to 1 transition is detected in the
assigned PLC address bit.

 PLC Controlled Silence Alarms silences the beeper and deactivates
the alarm relay when a 0 to 1 transition is detected on this bit.

PanelView terminals can be connected to any Allen-Bradley 1771 Remote
I/O Link. Applicable host controllers include almost all Allen-Bradley
Programmable Logic Controllers as well as certain IBM computers, VME
Controllers, and the DEC Q-Bus interface.

Newly released Allen-Bradley programmable controllers that are not yet
listed will support PanelView terminals, as long as they support the 1771
remote I/O link.

The PanelView terminal appears as one or more I/O rack(s) to a
programmable controller. It has the same configurability—and more—as a
standard I/O rack. Refer to your applicable Allen-Bradley Programmable
Controller and Remote I/O Scanner user’s manuals for various connection
and remote I/O configuration limitations. Chapter 4, Planning Your
Application, describes how to determine rack numbers, sizes, etc.

Applicable Programmable
Controllers and Connections
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PLC�5/11, 5/15, 5/20, 5/25, 5/30, 5/40, 5/60 and 5/250 Processors

You can connect one or more PanelView terminals directly to a PLC-5
Remote I/O Port (in Scanner Mode) along with other I/O racks. If the
PLC-5 Remote I/O Port is used in the adapter mode, one or more
PanelView terminals can be connected to that PLC-5 along with other I/O
racks via a 1771-SN I/O Subscanner Module.

All Series C Rev A and later terminals can communicate at 230.4K baud
with any PLC-5 capable of supporting that baud rate.

If you are using a PLC-5/15 with partial rack addressing and block
transfers, you must use PLC-5/15 series B, revision J or later.

Table 1.B
Rack Address Ranges of the PLC�5 Family

PLC�5/11 Rack 3 only

PLC�5/15 1�3 (octal)

PLC�5/20 1�3 (octal)

PLC�5/25 1�7 (octal)

PLC�5/30 1�7 (octal)

PLC�5/40 1�17 (octal)

PLC�5/60 1�27 (octal)

PLC�5/250 0�37 (octal)

PLC�5/10 Processor

One or more PanelView terminals can be connected to this processor along
with other I/O racks via the 1771-SN I/O Subscanner Module.

PLC�3 and PLC�3/10 Processors

One or more PanelView terminals can be connected directly to a PLC-3 or
PLC-3/10 remote I/O Scanner along with other I/O racks.

If you are using a 1775-S4A Remote Scanner /Distribution panel, you must
use Series B or higher.
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PLC�2 Family Processors via 1771�SN or 1772�SD2

This includes the PLC-2/05, 2/15, 2/30, 2/40, etc. One or more PanelView
terminals can be connected to these processors along with other I/O racks
via the 1771-SN I/O Subscanner Module.

If you are using a 1772-SD2 Scanner /Distribution panel, you must use
revision 3 or later.

SLC 5/02 via 1747�SN

One or more PanelViews can be connected to the 1747-SN I/O Subscanner
Module (SLC 500 RIO connection) for the SLC 5/02 processor. Each
module provides an additional remote I/O link for the host programmable
controller. The rack range of the 1747-SN is 0 to 3.

IMPORTANT:  With the SLC 5/02 and 1747-SN module, no block
transfers are possible.

1771�SN I/O Subscanner Module

One or more 1771-SN I/O Subscanner Modules can be installed in any
standard Allen-Bradley 1771 I/O rack. Each module provides an additional
remote I/O link for the host programmable controller. One or more
PanelView terminals can be connected to any of the previously mentioned
processors along with other I/O racks via a 1771-SN I/O Subscanner
Module. Refer to the 1771-SN Sub I/O Scanner Module Data Sheet for
specific details.

6008�SI IBM PC I/O Scanner

This module can be installed in an IBM PC or compatible computer to
provide the computer with an Allen-Bradley 1771 Remote I/O Link. You
can then connect Allen-Bradley Remote I/O racks and devices such as the
PanelView terminal to this computer.

6008�SV VME I/O Scanner

This module can be installed in a VME backplane, providing the VME
controller with an Allen-Bradley 1771 Remote I/O Link. Allen-Bradley
Remote I/O racks and devices such as the PanelView terminal can then be
connected to this VME controller.
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6008�SQ DEC Q�BUS I/O Scanner

This module can be installed into a DEC  Q-Bus  controller to provide it
with an Allen-Bradley 1771 Remote I/O Link. Allen-Bradley Remote I/O
racks and devices such as the PanelView terminal can then be connected to
this controller.
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Installing PanelBuilder

This chapter includes information on:

 PanelBuilder’s hardware and software requirements

 how to install and start up PanelBuilder

 the compatibility of older versions of PanelView terminals with
applications created by the current release of PanelBuilder

PanelBuilder requires DOS 3.0 or above.

PanelBuilder Development Software requires one of the following
computers:

 Allen-Bradley 1784 series industrial terminals and laptop computers

 Allen-Bradley 6120 series industrial computers and 6160 series
industrial workstations

 IBM XT  , AT , PS/2  or 100% compatible

In addition your system must have:

 one of the following video adapters and appropriate monitors:

 Standard Monochrome Adapter

 Hercules  Graphics Card

 Color Graphics Adapter (CGA )

 Enhanced Graphics Adapter (EGA )

 Video Graphics Array (VGA )

Screens for all terminals can be created using either a monochrome or
color monitor.

 at least 640K of RAM

 a floppy drive capable of reading the disks

Software Requirements

Hardware Requirements
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 a hard disk with at least 1.55Mb free space

 an RS-232 Serial Port: this port is required to upload and download
application files to and from your PanelView terminal

 an Upload/Download cable: this cable connects the development
computer’s RS-232 port to the PanelView terminal’s RS-232 port

The original PanelBuilder Development Software disks are not for running
the software. The floppy disks contain data-compacted, non-executable
files. The INSTALL procedure converts these files into executable form so
that PanelBuilder can run. The files can then be copied using standard
DOS commands.

Some of these files are for demonstration use and can be erased.

Table 2.A
PanelBuilder Files

Filename Description Status

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

PDS.EXE ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

PanelBuilder Development Software ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Essential

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

PDS.HLP ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

PanelBuilder Help File ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Essential

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

KC�DEMO.CFG ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Color Keypad demo program for PLC�5/15 ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Demo

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

TC�DEMO.CFG ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Color Touch Screen demo program for PLC�5/15 ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Demo

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

KCSLCDEM.CFGÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Color Keypad demo program for SLC 5/02 ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Demo

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

TCSLCDEM.CFGÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Color Touch Screen demo program for SLC 5/02 ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Demo

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

2711.B0$ ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Rung comment, instruction comment, address
comment and symbol files for PLC�5

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Demo

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

2711.B1$ ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁ
2711.IX$ ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁ
2711.LX$ ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁ
2711.OP$ ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁ
2711.PC$ ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁ
2711.AC$ ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ2711.CON

PanelBuilder Files



Installing PanelBuilder
Chapter 2

2-3

Filename StatusDescription

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

PVSLCDEM.AC$ ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

APS rung comment, instruction comment, address
comment and symbol files for SLC 5/02

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Demo

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

PVSLCDEM.B0$ ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁ

PVSLCDEM.B1$ ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁ

PVSLCDEM.IX$ ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁ

PVSLCDEM.LX$ ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁ

PVSLCDEM.OP$ ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁ

PVSLCDEM.PC$ ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁ

2711.AF5 ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Offline format of PLC�5 processor memory (also known
as an archive file)

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Demo

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

2711.D1$ ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁ
2711.P1$ ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁ
2711.LOG ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
Import/Export log file of PLC�5 ÁÁÁÁÁÁ

ÁÁÁÁÁÁ
Demo

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

PVSLCDEM.ACHÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

SLC 5/02 ladder program for use with demo ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Demo

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

PVSLCDEM.LIS ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

SLC 5/02 program listing report ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Demo

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

PVSLCDEM.NAMÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

SLC 5/02 ladder file names ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Demo

PVSLCDEM.PCR SLC 5/02 Processor Configuration Report Demo

Remote I/O Pass�Through Utility

The Remote I/O Pass-Through Utility disk is now provided with the
PanelBuilder Development Software disk set. You must install the Remote I/O
Pass-Through Utility to upload and download application files via the Data
Highway + and Remote I/O networks.

To install the Remote I/O Pass-Through Utility, place the disk labeled Remote
I/O Pass-Through Utility in a floppy drive, and at the DOS prompt, type:

install  press Enter

For information on uploading and downloading via pass-through, refer to
Chapter 6, File Operations, in the PanelBuilder Development Software User
Manual.

The DEFAULTS File

A DEFAULTS file is created when you first run PanelBuilder. The file
contains the default parameters for the mouse; the ports; the data file
directory; the display colors for PanelBuilder menus; and for all touch
screen and function key objects.
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If  your system contains a default file from an earlier version of
PanelBuilder, the file will be converted to version 5 format, and your
previously configured defaults will apply to the new installation. A copy of
the original file will be renamed as DEFAULT.nnn, where nnn is the
previous version number. (A defaults file from version 2.0 of PanelBuilder,
for example, would be renamed and saved as DEFAULTS.200.)

PanelBuilder Development Software is distributed on floppy disks. Before
installing PanelBuilder, make a backup copy of the original software. Store
the original software in a safe place and install PanelBuilder from the copy.

The software installation program creates a disk directory for PanelBuilder and
copies all the necessary files. By default, the directory is \PDS on drive C.

Example: Installing PanelBuilder in the \PDS directory on Drive C

Insert the (first) PanelBuilder Development Software disk in drive A and
switch to drive A. Type:

A:  press Enter

To run the installation program, type:

install  press Enter

Follow the instructions on the screen. If you wish to install the software in
some other directory or drive, you can change the drive and the pathname
when prompted by the installation program.

Follow these steps to start PanelBuilder:

1. Turn on the computer; if you are prompted, enter the time and date.

2. If the directory path isn’t specified, change to the PDS directory. If
you followed the INSTALL example, PanelBuilder is on the C drive.

Type:

C:  press Enter

CD PDS press Enter

Installing PanelBuilder on a
Hard Disk

Starting PanelBuilder
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3. To start the program type:

PDS press Enter

PanelBuilder Development Software has been upgraded four times: in
version 2, version 3, version 4 and now version 5.

As long as only the original objects and original features are used, your
application file will run on all PanelView terminals. If version 2 objects are
used in your application, the application will run on version 2, 3, 4 and 5
terminals, but not on version 1 terminals. If version 3 objects are used in
your application, it will run only on version 3, 4 and 5 terminals. Version 4
objects run on version 4 and 5 terminals. Enabling any of the new objects
in version 5 will make your application compatible with version 5
terminals only.

Table 2.B
Firmware Version Required for Objects and Features

These features require Version 2
firmware:

These features require Version 3
firmware:

These features require Version 4
firmware:

These features require Version 5
firmware:

Arc Extended Memory (via user
EEPROM)

Optional User EPROM/EEPROM
Power�Up Test

Scrolling List object

Diagonal Line Pass�Through Upload/Download PLC Time and Date Maximum of 875 Local Messages

ASCII Display Maintained Alarm Data Printer Form�Feed Control Alarm Status Reset Time/Date
Stamp

Alarm Status Screen Enhancements including up to 496
Alarm Messages

Improved Numeric Input Cursor
Point object

Terminal Pass�Through
Configuration

Background Alarming Alarm Messages longer than 36
characters

Screen Print Active feature

Screen Printing Single Line Alarm Window Acknowledge Alarm Indication

Auto�Repeat feature 230k Baud Rate: Series C Revision
A and later terminals

Acknowledge Information Message
Indication

Alarm History Screen number other
than 255

Block Transfer File 5 added ASCII Input object

Remote Clear/Silence of Alarm
Window

Control List Selector Enhancement Maximum of 255 objects on screen

Touch Screen Numeric Keypad
Enter Bit

Security Access Code Improvement

For a new application, the Version 5.0 PanelBuilder menus will default to
Version 5.0 features. See Figure 2.1 for modifying PanelBuilder menus.

Version Compatibility
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Figure 2.1
Setting the Version for PanelBuilder Menus to Version 5.0

23020

FILE MENU:       Screens     Windows     Options     Communications        Exit

5
Color

62,976
50 msec

1
400 msec

Disabled
Enabled
Disabled

Enabled
Disabled
Disabled
Disabled
Enabled

Options

Display Menus for Terminal Version
PanelView Display Type

User Memory Limit
Minimum Push Button On Time

Cursor Auto-Repeat Rate (per Sec.)
Cursor Auto-Repeat Start Delay

Time & Date to PLC Controller
Current Screen Number to PLC Controller
Screen Print Active to PLC Controller

PLC Controlled Audio
PLC Controlled Alarm Relay
PLC Controlled Screen Number
PLC Controlled Screen Print
PLC Controlled Time & Date

Configure Pass-Through Download Bits

Quit

When you’re developing an application file, PanelBuilder displays the
lowest level of compatibility for the application, at the left of the status line.

Figure 2.2
Version Compatibility and Memory Requirements of the Application File

23137

V5 Size: 20,001 File: SAMPLE    Keypad, Monochrome    Jun 21 1993 10:34

Memory requirements of this application file.

Minimum Firmware version
required for this application file.

FILE MENU:       Screens     Windows     Options     Communications        Exit
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Table 2.C
Version Compatibility

A Compatibility Level of: Runs on firmware releases:

1 1,2,3,4,5

2 2,3,4.5

3 3,4,5

4 4,5

5 5

Whenever you add or edit an object or enable or disable a feature in a way
that affects the file’s compatibility with various terminals, a message will
appear to inform you of the change.

PanelView Default Settings

In the unlikely event that version 1 firmware EPROMs are re-installed
after a terminal has been run with version 2, 3, 4 or 5 firmware EPROMs,
the following default settings will be lost:

 serial port settings

 access codes

 audio response

 alarm relay

 preset operations

 screen saver

 stuck button timeout

 screen alignment

 pass-through configuration

Verifying the PanelView Firmware Version

The firmware version is displayed on the PanelView terminal
Configuration Mode Menu screen along with the date of release, internal
version number and the current time and date.
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Figure 2.3
The PanelView Firmware Version Number

23593

Up

Cursor

Firmware Rev 05.00.00  06/21/93 (050900)  06/21/93 05:36:59 AM

Application File Name:  DEMO       10801 Bytes Used, 52175 Bytes Free

CONFIGURATION MODE MENU

�

Down

Cursor

Enter

Internal Version Number
Date Identification
and Software Version

Upload / Download

Serial Port

Rack Assignments

Access Codes

Audio Response

Alarm Relay

Preset Operations

Time and Date

Screen Saver

Screen Alignment

Stuck Button Timeout

User EPROM/EEPROM Power-up Test

Pass-Through Download Options

Unit Tests

In Figure 2.3 the Firmware Rev. 05.00.00 indicates version 5. Version 1
firmware is shown as 01.xx.xx., version 2 as 02.xx.xx, version 3 as
03.xx.xx and version 4 as 04.xx.xx.

Compatibility Reports

PanelBuilder can print a report listing all objects and global functions in an
application file. The report lists all screens and all objects used in a file.
More important for those with older terminals, the object listing shows the
version of firmware that is required for each object. With this report, you
can identify which objects must be removed or modified to make an
application file compatible with older terminals.

For details on how to print reports, see Chapter 6, File Operations.
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Using PanelBuilder

This chapter describes the basics of PanelBuilder including how to get help
and how to use the menus and the keyboard.

Press F1 to display a help screen relevant to the screen or object you’re
working on.

Certain keys are used to move through menus, enter data, or work with
objects on a screen. This section illustrates these keys and describes their
functions within the PanelBuilder software.

Menu Keys

The menu keys help you move quickly through the menus and the options
they provide.

The Escape key closes an open menu.

The Enter key chooses the highlighted option.

The Up and Down arrow keys move upward and downward through the
menu options. The Down arrow also opens a menu.

The Left and Right arrow keys move horizontally through a selection of
menus. These keys also close a menu and open the next one to the right or
the left.

The space bar moves horizontally through a selection of menus, or
vertically through the options of a single menu.

Getting Help
F1

The Keyboard

EscEsc

Enter

↓↑

��

Spacebar
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The Home key moves to the first item in a menu or selection.

The End key moves to the last item in a menu.

The F1 key displays the Help Screen.

The F2 key toggles the bottom status line on and off.

A Shortcut

In most menus, typing the first letter of an option’s name highlights that
option and opens that option’s window.

Data Entry Keys

Data is entered by choosing an item from a list or by typing in the required
information. Use the following keys when entering data.

The Escape key cancels the entry without saving the information.

The Enter key saves information once it is entered or chosen.

The Up and Down arrows move through a list of choices.

The Left  and Right arrows move the cursor through typed information, for
editing.

Pg Up moves several items upwards in a list or menu.

Esc
Home

Esc

End

F1

F2

Esc

Enter

↓↑

��

Pg Up
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Pg Dn moves several items downwards in a list or menu.

Home moves the cursor to the top of a list or to the beginning of a data
entry field.

End moves the cursor to the bottom of a list, or to the end of a data entry
field.

Ctrl-End  clears from the cursor to the end of a data entry field.

Ctrl-Home  clears a data entry field.

Insert toggles between insert and over-strike modes in a data entry field.

Keys for Editing Objects and Lines

The following keys are used to edit objects or lines on the screen.

Escape cancels the current operation and returns to the menu.

Enter finishes and saves the current operation and returns to the menu.

Tab or Shift Right moves the cursor, or the object, eight columns to the
right.

Pg Dn

Esc
Home

Esc

End

Ctrl +
Esc

End

Ctrl + Esc
Home

Ins

Esc

Enter

�

Shift +
�
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Shift Tab or Shift Left  moves the object, or cursor, eight columns to the
left.

Shift Up moves the object, or cursor, two rows up.

Shift Down moves the object, or cursor, two rows down.

Shift Home moves the object or cursor diagonally two rows up and eight
columns to the left.

Shift End moves the object or cursor diagonally two rows down and eight
columns to the left. 

Shift Pg Up moves the object or cursor diagonally two rows up and eight
columns to the right. 

Shift Pg Dn moves the object or cursor two rows down and eight columns
to the right. 

The Right arrow key moves the cursor, or the object, to the right. It also
draws or erases a horizontal line segment to the right. If you are setting the
size of an object, the Right arrow makes it larger.

The Left  arrow key moves the cursor, or the object, to the left. It also
draws and erases a horizontal line segment to the left. If you are setting the
size of an object, the Left  arrow makes it smaller.

The Up arrow moves the cursor or object upwards. It also draws or erases
a vertical line segment upwards. If you are setting the size of an object,
pressing the Up arrow makes it smaller.

The Down arrow moves the cursor, or the object, downwards. It also draws
or erases a vertical line segment downwards. If you are setting the size of
an object, pressing the Down arrow makes it larger.

Shift + �

Shift +
�

Shift + ↑

Shift + ↓

Shift + Home

Shift + End

Shift + Pg Up

Shift + Pg Dn

�

�

↑

↓
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Pg Up moves the cursor or object diagonally up and to the right. If you are
sizing an object, this key will increase the width and decrease the height of
the object.

Pg Up also draws or erases a diagonal line segment up and to the right.

Pg Down moves the object, or cursor, diagonally down and to the right. If
you are sizing an object, this key increases the width and height of the
object.

Pg Down also draws or erases a diagonal line segment down and to the
right.

Home moves the object or cursor diagonally up and to the left. If you are
sizing an object, this key decreases the width and height of the object.

The Home key also draws and erases a diagonal line segment up and to the
left.

End moves the object or cursor diagonally down and to the left. If you are
sizing an object, the End key decreases the object’s width and increases its
height.

The End key also draws and erases a diagonal line segment down and to
the left.

Ctrl Right  moves the cursor to the next text string when editing display
text. 

Ctrl Left  moves the cursor to the previous text string when editing display
text. 

Press the Ctrl or the Alt key to use the alternate character set for typing
object text. The set is illustrated in Appendix E, The Extended Character
Set.

The F3 key identifies the object being edited by causing it to blink.

Pg Up

Pg Dn

Esc
Home

Esc

End

Ctrl +
�

Ctrl +
�

Ctrl Altor

F3
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Figure 3.1 provides a guide for the menu structure of PanelBuilder
Development Software. Note that the Object Menu, at the bottom, shows
16 different items; in actual use, you will never see all of the items at once.
The contents of the Object menu change depending on the object being
edited.

Figure 3.1
PanelBuilder Menu Structure

MAIN MENU

ReportsTransferDevelop ExitSetupFiles

FILE MENU

OptionsWindowsScreens ExitCommunications

SCREEN MENU

DeleteMoveEdit OptionsRecallMemorize ExitAdd

OBJECT MENU

States & TextLook UtilityAddress ExitMove & Size

ButtonsMove FormatTextCursor Screen

ListMove & Edit States Outer Text
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The Main menu is the first menu displayed when PanelBuilder starts up,
and the last one displayed before shut-down. It contains the menus that
allow you to create, edit and manipulate application files. The Main menu
also allows you to send or receive application files to or from the
PanelView terminal, print reports on application screens, and set the
software for the creation of screens.

PanelBuilder Menu Structure

The Main Menu
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To open the Main menu, press any key when the Introduction Screen is
displayed.

Figure 3.2
The Main Menu
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Press F1 for Help                    Jul 25 1992 10:34

MAIN MENU:       Develop     Transfer     Reports     Files     Setup           Exit

The Develop Menu

To open the Develop menu, highlight Develop and press Enter. Use this
menu to create new application files, or to edit existing ones.

Figure 3.3
The Develop Menu
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Select File
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Quit

 Select File displays a list of application files which can be loaded and
edited.
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 Create New File allows you to make a new application file. After you
choose this option, type in a name for the new file and press Enter.
You’ll be asked if the file is for a Touch Screen or Keypad terminal.
Choose one or the other, and a new application file will be created.

 Directory  shows the current directory setting. Type in a different disk or
directory name to change the directory for loading or saving application
files.

The Transfer Menu

Choose Transfer from the Main menu, to open the Transfer menu. Use this
menu to send and receive application files to and from the PanelView
terminal.

Figure 3.4
The Transfer Menu
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Download to PanelView (RS-232)
Upload from PanelView (RS-232)

Pass-Through Download to PanelView (DH+ and Remote I/O)
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Burn EPROMs
Burn Single EPROM

Quit

 Download to PanelView Terminal (RS-232) sends a finished
application file to a terminal. The process involves the following steps:

1. Choose the file you want to send.

2. Establish the communications port.

3. Send the file.

 Upload from PanelView Terminal (RS-232) retrieves an application
file from a PanelView terminal for editing.

 Pass-Through Download to PanelView (DH+ and Remote I/O)
allows you to download PanelView files via a PLC-5 on a Data
Highway+ and remote I/O network. Before trying a pass-through
download or upload, refer to Chapter 6, File Operations.
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 Pass-Through Upload from PanelView (DH+ and Remote I/O)
allows you to upload PanelView files via a PLC-5 on a Data Highway+
and Remote I/O network. For more information on pass-through
download or upload, refer to Chapter 6, File Operations.

 Burn EPROMs allows an application file to be copied into EPROMs
for installation onto a PanelView terminal. Before burning EPROMs,
refer to Chapter 6, File Operations.

 Burn Single EPROM allows an application file to be burned into a
single EPROM for use with Series D or E terminals. This option must
also be used for upgraded older terminals with logic boards accepting
only one EPROM.

The Reports Menu

Choose Reports from the Main menu and the Reports menu appears. Use
this menu to generate printed reports of application files you have created.

For more information on reports and how to print them, see Chapter 6, File
Operations.

Figure 3.5
The Reports Menu
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Select File

Directory

Quit

 Select File presents a list of application files. Choosing any one will
open other menus where you can choose the types of reports you wish to
print, and choose a printer port.

 Directory  changes the directory setting, allowing you to locate files for
printing.

The Files Menu

Choose Files from the Main menu to open the Files menu. Use this menu
to copy, erase, rename, and move files to different disk directories.
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Figure 3.6
The Files Menu
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Application Files

Hex Files
All Files

Quit

 Application Files opens a menu that allows you to copy, erase and
rename application files.

 Hex Files opens a menu that allows you to copy, delete and rename hex
files. (Hex files are application files in Intel hex format—the format for
burning into EPROMs).

 All Files provides the same options for DOS files as those provided in
Application and Hex Files.

The Setup Menu

Choose Setup from the Main menu to open the Setup menu. Use this menu
to set various attributes for the PanelBuilder software, including the color
of PanelBuilder’s menus and text, and the time and date.

Figure 3.7
The Setup Menu
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MAIN MENU:     Develop    Transfer    Reports    File         Communicp      ExitSetup

Colors
Mouse

Time & Date

Information

Quit

 Colors permits you to choose the default palette of colors, or select your
own colors for the menus, data fields, etc., that will appear in
PanelBuilder during screen development.
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 Mouse allows you to use a mouse in PanelBuilder. A variety of serial
and bus mouse packages are available commercially, including software
drivers that emulate the functions of the arrow keys and Enter.

To use a mouse, you must install the driver and configure it to output the
cursor key codes when the mouse is moved. Similarly, the codes for the
Enter key and the Esc key must be assigned to two of the mouse’s
buttons. Refer to the mouse’s documentation for details.

Choosing Mouse allows you to adjust the “damping factors”—the
amount of mouse movement required to move the screen cursor. Keep
in mind the following points:

 a lower number moves the cursor further with the same mouse
movement

 with a bus mouse the damping factors may have to be set much
higher than the default settings

 settings that are too high or too low may cause undesirable
operation

IMPORTANT:  Allen-Bradley does not provide mouse driver software
for PanelBuilder. Ensure that the mouse package you purchase includes
driver software that allows the mouse to emulate the arrow, Enter, and
Esc keys. To use the cursor keys on the keyboard, the mouse option
must be disabled.

For information on how to interface the following mouse packages, ask
your Allen-Bradley representative for a copy of the application note
Using a Mouse with PanelBuilder Development Software:

 Microsoft� Serial Mouse Version 7.03

 Microsoft Bus Mouse

 Logitech  Serial Mouse Version 4.01

 Mouse Systems  Serial White Mouse or
Mouse Systems PC Mouse II Version 6.23

 Time & Date allows you to change the system’s time and date clock.

 Information  provides information on the version number of the
PanelBuilder software. For more details on version control, see Chapter
2, Installing PanelBuilder.
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The Exit Menu

Choose Exit from the Main menu to leave PanelBuilder.

Figure 3.8
The Exit Menu
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MAIN MENU:     Develop     Transfer     Reports    File    Setup      ExitExit

Yes, exit.

Cancel Exit

The File menu consists of five menus which allow you to edit application
files. To open the File menu, choose Select File or Create New File from
Develop in the Main menu.

Figure 3.9
The File Menu
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MAIN MENU:       Screens     Windows                             Setup              ExitDevelop

V1 Size:  2,243      File:  EXAMPLE      Keypad, Color       Jul 12 1992 14:40
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Select File
Create New File EXAMPLE

The File Menu
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The Screens Menu

Choose Screens from the File menu and the Screens menu appears, where
you create or edit screens and assign security levels.

Figure 3.10
The Screens Menu
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Select Screen
Create New Screen

Utilities
Powerup Screen

Application File Comment

Quit

 Select Screen chooses a screen from the application file.

 Create New Screen makes a new screen to work on.

 Utilities  allows you to copy, delete or rename screens, and assign screen
security levels.

For details on the Utilities menu see Chapter 8, Screen Operations.

 Powerup Screen allows you to specify the screen to be displayed when
the PanelView terminal starts up.

 Application File Comment allows you to add a 24 character message
about the application file.

The Windows Menu

Once you have returned to the Files menu, choose Windows to open the
Windows menu. Use this menu to:

 configure the Alarm and Information windows

 set the colors for the Terminal Fault, Alarm History and Alarm Status
screens

 set the numbers for the Alarm History and Alarm Status screens

 view alarm and information messages
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For more information see Chapter 7, Information and Alarm Windows.

Figure 3.11
The Windows Menu
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Quit

 Alarm Window  allows you to configure an alarm window for the
application file being edited. You can specify the alarm and information
messages and configure them to sound the alarm, trigger the alarm relay,
or print an alarm. You can also specify color (for a color terminal) and
size of the window, assign the PLC control address, define how alarm
acknowledgement will be communicated to the PLC controller, and
choose from various PLC controlled options.

 Information Window  allows you to configure an information window
for the application file being edited. You can specify the information
messages, the color (for a color terminal) and size of the information
window, assign the PLC control address, and enable an acknowledge
indicator that tells the PLC controller when a message has been
acknowledged.

 Terminal Fault Window  permits you to set the colors for the Fault
Window on a color PanelView terminal.

 Alarm History Screen permits you to set the screen number for the
alarm history screen, and for a color terminal, set the screen colors.

 Alarm Status Screen permits you to set the screen number for the
alarm status screen. It also allows you to enable/disable the Alarm
Status Reset Button, set the PLC Controlled Qty/Time Reset address,
and set the Qty/Time Reset to PLC Controller. Finally, in this screen you
can set the screen colors for a color terminal.

 Numeric and Security Entry Window allows you to set the Numeric
Entry and Security Window colors on a color system.
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The Options Menu

Choose Options from the File menu to open the Options menu. Use this
menu to:

 specify the PanelView display type including button delay, repeat
options and various PLC controlled functions

 use the optional user EEPROM as a source of extra application memory,
to expand the application memory to 128K

 set status/control bits which are used during pass-through transfer on a
Data Highway+

Figure 3.12
The Options Menu
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Time & Date to PLC Controller
Current Screen Number to PLC Controller
Screen Print Active to PLC Controller
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PLC Controlled Alarm Relay
PLC Controlled Screen Number
PLC Controlled Screen Print
PLC Controlled Time & Date

Configure Pass-Through Download Bits

Quit

Display Menus for Terminal Version allows you to set PanelBuilder’s
menus so the files you create will be compatible with version 1, version 2,
version 3, version 4 or version 5 of PanelView terminal firmware. Only
available features and objects compatible with the version you select will
be displayed. For more information on version control see Chapter 2,
Installing PanelBuilder.

PanelView Display Type sets the type of monitor that the application will
run on—either monochrome or color. For a color display, you can set and
change the palette of colors. You can create an application for a color
terminal even if your development system has a monochrome monitor.
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User Memory Limit  allows you to set the maximum amount of
application memory the file can occupy. With the standard amount of
application memory in the terminal (64K) you can choose whether or not
to retain the Alarm Status Screen data (the alarm count and accumulated
time in-alarm) in battery-backed memory. By choosing not to retain this
data in battery-backed memory, you increase the amount of memory
available to applications you have developed. To extend the amount of
memory even further, use the optional user EEPROM for extra application
memory. Then you can choose one of the 128K memory options.

IMPORTANT:  A User EEPROM must be installed in the terminal to
supply the extra memory. When the EEPROM is used for extended
application memory, it can’t be used to back up the application file.

Figure 3.13
Selecting the User Memory Limit

FILE MENU:       Screens     Windows     Options     Communications        Exit
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Color
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1
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Disabled
Enabled
Disabled

Enabled
Disabled
Disabled
Disabled
Enabled

59,904 Alarm Status Screen Data Battery-Backed
62,976 Alarm Status Screen Data NOT Battery-Backed
124,928 Alarm Status Screen Data Battery-Backed
128,000 Alarm Status Screen Data NOT Battery-Backed

The default is 62,976 Alarm Status Screen NOT Data Battery-Backed. The
setting you choose is saved in the application file.

IMPORTANT:  Your application file size must be in the same range as the
terminal’s memory configuration. If your file will fit into the lower
memory setting (59,904 or 62,976), choose one of these options.

If you select either of the higher options (124,928 or 128,000), the
following message will be displayed:
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Figure 3.14
Memory Limit Information Message
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Information

EEPROMs must be installed in the PanelView terminal to support this extended
user memory option. When the EEPROMs are used for extended user memory,
they cannot be used for backup of the Application File.

                                         Press any key to continue.

If, while you are editing your application, you increase the file size beyond
the User Memory Limit setting, the following message will be displayed:

Figure 3.15
Memory Limit Warning Message
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Warning

This application exceeds the currently selected user memory limit. This
operation will be completed. However, in order to download this application file
you need to change the user memory limit under Options in the File menu, or
delete one or more objects, messages or screens.

                                         Press any key to continue.

If you do not change the User Memory Limit to accommodate the extra
memory requirements, you will get an error message any time the file size
is critical, when attempting to download application files or create hex
files, for example.

 Minimum Push Button On Time extends the time that a button is
actually held on. This option helps to prevent a very quick button press
from being “ignored” by a PLC program or I/O scan.

 Cursor Auto Repeat Rate (per Sec.) allows you to set the repeat rate
for certain buttons including: list selectors, arrow keys, alarm window
and alarm status screens.

 Cursor Auto-Repeat Start Delay allows you to set a delay before the
repeat function starts, after a button has been pressed.

 Time and Date to PLC Controller enables or disables the transfer of
time and date from the PanelView terminal to the PLC controller.

 Current Screen Number to PLC Controller sends the current
PanelView screen number to the PLC controller each time the screen
changes.
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 Screen Print Active to PLC Controller warns the operator if the
printer is already busy with a screen print at the time the operator
requests a screen print.

 PLC Controlled Audio  allows the PLC controller to sound the beeper
on the PanelView terminal.

 PLC Controlled Alarm Relay allows the PLC controller to trigger the
PanelView terminal’s alarm relay.

 PLC Controlled Screen Number allows the PLC controller to change
screens on the PanelView terminal, with priority over the operator’s
settings.

 PLC Controlled Screen Print allows the PLC controller to trigger a
screen print of whatever screen is displayed on the PanelView terminal.

 PLC Controlled Time and Date allows the PLC controller to trigger
PanelView to obtain the time and date from the PLC controller and to
reset its internal clock to correspond.

 Configure Pass-Through Download Bits is only used for downloading
application files over a Data Highway Plus using the PLC-5
Pass-Through feature. For more information on downloading
application files over the Data Highway +, see Chapter 6, File
Operations.

When you choose this item, a second menu pops up, identifying three
optional (but strongly recommended) bits that can be configured for a
download. These addresses are only useful in conjunction with a PLC
program that can detect them and react to them.

 PLC Inhibit Bit Address —when this output address is set, the
PanelView terminal will not permit a download.

 Pass-Through Request Bit Address—this input address is set
when the download request is received, and is cleared once the
actual download begins.

 Pass-Through Status Bit Address—this input address is set while
the download is in progress, and is cleared once the download is
complete.

All three choices are set in the same way: a menu pops up where you
assign the address, rack number, start word, start bit, communication
type, and input or output.
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Figure 3.16
PLC Inhibit Bit Address Menu
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PLC Inhibit Bit Address

Current Address Unassigned Address

Data Type Bit
Communications Discrete

Input/Output Output
Rack 1
Start Word 0
Start Bit 0

Number of Bits 1

Update Address
View Address Map
Delete Address

Quit

Make the settings you require, and then choose Update Address to make
the settings current.

The Communications Menu

Choose Communications from the File menu to open the Communications
menu. Within this menu you can make rack assignments, assign block
transfer files, set the PLC baud rate and set up pass-through configuration
addresses.

Figure 3.17
The Communications Menu
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Block Transfer
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Quit

 PLC Type allows you to choose from a menu of supported PLC types.
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 Rack Assignment opens a menu where up to eight rack assignments
can be entered. Each one has a selection for rack number, starting
module group, rack size, and last chassis.

 Block Transfer opens a menu where up to five block transfer files can
be assigned. Each one has a selection for rack number, module group,
high/low byte and file size. Block transfer number 6 is reserved for the
Pass-Through function.

 PLC Baud Rate allows you to set one of three available PLC baud
rates:

 57.6 kilobaud, for a maximum cable length of 10,000 feet

 115.2 kilobaud, for a maximum cable length of 5,000 feet

 230.4 kilobaud, to a maximum cable length of 2,500 feet

Your terminal must be Series C Revision A or later to support 230.4
kilobaud. Some older PanelView terminals can be upgraded to support
the 230K baud rate. Contact Allen-Bradley System Support Services for
more information.

 Pass-Through Configuration allows you to configure the DH+ address
defining the PanelView terminal location and save it with the
application file. For a detailed discussion of this option see Chapter 6,
File Operations.

To open the Screen menu, select Screens and press Enter, then choose
Select Screen or Create New Screen. Each screen is automatically
numbered when you create it; however, you may enter a new number if
you wish. The number is displayed before the screen’s name.

The Screen menu contains eight items—including Exit—that are used to
manipulate or edit objects on any screen. Of these, the Move, Memorize,
and Recall menus can be used for single objects or groups of objects.

The Screen Menu
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Figure 3.18
The Screen Menu
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SCREEN MENU:   Add  Edit   Move   Delete   Memorize   Recall   Options   Exit

The Add Menu

To open this menu, choose Add from the Screen menu to display the list of
available objects. Objects can only be added one at a time.

Figure 3.19
The Add Menu
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Small
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The Edit Menu

Choose Edit and the Object Edit screen opens. Objects may only be edited
one at a time. To edit an object, select it by positioning the cursor on it, and
press Enter. The Object menu will open for editing.

IMPORTANT:  An object can only be edited when it is on the screen.

Figure 3.20
The Object Menu
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Move, Delete, and Memorize

These three menu functions can be used for single objects or groups of
objects.

When you memorize an object or a group of objects, you have the option
of memorizing the associated addresses as well. After choosing the
object(s) to memorize, you will be prompted:

Do you want to memorize the addresses as well?

If you choose Yes, the object addresses will be memorized; if you choose
No, only the screen appearance of the objects will be memorized.

The Memorize and Recall function can be used to copy the contents of an
entire screen to a new screen, or to another file. See the section Copying a
Screen From One Application to Another, in Chapter 8, Screen Operations.

The Move function is used in the following example to show how these
three menu options are used with object groups.
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Choose Move to begin the Object Move operation. “Select object or use
Multiple selection” is printed at the top of the screen as in the following
illustration.

Figure 3.21
The Move Menu
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To select a single object, use the cursor keys to move the cursor over the
object and press Enter to activate the command.

To choose several objects at once, press the M key. A second Object Move
screen opens offering five choices described below. Activate any of these
choices by typing the first letter of your choice on the keyboard. For
example, if you want to select an object, type the letter S.

 Select allows you to select one object at a time from a group of objects.
Use the cursor keys to move the cursor over the object, then press
Enter. The object will start flashing to indicate it is selected. Select
other objects in the group in the same way.

 Deselect allows you to remove one object at a time from a group of
selected objects. To deselect, place the cursor on the object and press
Enter. The object will stop flashing to indicate it is no longer selected.

 Group allows you to select or deselect a group of objects with a “rubber
band box” that appears on the screen.

To use this option, press G. A third Move Object screen will appear
displaying the rubber band box. Stretch or shrink the box with the cursor
keys to surround the objects of your choice, then press S or Enter to
select the objects, or the letter D to deselect.
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Once you have selected an object or objects, press Enter to perform the
actual move. The cursor will appear at the upper left corner of the
object(s) selected. Use the arrow keys to move the object(s). When the
desired position is reached, press Enter.

Figure 3.22
The Rubber Band Box
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 All  selects every object on the screen.

 Clear deselects all objects on the screen.

Recall

Choose Recall to add copies of one or more memorized objects to the
screen. If the recalled object(s) is on the same screen as the one that was
originally memorized, the two objects will overlap and look like a single
object until the recalled object(s) is moved.

If you memorize only one object, the Object menu opens for you to edit the
object as soon as the object is recalled. If you memorize more than one
object at a time, they will appear on the screen in Move and Size mode,
ready to be moved to whatever position you choose.

If two objects overlap, you will not be able to save the screen.



Using PanelBuilder
Chapter 3

3-25

With Memorize and Recall, you can copy groups of objects—even the
contents of an entire screen—to a different screen, or to a screen in another
application file, as long as the files are for the same kind of terminal,
Keypad or Touch Screen. See the section Copying a Screen From One
Application to Another, in Chapter 8, Screen Operations.

Options

The Options menu differs slightly between color and monochrome
terminals, and between keypad and touch screen terminals.

Figure 3.23
The Options Menu for Color Touch Screen Terminals
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Figure 3.24
The Options Menu for Monochrome Keypad Terminals
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 Object List displays a list of all the objects on a screen, along with
general object information.

 I/O Usage Table identifies the bits allocated to addresses in the terminal
rack and block transfer assignments for the application file.

 Background Color (Color terminals only) allows you to change the
screen’s background color.

 Function Key Table (Keypad terminals only) lists the function keys,
and the object assigned to each function key on the screen.
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Exit

The Exit choices are:

 Exit and Save screen saves the screen and returns to the File menu

 Save screen only saves the screen and stays in the Screen menu

 Don’t save, just Exit returns to the File menu without saving the screen

 Cancel Exit cancels the Exit

The selections offered in the Object menu allow you to precisely configure
each screen object.

Depending on the type of object you are creating or editing, the selections
offered in the Object menu will vary slightly.

Figure 3.25 shows three different Object menus. The menu at the top of the
illustration appears when a push button is selected. The next menu appears
for an arc, and the object menu at the bottom appears when a bar graph is
placed on the screen. When you select an object, it is identified at the
bottom of the Object menu screen.

Figure 3.25
Sample Object Menus
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Press F3 to make the object you are editing blink so you can identify it on
the screen.

Press F2 to remove the bottom status line so you can view the entire
display; press it again to enable the status line.

 Move & Size moves an object on the screen, changes its size, and
assigns it to a function key or touch cells.

The Object Menu
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 Move & Edit  moves and edits background text or lines on the screen.

 Look specifies the object’s color, border type, character size, and
whether the object will be blinking, underlined, highlighted, or in
reverse video. When adding ISA symbols, this is where you select
symbol types.

 Cursor is used with the Numeric Input Cursor Point and Set Bit Cursor
Point objects to define the cursor character. With it you can change the
cursor position, size (Large or Small), foreground and background color,
and the cursor display character. 

 Buttons is used to configure one or more of the following List Selector
buttons: Down Cursor button, the Enter button, and the Up Cursor
button. This menu option is also used to configure the buttons of an
ASCII Input and Cursor List object.

 List  configures the list elements of a List Selector and a Cursor List
object. It moves the list on the screen (independent of the buttons
associated with the list). For the List Selector object, it also determines
the width of the list (how many characters per line), and the number of
states (how many items in the list). In addition, it enters the text and
creates a border around the list. For the Cursor List object, it determines
the Number of States, Number of Visible States, Number of Preview
States, and the border of the Cursor List.

 States & Text displays the state of multi-state objects and configures
text and attributes for each state. These include: adding, editing or
moving text and outer text, blink, reverse video, high intensity, and
color.

 Outer Text defines the outer text for an object (such as a label outside a
button).

 Text is used to edit outer text and inner text.

 Format specifies the numeric display format.

 Address assigns the required PLC addresses to an object, assigns
control values and minimum/maximum values for the addresses, and
assigns button repeat parameters for specific objects.

 Screen allows you to assign a specific screen by entering the screen’s
number.

 Utility  assigns a name to the object and saves the new settings as the
new default for the object.
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 Exit  allows you to exit and save the object, save the object only, or exit
without saving the object.

The following section describes how to use the various options.

Move and Size

Use the Move and Size menu to define an object’s position and size, and to
assign function keys to buttons.

IMPORTANT:  Not every Object has a Move and Size menu. For
example, the Cursor List object only has a Move menu.

To Move an Object

1. Choose Move from the Move & Size menu. The cursor blinks in the
top right corner of the object.

2. Use the arrow keys to position the object. If you are designing a
screen for a Touch Screen terminal, remember that push buttons only
move in units that match the touch cells (by eight horizontally and by
two vertically).

3. When the object is in place, press Enter, or press Esc to return to the
original location on the screen.

To Size an Object

1. Choose Size from the Move & Size menu. The cursor blinks on the
object being edited, and the object’s size is shown in the top right
corner of the monitor.

2. Use the arrow keys to set the object’s size. The bottom right corner of
the object stretches or shrinks, while the top left corner stays still.

For notes on creating buttons for a Touch Screen terminal, refer to the
section Buttons and Touch Screen Terminals later in this chapter.

3. When the object is the correct size, press Enter, or press Esc to
restore the button to its original size.

Assigning Function Keys (Keypad terminals only):

1. Choose Function Key from the Move & Size menu.
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2. Type in the function key number that corresponds to the button you
are configuring, and then press Enter.

If you enter 0, no key is assigned.

Look

The options in the Look menu define the appearance of an object.

 Border Most objects allow you to define a rectangular border around
the object. To define a border:

1. Choose Border from the Look menu.

2. Choose the desired type of border. Your options are:

 Single
 Double
 None
 Dotted
 Outer
 Solid (the width of a character cell)

 Foreground Color provides a choice of color for the lines and borders
of the object. For color PanelView terminals you can assign both a
foreground and background color to each object.

 Background Color allows you to assign a background color to each
object created for color PanelView terminals.

IMPORTANT:  You cannot use the same color for both foreground and
background.

 High Intensity provides a choice of normal or high intensity display for
objects created for monochrome PanelView terminals.

 Reverse Video provides a choice of normal or reverse video display
(i.e., black on an amber background) for objects created for
monochrome PanelView terminals.

 Blink  causes the object to flash on the PanelView terminal screen.

 Underline underlines the display text on the screen on the PanelView
terminal screen.

 Character Height sets the object’s text as single or double height.

 Character Width  sets the object’s text as single or double width.
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 Symbol Type allows you to choose the type of ISA symbol. For a
complete listing of the ISA symbols and their on-screen appearance,
refer to Appendix D, ISA Symbols.

Buttons

Certain objects, such as the Control List Selectors and the Screen List
Selector, have two or more associated buttons. Use the Buttons menu to
configure these buttons.

Figure 3.26
The Buttons Menu for a Screen List Selector
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V1  Size:  1,068                                     Screen List Selector

OBJECT MENU:      Move      Look      List      Outer      Text      Utility      Exit

�

�

�

�

�

Buttons

SCREEN 1
SCREEN 2
SCREEN 3
SCREEN 4
SCREEN 5

UP

DOWN

ENTER

Up Cursor Enable
Down Cursor Enable
Enter

Quit

To configure a button, select the button type from the Buttons menu, and
choose either Enable or Disable. Disabling the button removes it from the
screen. (You can’t disable both the Up Cursor and Down Cursor buttons).
Enabling the button opens a menu with the following choices:

 Move positions the button on the screen independently of the other
components of the object.

 Size defines the size of the button.

 Function Key assigns a function key number (for Keypad terminals
only).

 Margin Size defines the display size of a margin of touch cells for the
button (on Touch Screen terminals only).
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 Edit Text  allows you to add text inside the button. The text can’t extend
outside the button’s border. To create a second line of text inside the
button, use the arrow keys to move the cursor to the next line. Press
Enter to save the new text.

 Move Text positions text within a button.

 Border sets the border for the button.

List

Certain objects, such as the Control List Selectors and the Screen List
Selector, contain a list of selections. The List menu configures the list.

Figure 3.27
The List Menu, for a Control List Selector
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V1  Size:  1,085                                     Control List Selector

OBJECT MENU:   Move  Look  Buttons  List  Outer Text  Address  Utility   Exit

�
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�
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STOP ON
IDLE ON
LO ON
MEDIUM ON
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Move
Width
Number of States 5

Edit Text
Move Text

Border Outer   �-�

Quit

UP DOWN

ENTER

PUMP_CONTROLS

 Move moves the list on the screen independent of any buttons
associated with the object.

 Width  determines both the width of the list on your screen and the
maximum number of characters for each list entry. Use the right arrow
to increase the list’s width, and the left arrow to decrease it.

 Number of States determines how many entries you can have in your
list and, consequently, the height of the list. Each state for the object
corresponds to one line in the list (two lines if Character Height is set to
Double).
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 Assign Screen to State (Screen List Selector only). For each selection
in the list you must designate the screen you want to display.

 Edit Text  allows you to type in the text for each selection. Use the
arrow keys to move the cursor from one line to the next when typing;
press Enter when you have finished entering all the text in the list.

 Move Text allows you to move text within the list.

 Border specifies the List Selector border type.

 Highlight Bar  allows you to select a highlight bar for the Object List in
the Scrolling List object. When you enable this option, the selected
object in the Object List is highlighted in reverse video.

States and Text 

States & Text allows you to define text and display attributes for State 0,
State 1 and Outer Text of all buttons except the Interlocked push button.

For the Multi-State Indicator, States & Text allows you to define up to 16
states. First define the number of states for the Multi-State Indicator, then
define the text and display attributes for each state.

 Display States lets you press the space bar to view the state settings you
have defined.

 Edit Text  allows you to enter text for the object. State Text appears
inside the object; Outer Text appears outside the object.

 Move Text moves the state text inside the object.

 Underline makes the state text appear underlined.

 Blink  causes the state text to flash on the PanelView terminal.

 Foreground Color sets the color of the state text and border.

 Background Color sets the color of the object.

 Reverse Video sets monochrome text to Reverse Video or normal
display.

 High Intensity sets monochrome text to High Intensity or normal
display.

 Character Height sets the characters to single or double height.

 Character Width  sets the characters to single or double width.
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Text and Outer Text

Any text you add with the Text menu or the Outer Text menu becomes part
of an object and is moved and copied with it. Do not confuse this display
text with Background Text.

For the different types of text (such as Inner Text, Outer Text and Button
Text) listed in the Text menu, the following choices are available.

 Edit Text  allows you to enter the state text for the object. State Text
appears inside the object; Outer Text appears outside the object. When
you enter text, remember to use the arrow keys to move from line to
line, and Enter to save the text.

 Move Text moves the text.

 Underline will make the text appear underlined.

 Blink  causes the text to flash on the PanelView terminal.

 Foreground Color sets the color of the text and border.

 Background Color sets the background color.

 Reverse Video sets monochrome text in reverse video.

 High Intensity sets monochrome text in high intensity.

 Character Height sets the characters to single or double height.

 Character Width  sets the characters to single or double width.

Format

Use the Format menu to define the numeric formatting in Numeric Data
Displays, Numeric Cursor Points and Numeric Keypads. There are three
options:

 Number of Digits specifies how many digits the Numeric Data Display
will have. You must specify a number between 1 and 8.

 Fill Left  specifies whether the characters to the left of the number
should be padded with zeros or spaces.
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 Decimal Point allows you to set the Numeric Data Display with a
decimal point. The position of the decimal point can be Fixed or PLC
controlled. If it is Fixed, set the Maximum Digits after Decimal Point
(between 0 and 7). If it is PLC controlled, specify the decimal point
address from the Decimal Point Position address.

 Decimal Key Controlled is an additional option for Numeric Keypads,
Numeric Cursor Points and Numeric Keypad-Enable buttons. With this
option, the PanelView terminal operator determines where to put the
decimal point by using the decimal key.

Address

Choose Address to assign the required PLC addresses to an object. It is
also used to assign control values and minimum/maximum values for the
addresses as well as objects.

To enter an address, define each of these items:

 Data Type defines the data type as Binary, BCD, Bit, or Integer
(signed) for the object. The Data Type is set to ASCII (two characters
per word) for the ASCII Display and ASCII Input objects.

 Communications specifies Discrete communications or Block
Transfers.

 Input/Output  specifies the address as an input or output address.

 Rack specifies the rack number. This option only appears for Discrete
communications.

 File specifies the block transfer file number. This option only appears
for Block Transfer communications.

 Start Word  specifies the starting word for the address.

 Start Bit  specifies the starting bit within the word for the address.

 Number of Bits specifies the number of bits in the address.

 Number of Words allows you to set the maximum number of
characters for the ASCII Display and ASCII Input objects. The range is
1 to 32 (contiguous words of two characters each) allowing up to 64
characters.
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Other Options in the Address Menu

 Update Address verifies all the values entered for the Data Type
through to the Number of Bits and saves them in Address Map. Look
for the new address beside “Current” at the top of the Address menu. If
you made a mistake entering a new address, an error message is
displayed when you choose Update Address.

 Change Preset sets the initial value of the PLC address that is used
after PanelBuilder downloads the application file to PanelView.

 View Address Map displays the PLC address bits allocated for all the
object, window, and PLC Control Option addresses in the application
file.

 Delete Address removes the existing address from the file.

 Preset shows the object’s current preset value.

Utility

Use the choices in the Utility menu to name the object being edited, and to
save a new set of default values for the object type.

 Name allows you to document an application by assigning a name to
each object (with the exception of Text, Line, Box, and Symbol). To
assign a name to an object:

1. Choose Name from the Utility menu.

2. When prompted, type in a name. It can be up to 15 characters
long, and can include any character on your computer’s
keyboard.

These names take up space in your application file. If you want
to save space on large application files, use short names or omit
this feature altogether.

3. Press Enter to accept the name, or Esc to cancel the operation.

 Default allows you to edit each object type’s default configuration. If
you want to change the default:

1. Edit the object to give it the attributes you want for the default.
These could include settings for size, shape, color, position, etc.
(not text).

2. Choose Default from the Utility menu.
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This saves the current settings for the particular object as the
new default. The PLC address can’t be saved as part of the
object’s default settings. For background text, only colors and
attributes (character height and width, underline, reverse video,
blink and high intensity) are saved as the default.

Exit

The Exit choices are:

 Exit and Save object saves the object and returns to the Screen menu

 Save object only saves the object and stays in the Object menu

 Don’t save, just Exit returns to the Screen menu without saving the
object

 Cancel Exit cancels Exit

Buttons and Keypad Terminals

When you create a button for a Keypad terminal, you are creating a
“soft-key” label for the button and then linking that label with a specific
key on the Keypad terminal. For example, if you want the operator to press
the F21 key to go to the next screen, you would place a “Go to Screen”
button on the right edge of the screen next to the F21 Key. Then you would
assign F21 to that button.

To assign a function key number to the label for single button objects
(Screen Selector Buttons, Push Buttons, Increment, Decrement, and Set
Value Buttons):

1. Choose Move and Size from the Object Menu.

2. Choose Function Key.

3. Enter the number for the desired function key (between 1 and 21, or 0
to leave the key unassigned).

To assign a function key number for multi-button objects (the Screen List
Selector, Control List Selector, and Control List Selector with Enter):

1. Choose Buttons from the Object Menu.

2. Choose a specific button.

3. Choose Function Key.

Button Concepts
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4. Enter the number for the desired function key.

If you want to hide the function key label, you can make it invisible by not
assigning a border or foreground text, and by changing the background
color to the screen color. You can also decrease the size of the label down
to 1 character cell, and move it to an unused area of the screen.

IMPORTANT:  If you need to use two function keys simultaneously, you
must use one from the horizontal group (F1-F16) and one from the vertical
group (F17-F21). Don’t use two from one section.

Buttons and Touch Screen Terminals

When you create a button for a Touch Screen terminal, you are designating
those touch cells that will make up the button, and the button’s label.

You must specify how big—how many touch cells wide and high—the
button is supposed to be. To specify size for single button objects (Screen
Selector Buttons, Control Push Buttons):

1. Choose Move and Size from the Object Menu.

2. Choose Size.

3. Use the arrow keys to shrink or stretch the touch cell.

4. Choose Margin Size to adjust the size of the button’s border.

To specify size for multi-button objects which have Up Cursor, Down
Cursor and Enter buttons all as part of one object, (the Screen List
Selector, Control List Selector, Control List Selector with Enter, Cursor
List and ASCII Input Object):

1. Choose Buttons from the Object Menu.

2. Choose a specific button.

3. Choose Size from the menu.

4. Use the arrow keys to shrink or stretch the touch cell.

5. Choose Margin Size to adjust the size of the button’s border.
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Buttons and Auto�Repeat

Three groups of buttons can have auto-repeat settings assigned. When
auto-repeat settings are changed from the default, the application will not
be compatible with version 1 firmware. For more information on version
control see Chapter 2, Installing Panel Builder.

Group 1 objects must be individually configured for auto-repeat when
each object is created. Group 1 objects include:

 Increment and Decrement Buttons

 Numeric Cursor Point Raise/Lower Function Keys

Set the Auto-Repeat Rate (per Sec.), Auto-Repeat Start Delay, and Amount
per Increment (for Increment buttons) or Amount per Decrement (for
Decrement buttons) under Address in the Object menu.

Group 2 objects are configured for auto-repeat as a group. Group 2 objects
include:

 Screen List Selector Up/Down Cursor Buttons

 Control List Selector Up/Down Cursor Buttons

 Control List Selector with Enter Up/Down Cursor Buttons

 Cursor Point Up/Down/Left/Right Function keys

 Alarm Window Up/Down Cursor Buttons/Keys

 Alarm History Screen Up/Down Cursor Buttons/Keys

 Alarm Status Screen Line Up/Down Cursor Buttons/Keys

 Cursor List Up/Down PgUp/PgDown Cursor Buttons

Set the Cursor Auto-Repeat Rate (per Sec.) and the Cursor Auto-Repeat
Start Delay under Options in the File menu. For group 2 objects, the
Amount per Increment is fixed at one.

Group 3 objects have a preset for auto-repeat which is not configurable.
Group 3 consist of the following objects in the Configuration Mode Menu
and the windows accessed from it:

 Main Menu: Up/Down Cursor Buttons/Keys

 Serial Port window: Change Data Button/Key

 Serial Port window: Up/Down Cursor Buttons/Keys
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 Access Codes window: Next Operator Button/Key

 Screen Alignment window: Up/Down/Left/Right Buttons/Keys

The Cursor Auto-Repeat Rate (per Sec.) for these objects is fixed at 4 per
second. The Cursor Auto-Repeat Start Delay is fixed at half a second and
the Amount per Increment is fixed at 1.
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Planning Your Application

This chapter is intended to help you plan a PanelView application. You
should at least skim the chapter before actually creating an application file.
It is important to become familiar with your PLC system configuration,
and your operator interface requirements.

Before designing your screens, you should be familiar with all the objects,
windows, and control options that are available. Refer to Chapter 7,
Information and Alarm Windows, Chapter 9, PLC Controlled Options, and
Chapter 10, The Objects.

Follow these steps when planning an application:

1. Consider safety regulations.

2. Determine your rack and block transfer needs.

3. Plan the appearance of each screen.

4. Complete the Object Address List.

5. Keep track of I/O usage.

6. Complete the PLC Communication Worksheet.

7. Determine the PanelView terminal firmware versions that you’re
designing for and adjust the planned object usage and memory
requirements accordingly.

When you get to the point of actually creating an application file, you will
find that the PanelBuilder makes it easy to revise your screen designs if
necessary, and automatically keeps track of I/O and memory usage.

Safety and PLC Programming Considerations

ATTENTION: Never use a PanelView terminal for emergency
stops or any other controls that are critical to the safety of
personnel or equipment; use separate hard-wired operator
interface devices that do not depend on solid state electronics.
Refer to the inside cover of this manual for more details and
references to applicable standards.

Emergency Stops and Other
Critical Controls
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System Response to a PanelView Terminal Failure

The PanelView terminal stops remote I/O communication and appears as a
faulted I/O rack to the host PLC controller if:

 the PanelView terminal is in configuration mode

 the PanelView terminal loses AC power

 the PanelView terminal has a major fault

 the remote I/O link fails

When any of the above situations occur, the associated rack fault bit in the
PLC controller will turn on (set to 1). Also, the programmable controller’s
discrete input image table and any block transfer read files will maintain
the last input states received from the terminal prior to the failure.

If there is no valid PLC communication with PanelView, and power is
removed and re-applied to the PLC controller, the programmable
controller’s discrete input image table bits will be reset to zero; block
transfer read files will retain their current states.

To ensure recovery from a faulted rack condition, program the PLC
controller to:

 monitor the rack fault bit associated with a PanelView terminal’s rack
assignment. Allen-Bradley PLC systems provide a rack fault bit table
which applies to PanelView terminals as well as to standard I/O racks.
Refer to your PLC documentation for specific information on this
function

 return any machine, or process that it controls, to a safe state of
operation in the event of any of the PanelView terminal rack fault
conditions previously described

When you plan the screen positioning of push buttons, be sure to consider
the following:

 Be careful not to use the same screen position for different buttons on
screens that might follow one another. An operator could inadvertently
press the same button position, mistaking a Start button on one screen
for a Stop button on another

 Don’t place important buttons on touch screens in a position where they
will be blocked by a temporary window such as an Alarm window,
Information window or Terminal Fault window

Button Location
Considerations
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Figure 4.1
Screen with Alarm Window Covering Buttons
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IMPORTANT:  As a safety feature, buttons are momentarily disabled
after screen changes. Also, whenever a new screen appears, all buttons
must be released before any button will respond.

Rack and block transfer assignments for a PanelView terminal follow the
same basic rules as standard Allen-Bradley 1771 I/O racks. For detailed
information on rack and block assignment, refer to the 1771 SN Sub I/O
Scanner Data Sheet.

Any available rack number(s) can be assigned to a PanelView terminal,
assuming, of course, that the assignment is valid for the type of host PLC
controller and Remote I/O Scanner in the PLC System. A PanelView
terminal can occupy up to eight different rack numbers and can also
support fractional rack assignments.

IMPORTANT:  Each rack assignment adds 5 to 7 milliseconds to the
remote I/O scan time.

Each rack can support up to 8 module groups (numbered 0–7). However,
PanelView can only support 1/4, 1/2, 3/4, and FULL rack sizes. Therefore,
the starting module groups are 0, 2, 4, and 6. Each module group supports
16 inputs and outputs which correspond to a 16-bit PLC I/O image table
word.

Understanding Rack and Block
Transfer Assignments

Starting Module Groups and
Fractional Racks
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Table 4.A
Rack Sizes

Starting Module Group Valid Rack Sizes

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

1st Quarter of rackÁÁÁÁ
ÁÁÁÁ

0 ÁÁÁÁÁ
ÁÁÁÁÁ

1/4 ÁÁÁÁ
ÁÁÁÁ

1/2 ÁÁÁÁ
ÁÁÁÁ

3/4 ÁÁÁÁÁ
ÁÁÁÁÁ

FULL

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

2nd Quarter of rackÁÁÁÁ
ÁÁÁÁ

2 ÁÁÁÁÁ
ÁÁÁÁÁ

1/4 ÁÁÁÁ
ÁÁÁÁ

1/2 ÁÁÁÁ
ÁÁÁÁ

3/4 ÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁ
3rd Quarter of rackÁÁÁÁ

ÁÁÁÁ
4 ÁÁÁÁÁ

ÁÁÁÁÁ
1/4 ÁÁÁÁ

ÁÁÁÁ
1/2 ÁÁÁÁ

ÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁ
4th Quarter of rackÁÁÁÁ

ÁÁÁÁ
6 ÁÁÁÁÁ

ÁÁÁÁÁ
1/4 ÁÁÁÁ

ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ

ÁÁÁÁÁ
ÁÁÁÁÁ

The PanelView terminal can share the same rack number with other
fractional Remote I/O racks and PanelView terminals. However,
PanelView terminals cannot be assigned the same rack number and contain
the same module group as another I/O chassis. The same rack number can
be assigned to a PanelView terminal and to other PanelView terminals or
I/O racks only if each is configured as a unique fraction of that rack
number. For example, Rack #1 could be configured as shown in Table 4.B.

Table 4.B
Remote I/O Configurations

Parameter First Remote I/O Rack Second Remote I/O Rack

Rack Number 1 1

Starting Module Group 0 6

Rack Size 3/4 1/4

Last Chassis No Yes

A PanelView terminal object, window or PLC controlled option can be
assigned either a discrete or block transfer control address.

IMPORTANT:  The SLC-5/02 and some PLC controllers do not support
block transfer addressing. See individual PLC controller manuals for this
information.

You can have up to five bi-directional block transfers (numbered 1–5) for
each PanelView terminal. A sixth block transfer file is reserved for the
pass-through function (the transfer of files between PanelView and the
computer over the Data Highway + connection). The Pass-Through block
cannot be used for normal block transfers. Refer to Chapter 6, File
Operations, for more information on the Pass-Through feature.

You must determine which byte—also known as module group and
slot—(in the I/O image table), will support each block transfer, and set up
the PLC’s block transfer instructions accordingly.

Block Transfers
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A block transfer address can be assigned to any PanelView terminal object,
window or PLC controlled option. PanelView references these addresses
according to block transfer file number (1–5), whether it’s a read or write
file, and its word (0–31) and bit number (0–15). The associated block
transfer instruction in the PLC controller will determine the actual PLC
address location of the read or write file. Each read or write file can
contain up to 32 PLC words.

Rack size and block transfer requirements depend on the number of
PanelView objects, windows and PLC controlled options that must interact
with the PLC controller. The smallest size is 1/4 rack. If you require more
objects or functions than can be supported by 1/4 rack, you can:

 increase the rack size (to 1/2, 3/4, or FULL)

 assign additional rack numbers

 assign block transfers

First, determine what rack numbers you have available. Next, try to
estimate how many racks you will need and whether or not you’ll need
block transfers.

There may be certain objects, such as push buttons, that you will definitely
prefer to keep in discrete I/O. Discrete I/O provides faster updates than
block transfers. Similarly, you may have identified a certain category of
objects or functions that you plan on grouping together using block transfer
addresses.

Following is the number of discrete I/O image table words and bits
available for PLC communication with each of up to 8 rack numbers
assigned:

Table 4.C
I/O Image Table Words and Bits

Rack Size 16�Bit Input
Words

16�Bit output
Words

Total Input Bits Total Output
Bits

ÁÁÁÁÁ
ÁÁÁÁÁ

1/4 ÁÁÁÁÁ
ÁÁÁÁÁ
2 ÁÁÁÁÁ

ÁÁÁÁÁ
2 ÁÁÁÁÁ

ÁÁÁÁÁ
32 ÁÁÁÁÁ

ÁÁÁÁÁ
32

ÁÁÁÁÁ
ÁÁÁÁÁ

1/2 ÁÁÁÁÁ
ÁÁÁÁÁ
4 ÁÁÁÁÁ

ÁÁÁÁÁ
4 ÁÁÁÁÁ

ÁÁÁÁÁ
64 ÁÁÁÁÁ

ÁÁÁÁÁ
64

ÁÁÁÁÁ
ÁÁÁÁÁ

3/4 ÁÁÁÁÁ
ÁÁÁÁÁ
6 ÁÁÁÁÁ

ÁÁÁÁÁ
6 ÁÁÁÁÁ

ÁÁÁÁÁ
96 ÁÁÁÁÁ

ÁÁÁÁÁ
96

ÁÁÁÁÁ
ÁÁÁÁÁ

FULL ÁÁÁÁÁ
ÁÁÁÁÁ
8 ÁÁÁÁÁ

ÁÁÁÁÁ
8 ÁÁÁÁÁ

ÁÁÁÁÁ
128 ÁÁÁÁÁ

ÁÁÁÁÁ
128

Determining Rack and Block
Transfer Needs
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Following is the maximum number of block transfers, data table words,
and bits available for PLC communication, when you assign from one to
five bi-directional block transfer files. This would be in addition to discrete
I/O words and bits.

Table 4.D
Block Transfer Data Table Words and Bits

No. of Block
Transfers

16 Bit Input
Words

16 Bit Output
Words

Total Input Bits Total Output
BitsÁÁÁÁÁ

ÁÁÁÁÁ
1

ÁÁÁÁÁ
ÁÁÁÁÁ
32

ÁÁÁÁÁ
ÁÁÁÁÁ

32
ÁÁÁÁÁ
ÁÁÁÁÁ

512
ÁÁÁÁÁ
ÁÁÁÁÁ
512

ÁÁÁÁÁ
ÁÁÁÁÁ

2
ÁÁÁÁÁ
ÁÁÁÁÁ
64

ÁÁÁÁÁ
ÁÁÁÁÁ

64
ÁÁÁÁÁ
ÁÁÁÁÁ

1024
ÁÁÁÁÁ
ÁÁÁÁÁ
1024

ÁÁÁÁÁ
ÁÁÁÁÁ

3
ÁÁÁÁÁ
ÁÁÁÁÁ
96

ÁÁÁÁÁ
ÁÁÁÁÁ

96
ÁÁÁÁÁ
ÁÁÁÁÁ

1536
ÁÁÁÁÁ
ÁÁÁÁÁ
1536

ÁÁÁÁÁ
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ÁÁÁÁÁ
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ÁÁÁÁÁ
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ÁÁÁÁÁ
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ÁÁÁÁÁ
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ÁÁÁÁÁ
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You can reduce PLC address requirements by multiplexing—in other
words, using one screen object for more than one purpose, depending on
the state of a variable.

Normally you won’t need to multiplex objects—PanelView provides
plenty of separate I/O addresses as well as the capability for block transfers
and multiple racks. However, you can multiplex momentary push buttons,
numeric display data, and other objects.

Here are some examples:

Examples of Multiplexed Objects

Multiplexing a Momentary Push Button requires a second PLC address.
This is checked by the PLC program to determine how to interpret the push
button’s control bit. For example, you could have a List Selector’s input
address work as the multiplex address. The PLC program would then
check this address to decide how to respond when the button is pressed.

Multiplexing a Numeric Display and a List Selector—the List Selector’s
input address would work as the multiplex address. The PLC program
could check the value at the multiplex address before deciding which value
to put in the Numeric Display.

Reducing PLC Addressing
Needs
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Using the same addresses for Numeric Displays on different
screens—by using the Current Screen Number to PLC Controller Option
function, you can tell the PLC controller which screen is currently
displayed. The PLC controller could then be programmed to display one
set of values if the first screen is displayed, and a completely different set
of values when the second screen is displayed.

Using the same address to send multiple types of information to the
terminal—by allowing the PLC to use the same address to send multiple
types of information to the PanelView terminal, the Scrolling List object
reduces PLC ladder logic and addressing typically needed to display and
edit large amounts of data.

There are six worksheets to help you plan an application. They include:

 Screen Worksheet for Keypad Terminals

 Screen Worksheet for Touch Screen Terminals

 Object Address List

 Discrete I/O Usage Worksheets

 Block Transfer I/O Usage Worksheet (2 pages)

 PLC Communications Worksheet

Two blank copies of each are included in Appendix C, Sample Worksheets.
Included in this chapter are completed worksheets for a sample application
discussed in this chapter and in Chapter 5, Creating a Sample Application
File. This section describes the steps involved in completing the
worksheets. A discussion of each worksheet follows.

How to Complete the Worksheets

1. Determine the rack numbers you can use for your PanelView
terminal. Although you won’t know your exact PLC I/O address
requirements until you’ve defined all the objects, windows and PLC
controlled options, you do need to know what rack numbers are
available so you can assign PLC addresses.

2. Use the appropriate screen worksheet and draw the objects for your
first screen.

Worksheets
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3. With the Object Address List, define the discrete or block transfer
PLC addresses for each object on your screen.

4. Enter the object reference number and screen number on the I/O
Usage Worksheets to map your PLC memory usage. Use the Discrete
I/O Usage Worksheet for discrete addresses. Use both the Discrete
I/O Usage Worksheet and the Block Transfer I/O Usage Worksheet
for Block Transfer Files. Use the Discrete worksheet to record any
block transfer control bytes in both the Input and Output sections of
the image table.

5. Use a new Screen Worksheet and Object Address List for each
screen. Use one Discrete I/O Usage Worksheet for each full or partial
rack assignment, and two Block Transfer I/O Usage Worksheets for
each block transfer file.

6. Use a separate Object Address List to record the addresses for your
windows and PLC controlled options, and map these addresses onto
the I/O Usage Worksheets. You may also wish to record all the
messages associated with the Alarm and Information windows, and
the Local Message Display object.

7. Only after you’ve finished assigning addresses to your objects,
windows and PLC controlled options will you know exactly how
many racks to assign to your PanelView terminal. Enter this
information on the PLC Communications Worksheet.

8. Calculate the size of the application file: your PanelView memory
requirements can’t exceed the terminal’s capabilities. Refer to
Table 4.E and Table 4.J.

Table 4.E
Terminal Memory Limits (in bytes):

Firmware Bytes of Memory

V1 and V2 firmware 62,976

V3, V4 and V5 firmware without retained alarm
data

62,976

V3, V4 and V5 firmware with retained alarm
data

59,904

V3, V4 and V5 firmware with 64k extra
EEPROM memory without retained alarm data

128,000

V3, V4 and V5 firmware with 64k extra
EEPROM memory with retained alarm data

124,928
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There are two types of screen worksheets: one for keypad terminals, and
one for touch screen terminals.

The Screen Worksheets are helpful in planning your screens; just
hand-draw the objects you want. Each screen-specific function is
represented on the screen by a visible object, such as a push button,
numeric display, indicator, text, etc. Based on your functional
requirements, identify all objects, windows and PLC controlled options
that your application requires.

A maximum of 255 objects can exist on a single screen. Objects generally
occupy a rectangular group of character cells. The size of this rectangle is
limited only by available screen space, since objects can’t be placed on top
of one another.

IMPORTANT:  If your screen changes are not PLC controlled, include a
screen select button on each screen you design so you can exit from it.

For detailed information on objects, information and alarm windows, and
PLC controlled options, refer to Chapter 7, Information and Alarm
Windows. Also, see Chapter 9, PLC Controlled Options and Chapter 10,
The Objects.

Screen Worksheet for Keypad Terminals

Use the Screen Worksheet for Keypad Terminals to specify the position
and size of every object. It outlines the 24 x 80 grid available for each
screen, and shows how the function buttons are aligned to character cells.

Screen Worksheets
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Figure 4.2
Screen Worksheet for Keypad Terminals
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Screen Worksheet for Keypad Terminal

Screen Name:

Application File Name:

Screen Number:
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F16
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Sketch the button’s label on your Screen Worksheet. You would likely
place this label adjacent to its respective function button, although you
could place it anywhere on the screen.

Objects can be rectangles of any size as long as they don’t overlap other
objects.

IMPORTANT:  When designing a screen, remember that the Alarm
window, the Information window and the Terminal Fault window can pop
up and cover any objects underneath. Also, if the objects on the screen use
the same buttons as the pop-up window, these buttons will be redefined
until the window is cleared.

Screen Worksheet for Touch Screen Terminals

Use the Screen Worksheet for Touch Screen Terminals to set the position
and size of each object on a touch screen. It outlines the 24 x 80 grid and
the actual alignment of the touch cells.
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Figure 4.3
Screen Worksheet for Touch Screen Terminals
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Screen Worksheet for Touch Screen Terminal

Screen Name:

Application File Name:

Screen Number:
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Sketch the label for each button on your worksheet. Buttons must be sized
in multiples of touch cells. Other objects, such as boxes or lines, can be
any size—from a one character cell to the full screen. Objects cannot
overlap.

IMPORTANT:  When designing a screen, remember that the Alarm
window, the Information window and the Terminal Fault window can pop
up and cover any objects underneath. On Touch Screen terminals, any
buttons which are covered can’t be pressed.

The Object Address List

Use the Object Address List to record details of the object you will put on
a screen, including object name, type, and address information. One or
more worksheets should be used for each screen.

Object Address List and I/O
Usage Worksheets



Planning Your Application
Chapter 4

4-12

Figure 4.4
The Object Address List Worksheet

Object Address List

Screen Number:Application File Name:

Object Address

D/B I/O R/F Wrd
Blk Xfer

PLC Addr Preset
Ref
No. Type Name

No. of
states

Data
Type

No. of
BitsBit

 Dynamic objects interact with the PLC controller and must be assigned
PLC addresses. Keep a separate list of dynamic objects for each screen.

 Static objects do not interact with the PLC controller, and don’t need a
PLC address. Text, Lines, Boxes, etc., are static and so are not listed in
the Object Address List.

The Alarm window, Information window, and PLC controlled options are
not screen specific. If you use them, list them on a separate Object Address
List.

The I/O Usage Worksheets

There are two I/O Usage Worksheets, one for discrete and one for block
transfer addresses. Use the two I/O Usage Worksheets in conjunction with
the Object Address List to keep track of free and allocated PLC I/O
addresses.

The Object Address List is for all dynamic objects, and for window and
PLC controlled options. Only a few objects require that you fill in all the
columns.



Planning Your Application
Chapter 4

4-13

There are certain objects or functions, such as Push Buttons, that are better
kept in discrete I/O. Similarly, you may have identified a category of
objects or functions that will be grouped together using block transfer
addresses. Start at the beginning of each block transfer or module group.

Use the Discrete I/O Usage Worksheet and the Block Transfer File Usage
Worksheet for any window and Controlled Options you include in your
application.

Figure 4.5
Discrete I/O Usage Worksheet

Discrete I/O Usage Worksheet
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Figure 4.6
Block Transfer I/O Usage Worksheet

Block Transfer I/O Usage Worksheet (Page 1 of 2)
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Block Transfer I/O Usage Worksheet (Page 2 of 2)
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Completing the Object Address List and I/O Worksheets

Fill out both the Object Address List and I/O Usage Worksheets for each
dynamic object. Mark on the I/O Usage Worksheet the PLC control bit(s)
that are to be assigned to that object.

Object

Each object must be assigned a type and reference number.

 Object Name identifies the object’s purpose. If the object has more than
one address, use the Object Name column to identify the purpose of
each associated PLC address. When you use these names in the
application file they take up memory, so keep them as short as possible.

 Object Type specifies which type of object you want, such as a Latched
Input Push Button.

 Reference Number is used to assign a unique reference number to each
object in the Object Address List. The object’s PLC address bit(s) must
also be indicated on the I/O Usage Worksheet.
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Address

To define the object’s PLC address, you must determine whether the
address is discrete or block transfer; whether it’s an input or output
address; the rack or file number; the word number; and the bit number, if
applicable.

Some objects require additional I/O addresses. If so, use one line in the
Object Address List for each PLC address and use the Name column to
describe the function of the additional address.

 Discrete or Block Transfer—either discrete or block transfer addresses
can be assigned to any object. In the D/B column, “D” refers to a
discrete address, and “B” refers to a block transfer address.

To assign discrete I/O addresses to PanelView objects, use the actual
PLC I/O image table address. The address must be within the range of
the I/O rack number assignments being configured for the PanelView
terminal.

The 1747-SN I/O subscanner module converts the I/O image table
address assigned in PanelBuilder into a special format in the SLC-5/02.
If you are using this scanner, see the section on SLC Addressing for
PanelView Applications in Appendix A, PLC Programming
Consideration.

With block transfer addresses, you designate Block Transfer File
Number (1–5). The word number specified here is not that of any
particular PLC address; it is the word offset (0–31) in the block transfer
Read or Write file. The block transfer instructions in the PLC program
determine where in the PLC data table the files will be read from and
written to. This concept also applies to 1771 Intelligent I/O Modules
that support block transfer.

The following entries are included in the Block Transfer and PLC table.

 Input or Output  specifies whether the assigned address is an Input (I)
“read” address, or an Output (O) “write” address.

 Rack or File Number identified in the “R/F” column to specify the
Rack Number (octal) for a discrete address, or the Block Transfer File
Number (1–5) for a block transfer address.
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 Word Number specifies the word address number in the discrete rack
or block transfer file. Use the “Wrd” column to specify the word number
(0–7 octal) if the address is discrete. This word number is also referred
to as module group number when actual 1771 I/O racks are addressed. If
this is a block transfer address, the range is 0–31 (decimal). The actual
PLC data table addresses will be determined by the block transfer
instruction in the PLC program.

 Bit Number—the range is 0–17 octal for discrete (i.e., 0–7 and 10–17),
and 0–15 decimal for block transfer. There are 16 bits per word.

IMPORTANT:  Discrete addresses are octal; block transfer addresses are
decimal.

Block Transfer PLC Address

The “Blk Xfer PLC Addr” column documents the actual PLC Data Table
Address. Use this column to document the actual PLC data table address.
The block transfer instructions in the PLC ladder program will determine
where in the PLC data table the block transfer files will be read from and
written to.

You may also use this to record the actual SLC-5/02 Data Table Address in
0–31 Word/0–15 bit format vs. the PanelView 0–3 rack/0–7 word 0–7 and
10–17 bit format. Refer to Appendix A for SLC addressing example.

Preset

Use this column to assign a preset value to an object that has a PLC input
address.

Number of States

This column is for objects that can be assigned a specific number of states.
The “Number of States” column, combined with the “Data Type” column,
is used to calculate the “Number of Bits” an object requires.

Data Types

Use this column for the data type to be assigned to each object’s PLC
addresses. PanelView supports 4 data types: binary, signed integer, BCD,
and bit position. The bit position data type is unique to PanelView.
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 Binary—when you select the binary data type, the object’s PLC address
will be a contiguous bit string 1 to 16 bits long. The range of values you
can access will depend on the number of bits you assign. You can
position a binary data address anywhere within a PLC word (any ”start
bit”). It is possible for the binary data address to extend into the next
word, but not past the end of a rack assignment or block transfer file.
The remaining bits in that word, on either side of the binary data
address, can be used for other PLC data types.

Table 4.F
Number of States Supported by Specific Number of Bits for Binary Data Types

Number of Binary States Bits Required
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

1-2
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

1
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

3-4
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

2
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

5-8
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

3
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

9-16
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

4
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

17-32
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

5
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
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16

 Signed Integer always occupies one 16-bit word. Positive integers are
stored in straight binary format while negative integers are stored in
two’s complement format. The range of data values is from –32,768 to
+32,767.

 BCD (Binary Coded Decimal)—if you select the BCD data type, the
object’s PLC control word will be a contiguous bit string of either 4, 8,
12, 16, 20, 24, 28, or 32 bits. The exact number of bits required will
depend on the maximum value required for the object. The first bit in a
BCD bit string can be aligned on any bit in a PLC word, but you would
typically use bit zero. It is possible for the BCD bit string to extend into
the next word, but not past the end of a rack assignment or block
transfer file.
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Each group of 4 bits represents the equivalent of 1 digit in a numeric
value display.

Example: BCD Values or States

If you configured a BCD data value to have a maximum of 16 states (2
digits), then the assigned address would be an 8-bit contiguous string
with 4 bits for each digit.

2 digits @ 4 bits each = 8 bits

If a numeric value display was configured to have a range from 00000
to 99999 (5 digits), then the assigned address would be a 20-bit
contiguous string with 4 bits for each of the 5 digits.

5 digits @ 4 bits each = 20 bits

Since a PLC word can only support 16 bits, an additional word is
required for the additional 4 bits.

When more than one PLC word is required to support the required
number of digits, all remaining digits will extend into the next higher
word. Taking another example, BCD value 123456 would be
represented in two PLC words as follows.

Table 4.G
BCD Format

ÁÁÁÁÁ
ÁÁÁÁÁ

Bit Numbers ÁÁÁÁÁ
ÁÁÁÁÁ

17 16 15 14 ÁÁÁÁÁ
ÁÁÁÁÁ

13 12 11 10 ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

7 6 5 4 ÁÁÁÁÁ
ÁÁÁÁÁ

3 2 1 0

ÁÁÁÁÁ
ÁÁÁÁÁ

Word X ÁÁÁÁÁ
ÁÁÁÁÁ

3 ÁÁÁÁÁ
ÁÁÁÁÁ

4 ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

5 ÁÁÁÁÁ
ÁÁÁÁÁ

6

ÁÁÁÁÁ
ÁÁÁÁÁ

Word X+1 ÁÁÁÁÁ
ÁÁÁÁÁ

ÁÁÁÁÁ
ÁÁÁÁÁ

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

1 ÁÁÁÁÁ
ÁÁÁÁÁ

2

Table 4.H shows the number of bits required for different numbers of
BCD digits:
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Table 4.H
Bits Required for BCD Digits

Number of BCD Digits Bits Required

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

1 ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

4

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

2 ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

8

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

3 ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

12

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

4 ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

16

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

5 ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

20

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

6 ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

24

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

7 ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

28

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

8 ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

32

 Bit Position Data Type—when you assign a bit position data type to a
dynamic object or window, each state of the object will correspond to a
unique bit in the assigned address (contiguous bit string).

The number of bits required is one (1) less than the maximum number
of states since All Bits Off is a state in itself (state 0). This applies to
objects but not message windows.

It is possible for the bit string to extend into the next word, but not past
the end of a rack assignment or block transfer file.

The bit position data type can also be used for objects that are controlled
by PLC outputs. For example, you could configure a Multi-State
Indicator to have twelve states, each with unique text and attributes. The
PLC output address would then be an eleven-bit string. Whichever bit
the PLC controller set would determine which state PanelView displays.

If more than one bit is set at a time, PanelView will consider only the
lowest bit set when assigned to Multi-State indicator.

The Alarm window, Local Message Display and Information window
can use bit strings up to 496 bits long.

If you use the bit position data type with the Alarm window, PanelView
will monitor all the bits in the bit string. Thus, the PLC controller can
set any number of bits simultaneously, and the Alarm window will scroll
through all the alarms with bits set, time-stamped and in lowest bit to
highest bit order.

Number of Bits

Use the “Number of Bits” column to document the specific number of bits
required by an object’s address assignment. The number of bits is
determined by the number of states and the data type.
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After assigning addresses to all objects, windows and PLC controlled
options, you can determine your I/O requirements. Record this information
on the PLC Communications Worksheet.

Figure 4.7
PLC Communications Worksheet

PLC Communications Worksheet

Application File Name:

PLC/Scanner Type:

Baud Rate: 57.6K (10,000 Ft) 115.2K (5,000 Ft) 230.4K (2,500 Ft)

Note: You must make at least one rack assignment. Additional rack assignments (up to a maximum of 8)
are optional. Write in the Rack Number and circle appropriate Rack Size, Starting Module Group, and 
Last Rack designation.

Rack Assignments

Rack Number Rack Size Starting Module Group Last Rack

1/4          1/2          3/4          1

0          2          4          6 Y N

Note: Block Transfers are optional. Circle the Block Transfer File Number, write in one of the rack numbers 
from above, circle the appropriate Module Group and Byte, and fill in the Block Transfer file size.

Block Transfer Assignments

Block Transfer
File Number Module Group

0  1  2  3  4  5  6  7 Hi               Lo

30

Byte
Rack

Number No. Words

0  1  2  3  4  5  6  7

0  1  2  3  4  5  6  7

0  1  2  3  4  5  6  7

Pass–Through

1

2

4

5

0  1  2  3  4  5  6  73

0          2          4          6 Y N

1/4          1/2          3/4          1

0          2          4          6 Y N1/4          1/2          3/4          1

0          2          4          6 Y N

0          2          4          6 Y N1/4          1/2          3/4          1

0          2          4          6 Y N1/4          1/2          3/4          1

1/4          1/2          3/4          1

0          2          4          6 Y N1/4          1/2          3/4          1

0          2          4          6 Y N1/4          1/2          3/4          1

Hi               Lo

Hi               Lo

Hi               Lo

Hi               Lo

PLC Communications
Worksheet
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PLC/Scanner Type

For the PLC/Scanner Type field, use one of the following combinations.

Table 4.I
PLC Controller and Scanner Types

PLC Controller Scanner Type

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

PLC�2/20 or PLC�2/30 ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

1772�SD/SD2

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

PLC�3 ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

1775�S4A/B

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

PLC�3 ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

1775�S5

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

PLC�3/10 ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

1775�SR5

PLC�5/11 Built in

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

PLC�5/15 ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Built in

PLC�5/20 Built in

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

PLC�5/25 ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Built in

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

PLC�5/30 ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Built in

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

PLC�5/40 ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Built in

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

PLC�5/60 ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Built in

PLC�5/250 5150�RS

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

SLC 500 ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

1747�SN

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Other ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

1771�SN Sub Scanner

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

IBM PC ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

6008�SI

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

VME Bus ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

6008�SV

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

DEC Q�Bus ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

6008�SQ

Baud Rate

The cable length determines the baud rate you can select.

 230.4 kilobaud to a distance of 2,500 feet (with PanelView terminals of
Series C rev A or later)

 115.2 kilobaud to a distance of 5,000 feet

 57.6 kilobaud to a distance of 10,000 feet

Rack Assignments

For each assignment indicated in your Object Address lists, define the
following:
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 Rack Number—choices are limited according to the type of PLC
controller you defined as PLC Type.

 Rack Size—may be specified as 1/4, 1/2, 3/4 or FULL. Circle the size
of your choice.

 Starting Module Group—may be specified as 0, 2, 4, or 6. Circle the
starting module group of your choice.

 Last Rack—Circle Y (yes) if there are no other fractional PLC rack
assignments that have the same rack number and a higher starting
module group number. Otherwise circle N (no).

Block Transfer Assignments

For each block transfer file, the block transfer file and the block transfer
control address in the PLC discrete I/O must be defined. Refer to your
Object Address List to define the following:

 Block Transfer File Number—circle the block transfers you are using
(1–5).

 Rack Number—the available rack numbers used in the block transfer
assignments are determined by the rack assignments described
previously.

 Module Group—you assign the module group (16-bit word) which will
contain the block transfer control byte (high or low byte). This applies
to both the discrete input and output image table words for the
applicable rack number. The Module Group must correspond to the
module group and rack size boundaries of the rack in the rack
assignment table with the same rack number.

 Byte—circle Hi or Lo to designate the high or low control byte. You
cannot enter the same rack number, module group and control byte for
more than one block transfer assignment.

IMPORTANT:  The 1771-SN and 1747-SN Modules do not support block
transfers to a remote I/O device. Block transfer assignments are only
applicable if you are using one of the other remote 1771 I/O Scanner
Devices.

 Number of Words—document the specific number of words required
by a block transfer assignment
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As you develop your application, the amount of PanelView memory that
the file will require is displayed in the lower left corner of the screen.

You can estimate the size of an application file before you create it, by
calculating the memory requirements of each element. To calculate an
application file’s size:

1. Start with the approximate size of an empty application file:
V1 909 bytes
V2 1001 bytes
V3 967 bytes
V4 959 bytes
V5 962 bytes

2. If the application file will have Information Messages, add: (2 bytes x
Largest Message Number), plus
1 byte per message, plus
1 byte per character in each message.

3. If your application file will have Alarm Messages, add: 
(2 bytes x Largest Message Number), plus
1 byte per message, plus
1 byte per character in each message.
If options are defined for each alarm message such as activate audio,
print message, energize relay, add
(1 byte x Largest Message Number with defined flags).

4. If the application file will have Local Messages, add: 
(2 bytes x Largest Message Number), plus
1 byte per message, plus
1 byte per character in each message.

5. For application screens, add: 
(2 bytes x Largest Screen Number), plus 
26 bytes per screen, plus
1 byte for each character in the Screen Name.

6. For each object on each screen, add:
the object’s memory size specified on the next page, plus
1 byte for each character in the Object Name.

7. For the first background object on each screen (excluding Arcs) add 2
bytes.

8. For all text including Background Text object and text associated
with an object on each screen, such as button text, state text, outer
text, and list text, add: 
8 bytes for each text element, plus
1 byte for each character.

Estimating PanelView Terminal
Memory Requirements
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Spaces within a text element, as between words, are shown as underline
characters on the development system.

Object Memory Usage

Following is a list of all the object types, and the minimum number of
bytes each one will use in your application file. The values listed do not
include an Object Name or descriptive text.

Table 4.J
Objects and their Byte Requirements

This Object: Firmware Version
Number

Uses this many bytes:

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Momentary Push Button - Normally OpenÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

All ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

24

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Momentary Push Button - Normally ClosedÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

All ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

24

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Latched Input Push Button ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

All ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

26

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Maintained Push Button ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

All ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

24

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Interlocked Push Button ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

All ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

20

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Control List Selector ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

V1/V2
V3/V4/V5

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

30
31

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Control List Selector w/ Enter
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

V1/V2
V3/V4/V5

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

37
38

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Set Bit Cursor Point ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

All ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

18

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Screen List Selector ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

All ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

37 (plus 1 byte/selection)

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Go To Screen Button ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

All ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

13

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Return To Screen Button ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

All ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

12

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Screen Keypad�Enable Button ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

All ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

11

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Screen Print Button ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

All ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

12

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Small Keypad Screen Selector ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

All ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

6

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Large Keypad Screen Selector ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

All ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

6

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Multi�State Indicator ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

All ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

16 (plus 4 bytes/state)

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

List Indicator ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

V1/V2
V3/V4/V5

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

16
27ÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁSet Value Button
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁAll

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ20ÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Increment Value Button
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

V1
V2/V3/V4/V5

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

20
24

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Decrement Value Button ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

V1
V2/V3/V4/V5

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

20
24

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

ASCII Display ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

All ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

16

ASCII Input: Large, Touch Screen
Small, Touch Screen
Small or large, Keypad

V4/V5
V4/V5
V4/V5

27
106
78

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Numeric Data Displays ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

All ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

19
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This Object: Uses this many bytes:Firmware Version
NumberÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁNumeric Keypad�Enable Button
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁAll

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ26ÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁNumeric Keypad�Enable Button w/ Enter
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁAll

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ30ÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁSmall Numeric Keypad
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁAll

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ16ÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁSmall Numeric Keypad w/ Enter
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁAll

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ20ÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Large Numeric Keypad
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

V1
V2/V3/V4/V5

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

16
20

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Large Numeric Keypad w/ Enter ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

All ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

20

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Numeric Input Cursor Point ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

V1
V2/V3
V4/V5

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

19
31
49

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Background Text
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

All
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

0 (see previous page)
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Arc
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

All
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

14
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Line
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

All
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

9 per segment
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Box
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

All
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

9
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Symbol
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

All
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

24
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Vertical Bar Graph
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

All
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

24
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Horizontal Bar Graph
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

All
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

24
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Time Display
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

All
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

10
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Date Display
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

All
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

10
ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

Local Message Display
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

All
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

16

Scrolling List V5 82

Each horizontal segment, vertical segment, corner and intersection
constitutes one line segment.

The Scrolling List object uses a minimum of 82 bytes. As shown in the
following table, the components you choose to use in the Scrolling List use
different amounts of memory.

Table 4.K
Scrolling List Components and their Byte Requirements

This Scrolling List
Component:

Uses this many
bytes:

Plus this many bytes
per visible state:

Plus this many bytes
per state:

Cursor List 82

Multi�State Object List 16 4 4

Local Message Object
List

12 4

Numeric Display
Object List

19 4
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To save application memory, consider the following options:

 when creating spaces between words in object text, use the space bar
instead of the right arrow key. The space character will appear as an
underscore in PanelBuilder, but will be a space on the PanelView
terminal screen. When the right arrow is used, each word becomes a
separate text element requiring 8 bytes of memory, whereas the space
character requires one byte

 when using the Multi-State Indicator, delete all states not being
used—four states is the default

 when drawing rectangles, use the Box object instead of drawing each
side with a Line object. Each line requires 9 bytes, whereas one Box
object requires 9 bytes

 if a Multi-State indicator will have the same text for all states, use outer
text and a solid indicator instead of state text. Outer text requires eight
bytes for each text string plus one byte per character; state text would
require the same amount of memory for each state

 in general, limit the use of text when assigning screen names, messages
and object text

The sample application consists of three screens: a main screen, a screen to
control five conveyor belts, and a screen to control five pumps and monitor
the pressure in five associated vessels. The application:

 turns five conveyor belts on and off

 selects one of five pumps and turns it on or off. The pumps maintain the
pressure (PSI) in associated vessels. The operator can monitor the
pressure of each vessel

The Sample Application is designed for:

 a color keypad terminal

 a PLC 5/15

 a quarter rack space

Reducing Memory
Requirements

Sample Application Planned
with Worksheets
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Figure 4.8
The Main Screen, as designed with the Screen Worksheet
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Screen Worksheet for Keypad Terminal

Screen Name:

Application File Name:

Screen Number:

01

02

03

04

05

06

07

08

09

10

11

12

13

14

15

16

17

18

19

20

21

22

23

F17

F1

F9

F2

F10

F3

F11

F4

F12

F5

F13

F6

F14

F7

F15

F8

F16

F18

F19

F20

F21

Example

1 Main Screen
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Figure 4.9
Screen 1 The Main Screen on the Development Computer

22062

V1  Size:  2,243            Screen:  1 MAIN SCREEN             Oct 15 1992 14:23

CONVEYOR
CONTROLS

PUMP
CONTROLS

SCREEN MENU:    Add  Edit  Move  Delete  Memorize  Recall  Options     Exit

M . A . I . N . � . S . C . R . E . E . N .

. . . . . . . . . . . . . . . . . . . . . . . . . .

Screen 1 consists of:

 one Text object, titled MAIN SCREEN. Each character is 2 character
cells high by 2 character cells wide

 two “Go To Screen” Buttons. The first one, labeled CONVEYOR
CONTROLS, calls screen 2 and is assigned to the F17 button. The
second, labeled PUMP CONTROLS, calls screen 3 and is associated
with the F18 button

IMPORTANT:  Screen 1 contains only static objects, so they are not
assigned to PLC addresses. Consequently, you won’t find an Object
Address List for this screen.
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Figure 4.10
The Conveyor Controls Screen Worksheet
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Screen Worksheet for Keypad Terminal

Screen Name:

Application File Name:

Screen Number:

01

02

03

04

05

06

07

08

09

10

11

12

13

14

15

16

17

18

19

20

21

22

23

F17

F1

F9

F2

F10

F3

F11

F4

F12

F5

F13

F6

F14

F7

F15

F8

F16

F18

F19

F20

F21

Example

2 Conveyor



Planning Your Application
Chapter 4

4-30

Figure 4.11
Screen 2 The Conveyor Controls Screen

22089

SCREEN MENU:   Add   Edit   Move   Delete   Memorize   Recall   Options   Exit

FRONT

FRONT
CENTER CENTER

BACK
CENTER BACK

MAIN
SCREEN

C . O . N . V . E . Y . O . R . � . C . O . N . T . R . O . L . S .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

V1  Size:  2,243               Screen:  2 CONVEYOR             Oct 15 1992 12:31

O.N. O.N. O.N. O.N. O.N.

O.F.F. O.F.F. O.F.F.O.F.F.O.F.F.

Screen 2 consists of:

 one Text object with the screen title CONVEYOR CONTROLS.

 one “Return To Previous Screen” Button labeled MAIN SCREEN.

 five Momentary Push Buttons—Normally Open with indicator state text
inside the buttons and “outer text” above the buttons

 five Momentary Push Buttons—Normally Closed with indicator state
text inside the buttons

Each push button has two possible states to which different text and
attributes will be assigned.

Each of the ten push buttons on this screen has a unique PLC input bit
address. You will program your PLC controller to turn on a conveyor when
its respective Momentary Push Button (Normally Open) is pressed, and to
turn it off again when its respective Momentary Push Button (Normally
Closed) is pressed.

Each of the ten buttons also has a unique PLC output bit address. These are
referred to as the “Indicator Control Bits”. Your PLC program should
include the logic to set the appropriate Indicator Control Bits to show that
the conveyor is on or off.
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The Text objects and the “Return To Previous Screen” Button are static
objects, and therefore are not included on the completed Object Address
List or the I/O Usage Worksheet.

Figure 4.12
The Pump Controls Screen Worksheet
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Screen Worksheet for Keypad Terminal

Screen Name:

Application File Name:

Screen Number:

01
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Example
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Figure 4.13
Screen 3 The Pump Controls Screen

22109

V1 Size:  2,243                Screen:  3 PUMP                     Oct 15 1992 12:31

SCREEN MENU:   Add   Edit   Move   Delete   Memorize   Recall   Options   Exit

UP

DOWN

CROSSOVR
MAIN
OUTPUT
INPUT
BACKUP

_NNNN
_NNNN
_NNNN
_NNNN
_NNNN

MAIN
SCREEN

ON
ON
ON
ON
ON

PUMP_CONTROLS PRESSURE_(PSI):

P . U . M . P . � . C . O . N . T . R . O . L . S .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

O.N.

O.F.F.

Screen 3 consists of:

 three Text objects including the screen title: PUMP CONTROLS, and
the two text labels: PUMP CONTROLS and PRESSURE (PSI)

 one Control List Selector Without Enter with five selections labeled
CROSSOVER, MAIN, OUTPUT, INPUT, and BACKUP. The Control
Selector’s two cursor control buttons are assigned to F3 and F11 and are
labeled UP and DOWN

 five Multi-State Indicators positioned immediately to the right of the
Control List Selector Without Enter Button. Each Multi-State Indicator
has been assigned two states. One state is labeled ON, the other OFF.
More states could be assigned

 five Numeric Display Objects positioned to the right of the Control List
Selector Without Enter Button and Multi-State Indicators

 one Box object surrounding the Control List Selector Without Enter
Button, the Multi-State Indicators, the Numeric Displays, and two of the
text objects

 two Momentary Push Buttons (Normally Open) labeled ON and OFF
assigned to F4 and F12

 one Return to Previous Screen button labeled MAIN SCREEN, assigned
to F17
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The Control List Selector Without Enter Button has been defined as a
five-state object using the bit position data type. Thus, there is a string of
four bits that the PLC controller uses to determine the current selection.
When the operator uses the UP and DOWN buttons, the PanelView
terminal turns off the current bit; turns on the next higher or lower bit in
this bit string; and scrolls the highlight bar up or down through the
selections.

When the operator presses the ON or OFF button, the PLC program checks
which of the five Control Selector bits is on. It then turns the related pump
on or off.

Each Multi-State Indicator has a PLC output bit associated with it. The
PLC program sets the bit on when the pump is on, and sets the bit off when
the pump is off. The PanelView terminal monitors these bits, and displays
the ON or OFF label depending on the state of each bit.

Now for the five Numeric Displays. In this sample application we’ve
restricted ourselves to using one quarter rack. Each Numeric Display
requires a full PLC word. If you were restricted to discrete addressing, a
quarter rack wouldn’t be adequate; at least a 3/4 rack would be necessary.
The quarter rack limitation can be met by using a block transfer file.

In defining the block transfer file, a control byte was assigned in both the
Input and Output section of the image table. This is noted in the Discrete
I/O Usage Worksheet. You can’t use this control byte for any other
purpose. Program your PLC block transfer instruction to use this control
byte.

The Text objects, the Box, and the Return to Previous Screen button don’t
change state or communicate with the PLC controller. Therefore, they are
not included on the completed Object Address List or the I/O Usage
Worksheet.
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Figure 4.14
Object Address List Worksheet for Screen 2

Object Address List

Screen Number:Application File Name:

Object Address

D/B I/O R/F Wrd
Blk Xfer

PLC Addr Preset
Ref
No. Type Name

No. of
states

Data
Type

No. of
BitsBit

1 Momentary N/O PB FRONT ON

Momentary N/O PB INDICATOR

2 Momentary N/C PB FRONT OFF

Momentary N/C PB INDICATOR

3 Momentary N/O PB FRONT CENTER ON

Momentary N/O PB INDICATOR

4 Momentary N/C PB

Momentary N/C PB INDICATOR

FRONT CENTER OFF

5 Momentary N/C PB CENTER ON

Momentary N/C PB INDICATOR

6 Momentary N/C PB CENTER OFF

Momentary N/C PB INDICATOR

7 Momentary N/O PB BACK CENTER ON

Momentary N/O PB INDICATOR

8 Momentary N/C PB BACK CENTER OFF

Momentary N/C PB INDICATOR

9 Momentary N/O PB BACK ON

Momentary N/O PB INDICATOR

10 Momentary N/C PB BACK OFF

Momentary N/C PB INDICATOR

D I 1 0 0

D O 1 0 0

D I 1 0 1

D O 1 0 1

D I 1 0 2

D O 1 0 2

D I 1 0 3

D I 1 0 3

D I 1 0 4

D O 1 0 4

D I 1 0 5

D O 1 0 5

D I 1 0 6

D O 1 0 6

D I 1 0 7

D O 1 0 7

D I 1 0 10

D O 1 0 10

D I 1 0 11

D O 1 0 11

2 Bit 1

2 Bit 1

2 Bit 1

2 Bit 1

2 Bit 1

2 Bit 1

2 Bit 1

2 Bit 1

2 Bit 1

2 Bit 1

2 Bit 1

2 Bit 1

2 Bit 1

2 Bit 1

2 Bit 1

2 Bit 1

2 Bit 1

2 Bit 1

2 Bit 1

2 Bit 1

Sample Application 2
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Figure 4.15
Object Address List Worksheet for Screen 3

Object Address List

Screen Number:Application File Name:

Object Address

D/B I/O R/F Wrd
Blk Xfer

PLC Addr Preset
Ref
No. Type Name

No. of
states

Data
Type

No. of
BitsBit

11 Control Selector PUMP CONTROLS

12 Momentary N/C PB PUMP ON

Momentary N/C PB INDICATOR

13 Momentary N/C PB PUMP OFF

Momentary N/C PB INDICATOR

14 Numeric Display CROSSOVER PUMP

15 Numeric Display MAIN PRESSURE

16 Numeric Display OUTPUT PRESSURE

17 Numeric Display INPUT PRESSURE

18 Numeric Display BACKUP PRESSURE

19 Multi–State Indicator CROSSOVER PUMP

21 Multi-State Indicator OUTPUT PUMP

22 Multi-State Indicator INPUT PUMP

23 Multi-State Indicator BACKUP PUMP

D I 1 0   12

D I 1 1 0

D O 1 1 0

D I 1 1 1

D O 1 1 1

B O 2 0 0

B O 2 1 0

B O 2 2 0

B O 2 3 0

B O 2 4 0

D O 1 0   12

D O 1 0   13

D O 1 0   14

D O 1 0 15

D O 1 0 16

5 Bit 5

2 Bit 1

2 Bit 1

2 Bit 1

2 Bit 1

 Binary   16

 Binary   16

 Binary   16

 Binary   16

2 Bit 1

2 Bit 1

2 Bit 1

2 Bit 1

 Binary   16

2 Bit 1

Sample Application 3

20 Multi-State Indicator MAIN PUMP
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Figure 4.16
Discrete I/O Usage Worksheet for the Sample Application

Discrete I/O Usage Worksheet
Application File Name: Rack Number:

PLC Output Bit Numbers

17 16 15 14 13 12 11 10 7 6 5 4 3 2 1

0

1

2

3

4

5

6

7

PLC Input Bit Numbers

0

17 16 15 14 13 12 11 10 7 6 5 4 3 2 1

0

1

2

3

4

5

6

7

0

Sample Application 1

* * * * * * * * * * * * * * *
* *b b b bb b b b

x x x x x x x x x x

x

x x x x x

x x x x x x

x x x x

x x x x

x x x x

x x x x x x x x x x x x

x x x x

x x x x

x x x x

x x xx x x

xx x x x

x x x x

x x x x

x x

x x

x x

x x

x

x

x

x

x

x

xx

x

x

* * * * * * * * * * *
b

x

* * * *
**bb b b b b b

x x x x x x x xx x x x x x x

The Words from 2 to 7 are empty as illustrated in Word 2

x

x
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Figure 4.17
Block Transfer Worksheet for the Sample Application	only page 1 is shown, page 2
is left empty

Block Transfer I/O Usage Worksheet (Page 1 of 2)

Application File Name:

Block Transfer File Number:               1          2          3          4          5               (Circle One)

Number of Words:

READ (PLC Inp) or WRITE  (PLC Out) (Circle One)

PLC Bit Numbers

14 13 12 11 10 8 7 6 5 4 3 2 1 0

0

915

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

Sample Application

5

From Word 5 to 31 is unused as illustrated in Word 5 & 6

*
x

*
*
*
*

x
*
x

*
*
*
*

x
*
x

*
*
*
*

x
*
x

*
*
*
*

x
*
x

*
*
*
*

x
*
x

*
*
*
*

x
*
x

*
*
*
*

x
*
x

*
*
*
*

x
*
x

*
*

x
*
x

*
*

x
*
x

*
*

x
*
x

*
*

x
*
x

*
*

x
*
x

*
*

x
*
x

*
*

x
*
x

*
*

x

* * * * * * * *
* * * * * * * *
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Figure 4.18
PLC Communications Worksheet for the Sample Application

PLC Communications Worksheet

Application File Name:

PLC/Scanner Type:

Baud Rate: 57.6K (10,000 Ft) 115.2K (5,000 Ft) 230.4K (2,500 Ft)

Note: You must make at least one rack assignment. Additional rack assignments (up to a maximum of 8)
are optional. Write in the Rack Number and circle appropriate Rack Size, Starting Module Group, and 
Last Rack designation.

Rack Assignments

Rack Number Rack Size Starting Module Group Last Rack

1/4          1/2          3/4          1

0          2          4          6 Y N

Note: Block Transfers are optional. Circle the Block Transfer File Number, write in one of the rack numbers 
from above, circle the appropriate Module Group and Byte, and fill in the Block Transfer file size.

Block Transfer Assignments

Block Transfer
File Number Module Group

0  1  2  3  4  5  6  7 Hi               Lo

30

Byte
Rack

Number No. Words

0  1  2  3  4  5  6  7

0  1  2  3  4  5  6  7

0  1  2  3  4  5  6  7

Pass–Through

1

2

4

5

0  1  2  3  4  5  6  73

0          2          4          6 Y N

1/4          1/2          3/4          1

0          2          4          6 Y N1/4          1/2          3/4          1

0          2          4          6 Y N

0          2          4          6 Y N1/4          1/2          3/4          1

0          2          4          6 Y N1/4          1/2          3/4          1

1/4          1/2          3/4          1

0          2          4          6 Y N1/4          1/2          3/4          1

0          2          4          6 Y N1/4          1/2          3/4          1

Hi               Lo

Hi               Lo

Hi               Lo

Hi               Lo

Sample Application

PLC 2/30 1771 – SD2
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Once the application is planned, the next step is to use PanelBuilder to
create the application file. For a detailed description of the steps involved
in creating the application file, see Chapter 5, Creating a Sample
Application. The steps, in general, are the following:

1. Start the PanelBuilder program and create a new (empty) application
file. Name the file and select the PanelView terminal type.

IMPORTANT:  Be sure to specify the correct PanelView terminal type
(monochrome/color; keypad/touch screen). The menu selections are
different for each type of terminal. Also Keypad terminal files cannot be
converted to Touch Screen files and vice versa.

2. Specify the PLC controller and I/O Scanner type.

3. Define the rack and block transfer assignments.

IMPORTANT:  PanelBuilder checks your rack and block transfer
assignments against your choice of PLC controller and I/O Scanner. It also
checks the PLC addresses assigned to your objects, windows, and PLC
controlled options, against your rack and block transfer assignments.

4. Configure the windows.

5. Create your screens.

6. If you plan on creating a password security system, assign security
levels to your screens.

7. Define any PLC controlled options that you want to include.

8. Specify the Powerup screen.

9. Download the application file to the PanelView terminal.

10. Modify your PLC program so that it recognizes the PanelView
terminal application.

11. Verify the operation of the PanelView terminal before using it to
control your process.

After Planning the Application,
Create the Application File
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Creating A Sample Application File

This chapter illustrates and describes the steps involved in creating an
application file. It follows from the worksheets developed in Chapter 4,
Planning Your Application, which allow an operator to:

 turn five conveyor belts on and off

 select one of five pumps and turn it on or off. The pumps maintain the
pressure (PSI) in the associated vessels. The operator can monitor the
pressure of each vessel

This chapter is written as a tutorial. Read it in sequence even if you don’t
follow every instruction. It is important to understand each step, and the
sequence, when creating application files.

Power up the computer. The AUTOEXEC file on the development
computer may be set to switch to the PanelBuilder directory and start the
program. If not, you’ll have to do it manually. If you installed PanelBuilder
on drive C, as described in Chapter 2, Installing PanelBuilder, type:

C:  press Enter

CD PDS press Enter

PDS press Enter

The first step is to create an empty application file.

1. Choose Develop from the Main menu.

2. Highlight Create New File, and press Enter.

Start up PanelBuilder

Step 1: Create the Application
File
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Figure 5.1
The Develop Menu

21031

MAIN MENU:          Develop     Transfer     Reports     Files     Setup          Exit

MAIN MENU          Develop     Transfer     Reports     Files     Setup          ExitDevelop

Select File
Create New File

Directory

Quit

3. Type the name for the new file, EXAMPLE and press Enter.

PanelBuilder automatically adds the file extension CFG to names of
application files.

4. Now specify the type of PanelView terminal that will run your
application. For this sample file, specify a color keypad terminal.
Press Enter to make the choice.

Figure 5.2
Selecting the Type of Terminal

Select PanelView Terminal Type

20033

Keypad, Monochrome display
Keypad, Color display
Touch screen, Monochrome display
Touch screen, Color display

Quit

An Information Window will appear, advising you that you’ve created a
new application file for a keypad terminal. Press any key to clear the
window, and you’ll see the File menu.
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Figure 5.3
The File Menu

20034

FILE MENU:       Screens     Windows     Options     Communications        Exit

IMPORTANT:  The file size of the application file is displayed in the
lower left corner of the screen. This is not the DOS file size on disk: it’s
the amount of memory the file will require in the PanelView terminal. As
you add and edit screens, objects and messages, this number will change to
reflect the current file size.

The application file has been created; now define your PLC
communication requirements. PanelBuilder needs this information to
calculate I/O addresses for each object. If you filled out the worksheets, all
the information you need is in the PLC Communication Worksheet.

For this sample application you’ll set up for a PLC-5/15, using a quarter of
a rack. It will be rack number 1, starting module 0. As well, you’ll define
one block transfer file.

Define PLC Type

1. Select PLC Type from the Communications menu, and press Enter.

A list of PLC and scanner types appears.

2. Choose PLC-5/15 integral from the list.

Step 2: Configure PLC
Communications
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Figure 5.4
Selecting PLC Type

22597

FILE MENU:       Screens     Windows     Options     Communicup        ExitCommunications

PLC Type                 PLC-5/15 integral

Rack Assignment
Block Transfer

PLC Baud Rate 57.6K

Pass-Through Configuration

Quit

PLC - 2/20 1772-SD/SD2
PLC - 2/30 1772/SD/SD2
PLC - 3 1775-S4A/S4B
PLC - 3 1775-S5
PLC - 3/10 1775-SR5
PLC - 5/11 integral
PLC - 5/15 integral
PLC - 5/20 integral
PLC - 5/25 integral
PLC - 5/30 integral
PLC - 5/40 integral
PLC - 5/60 integral
PLC - 5/250 5150-RS
IBM PC 6008-SI
VME BUS 6008-SV
DEC Q-BUS 6008-SQ
SLC-500 1747-SN
 - other - 1771-SN Sub

Define Rack Assignments

1. Choose Rack Assignment from the Communications menu to open the
Rack Assignment window.

Figure 5.5
Rack Assignments

20036

FILE MENU:       Screens     Windows     Options     Communicup        ExitCommunications

PLC Type                 PLC-5/15 integral

Rack Assignment
Block Transfer

PLC Baud Rate 57.6K

Pass-Through Configuration

Quit

Rack Assignment

Quit

Rack
Size

*
*
*
*
*
*
*
*

Last
Chassis

*
*
*
*
*
*
*
*

Starting
Module Group

*
*
*
*
*
*
*
*

Rack
Number

*
*
*
*
*
*
*
*

2. The first rack will be highlighted. Choose it by pressing Enter.

The Modify Rack Assignment window will appear.
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Figure 5.6
Modify Rack Assignments

20037

FILE MENU:       Screens     Windows     Options     Communicup        ExitCommunications

PLC Type                 PLC-5/15 integral

Rack Assignment
Block Transfer

PLC Baud Rate 57.6K

Pass-Through Configuration

Quit

Rack Assignment

Quit

Rack
Size

*
*
*
*
*
*
*
*

Last
Chassis

*
*
*
*
*
*
*
*

Starting
Module Group

*
*
*
*
*
*
*
*

Rack
Number

*
*
*
*
*
*
*
*

Modify Rack Assignment

Rack Number 1
Starting Module Group 0
Rack Size 1/4
Last Chassis ? No

Update Rack Definition

Delete Rack Definition

Quit

3. Go through each option, and make the following settings:

a. Set Rack Number to 1.

b. Set Starting Module Group to 0.

c. Set Rack Size to 1/4.

d. Set Last Chassis? to No.

4. Save the settings: press Enter on Update Rack Definition.

Since you only want to assign one rack, choose Quit from this window to
return to the Communications menu where Block Transfer will be
highlighted.
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Define Block Transfer Files

1. Choose Block Transfer in the Communications menu. The Block
Transfer window opens with the first block transfer file highlighted.

Figure 5.7
The Block Transfer Window

22591

FILE MENU:       Screens     Windows     Options     Communicup        ExitCommunications

PLC Type                 PLC-5/15 integral

Rack Assignment
Block Transfer

PLC Baud Rate 57.6K

Paass-Through Configuration

Quit

Block Transfer

Quit

Module Group

*
*
*
*
*

*

Rack
Number

*
*
*
*
*

*

Block Transfer
File

1
2
3
4
5

High/Low
Byte

*
*
*
*
*

*

File
Size

*
*
*
*
*

30Pass-Through

2. While 1 is highlighted, press Enter. The Modify Block Transfer
window opens, set for File 1.

Figure 5.8
Modify Block Transfer Window

20039

Modify Block Transfer File 1

Rack Number 1
Module Group 1
High or Low Byte ? High
File Size 5

Update Block Definition

Delete Block Definition

Quit

3. Go through each option, setting them as follows:

a. Set Rack Number to 1.
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b. Set Module Group to 1.

c. Set High or Low Byte to High.

d. Set File Size to 5. This sets the size of the block transfer to 5
words.

4. When the parameters are set, select Update Block Definition and
press Enter to save the changes and return to the Block Transfer
window.

5. Choose Quit to return to the Communications menu.

Set the Baud Rate

1. Choose PLC Baud Rate from the Communications menu to set the
baud rate for PLC communication.

Figure 5.9
Communications Menu

22040

FILE MENU:       Screens     Windows     Options     Communicup        ExitCommunications

PLC Type                 PLC-5/15 integral

Rack Assignment
Block Transfer

PLC Baud Rate 57.6K

Pass-Through Configuration

Quit

2. Set PLC Baud Rate to 57.6K, and press Enter.

3. Choose Quit to save the setting and return to the File menu.
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With the communications set up, you can create the screens that were
planned in the worksheets in Chapter 4, Planning Your Application.

Screen 1: MAIN SCREEN

1. The first screen automatically becomes Screen 1. To create it, choose
Screens from the File menu.

Figure 5.10
The Screens Menu

20041

FILE MENU:       Screens     Windows     Options     Communications         Exit

FILE MENU       Screens     Windows     Options     Communications          ExitScreens
Select Screen
Create New Screen 1 MAIN SCREEN

Utilities
Powerup Screen      255 Alarm History

Application File Comment

Quit

2. Choose Create New Screen and press Enter to open the screen
number field.

3. Press Enter to open the screen name field.

4. Type in the name MAIN SCREEN and press Enter again.

IMPORTANT:  Each screen is automatically numbered, but any unused
screen number can be entered.

Once the screen is named, the Screen menu appears. The screen is empty
because no objects have been defined yet. The name of the screen is
displayed at the bottom.

IMPORTANT:  As you add or edit screens and objects, PanelBuilder
updates the “Size” display, which shows the amount of memory the
application will require in a PanelView terminal. As you add screens and
objects, this number increases. The version compatibility is also shown:  a
lower version application file runs only on the same or higher version
terminal. For example, a version 3 application will run on version 3, 4 or 5
terminals, but not on version 1 or 2 terminals. (See Table 2.C.)

Step 3: Create the Screens
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Figure 5.11
Screen Menu

22042

V1   Size:  909               Screen:  1 MAIN SCREEN      Oct 15 1992 10:34

SCREEN MENU:   Add   Edit   Move   Delete   Memorize   Recall   Options    Exit

Make the Title

First, create a title on the screen. This will be a Text object since it will be
used to identify the screen. The title will not be part of a button, selector, or
the like.

1. Choose Add from the Screen menu,

2. Then choose Text/Draw from the Add menu.
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Figure 5.12
The Text/Draw Menu

21043

SCREEN MENU:   Add   Edit   Move   Delete   Memorize   Recall   Options   Exit

SCREEN MENU:   Add   Edit   Move   Delete   Memorize   Recall   Options   ExitAdd
Push Buttons

Control Selectors
Screen  Selectors
Indicators
Numerics

Text/Draw

Symbol
Bar Graphs

Time & Date
Screen Print Button

Local Message Display
ASCII Display
ASCII Input Small
Scrolling List Cursor List

Quit

Text/Draw
Text
Line
Box
Arc

Quit

3. Text /Draw lists the four objects available in this menu. Choose Text
from the list.

The Object menu appears, with the name of the object you’re
working on shown at the bottom.
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Figure 5.13
The Object Menu for Text

22044

V1   Size:  909                                    Text

OBJECT MENU:              Move & Edit         Look        Utility                      Exit

4. Set the attributes for the text before you type the title itself. Choose
Look from the Object menu and set the parameters as detailed below.

Figure 5.14
The Look Menu

20045

OBJECT MENU:              Move & Edit           Look          Utility                 Exit

OBJECT MENU:              Move & Edit           Look          Utility                 ExitLook

Foreground Color White
Background Color Black

Underline No
Blink No

Character Height Double
Character Width Double

Quit

a. Set the Foreground Color to White.

b. Set the characters to double height and width.

c. Choose Quit (or press Esc) to save the settings and return to the
Object menu.
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5. Now, type the text for the title:

a. Choose Move & Edit from the Object menu.

b. Then choose Edit Text from the Move & Edit menu.

Figure 5.15
The Move & Edit Menu

20046

OBJECT MENU:              Move & Edit           Look          Utility                 Exit

OBJECT MENU:              Move & Edit           Look          Utility                 ExitMove & Edit

Edit Text
Move Text

Quit

The empty screen you’re working on appears, with the title “TEXT
EDIT” at the top, and a flashing cursor in the center.

Figure 5.16
Text Edit Mode

20047

TEXT EDIT:                                                                            Row 12 Col 40

❚

c. Type the title MAIN SCREEN. It appears at the flashing cursor
in the middle. The dots under and beside the characters indicate
that they are double height and double width.
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Figure 5.17
Text Edit Mode with Title

20048

TEXT EDIT:                                                                            Row 12 Col 40

M . A . I . N . � . S . C . R . E . E . N . 
. . . . . . . . . . . . . . . . . . . . . . . . . .

Press Enter when the title has been typed and the Move & Edit menu
will reopen.

Figure 5.18
Move & Edit Menu

22049

OBJECT MENU:                                       Look          Utility                   ExitMove & Edit

Edit Text
Move Text

Quit

6. Choose Move Text to position the title. According to the worksheet,
the title should be placed at Row 10, Column 28.

The exact screen position of the first character in the line is indicated
at the top right of the screen. Press the arrow keys to move the title
into place.

Figure 5.19
Moving The Title Text

22050

OBJECT MOVE:                                                                      Row 10 Col 28

M . A . I . N . � . S . C . R . E . E . N . 
. . . . . . . . . . . . . . . . . . . . . . . . . .

When the title is in position, press Enter.

7. Choose Quit (or press Esc) to close the Move & Edit menu and return
to the Object menu.
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8. Choose Exit from the Object menu, and choose Exit and Save Object,
to return to the Text/Draw menu.

9. Choose Quit (or press Esc) to get back to the Add menu, so you can
add more objects to the screen.

Figure 5.20
The Text/Draw Menu

21245

SCREEN MENU:   Add   Edit   Move   Delete   Memorize   Recall   Options   Exit

SCREEN MENU:   Add   Edit   Move   Delete   Memorize   Recall   Options   ExitAdd
Push Buttons

Control Selectors
Screen  Selectors
Indicators
Numerics

Text/Draw

Symbol
Bar Graphs

Time & Date
Screen Print Button

Local Message Display
ASCII Display
ASCII Input Small
Scrolling List Cursor List

Quit

Text/Draw
Text
Line
Box
Arc

Quit

Add Two “Go To Screen” Buttons

1. Choose Screen Selectors from the Add menu, then “Go to Screen”
Button.



Creating a Sample Application File
Chapter 5

5-15

Figure 5.21
The Add Menu and Screen Selectors

21052

SCREEN MENU:   Add   Edit   Move   Delete   Memorize   Recall   Options   Exit

SCREEN MENU:   Add   Edit   Move   Delete   Memorize   Recall   Options   ExitAdd
Push Buttons

Control Selectors
Screen  Selectors
Indicators
Numerics

Text/Draw

Symbol
Bar Graphs

Time & Date
Screen Print Button

Local Message Display
ASCII Display
ASCII Input Small
Scrolling List Cursor List

Quit

Screen Selectors
�Go to Screen" Button
�Return to Previous Screen" Button

Screen List Selector
Screen Keypad-Enable Button

Quit

Once you have selected the “Go To Screen” button, the Object menu
opens for editing.

Figure 5.22
Editing the Go To Screen Button

22054

OBJECT MENU:       Move & Size     Look     Text     Screen     Utility        Exit

V1  Size:  990               �Go To Screen" Button

M . A . I . N . � . S . C . R . E . E . N .

. . . . . . . . . . . . . . . . . . . . . . . . . . .
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In the center of the screen is what appears to be an empty box. This is
the “Go To Screen” Button, which hasn’t yet been given any
attributes. It’s partially covering the title, so move it out of the way;
two objects cannot overlap.

2. Choose Move & Size from the Object menu to place the object, to size
it to the required dimensions, and to link it to a function key.

Figure 5.23
Move and Size

20055

OBJECT  MENU:     Move & Size     Look     Text     Screen     Utility         Exit

3. Choose Move to position the button. The cursor is at the top left
corner of the button—the position identified at the top of the screen.
According to the worksheet, the top left corner of the button should
be at Row 0, Column 69 (see Figure 4.8). Move the object with the
arrow keys. When it is in place, press Enter.

4. Choose Size and use the arrow keys to stretch the button’s height and
width. Set the button to a width of 11 and a height of 4, then press
Enter.

5. Choose Function Key to link the button to one of the function keys on
the PanelView terminal. The worksheet indicates this button should
be linked to function key number 17. Type in the number and press
Enter.

IMPORTANT:  These instructions are for setting up a Keypad terminal.
The Touch Screen terminal has no menu item corresponding to the
Function Key item .

6. Choose Quit to save your work and close the Move & Size menu.

The button is now in position, but needs an identifying label, as well as
color and a border.

7. Choose Look from the Object menu.
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Figure 5.24
The Look Menu

22056

OBJECT MENU:        Move & Size     Look     Text     Screen     Utility        Exit

OBJECT MENU:        Move & Size     Look     Text     Screen     Utility        ExitLook

Foreground Color White
Background Color Blue

Blink No

Border Single 	

Quit

M . A . I . N . � . S . C . R . E . E . N .

. . . . . . . . . . . . . . . . . . . . . . . . . .

Once the Look menu is open, make the following settings:

a. Choose Background Color and set it to Black.

b. Choose Border and set it to Double.

c. Choose Quit to save the settings and leave the Look menu.

8. For the button’s label, choose Text and then Button Text.

Figure 5.25
The Text Menu

M . A . I . N . � 
. S . C . R . E . E . N . �

. . . . . . . . . . . . . . . . . . . . . . . . . . . .

20057

OBJECT MENU:       Move & Size     Look    Text     Screen     Utility        Exit

OBJECT MENU:       Move & Size     Look     Text     Screen     Utility        ExitText

Button Text
Outer Text

Quit

Button Text

Edit
Move

Underline No

Character Width Single
Character Height Single

Quit

9. Choose Edit. The cursor appears on the screen, inside the button.
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10. The label takes up two lines inside the button. Type the first word,
CONVEYOR. Then use the arrow keys to move the cursor back to the
beginning of the second line and type CONTROLS. Press Enter after
both lines are typed.

11. Choose Quit to close the Button Text menu. Choose Quit again to
close the Text menu. The button is now positioned and labeled. The
next step is to set the function by naming the screen that the button
will call.

12. Open the Screen menu, and choose Go To Screen.

Figure 5.26
The Screen Menu

20058

OBJECT MENU:            Move & Size   Look   Text   Screen   Utility             Exit

OBJECT MENU:       Move & Size     Look     Text     Screen     Utility        ExitScreen

CONVEYOR
CONTROLS

Go to Screen 1

Quit

M . A . I . N . � . S . C . R . E . E . N .

. . . . . . . . . . . . . . . . . . . . . . . . . .

13. The CONVEYOR CONTROLS screen—which is not yet created—is
screen 2. Type the number 2 beside Go to Screen, and press Enter.

The first “Go To Screen” button is now defined.

14. Choose Quit (or press Esc) to close the Screen menu and return to the
Object menu. Choose Exit from the Object menu, then choose Exit
and Save Object.
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Figure 5.27
The Exit Menu

22059

OBJECT MENU:     Move & Size    Look    Text    Screen Exit

Exit and Save object
Save object only
Don't save, just Exit

Cancel Exit

M . A . I . N . � . S . C . R . E . E . N .

. . . . . . . . . . . . . . . . . . . . . . . . . .

Add the Second “Go To Screen” Button

Use the same steps to create the second button—with the following
changes:

1. Position the button at Row 5, Column 69.

2. Link function key 18 to the button.

3. Label the button PUMP CONTROLS.

4. Set the button to call Screen 3.

5. Exit and save the object.

Save the Screen

The screen now has a title and two buttons. To save it in the application
file:

1. Choose Quit in both the Screen Selectors and the Add menus.

2. Then choose Exit and Save Screen from the Exit menu.

The completed screen should look like the one below.
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Figure 5.28
The Main Screen (Screen 1) with Two Buttons and Title

22062

V1  Size:  2,243            Screen:  1 MAIN SCREEN             Oct 15 1992  14:23

CONVEYOR
CONTROLS

PUMP
CONTROLS

SCREEN MENU:    Add  Edit  Move  Delete  Memorize  Recall  Options     Exit

M . A . I . N . � . S . C . R . E . E . N .

. . . . . . . . . . . . . . . . . . . . . . . . . .

3. Choose Exit from the Screen menu.

4. Choose Exit and Save Screen from the Exit menu. You will return to
Screens in the File menu.

Screen 2: CONVEYOR CONTROLS

Creating the second screen follows many of the steps used to create Screen
1.

1. Choose Create New Screen.

2. Type in the the screen number 2 and press Enter.

3. Type the name CONVEYOR  and press Enter.
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Figure 5.29
The Screens Menu

20061

FILE MENU:       Screens     Windows     Options     Communications         Exit

FILE MENU       Screens     Windows     Options     Communications          ExitScreens
Select File 1 MAIN SCREEN
Create New Screen 2 CONVEYOR

Utilities
Powerup Screen 1 MAIN SCREEN

Application File Comment

Quit

4. Next, place a title on the screen.

a. Choose Text/Draw.

b. Then choose Text from the Text/Draw menu.

Figure 5.30
The Text/Draw Menu

21043

SCREEN MENU:   Add   Edit   Move   Delete   Memorize   Recall   Options   Exit

SCREEN MENU:   Add   Edit   Move   Delete   Memorize   Recall   Options   ExitAdd
Push Buttons

Control Selectors
Screen  Selectors
Indicators
Numerics

Text/Draw

Symbol
Bar Graphs

Time & Date
Screen Print Button

Local Message Display
ASCII Display
ASCII Input Small
Scrolling List Cursor List

Quit

Text/Draw
Text
Line
Box
Arc

Quit

5. Use the Look menu to set the text’s attributes.
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a. Set the Foreground text to White.

b. Set Character Height and Character Width both to Double.

Figure 5.31
The Look Menu

20065

Look

Foreground Color White
Background Color Black

Underline No
Blink No

Character Height Double
Character Width Double

Quit

6. Open the Move & Edit menu and choose Edit Text.

Figure 5.32
Move and Edit Menu

20046

OBJECT MENU:              Move & Edit           Look           Utility                Exit

OBJECT MENU:              Move & Edit           Look           Utility                ExitMove & Edit

Edit Text
Move Text

Quit

7. Type the title. It will appear on the screen with dots representing its
double height and width. Press Enter.

Figure 5.33
Screen Title Text Object

22067

TEXT EDIT:                                                                            Row 12 Col 40

C . O . N . V . E . Y . O . R . � . C . O . N . T . R . O . L . S .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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8. Choose Move Text, then use the arrow keys to move the title into
position. The worksheet indicates that the title’s top left corner should
be at Row 11, Column 17. Press Enter.

9. Once the title is in place, go to the Exit menu and choose Exit and
Save Object.

10. Then choose Quit in the Text/Draw menu. This returns you to the
Add menu.

Add One Momentary (Normally Open) Push Button

Screen 2 has ten push buttons: five Momentary (Normally Open) push
buttons, and five Momentary (Normally Closed) push buttons. Follow
these steps to create one Momentary (Normally Open) push button. Then
make the others in the same way. Check the worksheets for the different
attributes of the various buttons you are creating.

The Momentary (Normally Open) push button is the On button for the
front conveyor.

To add it to the screen:

1. Choose Push Buttons from the Add menu.

2. Choose Momentary (N/O) from the Push Buttons menu.

Figure 5.34
The Push Buttons Menu

20068

Add

Push Buttons

Control Selectors
Screen  Selectors
Indicators
Numerics

Text/Draw

Text/Draw
Text/Draw

Text/Draw
Text/Draw
Text/Draw

Quit

Push Buttons

Momentary (N/O)
Momentary (N/C)
Latched
Maintained
Interlocked

Quit

Once the button is selected, it appears on the screen as an empty square.
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Open the Move & Size menu and set the parameters as follows:

Figure 5.35
The Move and Size Menu

20077

OBJECT MENU:    Move & Size   Look   States & Text   Address   Utility    Exit

OBJECT MENU:    Move & Size   Look   States & Text   Address   Utility    ExitMove & Size

Move
Size
Function Key 0

Quit

1. Choose Move from the Move & Size menu and use the arrow keys to
place the button at Row 16, Column 11.

2. Choose Size, and use the arrow keys to shrink the button to Width 8,
Height 3.

3. Choose Function Key and link the button to Function Key 2.

The next step is to open the States & Text menu to label the button. This
button has two states:

 State 0 indicates the Front Conveyor is Off

 State 1 indicates the Front Conveyor is On
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Figure 5.36
The States and Text Menu
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States & Text

State 0
State 1
Display States

Outer Text

Quit

State 0

Edit Text
Move Text

Foreground Color Green
Background Color Black

Underline No
Blink No

Character Height Single
Character Width Single

Quit

Set the parameters for the button’s two states.

Set State 0

1. Choose State 0 to open the State 0 menu.

2. Set the Character Width to Double.

3. Choose Edit Text and type the label for the state, OFF. Press Enter.

4. Set the Foreground Color to Green. (This option is available in color
terminals only. )

5. Choose Quit to return to the States & Text menu.

Set State 1

1. Choose State 1 to set the second state for the button.

2. Set the Character Width to Double.

3. Choose Edit Text and type the label ON.

4. Set the Background Color to White so the button turns white when
the conveyor is in the On state.

5. Choose Quit to return to the States & Text menu.
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Indicate that the button is for the front conveyor. Since this label is an
identifier and not part of the button’s On/Off state, use Outer Text—it is
linked to the button, but not inside it.

1. Choose Outer Text from the States & Text menu. The Outer Text
menu will appear.

Figure 5.37
Outer Text Menu
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States & Text

State 0
State 1
Display States

Outer Text

Quit
Outer Text

Edit 
Move

Foreground Color Green
Background Color Black

Underline No
Blink No

Character Height Single
Character Width Single

QuitO.N.

2. Choose Edit and type FRONT, then press Enter.

3. Choose Move and center the legend above the button.

4. Choose Foreground Color and set it to White.

Once the parameters are set, define the PLC addresses for this push button.

1. Open the Address menu.

2. Choose Button Control Address.

The addresses for this push button are in the Object Address list shown in
Figure 4.14, Chapter 4, Planning Your Application.

Set the Button Control Address window as illustrated in Figure 5.38, then
choose Update Address.
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Figure 5.38
The Address Menu
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Button Control Address
Indicator State Address

Quit

Button Control Address

Current Address Unassigned Address

Data Type Bit
Communications Discrete

Input/Output Input
Rack 1
Start Word 0
Start Bit 0

Number of Bits 1

Update Address
View Address Map
Delete Address

Quit

FRONT

C . O . N . V . 
. . . . . . . . . . .

O.N.

You may have noticed that the cursor skipped over some selections in the
menu. The Data Type, Input/Output designation, and Number of Bits are
fixed for Push Buttons.

Choose View Address Map from the Button Control Address menu; the
following screen will appear.
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Figure 5.39
Setting the Address Map for Rack 1
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 Address

Button Control Address

View Address Map

Communications:Discrete
Input/Output:  Input
Rack:           1

Bit
1716151413121110 7 6 5 4 3 2 1 0

0 . . . . . . . . . . . . . . . *

W 1 b b b b b b b b . . . . . . . .
O 2 x x x x x x x x x x x x x x x x
R 3 x x x x x x x x x x x x x x x x
D 4 x x x x x x x x x x x x x x x x

5 x x x x x x x x x x x x x x x x
6 x x x x x x x x x x x x x x x x
7 x x x x x x x x x x x x x x x x

FRONT

O.N.

The Address Map indicates the amount of space you’ve allocated in the
Input Image Table for rack 1. Table 5.A explains the different symbols
used in the Address Map.

Table 5.A
Symbols Used in the Address Map

This symbol: means:

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

x ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

the bits are outside the available address range. They show the modules
that were NOT allocated to the PanelView terminal

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

.
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

the bits are still available
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

*
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

the bits that have been allocated to Objects, Windows, and PLC Control
Options

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

b ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

the bits that have been used as a block transfer control byte

In the Address Map, you can see the one bit that was allocated for the push
button in the Input Image Table.

Press Esc to remove the Address Map from the screen, then choose Quit to
close the Button Control Address menu.

From the Address menu, choose Indicator State Address. You’ll find the
addresses on the Object Address List shown in Figure 4.14, Chapter 4,
Planning Your Application.
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To define the address:

1. Choose Communications and then Discrete.

2. Choose Input/Output. For the Indicator State Address, you have the
choice of selecting either an input or output address. Choose Output.

3. Choose Rack and then 1.

4. Choose Start Word and type 0.

5. Choose Start Bit and type 0.

6. Choose Update Address. You’ll see the current address displayed on
the top line of the Indicator State Address window. Choose Quit to
close the Indicator State Address and Address menus.

Open the Utility menu, and choose Name.

Figure 5.40
The Utility Menu
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Name
Default

Quit

Type the name FRONT ON. The name identifies the object for
documentation purposes—it is printed at the bottom of the screen when
you select the object for editing, and it is included in the object’s listing in
printed reports.

When you’re finished, choose Quit, then Exit, then Exit and Save Object.
You are now at the Push Buttons menu.

The Remaining Momentary (Normally Open) Push Buttons

Use the Memorize and Recall functions to create the remaining four
Momentary (Normally Open) Push Buttons.

1. Close both the Push Buttons menu and the Add menu to go back to
the Screen menu.



Creating a Sample Application File
Chapter 5

5-30

2. Choose Memorize to begin the memorize operation.

Figure 5.41
Object Memorize Screen
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OBJECT MEMORIZE:  Select object or use Multiple selection...   Row 11 Col 47

3. Use the arrow keys to position the flashing cursor over the
Momentary (Normally Open) Push Button you just created, and press
Enter.

Figure 5.42
The Memorize Prompt

20244

OBJECT MEMORIZE: Memorize

Do you want to memorize addresses as well? Yes
No

Quit

?Y

4. The memorize prompt will appear asking if you want to memorize
the button’s address as well. Choose No and press Enter.

5. The button, its labels and all its attributes (except its address) are
copied into the computer memory. Now choose Recall.

Figure 5.43
Recall Option
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SCREEN MENU:  Add   Edit   Move  Delete  Memorize  Recall   Options     Exit



Creating a Sample Application File
Chapter 5

5-31

6. A copy of the push button is placed on the screen, but at first it can’t
be seen since it’s directly on top of the original one. To see the new
button, you have to move it aside.

Choose Move & Size and then Move.

Figure 5.44
The Move and Size Menu
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Move
Size
Function Key 0

Quit

7. Position the new button to the right of the previous one.

8. Choose Function Key and enter the appropriate function key number
(see Table 5.B).

9. Choose Quit or press Esc to close the menu.

Figure 5.45
States and Text Menu
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State 0
State 1
Display States

Outer Text

Quit

10. Choose States & Text from the Object menu.

11. Choose Outer Text.

12. Change the text above the button to match the plan in the worksheet
in Chapter 4 (see Figure 4.10).
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13. Choose Quit to close the States & Text menu.

14. Choose Address from the Object menu.

15. Change the Button Control Address.

16. Change the Indicator State Address.

Figure 5.46
The Address Menu
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Button Control Address
Indicator State Address

Quit

17. Choose Utility  from the Object Menu, and then choose Name.

Figure 5.47
The Utility Menu
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Quit

18. Type the button’s name.

19. Choose Exit from the Object menu.

20. Then choose Exit and Save Object.

You now are at the Screen menu.
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Make the Rest of the Momentary (Normally Open) Push Buttons

Repeat the above steps for each Momentary (Normally Open) Push Button
on the worksheet. Table 5.B shows the values to enter for each push
button:

Table 5.B
Values Assigned to the Push Buttons for Screen 2

Position:
Row, Col

Function Key Outer Text Addresses Name

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

16, 21
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

3
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

FRONT CENTER
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

D I 1 0/2 & D O 1 0/2
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

FRT CENTER ON
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

16, 31
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

4
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

CENTER
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

D I 1 0/4 & D O 1 0/4
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

CENTER ON
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

16, 41
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

5
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

BACK CENTER
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

D I 1 0/6 & D O 1 0/6
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

BCK CENTER ON
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

16, 51
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

6
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

BACK
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

D I 1 0/10 & D O 1 0/10
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

BACK ON

Make Five Momentary (Normally Closed) Push Buttons

As above, you’ll start by making one button, and then follow the same
steps to make the others.

The first Normally Closed button you’ll add is the Off button for the
“Front Conveyor”. To add this button:

1. Choose Push Buttons from the Add menu and choose Momentary
(N/C) from the Push Buttons menu.

An empty, square button is placed in the center of the screen.

2. Choose Move & Size from the Object menu and set the following
parameters for the button:

a. Choose Size from the Move & Size menu. With the arrow keys,
shrink the button to Width 8, Height 3.

b. Choose Move from the Move & Size menu. Use the arrow keys
to place the button at Row 21, Column 11.

c. Choose Function Key and assign this button to Function Key 10.

3. Open the States & Text menu to label the button. This button has two
states:

 State 0 indicates the Front Conveyor is Off

 State 1 indicates the Front Conveyor is On
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Figure 5.48
The States & Text Menu
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State 0
State 1
Display States

Outer Text

Quit

4. Choose State 0 to see the State 0 menu, and make the label as
follows:

a. Set Character Width to Double.

b. Set Foreground Color to Red.

c. Set Background Color to White.

Figure 5.49
State 0

20194

State 0
Edit Text
Move Text

Foreground Color Red
Background Color White

Underline No
Blink No

Character Height Single
Character Width Double

Quit

IMPORTANT:  PanelBuilder will not let you set the Foreground and
Background Color to the same color. To switch Foreground Color from
white to red and Background Color from red to white, change the
Foreground Color to a temporary color, say yellow, change Background
from red to white, and then change Foreground to red.

d. Choose Edit Text and type the OFF label inside the button. Press
Enter.

e. Choose Quit or press Esc to save the State 0 setting.
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5. Choose State 1 to see the State 1 menu, and make the label as
follows:

Figure 5.50
State 1

20195

State 1
Edit Text
Move Text

Foreground Color Red
Background Color White

Underline No
Blink No

Character Height Single
Character Width Double

Quit

a. Set Character Width to Double.

b. Set Foreground Color to Red.

c. Set Background Color to White.

d. Choose Edit Text and make the ON label for the inside of the
button.

e. Choose Quit or press Esc.

6. Open the Address menu and choose Button Control Address.

Figure 5.51
The Address Menu
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Button Control Address
Indicator State Address

Quit
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The addresses for this push button are on the Object Address List
shown in Chapter 4 (see Figure 4.14). To define the Button Control
Address:

a. Choose Communication and then Discrete.

b. Choose Rack and then 1. You’ll notice that “1” was your only
choice in the option list. This is because you only defined the
one rack when you defined Rack Assignments at the beginning
of this tutorial.

c. Choose Start Word and type 0.

d. Choose Start Bit and type 1.

e. Choose Update Address. You’ll see the current address
displayed on the top line of the Button Control Address window.

f. Choose Quit or press Esc to close the Button Control Address
menu.

7. Choose Indicator State Address. These addresses are in the Object
Address List shown in Chapter 4 (see Figure 4.14). To define the
address:

a. Choose Communication and then Discrete.

b. Choose Input/Output and choose Output.

c. Choose Rack and then 1.

d. Choose Start Word and type 0.

e. Choose Start Bit and type 1.

f. Choose Update Address. You’ll see the current address
displayed on the top line of the Button Control Address window.

g. Choose Quit or press Esc to return to the Object menu.

8. Open the Utility menu, and choose Name.
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Figure 5.52
The Utility Menu
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Name
Default

Quit

9. Type the name FRONT OFF.

10. Choose Quit or press Esc to return to the Object menu.

11. Then open the Exit menu and choose Exit and Save Object. This will
return you to the Push Buttons menu.

The Four Remaining Momentary (Normally Closed) Push Buttons

For each of the remaining four buttons, follow the steps shown earlier to
make copies of screen objects:

1. Back up to the Screen menu.

2. Choose Memorize. Position the cursor inside the Momentary
(Normally Closed) Push Button which you just created, and press
Enter.

3. Choose Recall. A copy of the push button is placed directly over the
top of the original push button, so that it looks as if there is only one.
An message will appear indicating that you have two buttons
assigned to the same function key. Press any key and proceed.

4. Move the copied button to the right of the original button.

5. Assign the correct function key to the button and choose Quit to close
the Move & Size menu.

6. Choose Address from the Object menu and type in the Button Control
Address and the Indicator State Text.

7. Choose Utility  from the Object menu, then choose Name, and enter
the button’s name.

8. Exit from the Object menu, and then choose Exit and Save Object.
You are returned to the Screen menu.
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These eight steps allow you to add a second Momentary (Normally
Closed) Push Button. To add the remaining three, recall and assign the
memorized button three times.

The table below shows the values you must enter for each push button:

Table 5.C
Values Assigned to the Push Buttons for Screen 2

Position
Row, Column

Function Key Addresses Name

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

21, 21 ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

11 ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

D I 1 0/3 & D O 1 0/3 ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

FRT CENTER OFF

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

21, 31 ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

12 ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

D I 1 0/5 & D O 1 0/5 ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

CENTER OFF

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

21, 41 ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

13 ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

D I 1 0/7 & D O 1 0/7 ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

BCK CENTER OFF

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

21, 51 ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

14 ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

D I 1 0/11 & D O 10/11 ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

BACK OFF

You have defined all ten push buttons. To complete the screen, add one
“Return To Previous Screen” button.

Add the “Return To Previous Screen” Button

1. Choose Screen Selectors from the Add menu and choose “Return To
Previous Screen” Button from the Screen Selectors menu.

Figure 5.53
The Screen Selectors Menu
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SCREEN MENU:   Add   Edit   Move   Delete   Memorize   Recall   Options   Exit

SCREEN MENU:   Add   Edit   Move   Delete   Memorize   Recall   Options   ExitAdd
Push Buttons

Control Selectors
Screen  Selectors
Indicators
Numerics

Text/Draw

Symbol
Bar Graphs

Time & Date
Screen Print Button

Local Message Display
ASCII Display
ASCII Input Small
Scrolling List Cursor List

Quit

Screen Selectors
�Go To Screen" Button
�Return to Previous Screen" Button

Screen List Selector
Screen Keypad-Enable Button

Quit



Creating a Sample Application File
Chapter 5

5-39

2. Choose Move & Size from the Object menu.

Edit the button in the following way:

a. Move the button to Row 0, Column 69.

b. Size the button to be Width 11 and Height 4.

c. Choose Function Key and link the button to function key 17.

d. Choose Quit to save your work and close the Move & Size
menu.

3. Open the Look menu and set the background color and border.

a. Set Background Color to White.

Figure 5.54
The Look Menu
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Foreground Color       Red
Background Color      White

Blink       No

Border       Single 	

Quit

b. Choose Border and set it to Double.

4. Press the right arrow key and choose Button Text from the Text menu.
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Figure 5.55
The Text Menu
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OBJECT MENU:         Move & Size         Look         Text         Utility         Exit

OBJECT MENU:         Move & Size         Look         Text         Utility         ExitText

Button Text
Outer Text

Quit

a. Choose Edit from the Button Text to label the button.

b. Enter the text MAIN SCREEN and press Enter.

c. Press the right arrow key twice and choose Exit and Save Object
from the Exit menu. You are back at the Screen Selectors menu.

5. Press Esc twice to close the Screen Selectors and Add menus, and
return to the Screen menu.

You’ve now finished the second screen. It should look like this:

Figure 5.56
Screen 2
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6. Save this screen by choosing Exit from the Screen menu and then
choosing Exit and Save Screen.

You will be returned to the Screens menu. At this point, the Screens menu
should be open and the Select Screen option should be highlighted.

Screen 3: PUMP CONTROLS

1. To create the third screen, choose Create New Screen. The cursor
moves to the next field where you enter the screen’s number.

2. Press Enter to accept the suggested screen number and type the name
for the screen, PUMP.

Figure 5.57
The Screens Menu
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FILE MENU:      Screens     Windows     Options     Communications         Exit
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Application File Comment

Quit

You’ve just created the third screen. Its name is in the status line at the
bottom of the screen, with the Screen menu across the top. The next step is
to start adding the objects.

If you refer back to Chapter 4 (Figure 4.13), you’ll see that Screen 3
consists of:

 three Background Text objects

 one five-position Control List Selector

 five Multi-State Indicators

 five Numeric Data Displays

 one Box
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 two Momentary (Normally Open) push buttons

 one “Return To Previous Screen” button

Add Background Text

You’ve already seen how to add Background Text to a screen. Those
step-by-step instructions are not repeated here, just the parameters you
need to define the text. If you’re not sure how to proceed, use the
instructions for Screen 2.

1. Text item 1 is the main title “PUMP CONTROLS”:

 double-height, double-width text

 located at Row 4, Column 24

 white foreground with black background

2. Text item 2 is the selector label “PUMP CONTROLS”:

 single-height, single-width text

 located at Row 9, Column 24

 white foreground with black background

 text is underlined (the underline option is found in the Look menu)

3. Text item 3 is the numeric indicator label “PRESSURE (PSI)”:

 single-height, single-width text

 located at Row 9, Column 41

 white foreground with black background

 text is underlined

Add the Control List Selector

The Control List Selector is an object with three different components: the
list of selections, the Up Cursor button, and the Down Cursor button.

When an operator uses the Up or Down Cursor buttons, the PLC records
which of the five selections is highlighted. When the operator presses one
of the Momentary (Normally Open) buttons, the PLC will either start or
stop the associated pump.
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To add the Control List Selector:

1. Choose Control Selectors from the Add menu.

2. Choose Control List Selector without Enter Key from the Control
Selectors menu.

Figure 5.58
The Control Selectors Menu
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You’ll see all three components of the selector in the center of the monitor
and the Object menu at the top of the screen.
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Figure 5.59
Control List Selector
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3. Choose Buttons from the Object menu and then choose Up Cursor
(Decr Value).

4. Choose Enable, and the Up Cursor (Decr Value) menu appears.

Figure 5.60
The Buttons Menu
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Quit
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Quit

From this menu:

a. Move the cursor to Row 18, Column 23.
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b. Size the button to Width 6, Height 3.

c. Link the button to Function Key 3.

d. Edit the text so the button is labeled UP.

e. Choose Quit or press Esc to return to the Buttons menu.

5. Choose Down Cursor (Incr Value) and then choose Enable. You are
presented with the Down Cursor (Incr Value) menu. From this menu:

a. Move the cursor to Row 21,Column 23.

b. Size the button to Width 6, Height 3.

c. Link the button to Function Key 11.

d. Edit the text so the button is labeled DOWN.

6. Choose Quit or press Esc to return to the Buttons menu.

7. Choose Quit or press Esc to return to the Object menu.

8. Choose List from the Object menu.

Figure 5.61
The List Menu
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List
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Width
Number of States  4

Edit Text
Move Text

Border Single

Quit

From the List menu:

a. Move the list to Row 11, Column 24.

b. Set the Border to None.

c. Set the Width to 11. You define the width of a list by using the
right arrow and left arrow, just as you’d size any other object.
However, you set the height of the object by specifying the
number of states.
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d. Set the Number of States to 5.

e. Choose Edit Text and define the five lines of text for:

 CROSSOVER
 MAIN
 OUTPUT
 INPUT
 BACKUP

Remember to use the arrow keys to move the cursor to the next line,
and only press Enter when you’ve typed in all five lines of text.

9. Choose Quit or press Esc to return to the Object menu.

10. Choose Address from the Object menu.

11. Choose Selector Control Address from the Address menu.

Figure 5.62
The Selector Control Address Menu
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Selector Control Address

Current Address Unassigned Address
Current Preset

Data Type Binary
Communications Discrete

Input/Output Input
Rack 1
Start Word 0
Start Bit 1

Number of Bits 1
Top Position Value 0

Update Address
Change Preset
View Address Map
Delete Address

Quit

The addresses for the Control List Selector are on the Object Address
List in Chapter 4 (see Figure 4.15). It is a four-bit bit-position
address.

IMPORTANT:  Remember that all bits off is a valid state (state 0).

a. Choose Data Type and then Bit.

b. Choose Communication and then Discrete.
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c. Choose Rack and then 1.

d. Choose Start Word and type 0.

e. Choose Start Bit and type 12.

f. Choose Number of bits and type 4.

g. Choose Top Position Value and choose ALL BITS OFF.

h. Choose Update Address. The current address will be displayed
on the top line of the Button Control Address window.

12. Choose Quit to close the Selector Control Address menu.

13. Choose Quit to close the Address menu.

14. Open the Exit menu. Choose Exit and Save Object.

15. Choose Quit or press Esc to close the Control Selectors menu and
return to the Add menu.

Add the Multi-State Indicators

The five Multi-State Indicators allow the operator to see the current state
for each of the pumps listed in the Control List Selector.

1. To define the first Multi-State Indicator, choose Indicators from the
Add menu; then choose Multi-State from the Indicators menu.
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Figure 5.63
The Indicators Menu
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You’ll see the object on the screen and the Object menu displayed
across the top of the screen.

Figure 5.64
The Move and Size Menu
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2. Choose Move & Size and:

a. Move the indicator to Row 11, Column 36.

b. Set the size for the indicator to Height 1, Width 6.

c. Choose Quit to close the Move & Size menu.
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3. Choose Look and set the border to None.

4. Press the right arrow key to close the Look menu and open the States
& Text menu.

Figure 5.65
States and Text Menu
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States & Text

State 0
Number of States 2
Display States

Outer Text

Quit

From this menu define:

a. The Number of States as 2.

b. The State as 0.

The State 0 menu appears.

Figure 5.66
The State 0 Menu
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Background Color Black

Underline No
Blink No

Character Height Single
Character Width Single

Quit

From this menu:

a. Choose Edit Text and type: OFF.

b. Choose Foreground Color and choose Red.

c. Choose Background Color and choose White.
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d. Choose Quit or press Esc to return to the States & Text menu.

Figure 5.67
States and Text Menu

20196
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State 1
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Display States

Outer Text

Quit

e. From this menu choose State and type 1.

You’ll see the State 1 menu. From this menu, choose:

a. Edit Text and type ON.

b. Foreground Color and choose Green.

c. Background Color and choose White.

5. Press the right arrow key to open the Address menu. Choose
Indicator State Address and define each element as indicated in
Figure 5.68.

Figure 5.68
The Indicator State Address Menu
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6. Choose Update Address. You’ll see the current address displayed on
the top line of the Indicator State Address menu.

7. Choose Quit to close the Indicator State Address window.

8. Choose Quit to close the Address menu.

9. Open  the Exit menu and choose Exit and Save Object.

Create the Remaining Four Multi-State Indicators

1. Press Esc twice to close the Indicators and Add menus. You’ll return
to the Screen menu.

Figure 5.69
The Screen Menu
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2. Choose Memorize. Position the cursor over the existing Multi-State
Indicator and press Enter.

3. Choose Recall. A copy of the Multi-State Indicator is placed directly
on top of the existing Indicator. (You can’t see it since it’s exactly on
top of the existing one.)

4. Choose Move & Size from the Object menu and then choose Move.
Position the new indicator one row below the previous Indicator and
press Enter. The correct positions for the remaining four Multi-State
Indicators are:

 Row 12, Column 36

 Row 13, Column 36

 Row 14, Column 36

 Row 15, Column 36

5. Choose Address from the Object menu and define the address for
each Multi-State Indicator. The correct addresses are:

 D O 1 0/13 with the Binary Data Type

 D O 1 0/14 with the Binary Data Type
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 D O 1 0/15 with the Binary Data Type

 D O 1 0/16 with the Binary Data Type

6. Choose Exit from the Object menu and choose Exit and Save Object.
You are returned to the Screen menu.

You have now defined two Multi-State Indicators. To add the other three,
repeat the last three steps (recalling, moving and sizing, and addressing) as
described above, using the correct position and address for each one.

Adding Momentary (Normally Open) Push Buttons

You’ve already seen how to add Momentary (Normally Open) Push
Buttons on Screen 2. Refer to Table 5.D for the parameters you’ll need to
define the two buttons. If you’re not sure how to proceed, look at the
step-by-step instructions given for Screen 2.

Table 5.D
Values for the Buttons on Screen 3

Parameters Button 1 Button 2

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Location ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Row 18, Column 31 ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Row 21, Column 31

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Width ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Width 8, Height 3 ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Width 8, Height 3

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Function Key ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

4 ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

12

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

State 0 Text ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

OFF ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

OFF

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

State 0 Colors ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Green on White ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Red on White

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

State 1 Text ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

ON ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

ON

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

State 1 Colors ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Red on White ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Green on White

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Character Height ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Single height ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Single height

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Character Width ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Double width ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Double width

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Button Control Addr. ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

D I 1 1/0 ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

D I 1 1/1ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁIndicator State Addr.

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁD 0 1 1/0

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁD 0 1 1/1ÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁName
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁPUMP ON

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁPUMP OFF

Add Numeric Data Displays

The Numeric Data Displays show the operator the current pressure within
the five tanks monitored by this screen.

Before you begin this section, make sure you are back at the Screen menu.

To add the Numeric Data Displays:



Creating a Sample Application File
Chapter 5

5-53

1. Choose Add from the Screen menu, and then Numerics from the Add
menu.

Figure 5.70
The Numerics Menu
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Quit

2. Choose Numeric Data Display from the Numerics menu. You then
have the choice of Standard or Scaled.

3. Choose Standard. From here, you choose the type of numeric display
you want.

Figure 5.71
Numeric Data Display
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Numeric Data Display

with
Decimal Point

with
Polarity

Quit

No
Yes
No
Yes

No
No
Yes
Yes

You want a Numeric Data Display with neither Decimal Point nor
Polarity, so select No | No and press Enter.
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You may want to look at Chapter 10, The Objects for more
information, but briefly, there are five different types of Numeric
Data Displays:

 the standard Numeric Data Display

 Numeric Data Display with Decimal

 Numeric Data Display with Polarity

 Numeric Data Display with Decimal and Polarity

 Numeric Data Display with Scaling

The object is placed in the center of the monitor, and the Object menu
is displayed across the top of the monitor.

4. Choose Move & Size and move the Numeric Data Display to Row 11,
Column 43.

5. Choose Look from the Object menu and turn the border off (i.e.,
choose Border and then choose None).

6. There are no other settings to be changed in the Look menu, so press
Esc.

The next step is to define the PLC address.

Choose Address and then Displayed Value Address. To define this address:

1. Choose Data Type and then BCD.

2. Choose Communication and then Block Transfer.

3. Choose Input/Output and then Output.

4. Choose File and then 1.

5. Choose Start Word and type 0, press Enter.

6. Choose Start Bit and type 0, press Enter.

7. Choose Number of Bits and type 16,  press Enter.

8. Choose Update Address. You’ll see the current address displayed on
the top line of the Displayed Value Address window.

9. Choose Quit to close the Displayed Value Address menu.

10. Choose Quit to close the Address menu.



Creating a Sample Application File
Chapter 5

5-55

11. Open the Exit menu, and choose Exit and Save object. You are
returned to the Numeric Data Display menu.

Create the Remaining Four Numeric Data Displays

1. Press Esc three times to close the Numeric Data Display, Numerics
and Add menus.

2. Choose Memorize. Put the cursor on the Numeric Data Display and
press Enter.

Figure 5.72
Memorize

20102

SCREEN MENU:  Add   Edit   Move   Delete   Memorize   Recall   Options    Exit

3. Choose Recall. A copy of the Numeric Data Display is placed
directly on top of the existing Numeric Data Display.

Figure 5.73
Recall
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4. Choose Move & Size, then choose Move. Position the Numeric Data
Display one row below the previous Display and press Enter. The
correct positions for the remaining four Numeric Data Displays are:

 Row 12, Column 43

 Row 13, Column 43

 Row 14, Column 43

 Row 15, Column 43

5. Choose Address from the Object menu and define the address for
each Numeric Data Displays. The correct addresses are:

 B O 1 1/0 thru 1/15 with the BCD Data Type
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 B O 1 2/0 thru 2/15 with the BCD Data Type

 B O 1 3/0 thru 3/15 with the BCD Data Type

 B O 1 4/0 thru 4/15 with the BCD Data Type

6. Choose Exit from the Object menu and choose Exit and Save Object.
You are returned to the Screen menu.

You have now defined two Numeric Data Displays. To add the other three,
repeat the above steps using the correct position and address for each one.

Add the “Return To Previous Screen” Button

The “Return To Previous Screen” button that you created on Screen 2 is
identical to the one you need for this screen. Rather than recreating the
button on this screen, you can call up Screen 2 and memorize the existing
button. Here’s how to do it:

1. You should be at the Screen menu. Choose Exit then Exit and Save
Screen. You are returned to the Screens menu of the File menu.

2. Choose Select Screen and choose 2 CONVEYOR.

Screen 2 is displayed and the Screen menu appears across the top of
the monitor.

3. Choose Memorize from the Screen menu, move the cursor to the
“Return To Previous Screen” button in the top right corner of the
screen, and press Enter.

The button is now memorized, ready to be recalled in Screen 3.

4. Choose Exit then Don’t save, just Exit and finally Yes. This returns
you to the File menu.

5. Choose Select Screen and choose 3 PUMP. Screen 3 is again
displayed.
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Figure 5.74
Select Screen
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Application Note

Quit

6. Choose Recall. The “Return To Previous Screen” button is displayed
in the top right corner, and the Object menu appears across the top of
the monitor.

7. Choose Exit then Exit and Save Object. You are once again back at
the Screen menu.

There is one more object to add and you’ll be finished creating your
screens.

Add a Box

To add the box to your screen:

1. Choose Add from the Screen menu.

2. Then choose Text/Draw from the Add menu.

3. Finally, choose Box from the Text/Draw menu.. You’ll see a small
box drawn in the center of the screen.
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Figure 5.75
The Add Menu
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Text/Draw
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Arc

Quit

4. Choose Move & Size.

5. Move the box to Row 8, Column 22.

6. Size the box so that it has Width 35, Height 10.

7. Choose Exit from the Object menu and then Exit and Save object.

Save the Screen

1. Press Esc twice to close the Text/Draw and Add menus. This returns
you to the Screen menu.

You have just finished the final screen. It should look like this:
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Figure 5.76
Screen 3
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2. Choose Exit and then Exit and Save Screen. This takes you back to
the Screens menu.

3. Press Esc to close the Screens menu and return to the File menu.

There is one more step to go before you’ve finished the sample application.

Save the Application File

Once you’ve finished your screens, you should save the file to disk.

1. Choose Exit from the File menu.

Figure 5.77
The Exit Menu
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2. Choose Exit and Save File and you will return to the Develop menu.

3. Press Esc to close the Develop menu and return to the Main menu.
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File Operations

This chapter describes the various operations that can be performed on
application files created with PanelBuilder. Application files can be:

 stored and retrieved

 renamed or erased on the development computer’s disk

 downloaded and uploaded to and from PanelView terminals

 downloaded and uploaded over an Allen-Bradley Data Highway + using
the Pass-Through feature of the PLC-5

 stored (burned) in EPROMs or EEPROMs

 documented with printed reports

Loading Files

To load an application file into PanelBuilder for editing or viewing, choose
Select File in the Develop menu.

Figure 6.1
The Develop Menu
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MAIN MENU          Develop     Transfer     Reports     Files     Setup          ExitDevelop

Select File SAMPLE
Create New File

Directory C:\PDS

Quit

You can find a file in any available directory by choosing Directory and
typing the directory’s pathname.

To make a new application file, choose Create New File. Enter a new file
name. The Select PanelView Terminal Type window will open.

Basic File Operations



File Operations
Chapter 6

6-2

Figure 6.2
The Select PanelView Terminal Type Window
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Select the appropriate terminal type and press Enter. The new file will be
created.

Saving Files

The application file is saved whenever you exit from the File menu, unless
you choose Don’t Save, just Exit from the Exit menu. Frequent saving is
recommended.

IMPORTANT:  It is possible for the development computer to run out of
memory when saving an application file, if the file contains a very large
number of long messages (information messages, alarm messages, and/or
local messages). This can be remedied by deleting some messages,
especially those which were recently created. When creating application
files which require a great number of long messages, it is advisable to save
the application file every 100 messages.

Copying, Deleting and Renaming Files

To copy, delete or rename files, choose Files in the Main menu. The
options available in the File menu are the same for Application Files, Hex
Files, and All Files.

 Application Files are DOS files which end in CFG.

 Hex Files are application files which have been converted into Intel Hex
format for transfer to EPROMs.

 All Files refers to all DOS files, including application files, Hex files
and any other files.
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To Copy a File:

1. Select the file in the Application Files menu.

2. Choose Copy File and press Enter. The Copy File menu will open.

3. To change the destination directory, choose Directory and type the
directory name.

4. Choose Copy File to:, then type the name of the new file and press
Enter.

Figure 6.3
The Files Menu
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Application Files

Hex Files

Quit

Application Files

Select File EXAMPLE

Copy File
Delete File

Quit

Copy File

Copy File to: EXAMPLE2

Directory C:\PDS

Quit

Choose Delete from the Application Files menu to delete the selected file.
To rename a file, choose Rename File to: and type in the new name.

You can print reports to document the screens, objects and functions in the
application file you are developing. You can print these reports on a printer
or send them to a disk file.

If you want printouts of the graphic images on your screens, your printer
must be able to print the IBM extended character set.

To print a report:

1. Choose Reports in the Main Menu.

2. In the Reports menu choose Select File to display the list of
application files.

Printing Reports
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Figure 6.4
The Reports Menu and Options

20114

MAIN MENU:         Develop     Transfer     Reports     File     Setup          Exit

MAIN MENU:         Develop     Transfer     Reports     File     Setup          ExitReports

Select File EXAMPLE

Directory C:\PDS

Quit

3. Cursor to the file of your choice and press Enter. The Select File
menu opens.

4. Choose Select Reports to view the available options, and select Yes
for those options you want documented. By default, Compatibility
Summary, Global Functions, I/O Usage Table and Object List are
selected as the report options to be printed.

Figure 6.5
The Select Reports Menu

21115

Select File

Select Reports

Compatibility Summary Yes
Global Functions Yes

PLC Communication No
I/O Usage Table Yes
I/O Address Cross Reference No

Screens No
Object List Yes
Function Key Usage No

Alarm Window No
Information Window No

Alarm Messages No
Information Messages No
Local Messages No

Computer Setup No

Quit

Print EXAMPLE
Select Reports

Con

Qui
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Some of the options in the Select Reports menu—like PLC
Communication and Alarm Window—will document the entire
application file. Other options, such as Screens or Alarm Messages,
allow you to specify a range of screens or messages to be printed.

 Compatibility Summary  prints the firmware version
compatibility of each screen within the entire application, the
firmware version compatibility of the application itself, and the
enabled global features of the application.

 Global Functions allows you to print the status of various
functions that are not related to specific screens. For example,
global functions may include the Time and Date to PLC
Controllers setting and screen number transfers, or may indicate
PLC controlled screens. See Figure 6.9 for an illustration of this
report.

 PLC Communication prints all the configuration settings for PLC
type, baud rate, push button input hold time, rack assignments, and
block transfer assignments.

 I/O Usage Table prints both the assigned and free address bits.
Two tables are printed: an Output Table for each rack assignment
in numerical order by rack number, and an Input Table. Any block
transfer assignments will also be listed in numerical order by file
number.

 I/O Address Cross Reference prints a report showing the
addresses used in the application file. The report will show all the
objects (choose All Addresses) or all objects with addresses within
a range that you define in the Starting Address and Ending
Address menus. The default Starting Address will be the lowest
defined address for the application; the default Ending Address is
the highest defined address for the application. The address range
can include inputs, outputs, discretes and block transfers.

Addresses are sorted as follows in the report:

 Block Transfer addresses before discrete addresses

 within discretes or block transfers:

- Input addresses before Output addresses

- File#/Rack# in numerically increasing order

 Start Word in numerically increasing order (0–31)

 Start Bit in numerically increasing order (0–17)
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 addresses with the same starting address, by their ending
address, in numerically increasing order

PanelBuilder will verify that the addresses specified are within the
allowable range, and that the starting address is less than the
ending address.

 Screens allows you to print the image of one specific screen, or a
range of screens, within the application.

IMPORTANT:  When printing a screen print, all special graphic
characters with an ASCII code of less then 20 (32 decimal) are
represented by blanks. In addition, arrow heads (such as those used
in cursor points) are printed as ASCII character 254. Refer to
Appendix E, The Extended Character Set.

 Object List allows you to list objects and associated information
for the entire application or for a range of screens within the
application. In the Object List menu, you can choose between two
Object List reports, a brief report that summarizes the key
information, and the full report. (See Figure 6.7 for an illustration
of these reports.) Another option also allows you to disable
printing of background text objects.

Figure 6.6
Object List Menu

23629

Object List

All Screens

Starting Screen
Ending Screen

Include Background Text Objects? Yes
Report Format Brief

Quit

 Function Key Usage (Keypad terminals only) allows you to print
a list of the function keys and associated objects names and type
assigned to each screen. Unassigned function keys will be
included, but the Object Name and Type fields will be blank.

 Alarm Window  prints all the configuration settings for the Alarm
Window.

 Information Window  prints all the configuration settings for the
Information Window.
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 Alarm Messages prints the entire list of alarm messages entered
for the Alarm List Window, or a range of messages.

 Information Messages prints the entire list of messages entered
for the Information Window, or a range of messages.

 Local Messages prints the entire list of messages created for the
Local Message Display objects, or a range of messages.

 Computer Setup prints all the configuration settings for the
PanelView terminal type, printer port, PanelView terminal port,
and EPROM burner port.

5. Once you have chosen the options you want to document, choose
Quit to return to the Select File menu.

6. Choose Report Destination to specify where you want the report to be
printed. To send the report to a printer, choose the port (COM1 or
COM2) your printer is attached to. To save the report as an ASCII
text file, choose File. The File window will open, showing the name
and path of the file to be saved. The default file name is the name of
the application file, and the default directory is the application file
directory. The file extension is .RPT. You can change the name and
the path, but not the extension.

Table 6.A
Printer Communication Port Settings Available in PanelBuilder

Port COM1 COM2 LPT1 not configurable LPT2 not configurable

Baud Rate 110 300 600 1200 2400 4800 *9600 19200

Parity odd even *none

Data bits 7 *8

Stop bits *1 2

*default settings

7. Choose Print FILENAME (where FILENAME is the name of the
application file you selected in step 3) to print the specified reports.

If you try to print when the printer is off-line or out of paper, there may be
long delays, and PanelBuilder may not respond to attempts to abort
printing. If this occurs, put the printer back on-line (press the ONLINE
button and verify the ONLINE indicator, reload the printer with paper and
put it back on-line, or momentarily power-down and power-up the printer).



File Operations
Chapter 6

6-8

If you can’t print, try again after following these steps:

1. Check your printer’s manual to ensure that you’ve assigned the
correct printer port setting, and that the port is correctly configured.

2. Ensure that your printer has been turned on, is on-line, and supplied
with paper.

3. Ensure that you did not set all the Select Reports settings to No.

Sample reports, two Object List reports and a Global Functions report, are
included on the following pages.

Figure 6.7
Full Object List Report

Full Object List File:  KA–TEST Oct 15 1992 20:49:12 Page 1

Screen 1:  KA–SCREEN–1

Momentary (N/C) Push Button:

Fkey:  F2 Row/Col:  5/0 Widt/Heigh:  10/3 Border:  Double Ver:1
Addresses Type Maximum Minimum Preset Control

Control  DI0101/10–01/13 Bit
Indicator DI103/01 Bit

State Fgnd/Bgnd Atrib State Text

00 Red/Blu riubwh State = 0
01 Wht/Red Riubwh State = 1

Fgnd/Bgnd Atrrib Outer Test

Red/Blk riUBwh Mom N/C PB

21211

Figure 6.8
Brief Object List Report

23631

Brief Object List File:  KC–DEMO Sep 28 1992 14:52:10 Page 1

Control List Selector: Vers:  1
Func Keys (Incr = F9, Decr = F1) States:  5
Addresses:
Control:  DI0101/10–01/13 Bit
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Figure 6.9
Global Functions Report

21210

Global Functions Report File:  BCK2 Jun 21 1993 09:22:24                           Page 1

VER5: Monochrome with Function Keys

Global Functions

Terminal Version Compatibility: 5
Power�Up Screen: 1
Alarm History Screen: 255
Alarm Window Type Full

Alarm Status Screen: 0
QTY/Time Reset Button: Enable

User Memory Limit 62,976 Not Battery�Backed
Application File Comment:
Application File Size: 1148 bytes
Application Disk File Size: 29736 bytes

Pass�Through Configuration

PLC DH+ Address: Not Used
Local Bridge Address: Not Used
Remote Bridge Address: Not Used

Auto Repeat Options

Cursor Auto�Repeat Rate (per sec.): 0
Cursor Auto�Repeat Start Delay (sec.): 0.4

Miscellaneous Control Options

Option Control Address

PLC Controlled Audio: Disable Unassigned Address
PLC Controlled Alarm Relay: Disable Unassigned Address
PLC Controlled Screen Print: Disable Unassigned Address
PLC Controlled Screen Number: Disable Unassigned Address
Current Screen Number to PLC Controller: Disable Unassigned Address
Time and Date to PLC Controller: Disable Unassigned Address
PLC Controlled Time & Date Control Disable Unassigned Address
PLC Controlled Time & Date Disable Unassigned Address
Screen Print Active to PLC Controller Disable Unassigned Address

PLC Controlled Clear Alarm Window: Disable Unassigned Address
PLC Controlled Silence Alarms: Disable Unassigned Address
Clear Alarm Window to PLC Controller: Disable Unassigned Address
Silence Alarms to PLC Controller: Disable Unassigned Address
Acknowledged Alarm Number Address: Disable Unassigned Address
Acknowledge Button Address: Disable Unassigned Address

PLC Controlled QTY/Time Reset: Disable Unassigned Address
QTY/Time Reset to PLC Controller: Disable Unassigned Address
Information Acknowledge Button Address: Disable Unassigned Address

PLC Inhibit Bit: Unassigned Address
Pass�Through Request Bit: Unassigned Address
Pass�Through Status Bit: Unassigned Address
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There are three ways of loading application files into PanelView terminals:

 loading application files into user PROMs and installing the user
PROMs into the terminals

 direct downloading of application files through the Upload/Download
cable. For installations where there are many PanelView terminals, this
requires going to each terminal, connecting the cable, and downloading
the application file

 downloading application files over the Data Highway + network, using
the PLC-5 Pass-Through feature. Pass-Through Download Options lets
you do this in two different ways. You can use the parameters of a
resident application file configured for pass-through. Or you can
manually configure the parameters for the Address Source. The
advantage of using the PLC-5 Pass-Through feature is that the
development computer doesn’t have to be physically moved from
terminal to terminal, and the terminals don’t have to have their cabling
changed

To send a completed application file to a PanelView terminal, choose
Download to PanelView (RS-232) in the Transfer menu. To retrieve an
application from a PanelView terminal for modification, choose Upload
from PanelView (RS-232) in the Transfer menu.

IMPORTANT:  Before you can download or upload, you must be sure
that the communication settings on the PanelView terminal and in the
PanelBuilder software are exactly the same.

Setting Upload/Download Communications on the PanelView Terminal

To download or upload, communications must be established between the
PanelBuilder computer and the PanelView terminal. The default settings
(indicated in Table 6.B and Table 6.C) of the terminal and PanelBuilder are
matched. To change the communication settings for your PanelView
terminal, follow these steps:

1. Set the PanelView terminal to Configuration mode.

2. Choose Serial Port from the PanelView terminal Configuration
menu.

3. Press Choose List  to choose the “Upload/Download” list.

4. Use the up and down cursor keys to move through the list, then use
the “Change Data” button to make your selection.

Methods of Loading
Application Files into
PanelView Terminals

Direct Downloading and
Uploading with the Upload
/Download Cable
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Table 6.B
Communication Settings Available on PanelView Terminals

Baud Rate 300 600 1200 2400 4800 *9600 19200

Parity Type odd even *none

Data Bits 7 *8

Stop Bits *1 2

Handshake Type *Hardware Software

Auto Line Feed *Off On

Auto Form Feed *Off On

*default settings

5. Press Save & Exit, and you return to the Configuration menu.

Setting Upload/Download Communications on the PanelBuilder
Computer

For uploading and downloading, the communication settings on the
PanelBuilder computer must match those of the PanelView terminal. The
default settings of the PanelBuilder software (indicated by * in Table 6.C)
are the same as the default settings of the PanelView terminal (indicated
by * in Table 6.B).

You can change the communication settings for either of the COM ports if
you wish. Also, you can configure one of the COM ports for
upload/download, and the other for printing (see Step 6 of Printing Reports
described earlier in this chapter).

1. From PanelBuilder’s Main menu, choose Transfer.

2. In the Transfer menu, choose Download to PanelView Terminal
(RS-232).

3. Select a file and press Enter. The Select File window opens.

4. Choose Configure Port from the Select File menu. The available port
and communication settings are as follows:

Table 6.C
Upload/Download Communication Settings Available in PanelBuilder

Port COM1 COM2

Baud Rate 300 600 1200 2400 4800 *9600 19200

Parity Type odd even *none

Data Bits 7 *8

Stop Bits *1 2

*default settings
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 Application Size: See Downloading Considerations later in this chapter.

Downloading to PanelView

To download means to transfer an application file from the development
computer to a PanelView terminal so that the application file can be run.
To download:

1. Connect the PanelView terminal to the development computer with
the Upload/Download cable.

2. Set the PanelView terminal to Configuration Mode and choose
Upload/Download from the terminal’s Configuration Mode Menu.

Figure 6.10
Configuration Mode Menu

23636

Up

Cursor

Firmware Rev 05.00.00  06/21/93 (050900)  06/21/93 05:36:59 AM

Application File Name:  DEMO       10801 Bytes Used, 52175 Bytes Free

CONFIGURATION MODE MENU
�

Down

Cursor

Enter

Upload / Download

Serial Port

Rack Assignments

Access Codes

Audio Response

Alarm Relay

Preset Operations

Time and Date

Screen Saver

Screen Alignment

Stuck Button Timeout

User EPROM/EEPROM Power-up Test

Pass-Through Download Options

Unit Tests

3. On the development computer, choose Download to PanelView
(RS-232) from the Transfer menu.
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Figure 6.11
The Transfer Menu

23639

MAIN MENU     Develop   Transfer    Reports     FilesCopy File     Setup     ExitTransfer

Download to PanelView (RS-232)
Upload from PanelView (RS-232)

Pass-Through Download to PanelView (DH+ and Remote I/O)
Pass-Through Upload from PanelView (DH+ and Remote I/O)

Burn EPROMS
Burn Single EPROM

Quit

4. Choose Select File to select the application file for downloading. If
necessary, choose Directory and type in the correct disk and directory.

Figure 6.12
Download to PanelView Menu

23639

MAIN MENU       Develop    Transfer     Reports    FilesCopy File  Setup    ExitTransfer

Download to PanelView (RS-232)
Upload from PanelView (RS-232)

Pass-Through Download to PanelView (DH+ and Remote I/O)
Pass-Through Download to PanelView (DH+ and Remote I/O)

Burn E
Burn Single EPROM

Quit

Download to PanelView (RS-232)

Select File EXAMPLE1

Directory C:\PDS

Quit

EXAMPLE1 13:37:22 05/28/90 16985 bytes
EXAMPLE2 09:44:10 05/28/90 17201 bytes
EXAMPLE3 11:36:03 05/18/90 17045 bytes

5. Choose Download FILENAME (where FILENAME is the name of the
selected file), and respond Yes when prompted to start downloading.
You can cancel the transfer at any time by pressing the Esc key.
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Figure 6.13
The Transfer Menu
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MAIN MENU:         Develop     Transfer     Reports     Files     Setup          Exit

MAIN MENU          Develop     Transfer     Reports     FilesCopy File        ExitTransfer

Download to PanelView (RS-232)
Upload from PanelView (RS-232)

Pass-Through Download to PanelView (DH+ and Remote I/O)
Pass-Through Download to PanelView (DH+ and Remote I/O)

Burn E

Quit

Download to a PanelView Terminal

Select File EXAMPLE1

Directory C:\PDS

Quit

EXAMPLE1 13:37:22 05/28/90 16985 bytes
EXAMPLE2 09:44:10 05/28/90 17201 bytes
EXAMPLE3 11:36:03 05/18/90 17045 bytes

Select File

Download EXAMPLE1
Configure Port COM1

Application Size

Quit

IMPORTANT:  If your terminal contains an application file in the User
EPROM, you can still download a different application file, which will
reside in application memory, for temporary use. The file will be erased,
and replaced by the file in the User EPROM memory, at the next
power-up.

If your terminal contains a user EEPROM, downloading to the terminal
will also replace the existing application file in the user EEPROM with the
new application file.

Downloading Considerations

 You cannot download a Keypad terminal application file to a Touch
Screen terminal, or a Touch Screen application file to a Keypad
terminal.

 You cannot download an application to a terminal whose memory
configuration does not match the “User Memory Limit” set in the
application file, even if there is enough available memory for the file in
the terminal.

 You cannot download an application which uses version 5 features to a
version 1, version 2, version 3 or version 4 terminal. The same is true
for all other application versions: you cannot download an application
containing higher version features to a lower version terminal.
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To use an application with previous release terminal firmware, you will
have to edit the application to remove the newer objects and features, or
upgrade the terminal’s firmware.

For more information on version compatibility see Chapter 2, Installing
PanelBuilder.

 When Application Size is chosen from the Select File menu within the
Download to PanelView (RS-232) menu, the PanelBuilder software
calculates the space the application file would occupy in a PanelView
terminal. This is not the same as the disk space used by the application
file in the development computer.

Uploading from PanelView

To upload is to transfer a copy of an application file from a PanelView
terminal to the development computer, so the file can be edited or saved on
disk. The uploaded application file can then be modified and downloaded
back to the PanelView terminal.

ATTENTION: If you upload an application file from a
PanelView terminal, the file will contain the current input states
or values in the terminal—not necessarily the terminal’s presets
for those inputs. If you want the file to contain the presets,
choose Preset Operations from the Configuration Mode menu,
and press the Load Presets button before uploading. This also
resets the terminal’s retentive input functions.

To upload:

1. Set the PanelView terminal to Configuration Mode and choose
Upload / Download from the terminal’s Configuration Mode menu.

2. On the development computer, choose Upload from PanelView
(RS-232) from the Transfer menu.

3. Choose Upload File as and specify a filename.

If a filename is not specified, the existing filename of the terminal’s
application file is used. If the filename exists within the upload
directory, you are asked if the file should be overwritten.

4. Respond Yes when prompted to start uploading to the development
computer. Screen messages inform you as the upload proceeds.
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PanelBuilder version 3 and later software and PanelView version 3 and
later firmware support the uploading and downloading of application files
over the Allen-Bradley Data Highway +, using the PLC-5 Remote I/O
Pass-Through feature, with the PanelView terminal connected as a remote
I/O device to the PLC-5. This feature allows you to download application
files to PanelView terminals without changing cabling on the terminals,
and without having to go from terminal to terminal with a PC for direct
downloading.

Figure 6.14
Connecting the Development Computer and PanelView Terminal through a Data
Highway + and PLC�5

23633

PanelView

PLC-5

DH+

Remote I/O

These PLC revisions support the Pass-Through feature:

Table 6.D
PLC Series/Revision Requirements for Pass�Through File Transfer

Processor Series Revision

PLC�5/11 All All

PLC�5/15 B N or later

PLC�5/20 All All

PLC�5/25 A J or later

PLC�5/30 A B or later

PLC�5/40 A
B

E or later
B or later

PLC�5/60 A
B

E or later
B or later

PLC�5/250 All All

Downloading and Uploading
over the Data Highway +
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The PanelView hardware and firmware revisions, and PanelBuilder
software revisions required are:

Table 6.E
Hardware, Firmware and Software Requirements for Pass�Through File Transfer

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

PanelView Hardware
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Series A, Rev B or later
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

PanelView Firmware
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Version 3.0 or later
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

PanelBuilder Software
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Version 3.0 or later

Pass�Through Utility Version 3.0.1

Configuring the Pass�Through Parameters

Before performing a file transfer with the Pass-Through feature, the
appropriate parameters must be configured in both PanelBuilder and
PanelView.

IMPORTANT:  As soon as any of the Pass-Through parameters are
configured, the application file becomes compatible with terminals with
version 3.0 or later firmware. The file cannot be downloaded to earlier
version terminals.

Once a valid file exists in the terminal, you can download to the same
address via the Pass-Through feature. Alternately, you can configure the
pass-through address at the terminal to match the application file’s
pass-through address.

Some parameters are saved in the application file. Some are configured
through the Transfer window just before the download. One parameter is
set in the PanelView terminal.

There are two groups of addresses to configure in the application file, the
Pass-Through Download bits and the PanelView location data.

The Pass-Through Download Bits

The Pass-Through Download Bits are optional, but are strongly
recommended. They are:

 the PLC Inhibit Bit.  When this bit is set (to 1), PanelView will not
permit a download. This bit must be reset by the PLC.

 the Pass-Through Request Bit. This bit is set (to 1) by PanelView
when a download request is received. It is cleared (reset to 0) once the
actual download starts.
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The PLC can be programmed to clear the PLC Inhibit bit when this bit
is set, allowing the file transfer to proceed.

 the Pass-Through Status Bit. This bit is set (to 1) by PanelView when
the first download block transfer is received, and remains set throughout
the download. It is cleared when the download is complete. When the
Pass-Through Status Bit is set, the Pass-Through Request Bit is cleared.

To configure these bits, open the File Menu and select Options
(Figure 3.12). From the Options menu, select Configure Pass-Through
Download Bits. The following window opens:

Figure 6.15
Configure Pass�Through Download Bits Window

22588

Configure Pass-Through Download Bits

PLC Inhibit Bit Address
Pass-Through Request Bit Address
Pass-Through Status Bit Address

Quit

Select one of the three options to open an address definition window like
Figure 6.16, the PLC Inhibit Bit Address window.

Figure 6.16
The PLC Inhibit Bit Address Window

23590

PLC Inhibit Bit Address

Current Address Unassigned Address

Data Type Bit
Communications Discrete

Input/Output Output
Rack 1
Start Word 0
Start Bit 0

Number of Bits 1

Update Address
View Address Map
Delete Address

Quit
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The Data Type and Number of Bits fields are not configurable; the data
type is always “Bit” and the number of bits is always 1. The Input/Output
field is always set to Input for the Pass-Through Status and Pass-Through
Request bits; for the PLC Inhibit bit, the default is Output, though Input is
permitted.

PanelView Location Data

These addresses locate your PanelView terminal on the communications
network. The Location Data includes the Block Transfer Control Address
(Rack, Group and Module); the PLC DH+ Address; and the Local and
Remote Bridge Addresses, when two DH+’s are configured together.

Of these parameters, the Pass-Through Block Transfer Control Address
must be configured through the Communications menu before
downloading. The information is saved with the application file, and is
automatically read when the download is initiated.

Pass-Through Block Transfer Control Address

The address is configured like any other block transfer address, in the
Block Transfer window of the Communications Menu. The Pass-Through
feature reserves a dedicated block transfer, called Pass-Through, for its
exclusive use. The file size for this block transfer is fixed at 30 words and
cannot be changed.

Figure 6.17
The Block Transfer Window

22591

FILE MENU:       Screens     Windows     Options     Communicup        ExitCommunications

PLC Type                 PLC-5/15 integral

Rack Assignment
Block Transfer

PLC Baud Rate 57.6K

Paass-Through Configuration

Quit

Block Transfer

Quit

Module Group

*
*
*
*
*

*

Rack
Number

*
*
*
*
*

*

Block Transfer
File

1
2
3
4
5

High/Low
Byte

*
*
*
*
*

*

File
Size

*
*
*
*
*

30Pass-Through
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The other Location Data parameters can be configured through the
Communications menu before downloading, or in the Pass-Through
Download to PanelView window at the time of the transfer. Configurations
defined through the Communications menu are saved with the application
file and picked up automatically at the time of the download.
Configurations defined at the time of download override the configurations
in the application file, but they are temporary, and apply only to the current
PanelBuilder session.

PanelView/PLC DH+ Addresses

To configure the DH+ addresses defining the PanelView terminal location
and save them with the application file, choose Pass-Through
Configuration in the Communications menu.

Figure 6.18
The Pass�Through Configuration Window

22589

Pass-Through Configuration

PLC DH+ Address Not Used
Local Bridge Address Not Used
Remote Bridge Address Not Used

Quit

Cursor to PLC DH+ Address and press Enter. The following window
opens:

Figure 6.19
PLC DH+ Address Window

22615

PLC DH+ Address

Not Used
PLC DH+ Address (0-77)

Quit

Cursor to PLC DH+ Address (0–77) and press Enter. Type the correct
address (in octal) in the small field that appears and press Enter.

Local Bridge Address/Remote Bridge Address

These fields are only required when you have two DH+ networks joined by
a connecting module or “bridge”. “Not Used” is the default entry in either
field; otherwise, enter the correct address in octal.
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Figure 6.20
Local Bridge Address and Remote Bridge Address Selection

22571

Local Bridge Address Remote Bridge Address

Not Used
Bridge Address (0-376)

Quit

Not Used
Bridge Address (0-77)

Quit

Configuring the PanelView Terminal for Pass-Through

The Auto-Restart After Download parameter can be configured at the
PanelView terminal.

Set the terminal’s Mode Select Keyswitch to Configure. From the
Configuration Mode Menu, choose Pass-Through Download Options. A
window will open, slightly different on a touch screen terminal than on a
keypad terminal.

Figure 6.21
The Pass�Through Download Options Window (Keypad Terminal)

23663

PASS-THROUGH

DOWNLOAD OPTIONS

>Auto Restart

Address Source

PLC Type

Baud Rate

Rack Number

Module Group

High/Low Byte

Up

Cursor

Save &

Exit

Manual

Address

Source

Down

Cursor

Change

Data

Yes

Application

PLC�5/30

115.2K

7

4

High

If you choose Yes for Auto-Restart, PanelView will start executing the new
application file as soon as the download is completed. If you choose No,
PanelView will wait for operator confirmation before starting to execute
the new application.

The rack assignments and PLC status will remain as per the previous
application file until the moment the new application begins executing.
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Address Source

You can choose between Application and Manual for the Address Source.
The first time that you enter this screen, the default is Application. When
you re-enter the screen, the values that were previously saved appear.

When you set the Address Source to Manual, you invalidate the application
file. When you set the Address Source back to Application, you revalidate
the application file. It will execute normally.

IMPORTANT:  After a successful download of an application file, via
Pass-Through or serial port, the terminal automatically resets the Address
Source to Application, uses the application file parameters, and discards
the Manual Address parameters.

 Application—When you choose Application, the terminal uses the
application file Pass-Through Address Source.

If the application file contains a pass-through configuration, its values
are displayed in the Manual Address Source area. If the application file
does not contain a pass-through configuration or there is no application
file present in the terminal, you will see asterisks displayed in the
Manual Address Source area. Without valid parameters in the Address
Source, the Pass-Through upload or download fails.

When you choose Application and then choose Save & Exit, the
terminal saves the Auto-Restart setting only.

 Manual—You must toggle the Address Source to Manual before you
can change any of the Manual Address Source entries.

When you choose Manual, the following message pops up:  

Choosing Manual Address Source will 
disable the Terminal’s current application 
file. Select Application to enable

This message remains on your screen until you toggle the Address
Source to Application.

If you toggle the Address Source to Manual but the current application
file has no Pass-Through configuration and a manual address has not
been configured and saved previously, the asterisks will be replaced by
the following defaults:

 PLC Type: PLC-5/25

 Baud Rate: 57.6K



File Operations
Chapter 6

6-23

 Rack Number: 1

 Module Group: 0

 High/Low Byte: Low

When you set the Address Source to Manual and choose Save & Exit,
the terminal validates the Manual Address Source and saves the
Pass-Through rack assignment setting and that of Auto-Restart. The
terminal also invalidates the existing application file to ensure that the
new manual Pass-Through rack assignment does not conflict with
existing application file rack assignments.

Downloading over the Data Highway +

To download using the PLC Pass-Through feature, both the PLC and
PanelView must be active on the network and in RUN mode. However,
PanelView ignores all operator and PLC inputs and outputs during the
download. The rack assignments and PLC status will remain as per the
previous application file until the download is complete.

Open the Transfer menu and choose Pass-Through Download to
PanelView (DH+ and Remote I/O).

Figure 6.22
Transfer Menu

22558

Transfer

Download to PanelView (RS-232)
Upload from PanelView (RS-232)

Pass-Through Download to PanelView (DH+ and Remote I/O)
Pass-Through Upload from PanelView (DH+ and Remote I/O)

Burn EPROMS
Burn Single EPROM

Quit

Then use the following menu to select the file and initiate the download.
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Figure 6.23
Pass�Through Download to PanelView Menu
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Pass-Through Download To PanelView (DH+ and Remote I/O)

Select Application File0
Application File Comment
Select Directory C: \PDS

Download Application File

PanelView Location Data

  Rack
  Group
  Module (High/Low Byte)
  PLC Type PLC-5/15 integral
  PLC DH+ Address (0-77)
  Local Bridge Address Not Used
  Remote Bridge Address Not Used

Programming Terminal Configuration

Quit

ATTENTION: Incorrect address selection could corrupt data in
a non-PanelView device. Verify that the address entered is
correct for your network.

If there are no application files in the selected directory, choose Select
Directory to change to the directory for the file you want to download.

If there are application files in the current directory, the Select Application
File field will display the name of the last file edited in this session; if
none, the last file name entered or selected; if none, the first application
file in the selected directory. The Application File Comment and the
PanelView Location Data for that file will be automatically copied to the
window.

You have the option at this point of changing some of the PanelView
Location Data. The PLC DH+ Address and the Local and Remote Bridge
Addresses can be configured at the time of the download. The changes will
apply only to this download operation, and will not be saved with the
selected application file, or replace the parameters configured in the file, if
any.

IMPORTANT:  Both the local and remote bridge addresses must be
defined or both must be set to “Not Used” in order to download the
application file.
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Programming Terminal Configuration

Your development computer (PC) must be configured to communicate with
the DH+. This requires defining the address of the PC on the network and
the type of hardware driver used.

These settings are stored in the PanelBuilder Defaults file and become the
new defaults for future downloads.

Figure 6.24
Programming Terminal Configuration Menu
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Programming Terminal Configuration

Programming Terminal DH+ Address 0
DH+ Hardware Driver 1770-KF2/1785-KE
Get 6200 Parameters
Pass-Through Utility Directory C:\PASSTHRU

Quit

You can use the first two menu items to enter these values manually, as
follows:

 Programming Terminal DH+ Address: This option defines the
address and parameters of the PC you will be using to download files.
Enter a value (0-77 octal). The default is 0.

 DH+ Hardware Driver:  Choose from:

 1770-KF2/1785-KE (choose a port, baud rate, parity, half/full
duplex, and error-checking type)

 1784-KL (choose between multi-drop or direct connection types)

 1784-KT/KT2 (you will have to choose a connection type and a
Driver Card Location).

 1784-KTK1 (choose a connection type, a Driver Card Location,
and an interrupt number)

 Get 6200 Parameters: Alternatively, if you have the 6200
Programming software, you can choose to have the addresses and
parameters loaded directly from the 6200 default file, instead of entering
them manually.
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You can load the parameters in the 6200 Defaults file by choosing Get
6200 Parameters. You will have to locate the directory path of the 6200
software drivers (by default C:\IPDS\ATTACH\) The directory setting
will be saved as a PanelBuilder default. Then choosing Get 6200 Driver
Parameters will load the parameters from the driver files.

Regardless which method you choose, the final menu item must be
configured, since the Pass-Through Utility is vital to the success of any
download using the Pass-Through feature.

 Pass-Through Utility Directory:  This field identifies the directory of the
pass-through utility files. By default they are located in C:\PASSTHRU.

IMPORTANT:  You must use Pass-Through Utility Version 3.0.1.

If the programming terminal configuration and PanelView Location Data
(addressing) information are correct, you can initiate the download.

1. Choose Download Application File from the Pass-Through
Download to PanelView (DH+ and Remote I/O) menu. A message
will appear, warning you that the addressing information which
locates the PanelView terminal on the network must be correct. If you
are sure of your settings, choose Continue. A further prompt will
display the estimated time for the download—the download will only
commence when you choose Start Downloading.

IMPORTANT:  If the file in the terminal is newer than the one on disk,
you will be informed and given a chance to cancel the download.

If the Inhibit bit is set, a message will appear on the status line. You
can cancel the transfer by pressing Esc, or you can wait for the Inhibit
bit to clear.

2. The status line will indicate whether the download is progressing. An
information message will be displayed on the screen when the
download is complete.

When the download is complete, the terminal will return to Run mode
either automatically, or when the operator restarts it, depending on the
terminal’s Auto-Restart configuration. (See Figure 6.21.)

IMPORTANT:  Do not try to download application files from two
development computers to the same location via the Pass-Through at the
same time. The results of such a conflict are unpredictable. The first
download will be terminated, but the second download may or may not be
completed successfully. An unsuccessful attempt will produce an error
message in both the PanelView terminal and the development computer(s).
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If both operations fail, the application file in the terminal may be
corrupted. The files in the computers will not be affected, so the best thing
to do is to try the download again immediately, but from only one
computer.

Uploading Over the Data Highway +

To upload, both PanelView and the PLC-5 must be active on the network
and in Run mode. Unlike download, the terminal will continue to function
in Run mode throughout the upload.

On the development computer, open the Transfer menu and choose
Pass-Through Upload from PanelView (DH+ and Remote I/O). Then use
the following menu to configure the PanelView terminal location on the
network, and initiate the upload.

Figure 6.25
Pass�Through Upload from PanelView Window
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Pass-Through Upload from PanelView (DH+ and Remote I/O)

Start Upload

Load PanelView Location Data

PanelView Location Data

  Rack
  Group
  Module (High/Low Byte)
  PLC Type
  PLC DH+ Address (0-77)
  Local Bridge Address Not Used
  Remote Bridge Address Not Used

Programming Terminal Configuration

Quit

The fields in this window are:

 Start Upload. If the PanelView terminal location data and
programming terminal configurations are correct, the upload will begin.
If an error is detected, a warning message will be displayed.

 Load PanelView Location Data allows you to get the location data
from an application file. The following window appears:
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Figure 6.26
The Load PanelView Location Data Window

22585

Load PanelView Location Data

Select Application File No File Selected
Application File Comment
Select Directory C: \PDS

Quit

 Select Application File produces a pop-up file selection list.

 Application File Comment displays the comment for the selected
file.

 Select Directory allows you to enter a new directory path to the
application file.

IMPORTANT:  This directory applies only to the application file selected.
It does not change the default directory, i.e., the one specified in the Files
menu.

 PanelView Location Data extracts the block transfer control address
and the DH+ addressing of the target PanelView from the application
file selected and places them in the PanelView Location Data fields.

 Programming Terminal Configuration  is the same as for
downloading.

 Quit  cancels the file operation.

ATTENTION: Incorrect address selection could corrupt data in
a non-PanelView device. Verify that the address entered is
correct for your network.

If the PanelView terminal location data and programming terminal
configurations are correct, choose Start Upload. A message will appear,
warning you that the addressing information which locates the PanelView
terminal on the network must be correct. If you are sure of your settings,
choose Continue. The upload will begin.

As the upload begins, the Start Upload menu will display information
about the file in the terminal, and the destination of the file on the
development computer’s disk.
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Figure 6.27
Start Upload Window
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Start Upload

Total Estimated Upload Time Minutes

Continue Upload
Upload As
Select Directory

Quit

From PanelView

File Name

File Comment

Last Edit Date

Last Edit Time

To Existing File

File Name

File Comment

Last Edit Date

Last Edit Time

The From PanelView section displays file information on the application in
the PanelView terminal.

The To Existing File section displays information about the disk file with
the same name as the application file in the terminal. If the file does not
exist, “To Existing File” will change to “To New File”, and all the fields
except the file name will be blank.

IMPORTANT:  Be sure that you are not about to overwrite a file on the
application computer’s hard disk which is more recent than the file in the
terminal.

You cannot change “From PanelView” or “To Existing File”.

You can change three of the selections at the bottom of the menu:

 Continue Upload allows the upload to proceed. If the terminal file
name matches one on disk, the “Overwrite?” prompt is displayed. You
will have to respond Yes to the prompt. If you respond No, the prompt
disappears and the highlight bar moves to the Upload As option.

 Upload As allows you to change the file name of the uploaded file. If
the new file name also exists on disk, the “To Existing File” information
will be updated with data from the new file. If the file does not exist, the
title “To Existing File” will change to “To New File”, and all the fields
except the file name will be blank.

 Select Directory allows you to upload the file into a different directory.
If changing the directory causes the file name to match one on disk, the
“To Existing File” information will be updated with data from the new
file. If the file does not exist, the title “To Existing File” will change to
“To New File”, and all the fields except the file name will be blank.
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Earlier PanelView terminals contained two sockets for optional PROMs.
Series D and E PanelView terminals have only one socket for one optional
EPROM/EEPROM.

To burn two 27C256 type EPROMs for use in a Series C or earlier
terminal, choose Burn EPROMS from the Transfer menu.

To burn a single 27C512 type EPROM for use in a Series D or E terminal,
choose Burn Single EPROM from the Transfer menu.

Figure 6.28
The Transfer Menu
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FILE MENU:       Screens     Windows     Options     Communicup        ExitTransfer

Download to PanelView (RS-232)
Upload from PanelView (RS-232)

Pass-Through Download to PanelView (DH+ and Remote I/O)
Pass-Through Upload from PanelView (DH+ and Remote I/O)

Burn EPROMS
Burn Single EPROM

Quit

Before you can burn an application file into the user EPROM, you must
connect your computer to an EPROM burner with an RS-232 serial cable.
The EPROM burner is connected to the same RS-232 port on the
development computer that is used to connect the PanelView terminal.
Refer to your EPROM burner user’s manual for connection instructions.

IMPORTANT:  PanelBuilder downloads the application file to the
EPROM burner in Intel Hex Format. The EPROM burner must be able to
accept a simple dump of Intel Hex format data and use 27C256 or 27C512
type EPROMs without special commands or operations.

PanelBuilder can also translate your application file to a DOS file with the
Intel Hex Format. This allows you to use other EPROM Burners (with
their own software drivers) for the IBM PC. See the following sections
Burn EPROMS and Burn Single EPROM for more information.

Burn EPROMS

To burn EPROMs for Series C and earlier terminals, choose Burn
EPROMS from the Transfer Menu. Then, choose Select Application File to
select the file you will download to the EPROM burner.

Burning the User EPROM
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After you press Enter, PanelBuilder takes a few seconds to generate the
hex files. When the file is created, the Burn FILENAME menu opens,
(where FILENAME is the name of the application file you selected).

Figure 6.29
The Transfer Menu and Burn EPROMS Menu
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MAIN MENU:       Screens     Windows     Options     Communicup        ExitTransfer

Download to PanelView (RS-232)
Upload from PanelView (RS-232)

Pass-Through Download to PanelView (DH+ and Remote I/O)
Pass-Through Upload from PanelView (DH+ and Remote I/O)

Burn EPROMS

Quit
Burn EPROMS

Select Application File EXAMPLE
Select Hex File EXAMPLE

Generate Hex Files EXAMPLE

Directory

Quit

Burn EXAMPLE

Send User Mem High Byte [U52]
Send User Mem Low Byte [U53]

Configure Port COM1

Application Size

Quit

The download to the burner is done in two parts, because one file is burned
into two EPROM chips—the high bytes in one and the low bytes in the
other. Both chips can be later installed into the PanelView terminal. In
Figure 6.29, [U52] and [U53] refer to the labels on the chip sockets on the
PanelView terminal’s logic board.

Send User Mem High Byte sends the data for EPROM chip U52 to the
EPROM burner.

Send User Mem Low Byte sends the data for EPROM chip U53 to the
EPROM burner.

Configure Port allows you to configure your computer’s serial port to
communicate with the EPROM burner.

Application Size calculates the amount of memory the application file
would occupy in a PanelView terminal. This is not the same as the disk
space used by the application file.
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To convert an application file into two hex files which can later be
retrieved or sent to the EPROM burner, choose Generate Hex Files. The
two files that are created correspond to “User Mem High Byte (U52)” and
“User Mem Low Byte (U53)” and have the file extensions .U52 and .U53.

To send previously generated Hex files, choose Select Hex File. The Hex
files will be loaded and the Burn FILENAME menu will appear as it does
when using the Select Application File option.

Burn Single EPROM

To burn a single EPROM for Series D or E terminals, choose Burn Single
EPROM from the Transfer menu. Then, choose Select Application File to
select the file you will download to the EPROM burner. After you press
Enter, PanelBuilder takes a few seconds to generate the hex file. When the
file is created, the Burn FILENAME menu opens, (where FILENAME is
the name of the application file you selected).

The file must have been created with the User Memory Limit set to one of
the smaller selections (59,904 or 62,976).

Figure 6.30
The Transfer Menu and Burn Single EPROM Menu
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MAIN MENU:       Screens     Windows     Options     Communicup        ExitTransfer

Download to PanelView (RS-232)
Upload from PanelView (RS-232)

Pass-Through Download to PanelView (DH+ and Remote I/O)
Pass-Through Upload from PanelView (DH+ and Remote I/O)

Burn EPROMS
Burn Single EPROM

Quit
Burn Single EPROM

Select Application File EXAMPLE
Select Hex File EXAMPLE

Generate Hex Files EXAMPLE

Directory

Quit

Burn EXAMPLE

Send User Memory [U2]

Configure Port COM1

Application Size

Quit

Send User Memory [U2] sends the data for the EPROM chip U2 to the
EPROM burner.
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Configure Port allows you to configure your computer’s serial port to
communicate with the EPROM burner.

Application Size calculates the amount of memory the application file
would occupy in a PanelView terminal. This is not the same as the disk
space used by the application file.

To convert an application file into a hex file which can later be retrieved or
sent to the EPROM burner, choose Generate Hex File. The file that is
created has the file extension .U2.

To send a previously generated Hex file, choose Select Hex File. The Hex
files will be loaded and the Burn FILENAME menu will appear as it does
when using the Select Application File option.

PanelView application files can also be stored in the optional EEPROM(s)
for easy installation into PanelView terminals on the factory floor.

Series C and earlier PanelView terminals contain two sockets for user PROMs.
Series D and E terminals have only one socket for one user EPROM/EEPROM.

An EEPROM can be programmed two different ways.

1. If an EEPROM is installed in the empty socket in the PanelView
terminal, an application file will automatically be copied into the
EEPROM when it is downloaded to the terminal. This method does
not require a PROM burner.

2. To program the EEPROM with a PROM burner, first convert the
application file to Hex files (Intel format) using Generate Hex Files,
as described in the previous section. The PROM burner must have its
own download utility software, and must be able to program a
28C256 or 28C512 type EEPROM. Refer to the instructions
furnished with your PROM burner for the download utility
procedure. Once programmed, the EEPROM(s) can be installed in the
empty PROM socket(s) in the PanelView terminal.

IMPORTANT:  The user EEPROM can be used for two purposes: for
application file backup (as described above) or to increase the memory
available for the application file to 128K from 64K bytes. If the EEPROM
is used for application memory, it can’t be used to back up the application
file. To make the memory option selection, open Options in the File menu,
and choose User Memory Limit. To use the internal EEPROM for backup,
choose one of the two smaller selections (59,904 or 62,976).

IMPORTANT:  PanelBuilder will not allow an application file whose
User Memory Limit exceeds 64K to be burned to PROMs.

Programming EEPROMs
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Burn EEPROMS

To burn EEPROMs for Series C and earlier terminals, choose Burn
EPROMS from the Transfer Menu. Then, choose Select Application File to
select the file you will download to the EPROM burner.

After you press Enter, PanelBuilder takes a few seconds to generate the
hex files. When the file is created, the Burn FILENAME menu opens,
(where FILENAME is the name of the application file you selected).

The download to the burner is done in two parts, because one file is burned
into two EEPROM chips—the high bytes in one and the low bytes in the
other. Both chips can be later installed into the PanelView terminal. In
Figure 6.29, [U52] and [U53] refer to the labels on the chip sockets on the
PanelView terminal’s logic board.

Send User Mem High Byte sends the data for EEPROM chip U52 to the
EPROM burner.

Send User Mem Low Byte sends the data for EEPROM chip U53 to the
EPROM burner.

Configure Port allows you to configure your computer’s serial port to
communicate with the EPROM burner.

Application Size calculates the amount of memory the application file
would occupy in a PanelView terminal. This is not the same as the disk
space used by the application file.

To convert an application file into two hex files which can later be
retrieved or sent to the EPROM burner, choose Generate Hex Files. The
two files that are created correspond to “User Mem High Byte (U52)” and
“User Mem Low Byte (U53)” and have the file extensions .U52 and .U53.

To send previously generated Hex files, choose Select Hex File. The Hex
files will be loaded and the Burn FILENAME menu will appear as it does
when using the Select Application File option.
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Information and Alarm Windows

Windows differ from PanelView objects in that they are not tied to specific
screens. They can appear over any screen at any time.

This chapter discusses the uses of the Information window and the Alarm
window, and describes how they are configured.

To define the Alarm and Information windows, choose Windows from the
File Menu and enable the appropriate window.

Figure 7.1
The Windows Menu
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FILE MENU       Screens     Windows     Options     Communications        ExitWindows

Alarm Window Disable
Information Window Disable

Terminal Fault Window
Alarm History Screen
Alarm Status Screen
Numeric and Security Entry Window

Quit

Enable
Disable

The Information window is triggered to display a message stored in the
PanelView terminal. The window appears over the current screen, showing
the specified message.

The Information window can be used to display:

 informative messages

 prompts or instructions

 warnings

 current states

The Information Window
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The window appears in the bottom four lines of the screen until either:

 the window’s Clear button is pressed, or

 the PLC controller instructs PanelView to clear the window by setting
the window control address value back to zero

Figure 7.2
Information Window
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Information Window Message 1
Clear
F8

If the Information window is on-screen at the moment when an alarm
occurs, the Alarm window may overlap the Information window. The
Information window will remain after the Alarm window is cleared.

Configuring the Information Window

To configure the Information window, set the Information Window to
Enable in the Windows menu. The Information window menu opens for
you to define the required parameters.
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Figure 7.3
Windows and Information Window Menus
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FILE MENU       Screens     Windows     Options     Communications        ExitWindows

Alarm Window Disable
Information Window Enable

Terminal Fault Window
Alarm History Screen
Alarm Status Screen
Numeric and Security Entry Window

Quit

Information Window

Messages

Window Look
Window Control Address
Acknowledge to PLC Controller  Disabled

Quit

Creating Messages

Choose Messages, then Create New Message to open the Edit Message
window. Type in the new message. Messages can be up to 70 characters
long. Each message is assigned a number which cannot be changed. The
maximum number of messages that can be entered is 496.

Figure 7.4
Information Window and Messages Menu
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Information Window

Messages

Window Look
Window Control Address

Quit

Messages

Select Message 1
Create New Message 2

Delete Message
Copy Message to: 2

Import Message Text
Export Message Text

Quit

Edit Message Number 2Edit Message Number 2

Boiler no. 7 is starting

Importing and Exporting Information Messages

You can import and export ASCII text files as text for information
messages.
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Importing Information Text

Using the text editor of your choice, create an ASCII text file of
information messages in this format:

nnn“ttt...ttt”  CR
!this is a comment

nnn  = information message number (1–496)
“  ”  = start and end of message
ttt  = message text (1–70 characters)
CR   = Carriage return (information record
 delimiter)
! = comment character

Follow these guidelines in preparing your information message text file:

 the message number must be between 1 and 496. The numbers do not
have to be created in ascending order, but they must be unique, i.e., no
two messages can have the same number

 the information text must be surrounded by quotation marks (”)

 to include a quotation mark (”) in your message, preface it with a
second quotation mark (””)

 PanelBuilder will ignore any spaces found outside the quotation marks

 do not use any character whose ASCII code is outside the range 32–127.
See Table 10.W for details of the ASCII character set

 use the comment character (!) as the first character in the line of a
comment. PanelBuilder will ignore lines that begin with !

 make sure your message text is 70 characters or less. If your character
width is set to double, use 35 characters or less. If PanelBuilder detects
a double width message of more than 35 characters, it will warn you and
change the character width to single

 when you name your file, use the extension .IMG

From the File menu, choose Windows. Then Enable the Information
Window item. The Information window menu opens. Choose Messages.
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Figure 7.5
The Messages Window
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Messages

Select Message                     1    Boiler no. 7 is starting
Create New Message

Delete Message
Copy Message to:

Import Message Text
Export Message Text

Quit

Choose Import Message Text. A window opens.

Figure 7.6
The Import Message Text Window

Import Message Text

Select File FILENAME
Directory c: \path1\path2\

Quit

23619

The file name in the Select File field will be one of the following defaults,
in decreasing order of priority:

 an .IMG file with the same name as the currently edited file

 the first .IMG file in the selection list

 a blank, if no .IMG files exist in the current directory

Choose Select File if you need to change the file name. A list of all files
with the .IMG extension in the current default directory appears. Choose
the one you want.

If the file is not in the current default directory, choose Directory to specify
the directory containing the file. The name of the specified directory will
be retained between PanelBuilder sessions.

Once the file is selected, PanelBuilder checks the current application file to
determine whether any information messages have already been defined. If
any messages are found, PanelBuilder displays this message:
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Figure 7.7
Import Error Message

Warning

Importing the messages into this file will replace all currently defined messages.
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Cancel Import
Continue

Choose Cancel Import or Continue. If you choose to continue,
PanelBuilder checks each record in the message file to make sure its
format is valid.

An error message will be displayed if any errors are found. The import will
be cancelled and the messages currently defined in the file will remain
unchanged.

If no errors are found, all the information messages in the application file
will be deleted and replaced by the imported ones.

Exporting Text

Choose Export Message Text from the Information window’s Messages
menu. The Export Message Text window will open. This window is the
same as the Import Message Text window, except for the title.

When the window opens, the Select File field will default to the name of
the application file currently being edited. You can keep the default or
change the name to any valid DOS file name. Once Select File is chosen
the filename area will be highlighted. If the displayed name is acceptable,
press Enter. An export of messages will be performed. You will be
informed if the file already exists in the current directory; the export will
not be performed until you choose Continue and answer Yes to “Overwrite
the Existing File?” PanelBuilder appends the .IMG extension when it
exports the file.

You can modify the export destination directory by selecting Directory
from the Export Message Text menu.

Editing Messages

Choose Messages from the Information window menu, then choose Select
Message to select a message for editing. Change the text in the Edit
Message window.
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Figure 7.8
Information Window and Messages Menu

Information Window

Messages
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Messages

Select Message 1 [---] Boiler no. 7 is starting
Create New Message 2

Delete Message
Copy Message to: 2

Import Message Text
Export Message Text

Quit

Edit Message Number 2

Edit Message Number 1

	 Boiler no. 7 is starting

Copying Messages

To copy a message, choose Messages from the Information window menu.
Choose Select Message to identify the message you want to copy. Then
choose Copy Message to:

The number shown in the Copy Message to: field is always the next
unused message number. You can type in another number if you choose.
The selected message will be copied to the message number in the Copy
Message to: field when you press Enter. Choose Select Message again to
see the copied text against the new message number.

Deleting Messages

To delete a message, choose Messages from the Information Window
menu. Then choose Select Message to identify the message you want to
delete. The message will be deleted when you choose Yes in the Delete
Message window.

Figure 7.9
Delete Message Window

Messages

Select Message 1 Boiler no. 7 is starting
Create New Message 2

Delete Message
Copy Message to: 2

Import Message Text
Export Message Text

Quit
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Delete Message

Delete Message 1? No
Yes
____
Quit
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Once the operation is complete, press Esc or choose Quit.

Setting the Window's Appearance

To define the appearance of the Information window, choose Window Look
in the Information window menu. This will open the Window Look menu.

Figure 7.10
The Window Look Menu

Information Window

Messages

Window Look
Window Control Address
Acknowledge to PLC Controller

Quit
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Window Look

Foreground Color Blue
Background Color White

Blink No
Underline No

Character Height Single
Character Width Single

Quit

IMPORTANT:  For monochrome terminals, you can select Reverse Video
and Intensity for the characters that appear, instead of the Foreground
Color and Background Color settings.

If you have defined a message that is longer than 35 characters,
PanelBuilder will not allow you to select Double for Character Width.

Address Assignment for the Information Window

To define the PLC address for the Information window, choose Window
Control Address from the Information window menu. The following menu
appears with a list of options described below.

IMPORTANT:  Remember that the appropriate addresses for both the
Information and Alarm windows should be determined when the screens
are designed. For more information see Chapter 4, Planning Your
Application.
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Figure 7.11
Window Control Address Menu

Information Window

Messages

Window Look
Window Control Address
Acknowledge to PLC Controller

Quit

21128

Window Control Address

Current Address Unassigned Address

Data Type Binary
Communications Discrete

Input/Output Input
Rack 1
Start Word 0
Start Bit 0

Number of Bits 1

Update Address
View Address Map
Delete Address

Quit

V

 Data Type defines the data type for the Information or Alarm window.
Valid data types are: Binary, BCD, and Bit. (For more information on
Data Type, see the next section on Address Assignment and PLC
Information Message Triggering.)

 Communications specifies Discrete or Block Transfer.

 Input/Output  specifies whether this is an input or output address
(typically output).

 Rack specifies the rack number. This option only appears on the menu
if you have specified the address as Discrete.

 File specifies the block transfer file number. This option only appears
on the menu if you have specified this address as a Block Transfer.

 Start Word  specifies the word or starting word for the address.

 Start Bit  specifies the starting bit within the word for the address.

 Number of Bits specifies the number of bits used in the address.

 if binary data type is specified, the address assignment will be a
contiguous bit string containing from 1 to 16 bits. For the
maximum number of messages allowed (496) you would need 9
bits
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 if BCD data type is specified, the address assignment will be a
contiguous bit string of 4, 8 or 12 bits (that is, 1, 2, or 3 digits). For
496 messages you would need 12 bits

 if bit is specified, the address assignment will always be a
contiguous bit string containing from 1 to 496 bits. For 496
messages you would need 496 bits

IMPORTANT:  The data type, together with the number of bits,
determines the maximum number of messages that can be triggered from
the PLC controller. See the following section on Address Assignment and
PLC Information and Alarm Message Triggering for more information.

 Update Address updates the application file with the values entered for
the Data Type through to the Number of Bits. The new address is
displayed at the top of the menu. If you make a mistake entering a new
address, an error message will appear when you choose Update Address.

 View Address Map shows you the address map of the bits allocated so
far for all the objects, windows and PLC Control Options.

 Delete Address removes the existing address from the file.

 Quit  closes the Window Control Address menu and returns you to the
Information Window menu.

Address Assignment and PLC Information Message Triggering

How the PLC controller triggers messages depends on the data type that is
selected. The data types are discussed below.

Binary Data Type

If binary data type is specified, the address assignment will be a contiguous
bit string containing from one to 16 bits. The bit string can be positioned
anywhere within the same PLC rack (even crossing word boundaries) by
designating the desired start bit (the default is zero which is the typical
choice). Together, the number of bits and the data type dictate the number
of messages you can trigger for the Information window.

BCD Data Type

If you specify BCD data type, the address assignment will be a contiguous
string of 4, 8 or 12 bits (that is, 1, 2, or 3 digits.)
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Triggering Information Messages for the Binary or BCD Data Type

To trigger a message, the PLC controller must put a non-zero value which
corresponds to the desired message number into the designated PLC
address. For example, a “trigger value” of 19 would cause the Information
window to appear, displaying message number 19 from the Information
Message List. If the PLC controller changed the trigger value to 27,
PanelView would replace the message with message number 27. The
operator can clear the window by pressing the Clear button. The window
will also be cleared whenever the PLC controller sets the trigger value to
zero. If the operator presses the Clear button while a valid trigger value is
still in the PLC address, the window will clear until the trigger value
changes to another non-zero value or until the screen changes. If the PLC
controller places an invalid (out of range) trigger value into the PLC
address, PanelView fills the Information window with question marks.

Bit Position Data Type

If bit data type is assigned, the address assignment will be a contiguous bit
string containing from 1 to 496 bits. Each bit in the string has a
corresponding message number in the Information Message List. For
example, the first bit corresponds to message number one, the second bit
corresponds to message number two, etc. When more than one PLC word
is required, the next higher word numbers will be used. When you specify
the number of bits for this function, you determine the maximum number
of messages that you can trigger for the Information window.

Triggering Information Messages for Bit Position Data Type

To trigger a message, the PLC program must set the PLC output bit that
corresponds to the desired message number in the Information Message
List. If PanelView sees any bit set, it displays the Information window with
the respective message.

PanelView ranks the message bits. If PanelView sees more than one bit set
to on at the same time, the message associated with the least significant bit
will be displayed. The operator clears the message by pressing the Clear
button. The message will also be cleared whenever the PLC controller sets
the associated message bits to zero.

If the least significant bit turns off, the message associated with the next
active bit is displayed. If there are no active bits, the Information window
is cleared.
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Information Window Acknowledgement

If your application requires that the Information window stay on the screen
until it is acknowledged, choose Enable for the menu item Acknowledge to
PLC Controller. An address definition window opens.

When this option is enabled, the message window is displayed on the
PanelView terminal with an ACK  button instead of a Clear button. The
window will stay on the screen until the window control address is set to
zero. If the screen changes, the message window will still be displayed
until the window control address is set to zero. To remove the window, the
PLC controller must detect the ACK bit and then reset the window control
address using ladder logic.

If the Acknowledge to PLC Controller address is assigned, the information
window will function as follows:

 When the user acknowledges an information message via the ACK
button, the terminal sets the “Acknowledge to PLC Controller” bit. The
bit stays on for up to 3 seconds, or until the window control bit resets to 0.

Use an Alarm window when you want the PLC controller to trigger the
display of an important message such as:

 alarm condition messages

 warnings

 informative messages

There are two types of Alarm window:

 a “single-line” Alarm window without buttons which displays the most
recent alarm, while leaving the current screen’s buttons active for
operator input

 a “Full” Alarm window with a set of buttons for operator response to
alarms. When the Full Alarm window is on the screen, all other buttons
on a keypad terminal are temporarily inoperative, until the operator
responds to the alarm. On a touch screen terminal, only those touch cells
that are covered by the Alarm window are disabled

IMPORTANT:  Do not confuse the Alarm window with the Alarm
History Screen.

The Alarm Window
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ATTENTION: Do not use your PanelView terminal as a
primary warning device or indicator of a critical or dangerous
situation. An operator’s response to a critical or dangerous
situation must never depend on software or solid state
electronics. All critical alarm indications and any critical host
controller responses must employ redundant and hard wired or
mechanical interlocks. “Critical” means any situation that could
result in physical injury, product damage or significant process
down time.

Alarm Messages

When the PLC controller triggers an alarm message, PanelView displays
the alarm message in the Alarm window. Time and date of occurrence are
displayed with the alarm message.

Figure 7.12
The Full Window with one Alarm Message
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Alarm message number 1                     01:52:28 PM 06/21/93

Cursor
Up

Acknowl
Alarm

Cursor
Down

The Full Alarm window can display up to 19 single-height messages. If the
PLC controller triggers more alarm messages before you clear the window,
the existing message shifts down, and the new messages are added to the
top of the list.
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If more messages occur than fit in the window, PanelView shifts the oldest
messages into the Alarm History screen and displays a message telling you
what it has done. You can view the Alarm History screen by pressing the
Alarm History button provided by the Full Alarm window.

The single-line Alarm window displays the alarm message, time and date
of occurrence and on/off status of the most recent alarm. The status of all
other alarms can be viewed in the Alarm History screen or the Alarm
Status screen. Since there are no buttons on the single-line Alarm window,
you should include a “Go To Screen” button on your operator screens to
call up the Alarm History screen.

Figure 7.13
Screen with Single�line Alarm Window
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Alarm message number 1                  01:52:28 PM  06/21/93 ON

R1
63012A

Alarm
History

The single-line Alarm window can only be removed from the screen by:

 acknowledgement of the alarm in the Alarm History screen

 a PLC-controlled clear alarm window

If the alarm displayed in the single-line Alarm window becomes inactive,
it still remains in the window. If the screen changes, the alarm display
remains on the new screen unless it is cleared by the PLC controller.



Information and Alarm Windows
Chapter 7

7-15

Background Alarms

If the Alarm window is disabled, alarms will continue to be triggered in the
background. They will still cause audio alarms, trip the alarm relay, and
send alarm messages to the printer and the Alarm History screen, but the
Alarm window will not pop up over the current screen.

Configuring the Alarm Window

In the File menu, open the Windows menu and set the Alarm window to
Enable. The Alarm Window menu opens for you to define the required
parameters.

Figure 7.14
The Alarm Window Menu
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FILE MENU       Screens     Windows     Options     Communications        ExitWindows

Alarm Window Enable
Information Window Enable

Terminal Fault Window
Alarm History Screen
Alarm Status Screen
Numeric and Security Entry Window

Quit

Alarm Window

Messages

Window Type        Full
Window Look
Window Control Address
Acknowledged Alarm Number Address   Disabled
Acknowledge Button Address       Disabled

Options

Quit

Creating Messages

Choose Messages to create or edit alarm messages. To make a message,
choose Create New Message. Press Enter and the message area is
highlighted and cursored awaiting message number entry (1–496). The
maximum number of alarm messages is 496.

IMPORTANT:  The maximum number of messages for Versions 1 and 2
firmware is 256. When you create an alarm message with a message
number higher than 256, you will be warned that the application’s
compatibility has changed—the new application will run only on terminals
with Version 3 and later firmware.
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Figure 7.15
The Messages Menu

20129

FILE MENU       Screens     Windows     Options     Communications        ExitWindows

Alarm Window Enable
Information Window Enable

Terminal Fault Window
Alarm History Screen
Alarm Status Screen
Numeric and Security Entry Window

Quit

Alarm Window

Messages

Window Type
Window Look
Window Control Address

Options

Quit

Messages

Select Message 1 [���] alarm number 1 is triggered
Create New Message 2

Delete Message
Copy Message to:

Import Message Text
Export Message Text

Quit

Once the number is assigned, press Enter; the Edit Message menu opens
with three alarm message options and a line for the message. The options
can be set differently for each message. Type the message and set the
options of your choice.

Figure 7.16
Edit Message Menu

Messages

Select Message 1 [���] alarm number 1 is triggered
Create New Message 2

Delete Message
Copy Message to:

Import Message Text
Export Message Text

Quit
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Edit Message Number 2

Message Text alarm number 2 is triggered

Activate Audio Disable
Print Message Disable
Energize Relay Disable

Quit

�

IMPORTANT:  The maximum length of Alarm Messages in Version 3, 4
and 5 is 50 characters; and in Version 1 and Version 2 it is 36 characters.
The first time you create a message with a length of more than 36
characters, you will be warned that the application’s compatibility has
changed—the new application will only run on terminals with release 3.0
and later firmware.

The Alarm window has more features than the Information window and
greater priority as well.
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The options are:

 Activate Audio—when the alarm is triggered, a continuous audio alarm
will sound.

 Print Message—when the alarm is triggered, the alarm message text
will be sent to a printer. If “Acknowledge Button Address” is enabled,
the alarm message will be printed again with the acknowledge time and
date when it is acknowledged. The printer prints each alarm message on
a single line, with the time and date when the alarm occurred. The
printer’s form feeds and line feeds are configurable through the Serial
Port screen of the PanelView terminal. See Chapter 2, PanelView
Terminal Functions, in the PanelView Operator Terminal User Manual.

 Energize Relay—when the alarm is triggered, the alarm relay is
energized—switching on whatever device is connected to the relay, such
as a warning light or remote audio alarm.

Importing and Exporting Messages

You can import and export ASCII text files as text for alarm messages.

Importing Alarm Text

Using the text editor of your choice, create an ASCII text file of alarm
messages in this format:

FFFnnn“ttt...ttt”  CR
!this is a comment

FFF = alarm flag 
A = Audio
P = Print
R = Relay

nnn  = alarm message number (1-496)
“   ”   = start and end of message
ttt  = message text (1-50 characters)
CR   = carriage return (alarm record delimiter)
! = comment character

Follow these guidelines in preparing your alarm message text file:

 specify one or more alarm flags at the beginning of the line. These can
be in any order, but define no more than three flags, and do not
duplicate any flag. If you don’t want any flags, leave this field blank
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 the message number must be between 1 and 496. The numbers do not
have to be created in ascending order, but they must be unique, i.e., no
two messages can have the same number

IMPORTANT:  Importing an alarm message whose number is greater
than 256 will make the application compatible with Version 3 and later
terminals only.

 the alarm text must begin and end with quotation marks

 PanelBuilder will ignore any spaces found outside the quotation marks

 PanelBuilder will ignore any character whose ASCII code is outside the
range 32–127. See Table 10.U for details of the ASCII character set

 use the comment character (!) as the first character in the line of a
comment. PanelBuilder will ignore lines that begin with the !

 make sure your message text is 50 characters or less.

IMPORTANT:  Importing an alarm message whose length is greater than
36 characters will make the application compatible with Version 3 and later
terminals only.

 when you name your file, use the extension .AMG

From the File menu, choose Windows. Then enable the Alarm Window
item. The Alarm Window menu opens. Choose Messages.

Figure 7.17
The Messages Window
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FILE MENU       Screens     Windows     Options     Communications        ExitWindows

Alarm Window Enable
Information Window Enable

Terminal Fault Window
Alarm History Screen
Alarm Status Screen
Numeric and Security Entry Window

Quit

Alarm Window

Messages

Window Type
Window Look
Window Control Address

Options

Quit

Messages

Select Message 1 [---] alarm number 1 is triggered
Create New Message 2

Delete Message
Copy Message to:

Import Message Text
Export Message Text

Quit
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Choose Import Message Text. A window opens.

Figure 7.18
The Import Message Text Window

Import Message Text

Select File FILENAME
Directory c: \path1\path2\

Quit

23619

The file name in the Select File field will be one of the following defaults,
in decreasing order of priority:

 an .AMG file with the same name as the currently edited file

 the first .AMG file in the selection list

 a blank, if no .AMG files exist in the current directory

Choose Select File if you need to change the file name. A list of all .AMG
files in the current default directory appears. Choose the one you want to
change.

If the file is not in the current default directory, choose Directory to specify
the directory containing the file. The name of the specified directory will
be retained between PanelBuilder sessions.

Once the file is selected, PanelBuilder checks the current application file to
determine whether any alarm messages have already been defined. If any
messages are found, PanelBuilder displays this message:

Figure 7.19
Alarm Import Warning Message

Warning

Importing the messages into this file will replace all currently defined messages.

23620

Cancel Import
Continue

Choose Cancel Import or Continue. If you choose to continue,
PanelBuilder checks each record in the message file to make sure its
format is valid. If any errors are found, an error message will be displayed,
the import will be cancelled and the currently defined messages will
remain intact.
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If no errors are found, all the alarm messages in the application file will be
deleted and replaced by the imported ones.

Exporting Text

Choose Export Message Text from the Alarm window’s Messages menu.
The Export Message Text window will open. This window is the same as
the Import Message Text window, except for the title.

When the window opens, the Select File field will show the name of the
application file currently being edited. The operator can keep the default or
change the name to any valid DOS file name. Once Select File is chosen
the filename area will be highlighted. If the displayed name is acceptable,
press Enter. An export of messages will be performed. You will be
informed if the file already exists in the current directory; the export will
not be performed until you choose Continue and answer Yes to “Overwrite
the Existing File?” PanelBuilder appends the .AMG extension when it
exports the file.

Editing Messages

Choose Messages from the Alarm window menu, then Select Message to
select a message for editing.

The messages you create are numerically ordered, and will appear in order
on the Messages screen. Each message has a 3 letter code in square
brackets after the number and before the first few words of the message.
The code is A for audio, P for printer, and R for relay, in that order. The
letters for the enabled functions appear, while disabled functions are
represented by a hyphen.

A message with audio and relay enabled would have the code [A–R], for
example, while a message with only the printer enabled would have the
code [–P–].

Alter the text or any parameter, in the Edit Message menu.

Deleting Messages

Choose Messages from the Alarm window menu, then choose Select
Message and the message to be deleted.
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Figure 7.20
Delete Message

Messages

Select Message 1
Create New Message 2

Delete Message
Copy Message to: 2

Import Message Text
Export Message Text

Quit

20126

Delete Message

Delete Message 1? No
Yes
____
Quit

To complete the operation choose Quit or press Esc to return to the
Messages menu; then choose Delete Message to remove the message from
the list.

Copying Messages

Choose Messages from the Alarm window menu, then choose Select
Message and the message to be copied. Then choose Copy Message to:

Figure 7.21
Copy Message
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Messages

Select Message 1 [APR] Alarm Message text
Create New Message

Delete Message
Copy Message to:    2

Import Message Text
Export Message Text

Quit

The number shown in the Copy Message to: field is always the next
unused message number. You can type in another number if you choose.
The selected message will be copied to the message number in the Copy
Message to: field when you press Enter. Choose Select Message again to
see the copied text against the new message number.
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Choosing the Window Type

Figure 7.22
Window Type

Alarm Window
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Messages

Window Type Single Line
Window Look
Window Control Address
Acknowledged Alarm Number Address
Acknowledge Button Address

Options

Quit

Full
Single Line

Window Type allows you to choose either a Full or Single Line Alarm
window. The Full Alarm window includes buttons to silence the alarm,
acknowledge the alarm or view the Alarm Status display or Alarm History
Screen (see Figure 7.12). The single line display has no buttons, and allows
operator access to any buttons on the current screen  (see Figure 7.13).

IMPORTANT:  With the single line Alarm window, the operator can only
acknowledge alarms in the Alarm History Screen. (Alarm windows can be
cleared by the PLC controller—see PLC Controlled Clear Window, at the
end of this chapter.) When you design your operator screens, be sure to
include a way for the operator to access the Alarm History Screen.

Setting the Window’s Appearance

Choose Window Look in the Alarm Window menu to define the appearance
of the Alarm window. Both Full and Single Line Alarm windows allow
foreground and background color, blink, and underline choices.

For the Full Alarm window you can also define:

 character height; (either single and double)

 how many messages will be visible (1 to 19 single height, 9 double
height). This also defines how large the window will be on the screen

With the single line Alarm window, you can choose whether the window
will appear at the top of the screen or the bottom of the screen. Be sure that
the single line window will not block operator access to important buttons
when it appears.
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You can only change the location of the single line alarm window
immediately after choosing Single Line from the Window Type menu. To
change the location of an existing single line window, choose Window
Type, then Single Line. The Window Location menu will open.

Figure 7.23
The Window Look Menu for the Full Alarm Window

Alarm Window

Messages

Window Type Single Line
Window Look
Window Control Address
Acknowledged Alarm Number Address Disabled
Acknowledge Button Address Disabled

Options

Quit
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Window Look

Foreground Color White
Background Color Red

Blink No
Underline No

Character Height Single
Number of Visible Messages 3

Quit

IMPORTANT:  For monochrome terminals, you can select High Intensity,
instead of the Foreground Color and Background Color settings.

Address Assignment for the Alarm Window

Window Control Address

To define the PLC address for the Alarm window, choose Window Control
Address in the Alarm window. The following menu appears with a list of
options described below.

IMPORTANT:  Remember that the appropriate addresses for the Alarm
window should be determined when the screens are designed. For more
information see Chapter 4, Planning Your Application.
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Figure 7.24
Window Control Address

Alarm Window

Messages

Window Type Single Line
Window Look
Window Control Address
Acknowledged Alarm Number Address Disabled
Acknowledge Button Address Disabled

Options

Quit
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Window Control Address

Current Address Unassigned Address

Data Type Bit
Communications Discrete

Input/Output Input
Rack 1
Start Word 0
Start Bit 0

Number of Bits 496

Update Address
View Address Map
Delete Address

Quit

.

 Data Type defines the data type for the Alarm window. Valid data types
are: Binary, BCD, and Bit. (For more information on Data Types, see
the next section on Address Assignment and PLC Alarm Message
Triggering.)

 Communications specifies Discrete or Block Transfer.

 Input/Output  specifies whether this is an input or output address
(typically output).

 Rack specifies the rack number. This option only appears on the menu
if you have specified the address as Discrete.

 File specifies the block transfer file number. This option only appears
on the menu if you have specified this address as a Block Transfer.

 Start Word  specifies the start word for the address.

 Start Bit  specifies the start bit within the word for the address.

 Number of Bits specifies the number of bits used in the address. The
number of bits together with the data type determines the maximum
number of alarm messages that can be triggered from the PLC
controller.
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 if Binary is specified, the address assignment will be a contiguous
bit string containing from 1 to 16 bits, depending on the number of
alarm messages defined. For example, for 256 alarm messages,
you would use 8 bits.

 if BCD is specified, the address assignment will be a contiguous
bit string of 4, 8 or 12 bits (that is, 1, 2, or 3 digits), depending on
the number of messages defined. For example, for 256 alarm
messages, you would use 12 bits.

 if Bit is specified, the address assignment will be a contiguous bit
string containing from 1 to 496 bits, depending on the number of
messages defined. For example, for 256 alarm messages, you
would use 256 bits.

IMPORTANT:  See the following section on Address Assignment and
PLC Alarm Message Triggering for more information.

 Update Address updates the application file with the values entered for
the Data Type through to the Number of Bits. The new address is
displayed at the top of the menu. If you make a mistake entering a new
address, an error message will appear when you choose Update Address.

 View Address Map shows you the address map of the bits allocated so
far for all the objects, windows and PLC Control Options.

 Delete Address allows you to remove the existing address from the file.

 Quit closes the Window Control Address and returns you to the Alarm
Window menu.

Address Assignment and PLC Alarm Message Triggering

How the PLC controller triggers messages depends on which data type is
selected.

Binary Data Type

If you specify Binary, the address assignment will be a contiguous bit
string containing from 1 to 16 bits. The bit string can be positioned
anywhere within the same PLC word (even crossing word boundaries) by
designating the desired start bit (the default is zero which is the typical
choice).
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BCD Data Type

If you specify BCD, the address assignment will be a contiguous string of
either 4, 8, or 12 bits (that is, 1, 2, or 3 digits). For 496 Alarm messages 12
bits are required (4 bits for each of the 3 digits).

Triggering Alarm Messages for Binary or BCD Data Types

To trigger a message, the PLC controller must put a non-zero value which
corresponds to the desired message number, into the designated PLC
address. For example, a “trigger value” of 19 would cause the Alarm
window to appear, displaying message number 19 from the Alarm Message
List. If the trigger value changed to 27, message number 27 would be
added to the list in the Alarm window. Any time the trigger value changes
to any other non-zero value, it is considered a message trigger. Unlike the
Information window function, a trigger value of zero will not make the
Alarm window disappear.

To clear the Alarm window, the operator presses the EXIT  button or
acknowledges all alarms. The Alarm window will also be cleared if the
PLC Controlled Clear Window bit is enabled and the bit set to one. PLC
Controlled Clear Window is discussed in the next section of this chapter.

If an invalid (out of range) trigger value is put into the PLC address, the
Alarm window message will be filled with question marks.

Bit Position Data Type for the Alarm window

The address assignment is a contiguous bit string from 1 to 496 bits. Each
bit in the string has a corresponding message number in the alarm message
list. For example, the first bit corresponds to message 1, the second bit
corresponds to message 2, etc. When more than one PLC word is required,
the next higher word number(s) are used. When you specify the number of
bits for this function, you determine the maximum number of messages
that you can trigger for the Alarm window.

IMPORTANT:  The Alarm Status screen can only be accessed if the
Alarm Window address is set to Bit data type.
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Triggering Alarm Messages for Bit Position Data Type

To trigger a message, the PLC program must set the PLC bit that
corresponds to the desired message number in the Alarm Message List. If
the PanelView terminal detects any bit change from 0 to 1, the Alarm
window appears, containing the defined message. If the Alarm window is
not cleared by the operator, and additional alarm bits change from 0 to 1,
they will be listed in the order of occurrence. If more than one bit changes
from 0 to 1 during a single PLC I/O scan, the alarms will be listed in order
from lowest to highest message number. Avoid situations in which the
same alarm bit can keep toggling rapidly. The Alarm window would be
triggered repeatedly and the same message repeatedly listed.

Acknowledged Alarm Number Address

When you enable the Acknowledged Alarm Number Address, an address
definition window opens. You can define a PLC Input address that
PanelView will use to indicate to the PLC controller which alarms have
been acknowledged.

 Data Type can be Binary, BCD or Bit

 for Bit: When the user acknowledges an alarm from the Alarm
window or the Alarm History screen, the acknowledge bit
corresponding to the alarm (the first bit or start bit corresponds to
alarm 1; the 496th bit corresponds to alarm 496) is set to 1. This
acknowledged bit will remain on until the corresponding alarm is
triggered again, which in turn will reset the acknowledge bit to 0.

 for Binary or BCD: When the user acknowledges an alarm from
the Alarm window or the Alarm History screen, the number of the
acknowledged alarm is put into the Acknowledged Alarm Number
Address. Pressing the Acknowl Alarm  button on the Alarm
History screen when there are no unacknowledged alarms resets
the value of this address.

 Number of Bits varies with the Data Type:

 for Bit data type, the number of bits that can be assigned ranges
from 1 to 496

 for Binary data type, the number of bits assigned can be from 1 to
16

 for BCD data type, the number of bits must be a multiple of 4,
from 4 to 32
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If the user acknowledges an alarm that is outside the specified
acknowledged alarm number address, the PanelView terminal does not
send or change the current alarm acknowledge input value to the PLC
controller and does not set the acknowledge button address bit to a one
when the acknowledge button is pressed.

Example: Sample PLC Logic to Clear Alarm Messages Using Ack Alarm
Number Address Bit

To clear the alarm message using the Acknowledged Alarm Number
Address, the following PLC logic is recommended when using the Bit data
type.

Figure 7.25
Sample Ladder Logic to Clear Alarm Message

ACK ALM NUMBER
BIT ADDRESS

I:010
]     [

     00

ACK BIT
ONE SHOT

BIT ADDRESS
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       00

ALARM INPUT
BIT ADDRESS

I:000
]     [

     00

ALARM INPUT
ONE SHOT

BIT ADDRESS
B3

] ONS [
        1

ALARM WINDOW CONTROL
BIT ADDRESS

0:010
( L )

       00
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The second rung latches the Alarm Window Control Bit Address, which
triggers the PanelView terminal’s alarm message. The ONS instruction
only allows this trigger on a false to true transition of the Alarm Input Bit.

Upon the terminal’s acknowledgment of this alarm message, the
corresponding Acknowledged Alarm Number Address Bit in the first rung
will become true, unlatching the Alarm Window Control Bit Address, and
clearing the alarm message. The ONS instruction in rung 2 ensures that the
Alarm Window Control Bit will stay unlatched even if the Alarm Input Bit
is on. The Alarm Input Bit must make another false to true transition to
trigger another PanelView Alarm Message. The Ack Bit ONS instruction
in rung 1 is used because the Acknowledged Alarm Number Bit Address
remains on until the same alarm message is triggered again.
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It is important to place the unlatch rung before the latch rung to ensure
proper alarm message triggering if both the alarm acknowledgment and
new alarm input trigger occur in the same PLC program scan.

Acknowledge Button Address

When you enable the Acknowledge Button address from the Alarm
Window menu, an address definition window opens. You can define a PLC
Input address that PanelView will use to tell the PLC controller that the
Acknowl Alarm  button on the Alarm History screen or Alarm Window is
pressed.

The Acknowledge Button Address bit is set to 1 for as long as the button is
pressed, or for the duration of the button hold time, whichever is longer.

When configuring the alarm system, you can enable several options
allowing the PLC controller to process alarms. To set the system for
Remote Window Processing, choose Options from the Alarm window
menu to open the Options menu.

Figure 7.26
Remote Processing Options

Alarm Window

Messages

Window Type Single Line
Window Look
Window Control Address
Acknowledged Alarm Number Address Disabled
Acknowledge Button Address Disabled

Options

Quit
Options

Clear Window to PLC Controller Disabled
Silence Alarms to PLC Controller Disabled

PLC Controlled Clear Window Enabled
PLC Controlled Silence Alarms Enabled

Quit
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Remote Window Processing
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To enable any of these four options, move the cursor to it and press Enter.
A menu will pop up allowing you to choose Enable or Disable.  Once
Enable has been chosen, a second menu will pop up where you assign an
address. For any of these options to work, it must be enabled and assigned
an address.

 Clear Window to PLC Controller —A single input bit must be
assigned to this function. This bit is set to 1 for 3 seconds whenever the
Alarm Window EXIT  button is pressed, or whenever all the alarms in
the Alarm window are acknowledged. After 3 seconds, the terminal will
reset this bit to 0.

IMPORTANT:  Only the Full Alarm window contains an
Acknowledge Alarm button or Exit  button. This Clear Window bit will
only operate when using a Full Alarm window.

 Silence Alarms To PLC Controller—When an input bit is assigned to
this function and this option is enabled, this assigned bit is set to 1 for 3
seconds each time the Full Alarm window’s Silence button is pressed.
After 3 seconds, the terminal resets the bit to 0.

IMPORTANT:  Only the Full Alarm window contains a Silence button.
The Silence Alarms To PLC Controller bit will only operate when using
a Full Alarm window.

 PLC Controlled Clear Window—This option will clear the Alarm
window, the alarm beeper, and the alarm relay, when a 0 to 1 transition
is detected on the assigned PLC address bit.

Subsequent alarm triggers are processed even if the bit remains at 1.

 PLC Controlled Silence Alarms—This option works the same way as
the Full Alarm window’s Silence button: it silences the beeper and
deactivates the alarm relay when a 0 to 1 transition is detected on this
bit.

Subsequent alarm triggers are processed even if the bit remains at 1.

 Assigning the PLC Address—When you enable any of these options,
the address menu will pop up, with the following selections:
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Figure 7.27
Address Assignment Menu

Alarm Window

Messages

Window Type Single Line
Window Look
Window Control Address
Acknowledged Alarm Number Address Disabled
Acknowledge Button Address Disabled

Options

Quit
Options

Clear Window to PLC Controller Disabled
Silence Alarms to PLC Controller Disabled

PLC Controlled Clear Window Enabled
PLC Controlled Silence Alarms Enabled

Quit
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PLC Controlled Clear Window

Current Address Unassigned Address
Current Preset

Data Type Bit
Communications Discrete

Input/Output Input
Rack 1
Start Word 0
Start Bit 0

Number of Bits 1

Update Address
Change Preset
View Address Map
Delete Address

Quit

 Data Type is automatically set to Bit for the Alarm window options.

 Communications specifies whether you want a Discrete or Block
Transfer.

 Input/Output  specifies whether this is an input or output address.

 Rack specifies the rack number. This option only appears on the menu
if you have specified that this is a Discrete address.

 File specifies the block transfer file number. This option only appears
on the menu if you have specified that this is a Block Transfer address.

 Start Word  specifies the starting word for the address.

 Start Bit  specifies the starting bit within the word for the address.

 Number of Bits is automatically set to 1 for all remote Alarm window
processing options.
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 Update Address takes all the new values and writes them to the
application file. The new address is displayed at the top of the menu. If
you made a mistake entering a new address, you’ll see an error message
when you choose Update Address.

 Change Preset allows you to assign a preset value to these options.
PanelBuilder software allows you to preset the initial values or states of
certain retentive objects including Control Selectors, Interlocked Push
Buttons, Numeric Input objects and other multi-state objects. These
values are PLC input states that are initially transferred to the PLC
controller and remain unchanged until altered by the operator. For more
information on retentive objects, see Chapter 10, The Objects.

 View Address Map shows the bits allocated for objects, windows and
PLC Control Options.

 Delete Address allows you to remove the current address from the file.

Buttons on the Full Alarm Window

The buttons on the Full Alarm window control the alarm system.

IMPORTANT:  If the single line Alarm window is used, the operator can
only acknowledge and clear alarms through the Alarm History screen.
Single line alarm windows can also be cleared by the PLC controller.

Figure 7.28
Buttons on the Full Alarm Window
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 Silence silences the audio indicator and unlatches the alarm relay if
either was triggered by an alarm message. If the alarm message has
audio and relay flags enabled, pressing EXIT  or Acknowl Alarm  will
also silence these alarms. Pressing Silence silences alarms without
clearing the Alarm window or acknowledging individual alarms.

This button will also set the “Silence Alarms to PLC Controller” bit to a
1 for 3 seconds, if the Silence Alarms to PLC Controller option is
enabled. This applies only to Version 2 firmware and later.

 Status brings up the Alarm Status screen which displays active and
inactive alarm states.

 History  displays the Alarm History screen.

 Cursor Up/Cursor Down buttons move the cursor bar up or down the
list of alarms, so you can acknowledge a specific message. When the
PLC controller triggers an alarm message that appears in the Alarm
window, the message appears highlighted by the Cursor Bar. As new
alarm messages are added to the list, the cursor bar shifts down, along
with the first message that was triggered.

 Acknowl Alarm acknowledges the highlighted alarm message and
removes it from the Alarm window. If the acknowledged alarm has the
audio flag enabled, the alarm beeper is then silenced. If the
acknowledged alarm has the relay flag enabled, the relay is deactivated.
The alarm message acknowledgement is then time stamped. If the
acknowledged alarm has the print flag enabled, the alarm will be printed
again, with the acknowledgment time stamp.

Pressing the Acknowl Alarm  button will have no effect on the audio
beeper if the PLC Controlled Audio bit is set at 1. (See Chapter 9, PLC
Controlled Options).

Pressing the Acknowl Alarm  button will have no effect on the alarm
relay if the PLC Controlled Relay bit is set at 1. (See Chapter 9, PLC
Controlled Options).

 EXIT  clears the Alarm window and will also set the Clear Window to
PLC Controller bit to a 1 for 3 seconds, if the Clear Window to PLC
Controller option is enabled.

The Alarm History screen can be called up from the Full Alarm window,
the Alarm Status screen, or by screen selection objects.

When it is called up by the Full Alarm window, it will overlay the Alarm
window and the currently displayed screen.

Alarm History Screen
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When the Alarm History screen is called up by a screen selection object on
another screen, it replaces that screen.

When the Alarm History screen is called up from the Alarm Status screen,
it replaces that screen.

Figure 7.29
The Alarm History Screen

22604

Cursor
Down

this is an alarm message 01:47:13 AM 11/15/89
this is an alarm message 01:47:13 AM 11/15/89
this is an alarm message 01:46:55 AM 11/15/89
this is an alarm message 01:42:12 AM 11/15/89
this is an alarm message 01:42:12 AM 11/15/89
this is an alarm message 12:01:24 AM 11/11/89 01:47:05 AM 11/15/89
this is an alarm message 12:01:24 AM 11/11/89 01:47:05 AM 11/15/89
this is an alarm message 12:01:24 AM 11/11/89

Print
History

Acknowl
Alarm

Cursor
Up

The Alarm History screen provides a record of the last 21 alarms that have
occurred. If more than 21 occur, the oldest alarm records will be lost,
unless the messages have been sent to a printer.

The Alarm History screen is pre-assigned screen number 255, although
that number can be reassigned. To view it, use any screen selection object.
For example, you could place a “Go To Screen” button, configured to call
Screen 255, on any screen. The operator could then view the Alarm
History screen even if the Alarm window wasn’t displayed.

IMPORTANT:  The Alarm History screen is pre-assigned screen number
255. In Version 1, the screen number is fixed at 255; in later versions this
can be changed. Changing the number makes an application file
incompatible with Version 1 terminal firmware.

The Alarm History screen contains the following buttons:

 Print History sends the Alarm History information to a printer

 Status opens the Alarm Status screen
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 Cursor Up/Cursor Down move the cursor bar through the list of
alarms, allowing you to highlight the appropriate alarm

 Acknowl Alarm acknowledges the highlighted alarm

IMPORTANT:  Alarms unacknowledged in the Alarm window can still
be acknowledged in the Alarm History screen.

 EXIT  takes you back to whatever screen you entered the Alarm window
from.

The Alarm Status screen displays active and inactive alarm states from the
PLC controller, as well as the number of times a point has gone into alarm
(the alarm count) and the total amount of time a point has been in-alarm.

The Alarm Status screen is called up by:

 pressing the Status button on the full sized Alarm window

 pressing the Status button on the Alarm History screen

 executing a screen selector object, i.e., Go To Screen button, that calls
up the Status screen’s screen number

 a PLC controlled screen change

The Alarm Status screen can be viewed in three different modes: viewing
all alarms (All Messages mode), active alarms only (Active Alarms mode)
and previous alarms (Past Alarms mode). The Alarm Status Screen Buttons
section later in this chapter supplies more details.

The three modes of the Alarm Status screen display the same columns of
information:

 Msg #—the alarm message number

 Qty—the number of times the alarm has gone into alarm.

 Accum Time—the total amount of time the alarm has been in the
in-alarm state.

 Alarm State—this shows ON or OFF (with ON flashing). In the
Display Active Alarms mode, only alarms which are ON are shown

 Message—the alarm message associated with the alarm

The Alarm Status Screen
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Figure 7.30
Alarm Status Screen (in Display Active Alarms Mode)

22603

Change
Mode

Page
Down

Page
Up

Msg      Accum Time Alarm      06/22/93 03:44:52 PM
  # Qty HH:MM:SS  State Message       Mode:  Display Active Alarms

1 5 00:02:18 ON This is alarm message 1

Reset
Qty/Time

Print
Status

Line
Down

Additional alarms:  Use Page�Up or Page�Down to view
Last QTY/TIME Reset occurred at:  06/21/93 14:07:35

Notes on the Alarm Quantity (Qty) and Accumulated Time (Accum
Time)

The Alarm Quantity (Qty) field shows the number of times the alarm has
gone into the alarm state. The field can display a maximum number of
9999. When the number of alarm transitions exceeds that, asterisks are
displayed: ****

The Accumulated Time (Accum Time) field keeps a record of how much
time each alarm has been on, i.e., in-alarm. The Accum Time field can
display an accumulated alarm time up to one second less than 100 hours
(99:59:59). When the accumulated time exceeds that maximum, asterisks
are displayed: **:**:**.

The Quantity and Accumulated Time fields for all alarm messages are reset
to zero when any one of the following occurs:

 the PanelView terminal powers up (only when the Alarm Status
information is NOT battery-backed—see the section on the
Files/Options Menu in Chapter 3, Using PanelBuilder, for details on
User Memory Limits)

 an application file is downloaded to the terminal

 the QTY/TIME Reset button on the Alarm Status Screen is enabled,
pressed, and confirmed
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 PLC Controlled QTY/Time Reset is enabled, and the PLC controller
resets the counts. The reset occurs when the PLC Controlled Reset bit
changes from 0 to 1. Alarm monitoring continues even though the bit is
on

When off-line to the PLC controller, the PanelView terminal stops
monitoring alarm time and quantity. In this case, “off-line” means:

 the PanelView terminal is disconnected

 the PanelView terminal is in Configuration mode

 the PLC controller is not in Run mode

 the PLC controller has the PanelView terminal Remote I/O racks
disabled

When the terminal goes back on-line, the alarm counts are increased by
one for those alarms already listed that are currently in-alarm, and the
times continue accumulating.

The Alarm Status screen can hold up to 496 alarm messages, but only 16
messages can fit on the screen. Use the PgUp and PgDn buttons to scroll
through the alarm messages.

IMPORTANT:  In order to be displayed in the Alarm Status screen,
alarms must have messages defined, and be of the bit data type.

Configuring the Alarm Status Screen

To configure the Alarm Status screen, choose Windows in the File menu,
then choose Alarm Status, and set the required parameters.

You can define its screen number, its colors, and whether the alarm count
(QTY) and total time in-alarm (TIME) of all messages can be reset to 0 by
the PLC controller and/or the Alarm Status screen’s QTY/TIME Reset
button. You can also enable the QTY/TIME Reset to PLC Controller
button to indicate when an Alarm Status QTY/TIME Reset has occurred.

You must assign the Alarm window control address to the bit data type,
otherwise the Alarm Status screen will not be displayed. For more
information, see the section on bit position data type for the Alarm
Window earlier in this chapter.

The Alarm Status screen can be accessed via:

 a “Go to Screen” button
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 a Screen Selector

 a PLC controlled screen change

 the Alarm History screen

 the Full Alarm Window

Figure 7.31
The Alarm Status Screen Menu
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FILE MENU       Screens     Windows     Options     Communications128    ExitWindows

Alarm Window254 Enable
Information Window Enable

Terminal Fault Window
Alarm History Screen
Alarm Status Screen
Numeric and Security Entry Window

Quit

Alarm Status Screen

Screen Number 254

Foreground Color Black
Background Color Cyan

PLC Controlled QTY/Time Reset Disable
QTY/TIME Reset Button Enable
QTY/TIME Reset to PLC Controller Enable

Quit
Enable
Disable

Alarm QTY/TIME Reset to PLC Controller

The QTY/TIME Reset to PLC Controller is available in PanelBuilder
Version 5 and later.

To activate the Alarm QTY/TIME to PLC Controller Reset, select the
QTY/TIME Reset to PLC Controller  option in the Alarm Status Screen
Menu. This option allows you to define a PLC address that indicates to the
PLC when an Alarm Status QTY/TIME reset has occurred.

To define the PLC address, select Enable. An address definition window
pops up (see Figure 7.32). In this window you define the PLC Input
address that is set when the Alarm Status QTY/TIME is reset. The options
are described below.
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Figure 7.32
QTY/TIME Reset to PLC Controller Address Assignment Menu
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Quit
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PLC Controlled QTY/Time Reset Disable
QTY/TIME Reset Button Enable
QTY/TIME Reset to PLC Controller Enable

Quit
QTY/TIME Reset to PLC Controller

Current Address Unassigned Address

Data Type Bit
Communications Discrete

Input/Output Input
Rack 1
Start Word 0
Start Bit 0

Number of Bits 1

Update Address
View Address Map
Delete Address

Quit

 Data Type is fixed at Bit.

 Communications specifies whether you want a Discrete or Block
Transfer.

 Input/Output —only a single Input address is permitted.

 Rack specifies the rack number. This option appears on the menu only
if you have specified that this is a Discrete address.

 File specifies the block transfer file. This option appears on the menu
only if you specified that this is a Block Transfer Address.

 Start Word  specifies the starting word for the address.

 Start Bit  specifies the starting bit within the word for the address.

 Number of Bits is fixed at 1.



Information and Alarm Windows
Chapter 7

7-40

 Update Address takes all the new values and writes them to the
application file. The new address is displayed at the top of the menu. If
you made a mistake entering a new address, you’ll see an error message
when you choose Update Address.

 View Address Map shows the bits allocated for objects, windows and
PLC Control Options.

 Delete Address allows you to remove the current address from the file.

When the PLC or a user resets the Alarm Status, the terminal automatically
sets the Alarm Status QTY/TIME Reset to PLC Controller bit. It resets this
bit 3 seconds after detecting the Alarm Status reset, regardless of whether
or not the Reset QTY/TIME button is still being pressed or the PLC
controlled QTY/Time Reset Bit is still active.

The Reset QTY/TIME button (or the PLC Controlled QTY/TIME Reset
bit) must make another 0 to 1 transition before the Alarm Status
QTY/TIME Reset to PLC Controller bit is set.

IMPORTANT:  While the Alarm Status QTY/TIME Reset to PLC
Controller bit is enabled, any subsequent Alarm Status QTY/TIME resets
will have no effect on the state of this bit.

When the QTY/TIME is reset, the Alarm Status Window displays the
Alarm Status Reset Time/Date Stamp.

Figure 7.33
The Last Reset Time/Date Stamp Screen
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Downloading an application to the terminal resets the Alarm Status
information. The Alarm Status Reset Time/Date Stamp shows the date and
time of the download completion. How the application is configured also
affects the Time/Date Stamp:

 For applications configured to retain Alarm Status information, the
Time/Date stamp is retained between power cycles.

 If the application is not configured to retain Alarm Status Information,
the Time/Date stamp is reset to show the time and date of power-up.

Alarm Status Screen Buttons

 Change Mode allows you to choose from three ways of viewing the
screen: viewing all alarms (All Messages), active alarms only (Active
Alarms) and previous alarms (Past Alarms).

 Reset Qty/Time (if enabled) resets the Qty (alarm count) field to 0, and
the Accum Time (accumulated time in-alarm) field to 00:00:00. If you
press this button, you will be prompted for confirmation before the
values are actually reset.

IMPORTANT:  The Alarm Quantity and Accumulated Time counts can
be reset from the Alarm Status Screen and from the PLC controller,
depending on your choices when configuring the Alarm Status screen.

 Print Status prints out the alarm status (all alarm messages, active
alarms or previous alarms, depending on the screen mode). You will be
prompted for confirmation before printing begins.

 History  opens the Alarm History screen.

 Page Up displays the previous page of alarms.

 Page Down displays the following page of alarms.

 Line Down scrolls to the first message of the next page (unless there are
no following messages).

 EXIT  returns you to the Alarm History screen.

Viewing the Display

Choosing Change Mode brings up the Change Mode To Display selection
of three buttons. Choose one of the three display modes.
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Figure 7.34
Selecting Display Modes
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Active Alarms (Display Active Alarms Mode)

The Alarm Status screen first opens in Display Active mode (see
Figure 7.30). This mode shows, in numerical order, all alarm bits that are
ON, along with the alarm’s Quantity, Accumulated Time, and Message
information.

If you enter Display Active Alarms mode from Display All Alarms or
Display Past Alarms mode, the display starts with the first active alarm
from the current screen, and displays the next 15 active alarms. If there are
no active alarms from the current screen to the end, the search will go
backward until 16 active alarms are found, or until the beginning of the list
is reached.

The first alarm in the Display Active screen acts as an anchor to the screen
of alarm messages. If this alarm changes to Off or is deleted, all the alarms
on the screen shift upwards. If this same alarm becomes active again, it
will reappear at the top of the list, and the other alarms will shift down.

As new alarms are entered on the screen, the alarms below the new entry
shift downwards. If an alarm becomes active which is before the first alarm
on the screen, or after the last alarm on the screen, the list of alarms will
not change. Instead a message “Additional Alarms: Use Page-Up to View”
or “Additional Alarms: Use Page-Down to View” appears to show that
there is information above or below the alarms which are displayed.

If all the alarms displayed on a screen turn Off, and there are no higher
alarm numbers On, the display will scroll to the previous screen of alarms.
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All Msgs (Display All Alarms Mode)

All alarms are listed in the Display All Alarms mode, whether they are
in-alarm or not—including those alarms which have never been in-alarm
since the Accum Time and Qty were last reset. The Alarm Status column
displays ON or OFF to indicate whether an alarm is active.

When you switch modes from Display Active Alarms or Display Past
Alarms, to Display All Alarms, the alarm at the top of the screen stays in
place and the next 15 alarms are displayed.

Figure 7.35
Alarm Status Screen (Display All Alarms Mode)
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To help you differentiate between active and inactive alarms, the Alarm
State text flashes on active alarms.

Past Alarms (Past Alarms Mode)

The Past Alarms display mode shows all alarms that are active or have
been active since the Qty/Accum Time was reset. The Alarm Status
column shows ON or OFF to indicate those alarms which are currently
in-alarm.
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The first alarm shown will be the first in the current or subsequent pages
with a quantity or accumulated time of greater than 0. The first alarm in the
Past Alarms screen acts as an anchor to the screen of alarm messages.
When a new alarm (an alarm with has not been active since the last reset)
is entered on the screen, the alarms below the new entry shift downwards.
If a past alarm becomes active which is before the first alarm on the screen,
or after the last alarm on the screen, the list of alarms will not change.
Instead a message “Additional Alarms: Use Page-Up to View” or
“Additional Alarms: Use Page-Down to View” appears to show that there
is information above or below the alarms which are displayed.

Figure 7.36
Alarm Status Screen (Past Alarms Mode)
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Screen Operations

This chapter describes the operations that can be performed on screens, and
the special attributes that can be assigned to them. For example, screens
can have restricted access for security reasons, and one screen can be
assigned as the first screen displayed when the PanelView terminal is
switched on.

With an application file selected, open the Screens menu and choose
Utilities to copy, rename, or delete a screen in the application file. Security
is discussed immediately following this section.

Figure 8.1
The Utilities Menu
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FILE MENU:       Screens     Windows     Options     Communications        ExitScreens

Select Screen 1 TEST SCREEN
Create New Screen

Utilities
Powerup Screen

Application Note

Quit

Utilities

Select Screen 1 TEST SCREEN

Delete Screen
Secure Screen

Copy Screen to: 3
Rename Screen to: TEST SCREEN

Quit

FILE MENU:       Screens     Windows     Options     Communications        Exit

Select Screen allows you to choose a screen for the following operations:

 Delete Screen removes the selected screen from the application file.

 Secure Screen is discussed in the Security section immediately
following this section.

Basic Utility Functions
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 Copy Screen To: makes a copy of the selected screen. You type in a
screen number for the new screen, but the screen name remains the
same. Once you have typed in the new screen number and pressed
Enter, you are asked whether you want to copy object addresses. If you
choose Yes, the addresses of the screen objects are copied to the new
screen; if you choose No, you will have to assign addresses to the
objects.

 Rename Screen To: allows you to change the name of the selected
screen by typing in a new one.

IMPORTANT:  Two screens may have the same name, but never the same
number.

Copying a Screen from One Application File to Another

The Copy Screen To function described above copies a screen within an
application file, but not from one application to another. Copying a screen
to another application file involves memorizing all of the screen objects,
and then recalling them on a different screen of the other application file:

1. Open a screen for editing.

2. Choose Memorize, then group all of the objects on the screen into a
single group.

3. Press Enter and then select whether to memorize the objects’
addresses.

4. Leave the screen and the application file. Do not quit PanelBuilder.

5. Create or select the application file you want to copy to.

6. Create or select the screen you want to copy to, and open the screen
for editing.

7. Choose Recall. The memorized objects will appear on the new
screen.

IMPORTANT:  You cannot copy a screen from a touch screen application
file to a keypad application file or vice-versa.
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You can restrict access to any or all of the screens you create by assigning
security. Specific operators can be restricted from specific screens, or up to
eight different operators may be assigned access to each screen. Choose
Secure Screen in the Utilities menu to set security.

Figure 8.2
The Secure Screen Menu
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Quit

Utilities

Select Screen 1 TEST SCREEN
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Quit

Secure Screen

Authorize Operator 1      No
Operator 2      No
Operator 3      No
Operator 4      No
Operator 5      No
Operator 6      No
Operator 7      No
Operator 8      No

Update Security

Quit

For each screen, specify which of eight operators are allowed access. If all
operators are specified No (the default), then anyone can view the screen
and the PanelView terminal will not request an access code.

When Yes is specified for one or more operators, the PanelView terminal
requests an access code before the screen can be viewed. Only the access
codes for those designated operators will be accepted.

The access code for each operator (1–8) is assigned on the PanelView
terminal in the Configuration Mode Menu. This allows a plant floor
supervisor with a mode select key to view and change access codes without
changing the application file. Information on how to change access codes
can be found in the PanelView Terminal User Manual, Chapter 2,
PanelView Terminal Functions.

When the eight operator choices are set, choose Update Security to save
the settings in the application file.

Security
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IMPORTANT:  If a screen is triggered by the PLC controlled option, or if
a screen is the Powerup screen, the screen will be displayed and no access
code will be requested regardless of the assigned security selections made.

The Powerup screen is the first screen displayed when the PanelView
terminal is switched on. You can set any screen to be the Powerup screen,
including the Alarm History or Alarm Status Screens. To define this
screen, choose Powerup Screen from the Screens menu, and select a screen
from the list of defined screens.

The Powerup screen is displayed, regardless of any security that has been
assigned to it.

Figure 8.3
Assigning the Powerup Screen
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In an empty application file, the Powerup screen is preset to the Alarm
History screen (screen 255, by default) if the Alarm History screen is
enabled. The first screen you create in the application is automatically
assigned as the Powerup screen. Should this screen be deleted, the
Powerup screen will is reassigned to the next screen in the list. If screen
number 1 is deleted, screen number 2 will become the Powerup screen.

A warning message is displayed whenever the Powerup screen is
reassigned.

The Powerup screen is unassigned if there are no screens in the application
file and if both the Alarm History and the Alarm Status screens have their
screen numbers set to 0.

The Powerup Screen
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Application File Comment

The Application File Comment field provides a 24 character space for
documentation purposes only. This comment is displayed in the
Pass-Through Upload/Download menus and in printed application file
reports. This note applies to the entire application file, not any particular
screen.

Figure 8.4
The Application File Comment Field
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FILE MENU:       Screens     Windows     Options     Communications        ExitScreens

Select Screen 1 TEST SCREEN
Create New Screen

Utilities
Powerup Screen     255 Alarm History

Application File Comment    _

Quit

To enter application file comment:

1. Choose Application File Comment from the Screens menu.

2. Type in the desired comment.

3. Press the Enter key.
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PLC Controlled Options

The PLC controller can control and monitor certain functions in the
PanelView terminal if you enable and assign a control address. The value
in the control address determines how the function operates on the
PanelView screen.

To set PLC controlled options, choose Options from the File menu. There
are eight options that can be enabled or disabled in this menu. The first
three provide information to the PLC controller, while the rest are
controlled by the PLC controller:

 Time and Date to PLC Controller

 Current Screen Number to PLC Controller

 Screen Print Active to PLC Controller

 PLC Controlled Audio

 PLC Controlled Alarm Relay

 PLC Controlled Screen Number

 PLC Controlled Screen Print

 PLC Controlled Time and Date

By default, all these options are Disabled. Highlight the option you want to
configure, press Enter, choose Enabled and press Enter again to open the
PLC address menu. Then define the PLC address for that option.
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Figure 9.1
Address and Communications Options for PLC Controlled Alarm Relay

FILE MENU:       Screens     Windows     Options     Communications        Exit

21152

Options

Display Menus for Terminal Version
PanelView Display Type

User Memory Limit
Minimum Push Button on Time

Cursor Auto-Repeat Rate (per Sec.)
Cursor Auto-Repeat Start Delay

Time and Date to PLC Controller
Current Screen Number to PLC Controller
Screen Print Active to PLC Controller

PLC Controlled Audio
PLC Controlled Alarm Relay
PLC Controlled Screen Number
PLC Controlled Screen Print
PLC Controlled Time & Date

Configure Pass-Through Download Bits

Quit

5
Color

62,976
50 msec

1
400 msec

Disabled
Enabled
Disabled

Enabled
Disabled
Disabled
Disabled
Enabled

PLC Controlled Alarm Relay

Current Address Unassigned Address
Current Preset

Data Type Bit
Communications Discrete

Input/Output Input
Rack 1
Start Word 0
Start Bit 0

Number of Bits 1

Update Address
Change Preset
View Address Map
Delete Address

Quit

You must define the following items to assign a PLC address. Figure 9.1
shows a typical address menu used for PLC controlled options.

IMPORTANT:  First enter the settings described below. Then choose
Update Address, or the settings you have entered will be lost.

 Current Address and Current Preset indicate the current address and
the preset values for the feature. These fields cannot be edited. The
value displayed is based on other settings entered.

 Data Type allows you to define the data type for the option. Valid data
types will vary depending on which control option you are defining.

 Communications specifies whether you want a Discrete or Block
Transfer. If you select Block Transfer the Rack option below changes to
File.

Assigning Addresses
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 Input/Output  specifies whether this is an input or output address.

 Rack specifies the rack number. This option only appears on the menu
if you have specified a Discrete address.

 File specifies the block transfer file number. This option only appears
on the menu if you have specified a Block Transfer in the
Communications field above.

 Start Word  specifies the starting word for the address.

 Start Bit  specifies the starting bit within the word for the address.

 Number of Bits specifies the number of bits used in the address.

 Number of Words will appear in this menu if Time and Date to PLC
Controller has been enabled. The number of words is fixed at seven and
cannot be edited.

 Update Address saves the displayed values and writes them to the
application file. The new address appears in the Current Address field at
the top of the menu. If you made a mistake entering a new address,
you’ll see the error message when you choose Update Address.

 Change Preset sets the value that the PLC address will have when the
terminal powers up.

 View Address Map shows the bits allocated for objects, windows and
PLC Controlled Options.

 Delete Address removes the current address from the file.

 Quit  exits the Address menu and returns you to the Options menu.

You can specify a file of seven 16–bit words within the PLC controller to
store the current time and date from the PanelView terminal’s clock.
PanelView will continually transfer the time and date to the PLC controller
in the format below when both the PanelView terminal and the PLC
controller are in Run mode.

Time and Date to PLC
Controller
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Table 9.A
Time and Date to PLC Controller Format

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Word ÁÁÁÁ
ÁÁÁÁ

1 ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Year (last 2 digits)

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Word ÁÁÁÁ
ÁÁÁÁ

2 ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Day of week (1 = Sunday)

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Word ÁÁÁÁ
ÁÁÁÁ

3 ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Month

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Word ÁÁÁÁ
ÁÁÁÁ

4 ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

Day of month

ÁÁÁÁÁÁWord ÁÁÁÁ5 ÁÁÁÁÁÁÁÁÁÁÁÁÁHours in 24�hour (military) formatÁÁÁÁÁÁ
ÁÁÁÁÁÁWord

ÁÁÁÁ
ÁÁÁÁ6

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁMinutesÁÁÁÁÁÁ

ÁÁÁÁÁÁWord
ÁÁÁÁ
ÁÁÁÁ7

ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁSeconds

 Start Word  can be any block transfer PLC input address. If discrete,
start word must be 0 or 1

 Data Type is BCD.

Enable this option to transfer the current screen number to the PLC
controller. This is useful for multiplexing display data from PLC output
addresses based on screen number. For more information on multiplexing,
see Chapter 4, Planning Your Application.

Choose Current Screen Number to PLC Controller from the Options menu.
Then enter a PLC input address. Be sure your address assignment is long
enough to accommodate the longest screen number—including the screen
numbers of the Alarm History Screen and Alarm Status Screen.

 Data Type can be Binary or BCD.

Screen print requests are ignored when the printer is already busy with a
screen print. The Screen Print Active option allows the PanelView terminal
to inform the PLC controller that a screen print is in progress.

Choose Enabled from the pop-up list to open the address definition
window and assign a PLC input address.

This option allows the PLC controller to sound the terminal’s built-in
beeper (audio indicator).

To use this feature, first select PLC Controlled Audio and choose Enabled.
Then define a PLC output address in the address definition window. If a
PLC output address bit is assigned and this function is enabled, then, when
the bit is set to 1, the beeper sounds. When the bit is set to 0, the beeper
stops.

Current Screen Number to PLC
Controller

Screen Print Active to PLC
Controller

PLC Controlled Audio
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To control the beeper from the PanelView terminal, assign a PLC input bit
address to a push button on one of your screens.

PLC Controlled Audio does not affect any alarm messages you may have
configured to sound the audio indicator. These alarms will sound the audio
indicator, regardless of whether you’ve enabled or disabled PLC
Controlled Audio or this address bit is 1 or 0.

Enable this option to assign a PLC output bit address that allows the PLC
controller to trigger the PanelView terminal’s alarm relay.

To use this feature, first choose PLC Controlled Alarm Relay from the
Options menu; then choose Enabled. Then define a PLC output address in
the address definition window. When the bit is set to 1, the alarm relay is
energized. When the bit is set to 0, the alarm relay de-energizes.

To control the alarm relay from the PanelView terminal, assign a PLC
input bit address and control that address with a push button on one of your
screens.

The PLC Controlled Alarm Relay does not affect any alarm messages you
may have configured to trigger the alarm relay; these alarms will energize
the relay regardless of whether you’ve enabled or disabled the PLC
Controlled Alarm Relay or whether this address bit is a 1 or a 0.

ATTENTION: Do not use the Alarm Relay for control
purposes.

Enable this option to allow the PLC controller to display specific screens.
Choose PLC Controlled Screen Number from the Options menu, then enter
a PLC output address. If a PLC output address is assigned and this function
is enabled, and the PLC controller moves a screen number into this
address, the PanelView terminal displays the screen, overriding the
operator’s selection.

Be sure your address assignment is long enough to accommodate the
longest screen number—including the screen numbers of the Alarm
History Screen and Alarm Status Screen.

The PLC output address must contain a 0 for the operator to have control
of screen selection.

PLC Controlled Alarm Relay

PLC Controlled Screen
Number
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If the PLC controller moves an invalid screen number into this address,
PanelView displays an “Invalid Screen” error message.

 Data Type can be Binary or BCD.

IMPORTANT:  Unexpected terminal operation can occur if the PLC
Controlled Screen Number function is assigned to an input address. You
must assign an output address to this feature for it to function properly.

Enable this option and assign a PLC output address to allow the PLC
controller to trigger a screen print of the current screen.

Assign a single PLC output bit. When the PLC output bit makes a
transition from 0 to 1, the screen displayed on the PanelView terminal will
be printed. The PLC controller must maintain the set bit long enough to
ensure that it is not missed by the PanelView terminal.

IMPORTANT:  Only the screen itself will be printed, not pop-up
windows, such as Alarm or Information windows.

About Screen Prints

Screen prints requested by the PLC controller are processed after all data
in the same PLC scan or block transfer file as the request is processed. If a
screen print request is logged in the same scan or file as a request for a
PLC controlled screen change, the screen displayed prior to the requests
will not be printed. Instead, the requested screen will be displayed and then
printed after it has been updated with the first scan of PLC data.

Some graphic characters will not be printed as they appear on the
PanelView terminal screen. Instead:

 ISA symbols, bar graphs, outer borders, arcs, diagonals and line
connectors will be replaced by ASCII character 219 decimal (illustrated
below)

 the first 32 characters, used for printer control, will be replaced by
ASCII character 254 decimal (illustrated below)

 double width/height characters will be replaced by a single normal sized
character and the appropriate number of blanks

Example: The letter A, displayed with double height and width,
occupies an area 2 characters high and 2 characters wide. Once printed,
the A will occupy the top left position leaving the other three characters
blank.

PLC Controlled Screen Print
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Figure 9.2
ASCII Characters 219 and 254 from the Alternate Character Set

23615

Character
219

Character
254

IMPORTANT:  An application file using the PLC Controlled Screen Print
feature is not compatible with Version 1 of the PanelView firmware. For
more details on version control see Chapter 2, Installing PanelBuilder.

Screen printing can also be initiated manually by means of the Screen Print
Button object. For more information on this object see Chapter 10, The
Objects. Refer also to the PanelView Terminal User Manual, Chapter 2,
PanelView Terminal Functions, for details on printer types.

Enable this option and assign a PLC output address to allow the PLC
controller to trigger PanelView to obtain the time and date from the PLC
controller and to reset its internal clock to match. This option is chiefly
useful for users who have a number of PanelView terminals connected to
the same PLC controller. It allows you to reset all the internal clocks in the
terminals through the PLC, rather than through operator input one at a
time.

Choose Enabled, and a menu opens, allowing you to set the Time and Date
Control Address and the Time and Date Address. Each of these menu
choices pops up an address definition window.

 The “Time and Date Control Address” defines the PLC address that
triggers PanelView to get the time and date from the PLC controller.
When this bit changes from 0 to 1, PanelView resets its internal time
and date to agree with the time and date read from the PLC controller.

 The “Time and Date Address” defines the PLC address from which the
PanelView will get the time and date. This must be in a 6 word block in
format:

PLC Controlled Time and Date



PLC Controlled Options
Chapter 9

9-8

Table 9.B
Time and Date Address Format

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Word ÁÁÁÁ
ÁÁÁÁ

1 ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Year (2 or 4 digits) ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

92-99, 00-25 (2 digit)
 or 1992-2025 (4 digit)ÁÁÁÁÁÁ

ÁÁÁÁÁÁWord
ÁÁÁÁ
ÁÁÁÁ2

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁMonth

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ1-12ÁÁÁÁÁÁ

ÁÁÁÁÁÁ
Word

ÁÁÁÁ
ÁÁÁÁ

3
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Day of month
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

1-31
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Word
ÁÁÁÁ
ÁÁÁÁ

4
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Hours in 24�hour (military) format
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

0-23
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Word
ÁÁÁÁ
ÁÁÁÁ

5
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Minutes
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

0-59
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Word
ÁÁÁÁ
ÁÁÁÁ

6
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Seconds
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

0-59

 Data Type can be BCD or Binary (default)

 Number of Words must be 6

 Start Bit  must be 0

If an error is detected in the data received from the programmable
controller, the data will be discarded and the following message will be
displayed.

Figure 9.3
Minor Fault Message: PLC Controlled Time and Date

23628

MINOR FAULT:  Time/Date received from PLC is invalid
Clear

F8

You can also enable several PanelBuilder options that allow the PLC
controller to process alarms. These are discussed in Chapter 7, Information
and Alarm Windows.

Four PLC controlled options (Clear Window to PLC Controller, Silence
Alarm to PLC Controller, PLC Controlled Clear Windows and PLC
Controlled Silence Alarms) appear under the section Remote Alarm
Window Processing.

A further option, the Alarm Quantity/Accum Time Reset, is explained
under the heading of The Alarm Status Screen.

Other PLC Controlled Options
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The Objects

This chapter defines all the objects, and describes the unique
characteristics of each type. Objects specifically designed for either
Keypad or Touch Screen terminals are identified as such.

Objects are the individual components of a screen. Each object is a
configurable and dynamic representation of a control panel component.
Examples include push buttons, selectors, bar graphs, and numeric
displays.

Certain types of objects have specific characteristics:

 background text and graphics don’t interact with the terminal
functions or the PLC controller. They are used to create titles for screens
and some objects, and to draw graphics, such as frames, circles, and
arrows

 momentary push buttons work very similarly to physical push buttons
which release when no longer pressed: they have a “normal” state which
they always default to, and to which they always return after being
released

 retentive objects are given a certain setting which they retain until it is
changed. Many PanelView objects are retentive, including maintained
push buttons, control list selectors, scrolling list object, and buttons
which increment, decrement, or set values

 display objects are used whenever you need to display a PLC value on
the screen, perhaps to show one of several states, a numeric or text
readout, or a bar graph. There are also some special display objects,
such as a time and date display and a local message display, which can
display preset messages when triggered by the PLC controller

 screen selectors are a special category; they are used to leave the
current screen and go to another screen. If simple buttons are used, the
operator selects a specific screen; if a screen list selector is used, the
operator can have a choice of screens to select. Unless your application
allows the PLC controller to control all screen changes, every screen
should contain at least one screen selector; otherwise the operator will
not be able to change screens

IMPORTANT:  A maximum of 255 objects can exist on a single screen.

Object Characteristics
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Retentive Objects

When the power is switched off and on, retentive objects hold their values
or revert to preset values, depending on whether the PanelView terminal’s
Preset Operations screen is configured as Last State or Preset. When the
terminal is switched from Run mode to Configure mode, retentive objects
hold their values.

Non-retentive objects revert to a default value when the mode is switched
or the power is turned off and on.

The following objects are retentive:

 Maintained Push Button

 Interlocked Push Button

 Control List Selector (with and without Enter key)

 Increment and Decrement Value Buttons

 Set Value Button

 Set Bit Cursor Point

 Numeric Input Cursor Point

 Numeric Keypad Entry Button

 Numeric Keypads (small and large)

 Scrolling List Object

Complete information on retentive objects, including special notes on how
to use them, is in the section About Retentive Objects at the end of this
chapter.
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From the File Menu, choose Screens. From the Screens Menu, choose Add.
All PanelView objects are listed in the Add menu. Below is a diagram
showing how to access objects through the Add menu.

Figure 10.1
The Add Menu and Its Objects

Add
Push Buttons

Control Selectors
Screen Selectors
Indicators
Numerics

Text/Draw

Symbol
Bar Graphs

Time & Date
Screen Print Button

Local Message Display
ASCII Display
ASCII Input
Scrolling List

Quit

Momentary (N/O)
Momentary (N/C)
Latched
Maintained
Interlocked

Control List Selector with Enter key
Control List Selector without Enter key
Set Bit Cursor Point (Keypad terminals)

�Go to Screen" Button
�Return to Previous Screen" Button
Screen List Selector
Keypad Screen Selector (Touchscreen terminals) 	 Small
Screen Keypad�Enable Button (Keypad terminals) 	 Large

Multi�State
List

Set Value Button
Increment Value Button Standard
Decrement Value Button Scaled
Numeric Data Display
Numeric Entry Keypad (Touchscreen terminals) 	 Small
Numeric Keypad�Enable Buttons (Keypad terminals) 	 Large
Numeric Input Cursor Point (Keypad terminals)

Text
Line
Box
Arc

ISA symbols

Vertical
Horizontal

Time Display
Date Display

ASCII Input keyboard (Touch Screen terminals) 	 Small
            Large

          (Keypad terminals) 	 Small
            Large

Cursor List
Object List 20228

The Add Menu
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In this chapter, the objects are described in the order in which they appear
in the Add menu (and the secondary menus which pop out from it).

There are five different types of push buttons that function like their
physical counterparts on an industrial control panel.

IMPORTANT:  Some PanelView objects contain buttons (such as the list
selectors, which have two or three associated buttons). These buttons are
configured as part of the object which contains them, not as independent
push buttons.

Momentary Normally Open (N/O) Push Button

The Momentary Normally Open Push Button controls the value at the
Button Control Address, a PLC input address. Normally, this bit is 0. When
the button is pressed, the bit is set to 1. When you release the button, the
bit is reset to 0.

You can use a Momentary Normally Open Push Button to initiate a PLC
controlled process or action.

To ensure that the PLC controller doesn’t miss a rapid button-press
between I/O scans, you can select the Minimum Push Button On Time
under Options in the File Menu. This “holds the button down” for a
minimum preset time.

In addition to the Button Control Address, this object has an Indicator State
Address which controls the display state of the object. Two states are
possible, 0 or 1. You can configure the button in a number of ways:

 if you assign just the Button Control Address and assign text and
attributes to state 0, the border on the button will highlight when you
press the button. The button text itself will remain unchanged

 if you assign the same PLC input address to the Button Control Address
and Indicator State Address, and assign different text and attributes to
state 0 and 1, the button will immediately change to state 1 when you
press it, and back to state 0 when you release it

 to provide a visual handshake with the PLC controller, assign a PLC
input address to the Button Control Address and a PLC output address
to the Indicator State Address. Program the PLC controller to turn the
Indicator State bit on when the Button Control bit is on, and the button
will change to state 1

Push Buttons
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More than one Momentary Normally Open Push Button can be assigned to
the same Button Control Address. Momentary Normally Open Push
buttons using the same PLC input address operate like their hard-wired
equivalents wired in parallel.

IMPORTANT:  The Momentary Normally Open Push Button is not
retentive or presettable.

If the button is being pressed at the moment when a window (Information,
Alarm or Fault Window) pops up on the screen, its value is reset to 0.

Momentary Normally Closed (N/C) Push Button

The Momentary Normally Closed Push Button controls the value at the
Button Control Address, a PLC input address. Normally, this bit is 1. When
the button is pressed, the bit is reset to 0. When you release the button, the
bit is set to 1.

This push button can be used as a stop button but not for emergency stops.
Emergency stop buttons must be hard wired.

To ensure that the PLC controller doesn’t miss a rapid button-press
between I/O scans, you can select the Minimum Push Button On Time
under Options in the File Menu. This “holds the button down” for a
minimum preset time.

In addition to the Button Control address, this object has an Indicator State
address used to define the display state of the object. Two states are
possible, 0 or 1. You can use these features to configure the button in a
number of ways:

 if you assign just the Button Control address and assign text and
attributes to state 0, the border on the button will highlight when you
press the button, but the button itself will remain unchanged

 if you assign the same address to the Button Control address and
Indicator State address, and assign different text and attributes to state 0
and 1, the button will immediately change to state 0 when pressed and
to state 1 when released

 to provide a visual handshake with the PLC controller, assign a PLC
input address to the Button Control bit and a PLC output address to the
Indicator State address. Program the PLC controller to turn the Indicator
State bit on when the Button Control bit is off, and the button will
change to state 1
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When two or more of these buttons are assigned to the same Button
Control address, they function like their hard-wired equivalents wired in
series: pressing either button, rather than both, turns off the PLC input bit.

IMPORTANT:  The Momentary Normally Closed Push Button is not
retentive or presettable.

If the button is being pressed at the moment when a window (Information,
Alarm or Fault Window) pops up on the screen, its value is reset to 1.

ATTENTION: For Momentary Push Buttons (Normally Open
and Closed) the input bits remain in their last states and the
buttons’ input bits will not reset if a remote I/O fault occurs.
The rack fault bit should be monitored when using these
buttons.

Latched Push Button

The Latched Push Button uses a “handshake” bit (usually a PLC output bit)
as well as the button control and indicator bits.

Pressing the button will set the Button Control bit to 1. The PLC program
must set the handshake bit to 1 when the Button Control bit is set to 1.
When the handshake bit is set to 1, PanelView will reset the control bit to
0. Your PLC controller must be programmed to turn the handshake bit off
(to 0).

You can use a latched input push button if you have a PLC controller with
long program and I/O scan times. Use the handshake bit to signal that the
program has indeed read the PLC input bit. In theory you can accomplish
the same thing by establishing a long enough Push Button Input Hold
Time, but a Latched Input Push Button takes the guesswork out of
estimating the program or I/O scan times.

You could also use this push button if you want the control bit to remain on
until a particular process within the PLC controller is completed.

IMPORTANT:  Operator screen changes are not permitted while the PLC
control bit is on. If the PLC controller initiates a screen change, the control
bit is reset to 0.

The Latched Push Button has two display states, 0 and 1. The push button
display state is controlled by the Indicator State Address. You can use this
feature to configure the button in a number of ways:
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 if you assign just the Button Control Address and assign text and
attributes to state 0, the border on the button will highlight when you
press the button, but the button itself will remain unchanged

 if you assign the same address to the Button Control bit and Indicator
State bit, and assign different text and attributes to state 0 and 1, then the
button will immediately change to state 1 when you press the button

 you can provide a visual handshake with the PLC controller by
assigning a PLC input address to the Button Control Bit and a PLC
output address to the Indicator State Address. By programming the PLC
controller to turn the Indicator State bit on when the Button Control bit
is set, the button will change to state 1

IMPORTANT:  The Latched Push Button is not retentive or presettable. It
does not retain its value when power is switched off and on again, or when
the terminal is switched to Configuration mode and then back to Run
mode.

Maintained Push Button

Pressing a Maintained Push Button, (also known as Push-On, Push-Off)
sets the corresponding PLC Button Control bit to 1. The bit remains set
even after the button is released. You must press the button a second time
to reset the bit to 0.

The Maintained Push Button controls the value at the Button Control
address, a PLC input address. In addition, this object has an Indicator State
address used to define the display state of the object. The Maintained Push
Button has two display states, 0 and 1. You can use this feature to
configure the button in a number of ways:

 if you assign just the Button Control address and assign text and
attributes to state 0, the border on the button will highlight when you
press the button, but the button text itself will remain unchanged.

 if you assign the same address to the Button Control address and
Indicator State address, and assign different text and attributes to state 0
and 1, then the button will immediately change to reflect the new state
when you press the button.

 to provide a visual handshake with the PLC controller, assign a PLC
input address to the Button Control address and a PLC output address to
the Indicator State address. Program the PLC controller to turn the
Indicator State bit on when the Button Control bit is on, and the button
will change to state 1



The Objects
Chapter  10

10-8

IMPORTANT:  The Maintained Push Button is a retentive object. Thus,
the PanelView terminal will retain the current value for the button setting
even after the terminal is turned off or switched to Configuration mode.
For this reason, do not use a Maintained Push Button to initiate a PLC
controlled machine or process. Instead use a Momentary Push Button. You
can assign a preset value to the Maintained Push Button.

Interlocked Push Button

The Interlocked Push Button is actually one push button in a group of push
buttons. The group of buttons functions together in much the same way as
the station selector buttons on a car radio: pressing one cancels the other
buttons and makes a new selection. Although they function as a group,
they are added to the screen individually.

Assign the same button control address, a PLC input address, to each
button in the group. Then assign a unique control value to each button. The
range of the value depends upon the data type and number of bits assigned
to the button control address. When you press an Interlocked Push Button,
the PanelView terminal places this control value at the button control
address in the PLC controller and highlights the selected button.

The Interlocked button remains highlighted as long as the PLC value is the
same as the value of the button. Thus only one button in the group will be
active and highlighted at any given time. On monochrome terminals,
highlighted buttons appear in reverse video; on color terminals they appear
with the foreground and background colors interchanged.

You can accomplish the same functionality with a Control List Selector
with Enter; however, you have much more flexibility in placing
Interlocked buttons on your screen.

If two or more Interlocked Push Buttons have the same control value, both
will be highlighted whenever the associated button control address
contains that value.

IMPORTANT:  The Interlocked Push Button is a retentive object. Thus,
the PanelView terminal will retain the current value for the button setting
even after the terminal has been turned off, or switched to Configuration
mode and back to Run mode. You can assign a preset value to the
Interlocked Push Button.
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There are three different Control Selectors:

 Control List Selector with Enter

 Control List Selector without Enter

 Set Bit Cursor Point (for Keypad terminals only)

These three objects allow an operator to select from a list of choices. The
current operator choice is always indicated by the the value at the selector
control address, a PLC input address.

The minimum size of a selector is 1 character.

Selectors can also be positioned so they point at other objects on the same
screen. For example, a list selector could point to an adjacent list of
numeric display objects. Values entered via the numeric keypad could be
directed (by the PLC program) to the PLC storage address of the numeric
value being displayed.

The Set Bit Cursor Point object is only available with Keypad terminals.
Set Bit Cursor Points can be positioned on the screen in a row, column, or
row and column array. The operator then uses special keys (arrow keys,
Home, Select and Cancel) to make choices.

Control List Selector Addressing

Consider each entry in the Control List Selector as a state, where state 0 is
the first entry, state ‘n’ is the last entry. Each state in the list corresponds to
a selector control address, (a PLC input address). The number of bits
required depends upon the number of states in the Selector and the data
type used. For example, if you have a List Selector with ten states, you will
need the following number of bits for the three data types listed below

 Binary: 4 bits

 BCD: 4 bits (Top Position value = 0)
8 bits (Top Position value = 1)

 Bit: 9 bits (Top Position = All Bits OFF)
       10 bits (Top Position = First Bit ON)

Control Selectors
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Top Position Value

Top Position refers to the first item in the control list. In PanelBuilder
Versions 1 and 2, when the top selector position is chosen, all bits assigned
to the object are turned off. In Versions 3, 4 and 5 you can choose the value
that will be written to the control address when the highlight bar is in the
top position.

In the Selector Control Address menu, choose Top Position Value and
choose from:

 Bit data type:

 All Bits OFF

 First Bit ON

 BCD or binary

 0

 1

When the highlight bar is in the top position, the value 1 will be written to
the control address if the top position value is set to 1 (First Bit ON). Zero
will be written if the top position value is set to 0 (All Bits OFF).

Figure 10.2
Selector Control Address with Bit Data Type

22611

Selector Control Address
Current Address Unassigned Address
Current Preset

Data Type Bit
Communications Discrete

Input/Output Input
Rack 1
Start Word 0
Start Bit 0

Number of Bits 1
Top Position Value All Bits OFF

Update Address
Change Preset
View Address Map
Delete Address

Quit

All Bits OFF
First Bit ON
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The following table indicates the state number and the required bit pattern
for each data type for 10 states.

Table 10.A
Bit Patterns for Each State if All Bits OFF: Binary, BCD and Bit Data Type

State Binary BCD Bits

0 0000 0000 000000000

1 0001 0001 000000001

2 0010 0010 000000010

3 0011 0011 000000100

. . . .

. . . .

9 1001 1001 100000000

Each of these numbers increases by 1 if “First Bit ON” or “1” is chosen for
Top Position Value.

Table 10.B
Bit Patterns for Each State if First Bit ON: Binary, BCD and Bit Data Type

State Binary BCD Bits

0 0001 0001 000000001

1 0010 0010 000000010

2 0011 0011 000000100

3 0100 0100 000001000

. . . .

. . . .

9 1010 10000 1000000000

Control List Selector with Enter

The Control List Selector with Enter object allows the operator to choose
from items in a list. As the operator presses the Up Cursor and Down
Cursor buttons, an arrow indicator moves up and down through the list,
wrapping around the top and bottom of the list. The item is not actually
selected until the Enter button is pressed; the selected item highlights in
reverse video and the PLC input is updated to reflect the new state.

The states, therefore, are not necessarily executed consecutively. Rather the
new state is determined by the position in the Selector when the Enter
button is pressed.
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The Control List Selector with Enter consists of the following components:

 List  is a vertical list that can have up to 24 different items (12 with
double sized text). The operator presses the Up Cursor or Down Cursor
buttons to move the arrow indicator up and down through the list. When
the Enter button is pressed, the line to the right of the arrow highlights
and the PLC input address is updated.

 Up Cursor (Decr Value) Button moves the arrow indicator up by one
list entry.

 Down Cursor (Incr Value) Button moves the arrow indicator down by
one list entry.

 Enter Button selects the desired option, and updates the PLC input
address.

If an address cannot accommodate the state entered, an error message is
displayed, and the PLC value is not changed. Clear the fault before
continuing.

IMPORTANT:  The Control List Selector with Enter is a retentive object.
Your PanelView terminal will retain the current value for the Control List
Selector with Enter, even after you’ve turned the terminal off, or switched
to Configuration mode. You can change the preset value of this object.

Choose List in the Object Menu to configure the selector list.

Use Move to position your object on the screen.

Choose Width to specify how many characters you can fit on a line for
each state in the list.

Choose Number of States to define the height of the list. For single height
characters, you can have up to 24 states; for double height characters you
can have up to 12 states. If you include a border around your list you will
lose two single size or one double size entry.

Use the Edit Text and Move Text items to create the list of names. The list
is strictly for your information. The movement between screens is
determined by the screen numbers you have defined for the states.

Use Border to select a border type for your list. If you include a border,
you will lose two single size or one double size entry (state).

Use Buttons in the Object Menu to configure the Up Cursor, Down Cursor
and Enter buttons. To save screen space you can disable either the Up
Cursor or the Down Cursor button (but not both). A button that has been
disabled doesn’t appear on the screen.
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Control List Selector without Enter

The Control List Selector without Enter object allows the operator to
choose from items in a list by means of Up Cursor and Down Cursor
buttons.

Unlike the Control List Selector with Enter, the selections are continually
highlighted and updated to the PLC controller. That is, as the operator
moves the cursor to each item, the item highlights and the corresponding
state value is transferred to the PLC input addressed by the Control
address.

The Control List Selector without Enter consists of the following
components:

 List—is a vertical list that can contain up to 24 different items (12 with
double size text). The operator presses the Up Cursor or Down Cursor
buttons to move through the list.

 Up Cursor (Decr Value) Button—moves the selection up by one list
entry, and updates the list position number in the PLC input address. 
(0 = the first item in the list.)

 Down Cursor (Incr Value) Button—moves the selection down by one
list entry, and updates the list position number in the PLC input address.

You can build a simple two position Control List Selector and include only
the Up Cursor button. Functionally, the result is the same as a Maintained
Push Button or a hard-wired two-position selector switch. However, you
would also have a two position list with the current selection highlighted.
You could even use Outer Text to add an extra label.

IMPORTANT:  The Control List Selector without Enter is a retentive
object. Your PanelView terminal will retain the current value for the
Control List Selector without Enter even after you have turned the terminal
off or switched to Configuration mode. The PanelBuilder Development
Software will allow you to enter a preset value for this object.

Choose List in the Object Menu to configure the selector list. The Number
of States you assign determines the height of the list. For single height
characters, you can have up to 24 states; for double height characters you
can have up to 12 states. If you include a border around your list you will
lose two single size or one double size entry. Similarly, the width you
specify for the list will determine how many characters you can fit on a
line for each state.
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Use Buttons in the Object Menu to configure the Up Cursor and Down
Cursor buttons. To save screen space you can disable either the Up Cursor
or the Down Cursor button (but not both). A button that has been disabled
doesn’t appear on the screen.

ATTENTION: Do not use the Control List Selector Without
Enter to initiate a control function.

Set Bit Cursor Points (Keypad terminals only)

The Set Bit Cursor Point object allows the operator to select from a list or
an array of objects. Associated with each Cursor Point is a unique PLC
input bit addressed by the Cursor Point Address. To use the Cursor Points,
the operator must press the Select button on the PanelView terminal
enabling the arrow and Home keys. The arrow keys are used to move to
the desired cursor point on the terminal display. The Home key moves the
cursor to the home position (the cursor position at the top left of the
screen).

The selected cursor point’s character will be highlighted and will blink; the
PLC input bit will be set to 1. To turn the Cursor Point feature off again,
and disable the keys, the operator must press the Cancel button on the
PanelView terminal.

Here’s an example of how you might use Set Bit Cursor Points. You want
to monitor all the motors on a conveyor belt. You could draw a line to
represent the belt, and then place set-bit cursor points pointing to each
motor along the belt. Then you’d program the PLC controller so that when
you display this screen on a PanelView terminal, you could cursor to the
desired motor and see its status displayed in a Local Message Display or
multi-state indicator on that screen.

IMPORTANT:  The Set Bit Cursor Point values are not changed when the
cursor point feature is cancelled. The last bit selected remains on.

Using PanelBuilder, you place successive Set Bit cursor points above,
below, or beside existing cursor points (any distance apart). Use the row
and column indicators at the top right of the monitor to make sure the
cursor points line up: there will be no warning if the cursor points don’t
line up.

IMPORTANT:  If the cursor points aren’t properly lined up, the Set Bit
cursor points may not work as expected when the application file is
downloaded to the terminal.
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When you create the screen in PanelBuilder, all cursor points are visible.
However, when you display the screen on a PanelView terminal, only one
cursor point will be visible and blinking and, on a monochrome screen, in
high intensity.

Cursor Point Default Operation

1. When a screen is selected for the first time after a download, the
PanelView terminal scans all Set Bit and Numeric Input Cursor Point
objects in the screen from left to right, top to bottom. The first Set Bit
Cursor Point object with a PLC bit set to 1 will be selected as the
active Cursor Point for that screen.

2. If none are found, the PanelView terminal selects the Cursor Point
object nearest the home position of the screen as the active cursor
point object for that screen. If this is a Set Bit Cursor Point, its PLC
bit will be set to 1.

3. All other Set Bit Cursor Point objects in the selected screen have their
PLC bits reset to 0. All other numeric cursor point objects remain
inactive.

ATTENTION: In Version 1 all other Cursor Point objects in the
current screen were not reset in certain cases—making it
possible to have more than one Cursor Point active on a screen.

4. When the screen is selected, and the Transfer Current Screen to PLC
Controller option is enabled, both the new screen number and the new
Cursor Point values will be transferred to the PLC controller in the
same PLC scan.

Retained Set Bit Cursor Point Default Operation

1. When a screen is re-selected, the active Set Bit Cursor Point object is
the Set Bit Cursor Point object active when the screen was last active.

2. The PLC bit associated with this object will be set to 1.

3. All other Set Bit Cursor Point objects in the selected screen have their
PLC bits reset to 0.
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Cursor Point Function on Power-up

On power-up the Set Bit Cursor Point operation status, Selected or
Cancelled, is retained. The active Set Bit Cursor Point object is the one
active when the screen was last displayed.

IMPORTANT:  Immediately after the downloading or the loading of a
new file from user PROMs, the operation status is selected.

ATTENTION: The Set Bit Cursor Point object should not
share addresses with objects used for control purposes. For
example, if a Set Bit Cursor Point on screen 2 is assigned to the
same address as a Normally Closed Push Button on screen 1, the
Normally Closed Push Button will open when screen 2 is
entered if the cursor point is not selected as the active point as
described earlier.

Examples: Set Bit Cursor Point Operation

1. In this example, a screen has five set bit cursor points; three in a row
at the top of the screen, and two in a row below. The first two cursor
points in each row are aligned in columns. Each cursor point uses a
unique bit address that is not shared with any other objects in the
application.

When the application is downloaded, the cursor point at the top left
corner of the screen is selected as the default and its PLC input
address is set to one. If the right arrow key is pressed, its PLC bit
address will be set to zero and the second cursor point in the same
row will be set to one.

2. In another example, the screen also has five set bit cursor points;
three in a row at the top of the screen, and two in a row below. The
last cursor point in the second row, however, uses the same address as
a set value button with a preset value of 1. In addition, the second
cursor point in the first row shares the same address with another set
value button, which is also preset to 1.
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When the application is downloaded and the screen is displayed, the
second cursor point in the first row will be selected as the active Set
Bit Cursor Point object and its associated PLC bit will be set to 1,
since it is closest to the home position. All other bits in the screen
will be reset to 0, including the address associated with the second
Set Bit Cursor Point object in the second row. When another cursor
point is selected with the Home and arrow keys, this bit will be reset
to 0 and the bit for the selected cursor point set to 1.

IMPORTANT:  Sharing Set Bit Cursor Point addresses with other objects
is not recommended in actual applications; it is only used here to explain
Cursor Point operation.

IMPORTANT:  The Set Bit Cursor Point is a retentive object. Your
PanelView terminal will retain the current value for the Set Bit Cursor
Point setting even after you’ve turned the terminal off, or switched to
Configuration mode and back to Run mode. The Set Bit Cursor Point is not
presettable.

To define the Set Bit Cursor Point Character choose Set Bit Cursor Point
from Control Selectors in the Object Add Menu. By default the Set Bit
Cursor object uses a small arrow as the cursor character. This cursor
character can be changed. If the cursor character you want to use appears
on the computer keyboard, then:

1. Choose Cursor Character.

2. Type that character and press Enter.

To use a character from the extended character set:

1. Choose Cursor Character.

2. Press and hold down a Ctrl  key combination or Alt  followed by the
character’s ASCII code on the keyboard’s keypad, then press Enter.
See Appendix E, The Extended Character Set for more information.

ATTENTION: Do not use the Set Bit Cursor Point to initiate a
control function.
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Screen selectors provide a way for an operator to move to another screen,
or to return to a previously displayed screen. Normally, every screen
should have a screen selector, so that an operator is not stranded at a
particular screen.

All screens can be coded for security. If the wrong code is entered an error
message is displayed and the screen does not change.

If the requested screen does not exist, or is corrupted, an error is displayed
and the screen does not change.

IMPORTANT:  If the PLC Controlled Screen Change is enabled and the
value at the associated PLC address is not zero, the PLC controller, not the
operator, has control over screen changes. If the operator presses a screen
selector, an error message appears.

Screen selection by the operator is not allowed when “Minimum Push
Button On Time”, “Latch Button PLC Handshakes” or “Enter Bit
Handshakes” are outstanding. An error message will be displayed and the
screen will not change.

�Go To Screen" Button

The “Go To Screen” button is used to display another screen. Once you
have added the object to your screen, choose Screen from the menu. In the
window that opens, type the number of the screen you want to go to when
the button is pressed. Then choose Quit to return to the Object menu and
your screen.

For example, a button labeled “View Current Status” could be included on
a screen. The button could be configured to go to a screen displaying the
current status. That screen would include a “Return To Previous Screen”
button, so the operator could easily return.

Another example: a button labeled “Select New Screen” could be
configured to go to a screen displaying a keypad screen selector (for Touch
Screen terminals) or a keypad screen select button (for Keypad terminals).
The operator could then select the desired screen by entering the screen
number.

�Return To Previous Screen" Button

The “Return To Previous Screen” button returns to the screen previously
displayed.

Screen Selectors
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IMPORTANT:  The PanelView terminal only remembers the last screen.
You cannot back up through a succession of screens with “Return To
Previous Screen” buttons.

If the PLC controller is controlling screen changes, the “Return To
Previous Screen” button will not take you back to the intended screen.

Screen List Selector

With a Screen List Selector, the operator presses Up Cursor and Down
Cursor buttons to scroll through a list of screen names, then presses the
Enter button to switch to a selected screen. The Screen List Selector is
similar to the Control List Selector with Enter, but it is only used to control
screen changes.

The Screen List Selector consists of the following components:

 List  is a vertical list that can contain up to 24 different items (12 with
double sized text). If you include a border around your list you will lose
two single size or one double size entry.

The operator presses the Up Cursor or Down Cursor buttons to move
the arrow indicator up and down through the list. When the Enter
button is pressed the screen is selected.

 Up Cursor button moves the arrow indicator up one entry.

 Down Cursor button moves the arrow indicator down one entry.

 Enter button selects the desired screen, and makes the screen appear.

Use Buttons in the Object Menu to configure the Up Cursor, Down Cursor
and Enter buttons in your Screen Selector. To save screen space you can
disable either the Up Cursor or the Down Cursor button (but not both). A
button that has been disabled doesn’t appear on the screen.

Choose List in the Object Menu to configure the selector list.

Use Move to position your object on the screen.

Choose Width to specify how many characters you can fit on a line for
each state in the list.

Choose Number of States to define the height of the list. For single height
characters, you can have up to 24 states; for double height characters you
can have up to 12 states.



The Objects
Chapter  10

10-20

Choose Assign Screen to State. Type in the number of the state you want to
assign. The first screen in the list is State 0, the second is state 1, etc. Press
Enter. A small window—the Assign Screen to State n window—will open.
Type in the number of the screen that you want to go to when State n is
chosen from the list. Repeat for each screen (state) on the list.

Use the Edit Text and Move Text items to create the list of screen names.
The list is strictly for your information. The movement between screens is
determined by the screen numbers you have defined for the states.

Use Border to select a border type for your list. If you include a border,
you will lose two single size or one double size entry (state).

Keypad Screen Selectors (Small and Large) 
(Touch Screen Terminals Only)

These two objects appear as numeric keypads overlaying the current
screen. They allow an operator to choose the next screen to be displayed by
entering its number.

The screen selector keypads differ only in size: the large keypad is 48
characters wide, while the small keypad is 24 characters wide. Both
keypads are 24 lines high, and both operate in the same way.
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Figure 10.3
Small Keypad Screen Selector

Enter removes this screen and
displays the screen with the
number on the scratchpad.

The Scratchpad is a three
digit numeric display

Delete deletes the most recent
entry

Number keys

Clear clears the scratchpad

ENT

9

6

87

DEL

54

321

0CLR

20334

Screen Keypad�Enable Button
(Keypad terminals only)

This button allows the operator to choose the next screen to be displayed
by entering the screen number on the terminal’s numeric keypad.

Figure 10.4
Screen Keypad�Enable Button

20336

Enter New Screen Number or press CANCEL >                            _

SCREEN
KPAD F17

A scratchpad pops up on the top three lines of the screen.  This displays the
numbers the operator types.
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The keys on the numeric keypad function as follows:

 the number keys enter numbers in the scratchpad

 Enter removes the scratchpad and displays the screen with the screen
number that was in the scratchpad

 Delete deletes the most recent entry

 Clear clears the scratchpad

 Cancel removes the scratchpad and cancels the screen change

IMPORTANT:  Operator input is disabled for a short time when the
scratchpad is displayed. This may result in a delay before the first digit can
be entered.

PanelView supports the following two types of indicators:

 Multi-State Indicator

 List Indicator

You can assign either a PLC output or input address for all indicators to
control the current state.

Multi�State Indicator

The Multi-State Indicator is a display object that allows you to display the
state of a PLC operation on the screen. You create a display area on the
screen, and then add from 2 to 16 unique states of text and attributes. The
text and attributes displayed on the PanelView terminal depends upon the
state number, that is, the value at the Indicator State Address.

The Multi-State Indicator can be used for a variety of purposes. For
example, you could make a Multi-State Indicator one character wide, to
simulate “flow” in a pipe, or to indicate the motion of an object. You could
use a two-state solid rectangle to simulate an indicator light, or add
descriptive text to the object.

This object supports binary, BCD and bit data types. The maximum
number of states is determined by the data type and the number of bits
assigned. For example, if you have a Multi-State Indicator with ten states,
0 to 9, you will need the following number of bits for the three data types
listed below:

 Binary: 4 bits

Indicators
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 BCD: 4 bits

 Bit: 9 bits; (all bits off = state 0) if more than one bit is on at a time, the
least significant bit’s state is displayed

The following table indicates the state number and the required bit pattern
for each data type:

Table 10.C
Bit Patterns for Each State: Binary, BCD and Bit Data Type

State Binary BCD Bits

0 0000 0000 000000000

1 0001 0001 000000001

2 0010 0010 000000010

3 0011 0011 000000100

. . . .

. . . .

9 1001 1001 100000000

If the value indicated by the PLC controller is not within the indicator’s
range, the colors and attributes of the highest numbered state will be
displayed but the text inside the indicator will be blanked.

List Indicator

The List Indicator is used to display the current status or state of a
particular PLC operation. The list can have up to 24 items, one of which is
highlighted to indicate that it is currently in effect. The operator can see all
the possible states for a particular operation, and see which state is current.
The List Indicator is similar to the Control List Selector, except that the
PLC controller, rather than the operator, controls the display.

The value of the object’s PLC address, the state number, and the
configuration of Top Position Value determine which entry is highlighted.
This object supports three data types, binary, BCD, and bit. Like the
Control List Selector object and the Multi-State Indicator, the maximum
number of states is determined by the data type and the number of bits
assigned. See Table 10.B for a list of valid state values for states 0 to 9. If
more than one bit is on at a time, the least significant bit’s state is
displayed.
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Top Position Value

In Versions 1 and 2 of the PanelBuilder software, the first selection in the
list, state 0, corresponds to a value of 0. In Version 3 and later you can
choose the value associated with the top position. In the Indicator State
Address menu, choose Top Position Value and choose from:

 Bit data type:

 All Bits OFF

 First Bit ON

 BCD or binary

 0

 1

When the value at the control address is 0, and the top position value is set
to 1 (First Bit ON), the highlight bar will not be visible. When the value at
the control address is 1 and the top position value is set to 1 (First Bit ON),
the first item in the list will be highlighted. If the top position value is set
to 0 (All Bits OFF) and the control address contains 0, the first item in the
list indicator will be highlighted, as in Version 2.

Figure 10.5
Indicator State Address

22612

Indicator State Address
Current Address Unassigned Address
Current Preset

Data Type BCD
Communications Discrete

Input/Output Output
Rack 1
Start Word 0
Start Bit 0

Number of Bits 2
Top Position Value 1

Update Address
Change Preset
View Address Map
Delete Address

Quit

0
1

If the value indicated by the PLC address is not within range of the
indicator, no list items will be highlighted.
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Choose List in the Object Menu to configure the list.

Use Move to position your object on the screen.

Choose Width to specify how many characters you can fit on a line for
each state in the list.

Choose Number of States to define the height of the list. For single height
characters, you can have up to 24 states; for double height characters you
can have up to 12 states. If you include a border around your list you will
lose two single size or one double size entry.

Use the Edit Text and Move Text items to create the list names. The list is
strictly for your information.

Use Border to select a border type for your list. If you include a border,
you will lose two single size or one double size entry (state).

Use Buttons in the Object Menu to configure the Up Cursor, Down Cursor
and Enter buttons. To save screen space you can disable either the Up
Cursor or the Down Cursor button (but not both). A button that has been
disabled doesn’t appear on the screen.

There are seven numeric objects:

 Set Value Button

 Increment Value Button

 Decrement Value Button

 Numeric Data Display

 Numeric Keypad-Enable Buttons (Keypad terminals only)

 Small or Large Numeric Entry Keypads (Touch Screen terminals only)

 Numeric Input Cursor Points (Keypad terminals only)

If you want to display an array of numeric values on a screen, and allow an
operator to change any of the values, refer to the section Editing an Array
of Numeric Values, later in this chapter.

Numeric objects can be divided into two groups: Input objects (which are
used for numeric entry) and Display Objects (which display numeric
values on the screen).

Numerics
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Table 10.D
Input and Display Objects

Input Objects Display Objects

Set Value Button Numeric Data Display

Increment Value Button Numeric Input Cursor Point

Decrement Value Button Scrolling List

Keypad (Touch Screen Terminals)

Keypad�Enable Button (Keypad Terminals)

Numeric Input Cursor Point

Table 10.E lists the capabilities of numeric objects, in terms of the decimal
points and negative sign—some objects can display the decimal point and
negative sign, and some cannot; some can accept the decimal point and/or
negative sign as part of the operator’s input, and some cannot.

Table 10.E
Decimal Point, Polarity Capabilities, and Data Ranges of Numeric Objects

Decimal Point Polarity Data Range

Set Value Button N N 0 - 99,999,999

Increment Value Button N N 0 - 99,999,999

Decrement Value Button N N 0 - 99,999,999

Keypad (Touch Screen
Terminals)

Y Signed Integer -32,768  - 99,999,999

Keypad�Enable Button
(Keypad Terminals)

Y Signed Integer -32,768 - 99,999,999

Numeric Input Cursor
Point

Y Signed Integer -32,768 - 99,999,999

Numeric Data Display Y Y -9,999,999 - 99,999,999

Scrolling List Y Y -9,999,999 - 99,999,999

Set Value Button

The Set Value Button is used to set a PLC input address to a specific value
(a control value) with a single button press. Use this button if there is a
typical set point value that an operator might want to revert to frequently.
You can use a Set Value Button with Numeric Data Display and the
Increment and Decrement Buttons to change and monitor a value
associated with the Set Value Button.
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The Set Value Button supports binary, BCD and signed integer data types.
This object does not support a separate sign bit, decimal point, or scaling.
The data type together with the number of bits assigned determines the
range of PLC values. However, PanelBuilder only allows the user to enter
an 8-digit positive number. The following table shows the data types and
their respective ranges:

Table 10.F
Set Value Button Data Types and Values

This data type: Supports this range of values:

Binary 0 - 65,535

BCD 0 - 99,999,999

Signed Integer 0 - 32,767

At the terminal, if the control value is too large, an error message will be
displayed; the number will not be sent to the PLC controller.

IMPORTANT:  The Set Value Button is a retentive object. Your
PanelView terminal will retain the current value for the button setting even
after you’ve turned the terminal off, or switched to Configuration mode
and back to Run mode. A preset value can be assigned to the Set Value
Button, and can be changed using PanelBuilder software.

Increment Value Button

The Increment Value Button increases the value at the assigned PLC input
address (the Button Control Address) each time the button is pressed. Use
this object to allow an operator to add a value to the current value by
pressing the button. You can set an upper limit for the PLC controller, a
positive integer, 0 to 99,999,999.

The Increment Value Button supports binary, BCD and signed integer data
types for the upper limit. This object does not support a separate sign bit or
decimal point, or scaling. Although PanelBuilder allows the user to enter a
positive 8-digit maximum value, the data type together with the number of
bits assigned determines the range of PLC values. The following table
shows the different data types and their respective ranges:
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Table 10.G
Increment Value Button Data Types and Values

This data type: Supports this range of values:

Binary 0 - 65,535

BCD 0 - 99,999,999

Signed Integer 0 - 32,767

If the value is already at, or above the maximum, the value is not changed.

Auto-Repeat

If a button is pressed for more than the time specified by the button’s
Auto-Repeat Start Delay, the value automatically increases by the amount
specified by the Amount per Increment at the rate specified by the
Auto-Repeat Rate.

 the Auto-Repeat rate may be set for 0 to 20 per second; auto-repeat is
disabled if the rate is set to 0

 the Auto-Repeat Start Delay may be set for 0.2 to 2.5 seconds

 the Amount per Increment is an integer value in a range of 1 to 10000;
the default is 1

IMPORTANT:  If you change any of the Increment Value Button default
settings (4 per second Auto-Repeat Rate, 400 msec Auto-Repeat Start
Delay and an Amount per Increment of 1), the application file will only be
compatible with Version 2 and later PanelView firmware.

Often, Increment and Decrement buttons are used together to control the
same PLC address. Since the buttons don’t display the value of the address,
a Numeric Data Display could be used to display the value at the address
as it raises or lowers.

IMPORTANT:  The Increment Value button is a retentive object. Your
PanelView terminal will retain the current PLC input address value even
after you’ve powered down the terminal or switched to Configuration
mode. Use PanelBuilder to define or change the preset value of this object.

Decrement Value Button

The Decrement Value Button decreases the value at the assigned PLC input
address each time the button is pressed. Use this object to allow an
operator to subtract a value from the current value by pressing the button.
You can set a lower limit for the PLC value, a positive integer, 0 to
99,999,999.
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The Decrement Value Button supports binary, BCD and signed integer data
types for the lower limit. This object does not support a separate sign bit or
decimal point, or scaling. Although PanelBuilder allows the user to enter a
positive 8-digit minimum value, the data type together with the number of
bits assigned determines the range of PLC values.

The following table details the different data types and their ranges:

Table 10.H
Decrement Value Button Data Types and Values

This data type: Supports this range of values:

Binary 0 - 65,535

BCD 0 - 99,999,999

Signed Integer 0 - 32,767

If the value is already at or below the minimum, the value is not changed.

Auto-Repeat

If a button is pressed for more than the time specified by the button’s
Auto-Repeat Start Delay, the value automatically decreases by the amount
specified by the Amount per Decrement at the rate specified by the
Auto-Repeat Rate.

 the Auto-Repeat rate may be set for 0 to 20 per second; auto-repeat is
disabled if the rate is set to 0

 the Auto-Repeat Start Delay may be set for 0.2 to 2.5 seconds

 the Amount per Decrement is an integer value in a range of 1 to 10000;
the default is 1

IMPORTANT:  If you change one or more of the Decrement Value Button
default settings (4 per second Auto-Repeat Rate, 400 msec Auto-Repeat
Start Delay and an Amount per Decrement of 1), the application will only
be compatible with Version 2 and later PanelView firmware.

Often, Increment and Decrement buttons are used together to control the
same PLC address. Since they don’t display the value of the address, a
Numeric Data Display could be used to display the value at the same
address.

IMPORTANT:  The Decrement Value button is a retentive object. Your
PanelView terminal will retain the current PLC input address value even
after you’ve powered down the terminal or switched to Configuration
mode. The preset value of this object can be defined and changed using
PanelBuilder.
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Numeric Data Display

The Numeric Data Display object allows the operator to monitor PLC
variables such as temperature, level and speed.

As with other display objects, you can assign a PLC output or input
address to a Numeric Data Display Displayed Value Address. If you assign
an output address, the value stored in the PLC data table is transferred to
the terminal.

If you assign a PLC input address you will probably want to use Numeric
Data Displays with other objects. For example, you could include
Increment and Decrement buttons, or a Numeric Keypad (for Touch Screen
terminals), or a Numeric Keypad Enable button (for Keypad terminals) on
the same screen as a Numeric Data Display. If you assign the same input
address to both the Numeric Display object and numeric entry objects, you
could see the new value as you change the value in the PLC controller.

IMPORTANT:  If you assign a PLC input address shared by a retentive
object, your PanelView terminal will retain the current PLC input address
value even after you’ve powered down the terminal or switched to
Configuration mode.

The Numeric Data Display object supports two types of numeric displays,
Standard and Scaled. Choose Standard to display “raw” PLC values.

Standard Numeric Data Display

The Standard Numeric Data Display has two display options, a decimal
point position and a polarity indicator (the negative sign). Several more
choices arise from these two options. The following table shows the
breakdown of formatting options, and the addressing limits for each option.

Table 10.I
Standard Numeric Data Display Formatting and Addressing Options
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Display Formatting

When fewer digits than the maximum are to be displayed, the left portion
of the display must be filled with either blank spaces or zeroes. You can
choose either spaces or zeroes by choosing Fill Left With.

If the value cannot be displayed within the number of digits specified for
the object, a string of asterisks (*) is displayed instead.

Displays with Decimal Point

The position of the decimal point can be fixed or PLC controlled.

To create a fixed decimal position, you select the number of digits that will
be displayed to the right of the decimal point. The number can be 1 to 7
(the default is 1).

To create a PLC controlled decimal point, you must assign a Decimal Point
Position Address, a PLC input or output address. This three-bit binary code
indicates the number of digits to the right of the decimal. For example, a
value of zero (000 binary) means that there will be no digits displayed after
the decimal point (and the decimal itself will not be displayed); a value of
three (011 binary) means there will be three digits to the right of the
decimal point; a value of seven (111 binary) means that seven digits will be
displayed to the right of the decimal point. The remaining bits in the word
address can be assigned to other functions.

Use a PLC input address if you want to control the decimal position from
the terminal using other input objects. If you want the PLC controller to
dynamically change the decimal position, assign a PLC output address for
the decimal point. No PLC address is needed if the decimal position is
fixed.

With a decimal point but no polarity bit, this object can display 2 to 8
digits (the default is 6). The maximum PLC value depends upon the data
type and number of bits assigned to the Displayed Value Address.
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If you are displaying a number with a decimal point, the decimal point
occupies the space of one digit. For example, if you want to display a
fractional number and you specify eight digits, the Numeric Data Display
will show seven numeric digits, plus the decimal point.

Displays with Polarity

Enabling polarity extends the range of values that can be displayed. There
is only an implied relationship between the numeric value and the minus
sign. If the bit at the Polarity Address is 0, the minus sign is not displayed;
if the bit at the Polarity Address is 1, then the minus sign is displayed.

If the object is configured with just the polarity bit, 2 to 8 digits can be
configured (the default is 6), depending upon the field size. If both the
decimal point and polarity point are used, from 3 to 8 digits are allowed
(the default is 7).

If you are displaying negative numbers, the minus sign occupies the space
of one digit. For example, if you want to display a negative fractional
number and you specify eight digits, the Numeric Data Display will show
six numeric digits plus the minus sign and the decimal point.

There are two ways to display negative values—one uses “No Polarity”
and the “Signed Integer” data type. This automatically inserts the minus
sign when the signed integer bit value is negative. The other way is to
select “Polarity”.

Scaled Numeric Data Display

The Numeric Data Display object supports two types of numeric displays,
Standard and Scaled. Choose Scaled if you want to scale the PLC value
(for example, convert the raw PLC value into meaningful engineering units
such as gallons, inches, PSI, or inches per second).

Table 10.J
Scaled Numeric Data Display Formatting and Addressing Options
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You have the choice of displaying the value with a decimal point, or
rounding off the scaled value to the nearest whole number. For scaling,
PanelView uses the formula:

Displayed value = Mx + b

 M is the scaling factor

 x is the value in the associated PLC address. The PLC address must
contain data in the BCD, binary or signed integer data format

 b is the offset

Example: Scaling Formula

The range of values in the assigned PLC Address is from 0 to 4095. This
range was determined by the specific type of analog input module being
used. The actual range in engineering units is 0 to 700 gallons per minute.
This range was determined by the measuring device providing the signal to
the analog input module (for example, the flow meter).

Based on the above information, you would assign the following:

M = 700/4095 = 0.171

b = 0

If the PLC value was 3,000, the display would be:

Displayed  Value = Mx + b

= (0.171 * 3000) + 0

= 512.821 (513 rounded)

When fewer digits are displayed, the left portion of the display must be
filled with either blank spaces or zeroes. You can choose either spaces or
zeroes by choosing Fill Left With.

If the value cannot be displayed within the number of digits specified for
the object, a string of asterisks (*) is displayed instead.
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Numeric Keypad�Enable Button (Keypad Terminals only)

The Numeric Keypad-Enable Button object calls up the Numeric Keypad
window, which is used to enter a numeric value. While the Numeric
Keypad is on screen, the Cancel key, numerics, backspace, decimal point,
sign and Home/Arrow keys (if cursor points have been selected on the
screen) will remain active. All other keys and buttons are disabled.

The Numeric Keypad clears when:

 the Cancel key is pressed

 the screen changes

 the operator cursors to a numeric input cursor point

IMPORTANT:  Operator input is disabled for a short time when the
keypad is displayed. This may result in a delay before the first digit can be
entered.

Table 10.K
Numeric Keypad�Enable Button Formatting and Addressing Options
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0 - 7

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Scratchpad
Operation

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Retain after ENTER
Remove after ENTER

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

#Enter Key Control
Address

ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

Bit
ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

0 - 1

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

#Enter Key
Handshake
Address

ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

Bit ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

0 - 1

*only useful with Decimal Key Controlled and PLC Controlled formats - not necessary otherwise
#optional

A maximum of 8 digits can be displayed in the Numeric Keypad window;
the decimal point and minus sign use one digit each. The data type together
with the number of bits assigned to the Keypad Control Address, a PLC
input address, determine the range of PLC values.

If the data type is a signed integer, the minus key on the terminal’s keypad
is functional. The minus key will toggle the polarity if there are no digits in
the scratchpad.

The Scratchpad Operation option allows you to decide if the numeric
data entry scratchpad is removed or retained after the ENTER key is
pressed.
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IMPORTANT:  The Numeric Keypad scratchpad occupies the top three
lines of the screen. Keep this in mind before you place any objects on these
lines.

To provide feedback to the operator, the Numeric Keypad-Enable button
can be configured with two states, 0 and 1. If you assign text and attributes
to state 0 only, the border on the button will highlight when you press the
button; the button itself will remained unchanged. If you assign different
attributes and text to states 0 and 1, then the button will immediately
change to state 1 when you press the button.

Configure the Enter key with a handshake so the PLC controller can
acknowledge that a value has been received from the terminal. Define two
PLC addresses: the Enter Key Control address and the Enter Key
Handshake address. When the operator presses the Enter key to send the
value to the PLC controller, the terminal sets the Enter Key Control
address to 1 (after a 400 msec. delay). Put a line in your PLC program to
turn on the bit at the Enter Key Handshake address, to inform the terminal
that the handshake has been received. When the terminal sees this bit on, it
turns off the Enter Key Control bit.

If the terminal does not receive acknowledgement (transition from 0 to 1)
within 5 seconds, (or the Enter Key Handshake is unassigned), it displays
an error message in the Fault Window and resets the Enter bit. If the Enter
Key Handshake is unassigned, the Enter bit will remain set for the duration
of the button hold time or for as long as the button is pressed, whichever is
longer.

IMPORTANT:  All function keys are disabled while the terminal is
waiting for handshake acknowledgement.

Decimal Point Format

To allow an operator to enter numbers with decimal points, choose Format
from the Object menu. The menu item Decimal Point will be highlighted.
Press Enter and choose from one of the following:

 Disabled specifies no values with decimal points can be entered through
the Numeric Keypad

 Fixed Position specifies a set number of digits to be displayed after the
decimal point in the window. For example, if the setting was for three
digits after the decimal, an operator’s entry would appear as follows:
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Table 10.L
Fixed Position Decimal Point

Digits Entered Keypad Control Address
Value

Number Displayed

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

1
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

100
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

.1
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

12
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

120
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

.12
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

123
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

123
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

.123
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

1234
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

1234
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

1.234
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

12345
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

12345
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

12.345

 PLC Controlled allows the PLC controller to set the number of digits
to be displayed after the decimal point.

If you choose the PLC controlled decimal point, assign a Decimal Point
Position Address, a PLC input or output address. This three-bit binary
code indicates the number of digits to the right of the decimal.

For example, a value of zero (000 binary) means that there will be no
digits displayed after the decimal point (and the decimal itself will not
be displayed); a value of three (011 binary) means there will be three
digits to the right of the decimal point; a value of seven (111 binary)
means that seven digits will be displayed to the right of the decimal
point. The remaining bits in the word address can be assigned to other
functions.

 Decimal Key Controlled allows the operator to enter the number and
decimal point. The terminal interprets the decimal point position in the
window and sets the Decimal Point Position Address to that value.

Table 10.M
Decimal Key Controlled Decimal Position

Digits Entered Keypad Control
Address Value

Decimal Point
Position Address
Value

Number Displayed

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

123 ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

123 ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

0 ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

123

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

1.23 ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

123 ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

2 ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

1.23

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

.12345 ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

12345 ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

5 ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

.12345

To send a decimal point value to the PLC controller, define a Decimal
Point Position Address. In this case, only a PLC input can be used. The
three-bit value stored at this address determines the number of digits to
the right of the decimal point. The relationship between the number and
decimal point is implied; the number sent to the PLC controller does not
contain a decimal point.
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IMPORTANT:  The Numeric Keypad Enable Buttons are retentive
objects. Your PanelView terminal will retain the current value of Numeric
Keypad Enable Buttons even after you’ve turned the terminal off, or
switched to Configuration mode. This is true for both the Keypad Control
Address and the Decimal Point Position Address. Presets can be defined
for both.

Small or Large Numeric Entry Keypads 
(Touch Screen terminals only)

The Small or Large Numeric Entry Keypads enable an operator to send
numeric data to the PLC controller from a Touch Screen terminal.

The two keypads differ only in size: the large keypad is 48 characters wide;
the small keypad is only 24 characters wide. Both keypads are 24 lines
high, and both keypads operate in exactly the same way

Table 10.N
Numeric Entry Keypads Formatting and Addressing Options

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Format Options ÁÁÁÁÁ
ÁÁÁÁÁ

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Address Options ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Data Types ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Data Range

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Decimal Point ÁÁÁÁÁ
ÁÁÁÁÁ

Disabled ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Keypad Control ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Binary ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

0 - 65,535

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

ÁÁÁÁÁ
ÁÁÁÁÁ

Fixed Position ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

No. of digits after decimal pt.ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Address ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

BCD ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

0 - 99,999,999

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

ÁÁÁÁÁ
ÁÁÁÁÁ

PLC Controlled ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Signed Integer ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

-32,768 - +32,767

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

Decimal Key
Controlled

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

*Decimal Point Position
Address

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Binary ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

0 - 7

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

#Enter Key Control
Address ÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁ

Bit ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

0 - 1

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

#Enter Key Handshake
Address

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Bit ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

0 - 1

*only useful with Decimal Key Controlled and PLC Controlled formats - not necessary otherwise
#optional

Both keypads include Digit keys, Enter, Delete, Clear, the decimal point (if
decimal point operation is enabled) and the minus sign (if the keypad’s
data type is Signed Integer).

A maximum of 8 digits are displayed in the keypad’s scratchpad; the
decimal point and minus sign use one digit each. The data type, together
with the number of bits assigned to the Keypad Control Address and a PLC
input, determine the range of PLC values.
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Configure the Enter key with a handshake so the PLC controller can
acknowledge that a value has been received from the terminal. Define two
PLC addresses: the Enter Key Control address and the Enter Key
Handshake address. When the operator presses the Enter key to send the
value to the PLC controller, the terminal sets the Enter Key Control
address to 1 (after a 400 msec. delay). You must have a line in your PLC
program to turn on the bit at the Enter Key Handshake address, to inform
the terminal that the Enter Key bit has been received. When the terminal
sees this bit on, it turns off the Enter Key Control bit.

If the terminal does not receive acknowledgement (transition from 0 to 1)
within 4 seconds, (or the Enter Key Handshake is unassigned), it displays
an error message in the Fault Window and resets the Enter bit. If the Enter
Key Handshake is unassigned, the Enter bit will remain set for the duration
of the button hold time or for as long as the button is pressed, whichever is
longer.

IMPORTANT:  All touch screen input is disabled while the terminal is
waiting for handshake acknowledgement.

Decimal Formatting

To allow an operator to enter numbers with decimal points, choose Format
from the Object menu. The menu item Decimal Point will be highlighted.
Press Enter to open the list of choices for Decimal Point entry and choose
one of the following:

 Fixed Position specifies a set number of digits to be displayed after the
decimal point in the window. For example, if the setting was for three
digits after the decimal, an operator’s entry would appear as follows:

Table 10.O
Fixed Position Decimal Point

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Digits Entered ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

Keypad Control Address Value ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Number Displayed

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

1 ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

100 ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

.1

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

12 ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

120 ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

.12

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

123 ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

123 ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

.123

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

1234 ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

1234 ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

1.234

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

12345 ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

12345 ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

12.345

 PLC Controlled allows the PLC controller to set the number of digits
to be displayed after the decimal point.
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If you choose the PLC controlled decimal point, you must assign a
Decimal Point Position Address, a PLC input or output address. This
three-bit binary code indicates the number of digits to the right of the
decimal.

For example, a value of zero (000 binary) means that there will be no
digits displayed after the decimal point (and the decimal itself will not
be displayed); a value of three (011 binary) means there will be three
digits to the right of the decimal point; a value of seven (111 binary)
means that seven digits will be displayed to the right of the decimal
point. The remaining bits in the word address can be assigned to other
functions.

 Decimal Key Controlled allows the operator to enter the number and
decimal point. The terminal interprets the decimal point position in the
window and sets the Decimal Point Position Address to that value.

Table 10.P
Decimal Key Controlled Decimal Position

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Digits Entered ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Keypad Value to the
PLC controller

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Decimal Position to
the PLC controller

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Number Displayed

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ123

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ123

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ0

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ123ÁÁÁÁÁÁ

ÁÁÁÁÁÁ1.23
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ123

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ2

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ1.23ÁÁÁÁÁÁ

ÁÁÁÁÁÁ.12345
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ12345

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ5

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ.12345

To send a decimal point value to the PLC controller, define a Decimal
Point Position Address. In this case, only a PLC input can be used. The
three-bit value stored at this address determines the number of digits to
the right of the decimal point. Thus, the relationship between the
number and decimal point is implied; the number sent to the PLC
controller does not contain a decimal point.

When the Enter Key Control Address and the Enter Key Handshake
Address are assigned for Numeric Entry Keypads, the application file
created will only be compatible with Version 2 and later firmware.

IMPORTANT:  The Numeric Entry Keypads are retentive objects. Your
PanelView terminal will retain the current value of Numeric Entry
Keypads even after you’ve turned the terminal off, or switched to
Configuration mode. This is true for both the Keypad Control Address and
the Decimal Point Position Address. Presets can be set for both.
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Numeric Input Cursor Point (Keypad Terminals Only)

The Numeric Input Cursor Point object allows the operator to select from
an array of numbers. Each Numeric Cursor Point has an associated PLC
input address, the Keypad Control Address, in which the value is
communicated to the PLC.

To use the Numeric Input Cursor Point, the operator must press the Select
button on the PanelView terminal, enabling the arrow and Home keys.
These keys are used to move to the desired cursor point on the terminal
display. The selected cursor point’s character will be highlighted. To turn
the Numeric Input Cursor Point feature off and disable the keys, the
operator must press the Cancel button on the PanelView terminal. No
operator screen requests can be made if the keypad is active.

When a Numeric Input Cursor Point is selected, the numeric entry window
(scratchpad) prompt “Enter New Value or Press Cancel”  appears on the top
of the display. The operator then uses the numeric keypad keys to type the
new value into the window, and presses the terminal’s Enter key to send
the value to the Keypad Control Address.

If you use the Raise or Lower buttons without entering anything in the
window, the displayed value will change and the changed value will be
sent directly to the PLC controller without the Enter key being pressed.
The Raise and Lower buttons are disabled as soon as you enter a digit into
the numeric entry window, and they remain disabled until the value in the
window has been entered or cleared.

A maximum of 8 digits can be entered in the window (default is 5). When
the Enter key is pressed, the value is validated. If the value entered is
valid, the window is cleared; the new value is sent to the PLC controller,
and the previously displayed value for the selected Numeric Cursor Point
is updated. If the value is invalid, an error message is displayed. The value
remains in the window and is not sent to the PLC controller. The operator
must clear the error message from the display.

An upper and lower limit can be assigned to the Numeric Input Cursor
Point. These limits will apply whether the value is entered via the Enter
key or via the Raise and Lower buttons.

The Numeric Input Cursor Point value can be left-filled with blanks or
zeroes; outside text such as units of measure can also be added.

Using PanelBuilder, place successive Numeric Cursor Points any distance
above, below, or beside existing cursor points. Use the row and column
indicators at the top right of the monitor to make sure the Cursor Points
line up: you will not see a warning if the Cursor Points don’t line up.
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IMPORTANT:  If the Numeric Input Cursor Points aren’t properly lined
up, they may not work as expected when the application file is downloaded
to the terminal.

When you create the screen, you’ll be able to see all the cursor point
characters. However, when you display the screen on a PanelView
terminal, only one cursor point character will be displayed blinking and
intense.

IMPORTANT:  The numeric entry window occupies the top three lines of
the screen. Keep this in mind before you place any objects on these lines.

IMPORTANT:  The Numeric Input Cursor Point is a retentive object.
Your PanelView terminal will retain the current value for each of the
Cursor Points even after you’ve powered down the terminal or switch from
Run mode to Configuration mode and back. PanelBuilder allows you to set
a preset value for this object.

Format

Choose Format from the Object menu after adding a Numeric Input Cursor
Point to your screen; a menu with two choices opens:

 Numeric Input  brings up a menu allowing you to choose a Decimal
Point format for your numeric inputs. If you choose anything other than
Disabled, you can specify decimal values for the Maximum Value,
Minimum Value and Amount per Increment/Decrement options.

To allow an operator to enter numbers with decimal points, choose from
one of the following:

 Fixed Position—Specifies a set number of digits to be displayed
after the decimal point in the window. For example, if the setting
was for three digits after the decimal, an operator’s entry would
appear as follows:

Table 10.Q
Fixed Position Decimal Point

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Digits Entered ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Numeric Input Address
Value

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Number Displayed

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

1 ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

100 ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

.1

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

12 ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

120 ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

.12

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

123 ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

123 ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

.123

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

1234 ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

1234 ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

1.234

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

12345 ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

12345 ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

12.345
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 PLC Controlled—Allows the PLC controller to set the number of
digits to be displayed after the decimal point.

For example, a value of zero (000 binary) means that there will be
no digits displayed after the decimal point (and the decimal itself
will not be displayed); a value of three (011 binary) means there
will be three digits to the right of the decimal point; a value of
seven (111 binary) means that seven digits will be displayed to the
right of the decimal point. The remaining bits in the word address
can be assigned to other functions.

If you choose the PLC controlled decimal point, you will have to
choose Address in the Object menu to assign a PLC input or output
address as a Decimal Point Position Address. This three-bit binary
code indicates the number of digits to the right of the decimal. For
further details, see the section on Address that follows this section,
Format.

 Decimal Key Controlled—Allows the operator to enter the
number and decimal point. The terminal interprets the decimal
point position in the window and sets the Decimal Point Position
Address to that value.

To send a decimal point value to the PLC controller, define a
Decimal Point Position Address. In this case, only a PLC input can
be used. The three-bit value stored at this address determines the
number of digits to the right of the decimal point. The relationship
between the number and decimal point is implied; the number sent
to the PLC controller does not contain a decimal point.

Table 10.R
Decimal Key Controlled Decimal Position

ÁÁÁÁÁ
ÁÁÁÁÁ

Digits Entered ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Keypad Value to the
PLC

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Decimal Position to
the PLC controller

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Number Displayed

ÁÁÁÁÁ
ÁÁÁÁÁ

123
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

123
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

0
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

123
ÁÁÁÁÁ
ÁÁÁÁÁ

1.23
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

123
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

2
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

1.23
ÁÁÁÁÁ
ÁÁÁÁÁ

.12345
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

12345
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

5
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

.12345

 Display brings up a menu with the following choices:

 Number of Digits—Choose a number from 1 to 8. The default is
5.

 Fill Left With —Choose Spaces (_) or Zeroes (0) from the list.
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 Decimal Point—If Decimal Point is Enabled, the decimal point
can be in Fixed Position or PLC Controlled. There is no Decimal
Key Controlled option, because the displayed value always comes
from the PLC controller, never directly from the keypad. Other
than that, this option is the same as the Numeric Input option of
the same name (see above).

Use a PLC input address if you want to control the decimal
position from the terminal using other input objects. If you want
the PLC controller to dynamically change the decimal position,
assign a PLC output address for the decimal point. No PLC
address is needed if the decimal position is fixed.

With a decimal point but no polarity bit, this object can display 2
to 7 digits. The default is 5. (If you want more than the default,
you must configure more in the Move & Size menu.) The
maximum PLC value depends upon the data type and number of
bits assigned to the Displayed Value Address.

If you are displaying a number with a decimal point, the decimal
point occupies the space of one digit. For example, if you want to
display a fractional number and you specify eight digits, the
Numeric Data Display will show seven numeric digits, plus the
decimal point.

Address

Each Numeric Input Cursor Point has:

 a Keypad Numeric Input Address: an associated PLC input address in
which the value is communicated to the PLC controller

 a Displayed Value address: an associated PLC address whose value is
displayed

 an optional Decimal Point Position Address: a PLC input or output
address, indicating the number of digits to the right of the decimal

 an optional Enter Key Control Address

 an optional Enter Key Handshake address

If no addresses are assigned to the optional parameters, the Numeric Input
Cursor Point will have no decimal point or Enter key control/handshake.

When you choose Address from the Object menu after adding a Numeric
Input Cursor Point to your display, the Address window opens. There are
two choices in the window, Numeric Input and Display.
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 Numeric Input  configures the way numbers are entered into the
Numeric Input Cursor Point from the keypad, and sent to the PLC
controller. The Numeric Input address menu has the following items:

 Auto-Repeat Rate (per Sec.)—Enter a time number between 0
and 20. If you use the Raise and Lower buttons for editing values
in Numeric Input Cursor Points, this number specifies how many
times per second the values will change when the Raise or Lower
button is held down. The default is 0 times per second.

 Auto-Repeat Start Delay—Choose a time value from the list (200
milliseconds to 2.5 seconds). If the Raise or Lower button is held
down, this is the length of time before the value in the Numeric
Input Cursor Point will start to change. The default is 400 msec.

 Amount per Increment/Decrement—This value is the amount
the value in the Numeric Input Cursor point will change each time
the Raise or Lower button is pressed. The default is 1.

Range with Decimal Point Enabled Range with Decimal Point Disabled

0.0000001 to 10,000 1 to 10,000

If the Raise or Lower button is pressed for more than the time
specified by the button’s Auto-Repeat Start Delay, the value
automatically increases by the amount specified by the Amount
per Increment/Decrement at the rate specified by the Auto-Repeat
Rate. Auto-repeat is disabled if the rate is set to 0.

 Maximum Value—99,999,999 is the largest value that can be
entered in the Numeric Input Cursor Point. The default is
99,999,999.

Range with Decimal Point Enabled Range with Decimal Point Disabled

0.0000001 to  99,999,999 1 to 99,999,999

 Minimum Value—99,999,998 is the highest value that can be
entered in the Numeric Input Cursor Point. The default is 0.

Range with Decimal Point Enabled Range with Decimal Point Disabled

0.0000000 to 99,999,998 0 to 99,999,998

IMPORTANT:  If you change any of the above Numeric Input Cursor
Point default settings, the application will only be compatible with Version
2 or later PanelView firmware. If you configure a decimal point for your
Minimum and Maximum values, the application will only be compatible
with Version 4 and later firmware.
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 Keypad Numeric Input Address—opens an address definition
window.

Data Type can be binary, BCD or signed integer data. The ranges
are:

 Binary: 0 – 65,535

 BCD 0 – 99,999,999

 Signed Integer –32,768 – +32,767

IMPORTANT:  Negative integers are only supported for version 1
compatibility level Numeric Input Cursor Points.

 Decimal Point Position Address—opens an address definition
window.

This option is linked with the Format option in the Object menu. If
you chose PLC Controlled as the decimal point format for your
Numeric Input under Format, you must assign a Decimal Point
Position Address, a PLC input or output address. This three-bit
binary code indicates the number of digits to the right of the
decimal.

 Enter Key Control Address

This address is linked to the Enter Key Handshake Address. They
are both described under Enter Key Handshake Address, below.

 Enter Key Handshake Address

You can configure the Enter key with a handshake so the PLC
controller can acknowledge a value received from the terminal. To
do this, you must define two PLC addresses: the Enter Key Control
address and the Enter Key Handshake address.

When the operator presses the Enter key to send the value to the
PLC controller, the terminal sets the Enter Key Control address to
1 (after a 400 msec. delay).

Program your PLC to turn on the bit at the Enter Key Handshake
address, to inform the terminal that the handshake has been
received. When the terminal sees this bit on (receives
acknowledgement), it turns off the Enter Key Control bit.
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If the PanelView terminal does not receive acknowledgement
(transition from 0 to 1) within 4 seconds, it displays a Minor Fault
message in the Fault Window and resets the Enter bit. If the Enter
Key Handshake is unassigned, the Enter bit will remain set for as
long as the button is pressed or for the duration of the button hold
time, whichever is longer.

IMPORTANT:  When the Raise or Lower button is pressed, PanelView
sets the Enter Key Control bit (after a 400 ms delay) and ignores the Enter
Key Handshake bit. After the button is released, PanelView delays 400 ms
and then monitors the Enter Key Handshake bit for a false to true
transition. If the Enter Key Handshake bit is already set to 1 when the
Raise or Lower Button is released, the minor fault will occur if the bit does
not make another transition within 4 seconds.

IMPORTANT:  All function keys are disabled while the terminal is
waiting for handshake acknowledgement.

 Display opens a menu with two items:

 Displayed Value Address—opens an address definition window.

If you have not defined the Enter Key Control and Enter Key
Handshake addresses, you can enter the same input address
assigned to the Keypad Numeric Input. Whatever value appears in
that address will be displayed.

If you are using the Enter Key Control And Enter Key Handshake
addresses, you must assign an output address to have the value
transferred to the terminal and displayed in the Numeric Input
Cursor Point. Program your PLC to read the value at the Keypad
Numeric Input Address and copy it to the Displayed Value
Address.

 Decimal Point Position Address—this option is linked to the
Format option in the Object menu. If you chose PLC Controlled as
the decimal point format for your Numeric Input under Format,
you must assign a Decimal Point Position Address, a PLC input or
output address. This three-bit binary code indicates the number of
digits to the right of the decimal.

Program your PLC to transfer the value from the Decimal Point
Position Address assigned to the Numeric Input into the address
assigned here.
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To Define the Numeric Input Cursor Point Character

1. Choose Numeric Input Cursor Point from Numerics in the Add menu
to place the object on the screen. By default, the Numeric Cursor
Point object uses a small arrow as the cursor character. This character
can be changed. If you want to use one of the characters on the
keyboard for the cursor point character, choose Cursor from the
Object menu.

2. Type the character of your choice and press Enter.

If the character is not available on the keyboard, then:

1. Choose Cursor Character

2. Press and hold down a Ctrl key combination or Alt and the
character’s ASCII code, then press Enter. See Appendix E, The
Extended Character Set for more information.

Editing an Array of Numeric Values

The following examples show different ways of displaying several numeric
values on a screen and allowing an operator to change any of them.

Example 1 (for Keypad terminals)

Figure 10.6
Example 1

20385

� NNN.N � NNN.N

� NNN.N � NNN.N

ENTER
VALUE

Keypad Enable Button
DI11/0-17 - Keypad Control Address
DI10/1 - Enter Key Control Address

Numeric Data Display
DO10/0-17

Set Bit Cursor Point
DI10/0
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In this example, numeric values are entered using a numeric Keypad
Enable Button. Numeric Data Displays are used to display values in the
PLC controller (they are assigned output addresses). Set Bit Cursor Point
objects are placed next to each Numeric Data Display to provide a means
of selecting which value to change.

The following PLC-5/15 rung shows how the data can be read into the
PLC controller and transferred to the corresponding Numeric Data Display.

Figure 10.7
Ladder Logic Rung for Example 1

20383

MOV

MOVE
SOURCE: I:011
DEST: O:010

Enter Bit
I:010
]    [

I:010
]    [

0 1

To select the value to change, press the SELECT button on the PanelView
terminal to enable the Set Bit Cursor Point object. Use the arrow keys to
select the value. Then press the Numeric Keypad Enable button and enter
the new value.

Example 2 (for Keypad terminals)

Figure 10.8
Example 2

20386

� NNN.N � NNN.N

� NNN.N � NNN.N

Numeric Input Cursor Point
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In this example, Numeric Cursor Point objects are used to change an array
of values.

To select which value to change, press the SELECT button on the
PanelView terminal to enable the Numeric Input Cursor Points and to open
the scratchpad at the top of the screen. Use the arrow keys to select the
value to change, then use the Numeric Keypad to enter the data into the
window. Use the Enter key to send the data to the PLC controller.

Example 3 (for Touch Screen terminals)

Figure 10.9
Example 3

20387

ENT

9

6

87

DEL

54

321

	0CLR

� NNN.N � NNN.N

� NNN.N � NNN.N

Keypad Enable Button
DI11/0-17 - Keypad Control Address
DI10/1 - Enter Key Control Address

Numeric Data Display
DO10/0-17

Interlocked
Pushbutton

DI10/0

In this example, all numeric values are entered using one numeric keypad.
Numeric Data displays are used to display the values in the PLC controller
(assigned output addresses). Interlocked Push Buttons are placed next to
each Numeric Data Display to provide a means of selecting which value is
to change.
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The following PLC-5/15 rung shows how the data can be read into the
PLC controller and transferred to the corresponding Numeric Data Display.

Figure 10.10
Ladder Logic for Example 3

20383

MOV

MOVE
SOURCE: I:011
DEST: O:010

Enter Bit
I:010
]    [

I:010
]    [

0 1

To select which value to change, press the Interlocked Push Button beside
the value, and use the Numeric Keypad to enter the new value.

Text/Draw text and graphics objects are used for illustrating or labeling
screens. They are not associated with PLC or terminal functions, so there
are no data types or I/O addresses associated with them.

There are four Text/Draw objects.

Text

Text/Draw text is used for labels or titles which are independent of other
objects on the screen.

Do not confuse background text with object text. Object text, such as a
button’s label or the text in a list selector, is part of the object—if you
move the object, the text moves with it. Object text is added when you are
editing the object, whereas background text is an object on its own.

Line

Vertical and Horizontal Lines

Lines can be used for emphasis, to divide the screen, connect symbols, or
to represent physical devices like pipes or conveyors. You can draw
straight lines, polylines, boxes or polygons.

Text/Draw
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To draw a line:

1. Choose Text/Draw from the list of objects, and then Line.

2. Choose Move & Edit.

When you choose Edit, the menu across the top of the monitor changes.
With this menu, you can:

 Draw the line. Use the arrow keys on the computer keyboard to draw
the lines. If you intersect part of the line, the appropriate connector or
corner is drawn. If a straight line is drawn over a diagonal line, the
straight line character will replace the diagonal line character. To choose
Draw, press D. Draw will be highlighted in the menu.

 Erase part of an existing line. Use the arrow keys to move the cursor
along the line. The line will only be erased when the cursor follows
along the line; not when the cursor simply crosses it. To choose Erase,
press E. Erase will be highlighted in the menu.

 Relocate the cursor on the screen without drawing a line. To choose
Relocate, press R. Relocate will be highlighted in the menu.

In Draw mode, you can add special characters to your line:

 Arrows places an arrow head on the line. To add an arrow head to
vertical and horizontal lines, press A. Choose the arrow head from the
Arrows menu.

 Connector Characters connect a line to one of the 32 ISA Symbols.
Lines are drawn through the center of the character cell while the
connectors for the ISA Symbols may be at one edge of the character
cell. The connectors allow the line to meet up perfectly with the ISA
Symbol. To add a connector to a Line, press C. The Connector
Characters menu will open.

Diagonal Lines

Diagonal lines are selected with the same menu options as other lines, but
they are drawn with the Home, Pg Up, Pg Dn, and End keys (rather than
the arrow keys).

Don’t try to draw diagonal lines with a mouse. You will only create a
staircase line of vertical and horizontal line segments.
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Diagonal lines may intersect with other diagonal lines or with vertical or
horizontal lines. On the PanelView terminal, the diagonal lines are drawn
with the PanelView character set. The lines are drawn from one corner of
the character to the other (so they are not exactly 45 degrees). Where lines
overlap, special connector characters automatically replace the diagonal
lines.

The PanelBuilder character set cannot show overlapping diagonal lines, so
the crossing points are represented by characters from the IBM character
set, as shown in the following table.

Table 10.S
Diagonal Lines and Line Crossings on the PanelBuilder Screen

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Character ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Example

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

\  / ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

diagonal lines ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

\     /
 \  /ÁÁÁÁÁÁ

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

v
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

2�line intersection (up)
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

\  /
 v

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

^ ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

2�line intersection (down) ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

 ^
/ \

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

> ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

2�line intersection (left) ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

\   
 > 
/

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

< ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

2�line intersection (right) ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

 /
< 
 \

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

b
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

3�line intersection (left & down)
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

\
 b 
/ \

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

d ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

3�line intersection (right & down) ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

  /
 d 
/ \

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

p ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

3�line intersection (left & up) ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

\  /
 p 
/

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

q
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

3�line intersection (right & up)
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

\  /
 q 
  \

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

x ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁ

4�line intersection ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

\  /
 x 
/ \

Diagonal lines are only compatible with Version 2 or later firmware.
However, if you delete or erase all diagonal characters and no other
Version 2 features are enabled, the application file will be compatible with
Version 1 PanelView firmware. For more information on version control
see Chapter 2, Installing PanelBuilder.
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Box

Boxes can be used to emphasize text or any other object. You can set the
size and position of boxes using the arrow keys on the computer keyboard.

To create a box:

1. Choose Text/Draw from the list of object types, then choose Box from
the Text/Draw menu.

2. Choose Move & Size to:

a. define the Size of the box

b. move the box into position

3. Choose Look to:

a. determine whether the box will Blink

b. define the Foreground Color and Background Color for the box

c. have the (monochrome) box appear in Reverse Video

d. have the (monochrome) box appear in High Intensity

e. change the Border used to define the box

Arc

Arcs are quarter circles, which can be used to draw full circles, quarter,
half, or three-quarter circles. Arcs can also be used to create rounded
corners on line drawings.

Each arc segment must be separately enabled. With all four segments
enabled, the object will be a circle; with the top-left and bottom-left
segments enabled, the object will be the left half of a circle. The segments
are enabled in the Arc’s Look menu.

There are four sizes of arc. Since the PanelBuilder screen does not show
graphics, a character representation is displayed so you can design your
screens. On the PanelView terminal you see true arcs and circles.
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Table 10.T
Arc Size and Screen Representation

ÁÁÁÁ
ÁÁÁÁ

Arc Size ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

PanelBuilder Screen RepresentationÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Character Size of ArcÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Character Size of Full Circle

ÁÁÁÁ
ÁÁÁÁ

smallest ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

(– ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

2 wide 1 high ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

4 wide 2 high

ÁÁÁÁ
ÁÁÁÁ

small ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

..——

./..
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

4 wide 2 high ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

8 wide 4 high

ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ

large
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

 _——
(.

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

4 wide 2 high
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

8 wide 4  high

ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ

largest ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

  ..————
  ./    
../.
./..

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

8 wide 4 high ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

16 wide 8 high

The small and large arcs take the same number of character cells; the arcs
that they create are different sizes, but fit within the same cell boundaries.

Figure 10.11
Arcs as Displayed on the PanelView Screen
Smallest Small Large

Largest

20322



The Objects
Chapter  10

10-55

To draw an arc:

1. Choose Text/Draw from the list of objects and then Arc. The menu
across the top of the screen changes to the Object menu; at the bottom
the object is identified as an Arc.

2. Choose Move and Size to move the object or to set its size to
Smallest, Small, Large or Largest.

3. Choose Look to enable or disable any of the quadrants. When the arc
is first created, all quadrants are enabled. The Look menu also
contains the color, blink, reverse video and high intensity settings.

4. Choose Utility to name the arc or to set it as a default.

You can include any of the ISA Industrial Symbols in your screen by
opening the Add menu and choosing Symbol. Then, choose Symbol Type
from the Look menu and select the symbol of your choice. The symbol can
be single or double size.

If a symbol’s connection points are not at the center of a character cell, or
if the symbol is double size, you will need to use the connectors.
Connector characters connect a line to one of the 32 symbols. Lines are
drawn through the center of the character cell while the connectors for the
symbols may be at one edge of the character cell. To have the line meet up
perfectly with the symbol you’ll need one of the connectors. (See the
section on Lines earlier in this chapter for information on how to choose
connector points.)

IMPORTANT:  The symbol you choose will appear on the PanelBuilder
screen as a box. The actual symbol will be displayed on the PanelView
terminal screen.

The following illustration shows the ISA symbols. The precise screen
appearance of the ISA symbols can be found in Appendix D, ISA Symbols.

Symbols
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Figure 10.12
ISA Symbols

20180

Each symbol can have up to four different states. Unique attributes can be
assigned to each state. You assign a PLC address (1 – 3 bits) to control
these states. The value of these bits determines which state attributes are in
effect (color, blink, intensity, etc.).

If the value is less than zero, then state 0 will be displayed. If the value is
greater than state 3, then state 3 will be displayed.

IMPORTANT:  All bits off displays state 0.

Bar graphs can be used to monitor changing conditions, such as
temperature or fluid levels. You can create vertical and horizontal bar
graphs up to 80 characters wide and 24 characters high.

Vertical bars move from top to bottom. Horizontal bars move from left to
right.

On the PanelView terminal, bar graphs will operate at pixel resolution.
Each character cell is 8 w x 10 h pixels.

You can use Outer Text to make incremental marks alongside the bar
graph. The underscore character often does this best for vertical graphs.

Bar Graphs
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Like many objects, bar graphs can be grouped together with other objects
to create a fully functional “template”. For example, you can position two
or three bar graphs together and put numeric display objects immediately
below the bar graphs to display the process variable, set point, and control
variable. You can use any of the numeric entry functions interactively with
these values. You can also draw a box around the entire group of objects.

After sizing the bar in PanelBuilder, you assign a PLC input or output
address and a “data range”: a low and high value is assigned. If the value is
less than the lower limit, the bar will have no size. If the value is greater
than the upper limit, the bar will be full size.

The data range that can be displayed is 0 to 99,999,999 but the actual value
will depend on the data type and the address size. Available data types for
bar graphs are BCD, bit and integer. Negative numbers will be displayed as
0 bar size.

For example, with a data range of 0 to 4095, a data value of 2047 would be
at 50% of the scale. Another example: with a data range of 100 to 200, a
data value of 125 would be at 25% of the scale.

The resolution of the bar movement will be 10 pixels per character
vertically and 8 pixels horizontally.

To have a bar graph change color at certain values, cascade bar graphs
together: place the high end of one graph at the low end of the next, and
adjust each graph’s data range accordingly.

There are two objects that allow the display of time and date information:
the time display and the date display. There can be only one time display
and one date display per screen.

Time Display

The Time Display displays the current time at a specified location on a
screen. The time is displayed in the format hh:mm:ss (hours, minutes,
seconds). You can enclose the time display in a box for added emphasis.

Use the PanelView terminal’s Configuration Menu or the PLC Controlled
Time & Date option (under Options in the File menu) to set the correct
time on your PanelView terminal. The Configuration Menu can also be
used to set the time to appear in 12-hour (AM/PM) or 24-hour format.

Time and Date
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Date Display

The Date Display displays the current date at a specified location on a
screen. The date is displayed in the format mm/dd/yy (month, day, year).

You can enclose the date display in a border for added emphasis.

Use the PanelView terminal’s Configuration Menu or the PLC Controlled
Time & Date option (under Options in the File menu) to set the correct date
on your PanelView terminal.

The Local Message Display consists of two components: the Local
Message Display object that you can place on any screen, and the Local
Message List.

For Version 5 PanelBuilder, this Local Message List can contain up to 875
messages. Versions 4 and earlier allow up to 496 messages. You can edit
the messages in the list any time you are adding or editing a Local Message
Display object. In other words, the Local Message List is accessible to all
the Local Message Display objects through the entire application file.

Once you create the Local Message Display object, the PLC value
associated with this object determines which of the messages is displayed.
For example, if the PLC value is 39, then message number 39 will be
displayed in the Local Message Display.

Local Messages are similar to Information Messages in that the PLC
controller controls which message is displayed. An Information Message,
however, is displayed in its own window on top of any screen. A Local
Message is part of a screen containing a Local Message Display.

Displays can be single or multiple lines: if you configure a single line
display, when a message is triggered the text will be automatically
centered. A multiple line display will automatically start at the top left
corner, with automatic word wrapping.

A message can have a maximum of 72 characters (or less, depending on
the display area)—any additional characters won’t be displayed.

Importing and Exporting Messages

You can import and export ASCII text files as text for local messages.

Local Message Display
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Importing Local Message Text

Using the text editor of your choice, create an ASCII text file of local
messages in this format:

nnn“ttt...ttt” CR
!this  is a comment

nnn  = local message number (1–875)
“   ”   = start and end of message
ttt  = message text (1–72 characters)
CR   = Carriage Return (local message record

delimiter)
! = comment character

Follow these guidelines in preparing your local message text file:

 the message number must be between 1 and 875. The numbered
messages do not have to be created in ascending order, but the numbers
must be unique, i.e., no two messages can have the same number

 the local message text must begin and end with quotation marks (”)

 to include a quotation mark (”) in your message, preface it with a
second quotation mark (””)

 PanelBuilder ignores any white space found outside the quotation marks

 do not use any character whose ASCII code is outside the range 32–127.
See Table 10.W for details of the ASCII character set

 use the comment character (!) as the first character in the line of a
comment. PanelBuilder will ignore lines that begin with the !

 make sure your message text is 72 characters or less. PanelBuilder does
not truncate local messages that are too long

 when you name your file, use the extension .LMG

Once you have placed a Local Message Display object on your screen,
choose Text from the Object menu, then choose Messages.
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Figure 10.13
The Messages Window

20124

Messages
Select Message 1 Local Message Text
Create New Message

Delete Message
Copy Message to:

Import Message Text
Export Message Text

Quit

Choose Import Message Text. A window opens.

Figure 10.14
The Import Message Text Window

Import Message Text
Select File FILENAME
Directory c: \path1\path2\

Quit

23619

The filename in the Select File field will be one of the following defaults,
in decreasing order of priority:

 an .LMG file with the same name as the currently edited file

 the first .LMG file in the selection list

 a blank, if no .LMG files exist in the current directory

Choose Select File to import a different file. A list of all .LMG files in the
current default directory appears. Choose the one you want.

The Directory field defaults to PanelBuilder’s current working directory. If
the file is not in the current directory, choose Directory to specify the
directory containing the file. The name of the specified directory will be
retained between PanelBuilder sessions.

Once the file is selected, PanelBuilder checks the current application file to
determine whether any local messages have already been defined. If any
messages are found, PanelBuilder displays this message:
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Figure 10.15
Message Import Warning

Warning

Importing the messages into this file will replace all currently defined messages.

23620

Cancel Import
Continue

Choose Cancel Import or Continue. If you choose to continue,
PanelBuilder checks each record in the message file to make sure its
format is valid. If any errors are found, an error message will be displayed,
the import will be cancelled and the messages in the current file will
remain intact.

If no errors are found, all the local messages in the application file will be
deleted and replaced by the imported ones.

Exporting Local Message Text

Choose Export Message Text from the Messages menu. The Export
Message Text window will open.

When the window opens, the Select File field will show the name of the
application file currently being edited. You can use the default or change
the name to any valid DOS file name. PanelBuilder appends the .LMG
extension when it saves the file.

Address Assignment and PLC Message Triggering

Which data type you select determines how the PLC controller triggers
messages.

Triggering Messages for the Binary or BCD Data Type

To trigger a message, the PLC controller must put a non-zero value which
corresponds to the desired message number into the designated PLC
address. For example a trigger value of 19 would cause message 19 from
the Local Message Display List to appear in the display. If the trigger value
changed to 27 message 27 would appear, replacing message 19. The
window is cleared when the trigger value is 0.
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 Binary

If the binary data type is selected, the address assignment will be a
contiguous bit string containing from 1 to 16 bits. The bit string can be
positioned anywhere within the same PLC word by designating the
desired “start bit” (the default is zero, the typical choice). The number
of bits will depend on how many messages you wish to trigger from the
Local Message Display List.

 BCD

If the BCD data type is selected, the address assignment will be a
contiguous string or either 4, 8, or 12 bits (1, 2, or 3 digits). The number
of bits will depend on how many messages you wish to trigger from the
Local Message Display List.

Triggering Local Messages for Bit Position Data Type

To trigger a message, the PLC program must set a PLC output bit that
corresponds to the desired message number in the Local Message Display
List. If the PanelView terminal sees any bit set, the corresponding message
will appear in the display area.

 Bit Position

If Bit Position data type is selected, the address assignment will be a
contiguous bit string containing from 1 to 496 bits. Each bit in the string
has a corresponding message number in the Local Message Display
List. For example, the first bit corresponds to message number one, etc.
When more than one PLC word is required, the next higher word
number(s) are used. The number of messages you wish to trigger
determines the number of bits you configure this string for.

The PanelView terminal prioritizes the message bits: if the terminal sees
more than one bit set at the same time, the message associated with the
bit with the lowest address is displayed.

Triggering Messages on Multiple Local Message Displays

PanelView has one local message list but you can have several local
message displays for different purposes. It is possible to trigger different
messages for different displays by creating a subset of the local message
list for each display.

To trigger different messages on multiple Local Message Displays, the first
step is to create the display objects using non-overlapping PLC addresses.
Then enter the list of all messages in the Local Message list.
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The PLC controller can write different values into each address, causing
different subsets of the messages to be displayed.

The Screen Print Button prints the screen displayed on the PanelView
terminal. When this button is pressed, the screen is copied to the
PanelView terminal’s print buffer and sent to the printer.

Screen print requests are ignored when the printer is already busy with a
screen print. The Screen Print Active item in the Options menu allows the
PanelView terminal to inform the PLC controller that a screen print is in
progress. See Chapter 9, PLC Controlled Options, for more information.

Screen prints may also be triggered by the PLC controller. See Chapter 9,
PLC Controlled Options for details.

If the PLC controller is controlling the screen print and the screen change,
you can have the PLC controller print any screen as soon as it is displayed.
This is done by requesting the new screen as well as a screen print in the
same PLC scan.

Some graphic characters will not be printed. Instead:

 ISA symbols, bar graphs, outer borders, arcs, diagonals and line
connectors will be replaced by ASCII character 219 decimal illustrated
in Figure 10.16

 the first 32 characters, used for printer control, will be replaced by
ASCII character 254 decimal illustrated in Figure 10.16

 double width/height characters will be replaced by a single normal sized
character and the appropriate number of blanks

For example, the letter A, displayed with double height and width,
occupies an area 2 characters high and 2 characters wide. Once printed, the
A will occupy the top left position leaving the other three characters blank.

Figure 10.16
ASCII Characters 219 and 254 from the Alternate Character Set

23615

Character
219

Character
254

1q1111q

Screen Print Button
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An application file containing a Screen Print Button is not compatible with
Version 1 firmware.

The ASCII Display object is used to display a character string sent from a
PLC controller directly on the PanelView terminal. The display is updated
whenever the string changes.

Like any other PanelView object, it is placed on the screen and then
customized, given a size, character size, and color (on a color terminal) or
intensity (on a monochrome terminal).

Any character in the IBM extended character set can be displayed. See
Appendix E, The Extended Character Set.

Special control characters can be included, to affect the characters which
are displayed. The characters displayed are controlled exactly as specified
by the data in the string.

Characters are processed sequentially until a null character (all bits 0) is
received. Null is the string termination character; any characters after a
null are ignored.

The maximum string length is one block transfer write or 64 characters.

If only 10 displayable characters (not control characters) are in the string,
only 10 positions on the screen will be filled. Any previously existing text
anywhere within the display area will be unaffected.

Words wrap within the area defined for the ASCII Display object, but lines
do not wrap. If the character string is too long to be displayed the extra
characters are ignored.

For example, the display is defined as 10 characters wide by 3 characters
high. The characters are single height and single width. The string to be
displayed is “A long string for the ASCII display”

The object will show:

A long
string for
the ASCII

Note that the last word of the string is lost, because the object as defined
isn’t large enough for the whole string.

ASCII Display
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A second string is sent while the first one is displayed. The string is: “This
shows how characters overwrite”.

This  shows 
how ng for
characters

Note that any character which was not directly covered by a new character
remained in the display. This feature can be useful for updating portions of
an ASCII display while leaving portions unchanged. If you want to clear
the display, or clear a line in the display, control characters for those
purposes can be embedded in the string.

To properly display the second string shown above, a “clear to end of
display” control sequence, ESC[J, could have been included at the
beginning of the string.

The string would then be: “ESC[J This shows how characters overwrite”,
which would display:

This  shows
how
characters

See the table of control sequences, Table 10.V, and the description of
Invalid Control Sequences which follows it.

Move and Size

An ASCII display object can be any size from one line high by one
character wide, to 24 lines by 80 characters. Moving and sizing the object
is identical to the “Local Message Display”.

ASCII Display String Format

The format of the data string must be as in Table 10.U. Table 10.W lists the
ASCII character set. For more characters, see Appendix E, The Extended
Character Set.

Table 10.U
ASCII String Format

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Bit ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

15                  8 ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

7                    0

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

1st word ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

1st character ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

2nd character

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

2nd word ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

3rd character ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

4th character

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

… ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

…
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Special Characters and Control Sequences

Character 255 is used as the fill character by the ASCII Display object.
The fill character is used by the PLC controller to align display strings of
odd length. Fill characters are not printable and will not occupy space on
the display.

Table 10.V lists the control sequences used by the PanelBuilder software.

Table 10.W lists the ASCII character set. For more characters, see
Appendix E, The Extended Character Set.

Table 10.V
Control Sequences

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Name ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Sequence ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

Hex ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Action

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Carriage Return ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

CR ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

0D ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Move to the beginning of the current line

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Line Feed ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

LF ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

0A ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Move to the next line below the current one. If the current position is the last
line, no more data from the string is displayed.

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Clear to End of Display
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

ESC[0J or ESC[J
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

1B5B4A
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Clear from the current display position to the end of the display.
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Clear to End of Line
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

ESC[0K or ESC[K
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

1B5B4B
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Clear from the current display position to the end of the line.
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Position Text
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

ESC[row;columnH

ESC[;columnH

ESC[rowH

ESC[H

ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

1B5Bxx3Byy48

1B5B3Byy48

1B5Bxx48

1B5B48

ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Move the display position to the specified row and column number. The top
left corner of the display area is row and column number 0;0. If either row or
column number is omitted, the missing coordinate will be 0.

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Reverse Video Text OnÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

ESC[7m ÁÁÁÁÁÁ
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

1B5B376D ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

Begin displaying text in reverse video. On a color terminal this flips the
foreground and background colors. On a monochrome terminal, this switches
the current reverse�video setting.

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Reverse Video Text Off
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

ESC[27m
ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

1B5B32376D
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁÁ

End the reverse�video text block.
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Table 10.W
The ASCII Character Set

ÁÁÁ
ÁÁÁ

Dec ÁÁÁ
ÁÁÁ

Oct ÁÁ
ÁÁ

HexÁÁÁ
ÁÁÁ

CharÁÁÁÁ
ÁÁÁÁ

Control
Code

ÁÁ
ÁÁ

DecÁÁÁ
ÁÁÁ

OctÁÁÁ
ÁÁÁ

HexÁÁÁ
ÁÁÁ

CharÁÁÁ
ÁÁÁ

DecÁÁÁ
ÁÁÁ

OctÁÁÁ
ÁÁÁ

HexÁÁÁ
ÁÁÁ

CharÁÁÁ
ÁÁÁ

Dec ÁÁÁ
ÁÁÁ

Oct ÁÁÁ
ÁÁÁ

Hex ÁÁÁ
ÁÁÁ

Char

ÁÁÁ
ÁÁÁ0
ÁÁÁ
ÁÁÁ000
ÁÁ
ÁÁ00
ÁÁÁ
ÁÁÁNUL
ÁÁÁÁ
ÁÁÁÁCTRL@

ÁÁ
ÁÁ32
ÁÁÁ
ÁÁÁ040
ÁÁÁ
ÁÁÁ20
ÁÁÁ
ÁÁÁSP
ÁÁÁ
ÁÁÁ64
ÁÁÁ
ÁÁÁ100
ÁÁÁ
ÁÁÁ40
ÁÁÁ
ÁÁÁ@
ÁÁÁ
ÁÁÁ96
ÁÁÁ
ÁÁÁ140
ÁÁÁ
ÁÁÁ60
ÁÁÁ
ÁÁÁ\ÁÁÁ

ÁÁÁ1
ÁÁÁ
ÁÁÁ001
ÁÁ
ÁÁ01
ÁÁÁ
ÁÁÁSOH
ÁÁÁÁ
ÁÁÁÁCTRL A

ÁÁ
ÁÁ33
ÁÁÁ
ÁÁÁ041
ÁÁÁ
ÁÁÁ21
ÁÁÁ
ÁÁÁ!
ÁÁÁ
ÁÁÁ65
ÁÁÁ
ÁÁÁ101
ÁÁÁ
ÁÁÁ41
ÁÁÁ
ÁÁÁA
ÁÁÁ
ÁÁÁ97
ÁÁÁ
ÁÁÁ141
ÁÁÁ
ÁÁÁ61
ÁÁÁ
ÁÁÁaÁÁÁ

ÁÁÁ2
ÁÁÁ
ÁÁÁ002
ÁÁ
ÁÁ02
ÁÁÁ
ÁÁÁSTX
ÁÁÁÁ
ÁÁÁÁCTRL B

ÁÁ
ÁÁ34
ÁÁÁ
ÁÁÁ042
ÁÁÁ
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Invalid Control Sequences

If an incorrect control sequence is detected, the invalid portion will be
displayed as part of the string.

For example, in the display area shown earlier, the string: “ESC[3;0HThis
sequence is invalid” would be invalid: the display is 10 characters by 3
lines, and a line specification of 3 would start printing at the fourth line.

If the current display position were 0;0, the string would display:

←[3;0HThis
sequence  is 
invalid

The left arrow character in the display represents ESC.

Other invalid sequences:

 nested Reverse Video On, for example, “ESC[7mOneESC[7mTwo” The
second command is invalid and if possible will be displayed as part of
the string

 nested Reverse Video Off, for example, “ESC[27mOneESC[27mTwo”
The second command is invalid and if possible will be displayed as part
of the string

 wrong characters in text position sequence. The text position
coordinates must not contain any characters other than 0 to 9, for
example, “ESC[a3;4HThe string”

The ASCII Input object allows the operator to send an ASCII string to a
PLC input address.

On the Large ASCII Input object for a Touch Screen terminal, the operator
selects characters by touching them on the screen. The selected character
appears in the scratchpad. When the string in the window is complete, the
operator sends it to a preconfigured PLC address by pressing the ENT key.

ASCII Input Object
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Figure 10.17
Large ASCII Input Object, Touch Screen Terminal
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On the other three versions of this object, the operator selects characters
from the keyboard by moving the screen cursor to the desired character
(with the arrow keys) and pressing the SEL button.

Figure 10.18
Small ASCII Input Object, Touch Screen Terminal
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Figure 10.19
Large ASCII Input Object, Keypad Terminal
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Figure 10.20
Small ASCII Input Object, Keypad Terminal
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Table 10.X details the differences between the various types of displays,
what parts of each can be configured and what keys are unique to each
display.

To add an ASCII Input object to your screen:

1. Select ASCII Input from the Add menu.

2. Choose Small or Large from the list.

Buttons

The following buttons are common to all four keyboard displays, and are
used to edit the string displayed in the scratchpad:

 INS (Insert)—toggles the keyboard between Insert (INS) and
Overstrike (OVR) modes.

When the button is “off” (default) the keyboard is in Insert mode.

New characters appear at the current cursor position. The cursor also
moves one character to the right. If the scratchpad is full, the new
character will not be inserted.

When the button is “on”, the keyboard is in Overstrike mode. New
characters type over existing characters.

The state of the INS button is maintained between screen changes but
not between power cycles.

 DEL (Delete)—deletes the character at the current scratchpad cursor
position.

 <<—moves the cursor in the scratchpad to the left.

The button auto-repeats at the rate defined in the Options menu.

 >>—moves the cursor in the scratchpad to the right.

The button auto-repeats at the rate defined in the Options menu.

 CLR (Clear)—clears the scratchpad.
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 ENT (Enter)—sends the string displayed in the scratchpad to the ASCII
Input Address in the PLC controller. The leftmost character is placed in
the high order byte of the first PLC word, the next character to the right
in the low order byte, etc. If the string is too large for the configured
address, the terminal displays an “out of range” message; the string is
not sent to the PLC controller.

The scratchpad is not cleared after the ENT button is pressed. If the
next key pressed is an ASCII character, the scratchpad clears and
displays the character. If the key is an editing key, (INS, DEL  or cursor
keys), the string remains displayed in the scratchpad, allowing you to
edit the string without having to retype it.

If the Enter Key Control address is defined, the terminal sets this
address 400ms after the ENT button is pressed. If the Handshake
address is defined, the Enter Bit is reset by the terminal when the
Handshake address makes a 0 to 1 transition within 4 seconds of the
Enter Bit being set. If the Handshake bit does not make a 0 to 1
transition, the user is informed and the Enter Bit is reset automatically.
If the Handshake address is not defined for this object, the Enter bit is
reset when the button hold time elapses.

IMPORTANT:  All keypad and touch input is disabled while the Enter
Key Control Bit is set to 1.

The SEL (Select) Button

The SEL (Select) button is common to the small ASCII Input Object for
the Touch Screen terminal and to both the large and small objects for the
Keypad terminal. To select a character:

1. Use the keypad cursor keys to move the cursor to the desired
character.

2. Press the SEL button.

This places the selected character into the scratchpad at the current
scratchpad cursor position.

The following buttons are unique to the various types of terminal.

Touch Screen Terminal, Large ASCII Input Object

The large ASCII input object has the following unique buttons:

 CAPS—toggles between upper case and lower case characters. When
the button is “off” (default), the keyboard is in lower case mode; when
the button is “on”, the keyboard is in upper case mode.
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 SHF—shifts the next character typed to upper case, or to the special
shift-key character for that key. To cancel the shift, press the SHF key
again.

Touch Screen Terminal, Small ASCII Input Object

The small ASCII input object has the following unique buttons:

 �  Up cursor: moves the keyboard cursor up

 �  Down cursor: moves the keyboard cursor down

 �  Left cursor: moves the keyboard cursor to the left

 �  Right cursor: moves the keyboard cursor to the right

Table 10.X
Keyboard Displays for the ASCII Input Object

Display Components Touch Screen Terminal Keypad Terminal

Small Large Small Large

Keyboard characters Not configurable Not configurable Not configurable Not configurable

Keyboard Location configurable in the
Move menu

Vertical location only
configurable in Move menu

Location configurable in the
Move menu

Location configurable in the
Move menu

Characters within
scratchpad

Size configurable in the
Look menu

Size configurable in the
Look menu

Size configurable in the
Look menu

Size configurable in the
Look menu

Scratchpad Size configurable in Look
menu; location configurable
in Move menu

Size configurable in Look
menu; location configurable
in Move menu

Size configurable in Look
menu; location configurable
in Move menu

Size configurable in Look
menu; location configurable
in Move menu

Buttons Size fixed
Location configurable in the
Buttons menu

Not configurable Size fixed
Location configurable in the
Buttons menu
Function keys can be
assigned

Size fixed
Location configurable in the
Buttons menu
Function keys can be
assigned

Unique keys �  Up cursor
�  Down cursor
�  Left cursor
�  Right cursor
SEL - Select

CAPS - Caps Lock
SHF - Shift

SEL - Select SEL - Select

Character Selection Move cursor to the desired
character with the cursor
keys and press SEL button

Press the desired character
on the touch screen to place
it in the data entry window

Move cursor to the desired
character with the cursor
keys and press SEL button

Move cursor to the desired
character with the cursor
keys and press SEL button
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Configuring the ASCII Input Object

Like any other PanelView object, the ASCII Input object is given a size, a
foreground and background color (for color terminals) or intensity (on
monochrome terminals). The Keyboard and Scratchpad are separate items
and can be moved and colored (or given intensity) separately. Use the
items in the Object menu to define the position and appearance of your
ASCII Input object.

Once you have added an ASCII Input object to your screen, the following
Object menu selections are available to you:

Move—the Move menu for the ASCII Input object contains the following
options:

 ASCII Input —allows you to move the entire object as a unit

 Scratchpad—allows you to move the scratchpad part of the object

 Keyboard—allows you to move the keyboard part of the object

Look—the Look menu for the ASCII Input object has two items,
Scratchpad and Keyboard. The submenus vary between color and
monochrome applications.

Table 10.Y
The Look Submenus for ASCII Input Object, Color and Monochrome

Scratchpad Keyboard

Color Monochrome Color Monochrome

Size Size Foreground Color Reverse Video

Foreground Color Reverse Video Background Color High Intensity

Background Color High Intensity

Border Border

Character Height Character Height

Character Width Character Width

Buttons—the Buttons menu varies slightly between keypad and touch
screen applications. It is not available at all for the large Touch Screen
ASCII Input object, where the buttons are a part of the keyboard.
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Table 10.Z
Button Menu Variations

Small Touch Screen Object Small or Large Keypad Object

Menu Submenu Menu Submenu

Move:
allows you to move
the buttons in relation
to the keyboard

INS
DEL
SEL
CLR
ENT
<<
>>
�

�

<
>

INS
DEL
SEL
CLR
ENT
<<
>>

Move
allows you to move
the buttons in relation
to the keyboard

Function Key
allows you to assign a
function key to the
button

Background Color
allows you to choose
a color for the button's
background

Black
Blue
Green
Cyan
Red
Magenta
Yellow
White

Background Color
allows you to choose
a color for the button's
background

Black
Blue
Green
Cyan
Red
Magenta
Yellow
White

Foreground Color
allows you to choose
a foreground color for
the button's text

Black
Blue
Green
Cyan
Red
Magenta
Yellow
White

Foreground Color
allows you to choose
a foreground color for
the button's text

Black
Blue
Green
Cyan
Red
Magenta
Yellow
White

Quit Quit

Outer Text—the Outer Text menu has the following options:

 Edit Text  allows you to enter the outer text for the object. Outer Text
appears outside the object. When you enter text, remember to use the
arrow keys to move from line to line, and Enter to save the text.

 Move Text moves the text.

 Underline makes the text appear underlined.

 Blink  causes the text to flash on the PanelView terminal.

 Foreground Color sets the color of the text and border.

 Background Color sets the background color of the object.

 Reverse Video sets monochrome text in reverse video.

 High Intensity sets monochrome text in high intensity.

 Character Height sets the characters to single or double height.
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 Character Width  sets the characters to single or double width.

Format—the Format menu has the following options:

 Number of Characters specifies the number of characters that will fit
in the scratchpad. The default is 8, and the maximum is 64.

 Fill Character  determines the character with which the ASCII string is
padded when the input string is less than the configured maximum
length. You can choose from the following characters:

 Spaces

 Zeroes

 FF

 Null

The Fill Character is transferred to the PLC but not displayed in the
scratchpad.

Address—the Address menu is a standard PanelBuilder menu with three
items, ASCII Input Address, Enter Key Control Address and Enter Key
Handshake Address. The first address must be configured, but the last two
are optional.

 ASCII Input Address  specifies the address to which the string
displayed in the data entry window is sent. It is:

  an Input address

 Data Type: ASCII

 Number of Words: from 1 to 32

 Start Bit: for Discrete communications, 0 or 10; 
              for Block Transfers, 0 or 8.
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Table 10.AA
Scratchpad Input and Contents of ASCII Input Address

Scratchpad Input Address

left most character high byte - 1st word

2nd character low byte - 1st word

3rd character high byte - 2nd word

4th character low byte - 2nd word

You can also configure the Enter key with a handshake so the PLC
controller can acknowledge a value received from the terminal. To do this,
you must define two PLC addresses: the Enter Key Control address and the
Enter Key Handshake address.

When the operator presses the Enter key to send the value to the PLC
controller, the terminal sets the Enter Key Control address to 1 (after a 400
msec. delay).

Program your PLC controller to turn on the bit at the Enter Key Handshake
address, to inform the terminal that the Enter Key Control Bit has been
received. When the terminal sees this bit on (receives acknowledgement),
it turns off the Enter Key Control bit.

If the PanelView terminal does not receive acknowledgement (transition
from 0 to 1) within 4 seconds, it displays a Minor Fault message in the
Fault Window and resets the Enter bit. If the Enter Key Handshake is
unassigned, the Enter bit will remain set for the duration of the button hold
time or for as long as the button is pressed, whichever is longer.

IMPORTANT:  All keypad and touch input is disabled while the Enter
Key Control Bit is set to 1.

Configure these two optional addresses for the Handshake functionality:

 Enter Key Control Address specifies the input bit PanelView sets
when the ENTER button is pressed. It is:

 an Input address

 Data Type: Bit

 Number of Bits: 1

 Enter Key Handshake Address specifies the bit the PLC controller
sets when it detects the ENTER bit is set:

 can be Input or Output (default)

 Data Type: Bit

 Number of Bits: 1.
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IMPORTANT:  The ASCII Input object is not a retentive object. You
cannot assign it a preset value.

The Scrolling List object is available in PanelBuilder Version 5. The
Scrolling List object allows you to define and view a list that is not limited
by the size of the screen. You can use the cursor buttons to move through a
maximum of 999 items within these object lists.

You can define multiple object lists, including Local Message Object Lists,
Multi-State Indicator Object Lists, and Numeric Display Object Lists.

The Scrolling List addressing permits PLC output data multiplexing to
PanelView. This reduces PLC ladder logic and addressing typically needed
to display and edit large amounts of data.

You access the Scrolling List through the Add Menu.

Figure 10.21
The Add Menu with the Scrolling List Selected
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The Scrolling List consists of a Cursor List and one or more Object List(s).
You must create the Cursor List before you can define Object Lists. The
following figure provides an example of how a completed scrolling list
appears on the terminal screen.

Scrolling List Object
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Figure 10.22
Sample Scrolling List Screen
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IMPORTANT:  The Scrolling List is a retentive object. Your PanelView
terminal will retain the current value for the Cursor List and Object List
settings even after you’ve turned the terminal off, or switched to
Configuration mode and back to Run mode. You can enter preset values
for this object.

Please turn to Appendix A for a Scrolling List object example. This
example defines a Scrolling List object that allows you to monitor and
control the operations of an automobile luxury option assembly operation.
It also includes PLC programming suggestions.

Cursor List

In the Cursor List you define all the buttons associated with the Scrolling
List, as well as the List’s cursor display area.

You can enable, disable, move, and change the text for each button in the
list. When you create a Cursor List, you see the object illustrated in the
following figure. Only the Up and Down cursor buttons appear, because
these two buttons are enabled by default. The other buttons are disabled by
default. Note that the text shown for the buttons is not fixed.
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Figure 10.23
The Cursor List with Up and Down Buttons Enabled
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Cursor List Object

The Object Menu allows you to move and change the text and attributes of
the entire Scrolling List object (the buttons and the Cursor List). The next
section briefly outlines these functions. For more detailed information on
the Object Menu and its functions, please see Chapter 3, Using
PanelBuilder.

Move

Choose the Move menu, and use the Move List option to move all
components of the Cursor List object together as a group.

Look

Choose Look to change the attributes associated with the buttons and the
Cursor List. These attributes include foreground and background color,
underline, blink, character height and width.

IMPORTANT:  If you change the Character Height, the height of the
Cursor List changes automatically. For example, if you change the height
from Single to Double, the Cursor List height will double. You cannot
change the Character Height to Double if the new height exceeds the
screen boundary.
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Buttons

Choose Buttons to enable or disable the buttons associated with the Cursor
List object through the Buttons Menu.

The following table shows the buttons that you can configure for this list,
as well as their default settings.

Table 10.AB
Buttons Associated with Scrolling List and Their Default Settings

Up Cursor Enabled

Down Cursor Enabled

Page Up Disabled

Page Down Disabled

Home Disabled

End Disabled

Enter Disabled

After you enable a button, you can configure it through the Button Enable
sub-menu.

If you disable a button, it disappears from the screen. When you enable a
button, the button appears in the middle of the screen. A menu also
appears. This menu allows you to configure the button:

 Choose Move to move and position each button independently.

 Choose Size to change the button’s size.

 Choose Function Key to assign a function key number to the button.
This option is available only when you are configuring a keypad
terminal application.

 Choose Margin Size to define the inactive region around the button.
This option is available only for touch screen applications.

 Choose Edit Text to create text for each button. The button size limits
the amount of text you can create.

 Choose Move Text to position the inner text associated with the button.
The size of the button determines how much you can move the text.

 Choose Border to change the border type for each button. The default
border of the function key application is Single. For a touch screen
application, the default is Outer.
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List

The List menu allows you to move the cursor list independently from the
cursor list buttons. In this menu you must also define the Number of States,
Number of Visible States, and Number of Preview States for the entire
Scrolling List object. This menu also lets you configure the border type for
the list independently from the button.

 Choose Move to relocate the list part of the object. The buttons will not
move. The list moves on character boundaries.

 Choose Number of States to specify the total number of states or items
in the Scrolling List object. The default Number of States is 10. The
valid range is from 2 to 999. This value cannot be less than the Number
of Visible States defined for the object.

 Choose Number of Visible States to define the height of the scrollable
list that is visible to the operator. The default Number of Visible States
is 5. The valid range is from 1 to 24. The value you enter cannot be
greater than the Number of States defined for the object. It must also be
greater than the Number of Preview States.

 Choose Number of Preview States to define the minimum number of
visible states above or below the cursor before the list begins to scroll.
The default is 1. The minimum number you can enter is 0. The
maximum is half the Number of Visible States minus 1.

The following figure shows an example of how the preview state option
works when the Number of States is 7, the Number of Visible States is
5, and the Number of Preview States is 1.
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Figure 10.24
Scroll List Preview State Cursor Movement Example
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 Choose Border to configure the border type for the list independently
from the border type of the buttons. The default border type is Outer.

Outer Text

Choose the Outer Text menu to define and attach outer text to the Cursor
List object.

Address

Choose the Address menu for the list of addresses you must configure for
the Cursor List object:
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 Cursor Control Address is an output address from the PLC that
informs the terminal where to position the cursor in the Scrolling List.
The address contains the value of the state to place the cursor on.

For example, if the PLC places a value of 100 in the Cursor Control
address, the PanelView terminal will place the cursor on the 100th state
of the list. Based on the Number of Visible States and Preview States
configured, the PanelView will scroll the visible states accordingly, and
send the appropriate value to the top position address. The PLC will
then use the Top Position Address value to place the appropriate top or
first visible state value and consecutive values in the visible state
addresses. The following figure illustrates how this works.

Figure 10.25
Cursor Control Address Functions
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If the PLC sets the Cursor Control Address value to 0, the cursor list
buttons control the cursor. Until a Cursor List button is pressed, the
cursor will remain on the last state according to the last value that was
placed in the address.

The Cursor Control Address is an Output only address. You can
configure the data type to Binary, BCD or Bit.

 Cursor Indicator Address informs the PLC of the cursor’s location in
the Scrolling List. The address contains the value of the state that the
cursor is pointing to. The terminal updates this value when the cursor
position changes.

This address value is updated regardless of the value in the Cursor
Control Address. If the Cursor Control Address value is 0, the Cursor
List buttons control the Cursor Indicator Address value. If the Cursor
Control Address value is not 0, the Cursor Indicator Address value
reflects the Cursor Control Address value.

This is an Input only address. You can configure the data type to Binary,
BCD or Bit.
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IMPORTANT:  The Cursor Indicator Address should not share its address
with other objects. Overlapping objects may cause unpredictable results.

 Top Position Address informs the PLC of the value of the state
displayed at the top of each Object List.

This value directs the PLC to what value should be placed in the first or
“Top” Visible State address.

This is an Input only address. You can configure the data type to Binary,
BCD or Bit.

IMPORTANT:  The Top Position Address should not share its address
with other objects. Overlapping objects may cause the PLC to display a
wrong range of numbers.

 Enter Key Control Address indicates when the Cursor List Enter
button is pressed.

This is an Input only address. The Bit and size is 1.

See the following button operation section for value and timing
characteristics of this address and button.

 Enter Key Handshake informs the terminal that the PLC has read the
Enter Key Control Address.

This is an Input/Output address.

See the following button operation section for value and timing
characteristics of this address and button.

Object List

An Object List is a list of objects of the same type. These objects are
displayed in accordance with the Cursor List.

The Object List(s) and the Cursor List together make up the Scrolling List.
You must define the Cursor List before you can create an Object List. You
can create any number of Object Lists for each screen, as long as there is
sufficient space on the screen.

Although you define the Cursor List and Object List components
separately, they are in fact components of a single Scrolling List object.
Therefore the Cursor List’s definition—Cursor Control address, Cursor
Indicator address, Top Position address, Number of States—also applies to
all the Object List(s) in the Scrolling List.
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To create an Object List, select Object List in the Scrolling List selection of
the Add menu.

Figure 10.26
Selecting the Object List in the Add Menu
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There are three types of Object Lists that you can choose from:

 Multi-State Indicator Object List —This Object List is a list of
multi-state indicator objects that can display different states at any given
time. The Number of States that you specified for the Cursor List
determines the total number of multi-state objects you can define in a
single Object List. Defining this object is similar to defining the regular
Multi-State Indicator object, except that you can define only one set of
state text information (16 state text strings) per Multi-State Object List.

 Local Message Object List—The Local Message Object List is a
listing of individual local message display objects. The total number of
Local Message objects in a single Object List depends on the Number of
States you specified for the Cursor List.

 Numeric Data Display Object List—This Object List allows you to
configure multiple Numeric Data Display Objects in a list. If you select
this option for your Object List, you can choose among the following
Numeric Data Display options, similar to the single Numeric Data
Display Object:
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 Standard Numeric Data Display

 Standard Numeric Data Display with Polarity

 Standard Numeric Data Display with Decimal Point

 Standard Numeric Data Display with Polarity and Decimal Point

 Scaled Numeric Data Display

You can define only one type of numeric display for each Numeric Data
Display Object List. The total number of Numeric Display objects in a
single Object List depends on the Number of States you specified for
the Cursor List.

You can define more than one Object List of each type for each screen, and
position them in any order, on any free location on the screen. The number
of Object Lists you create is limited only by the space on your screen.

For more specific information about each of the individual object types and
how they function, please see the appropriate section earlier in this chapter.

IMPORTANT:  Each scrollable Object List can contain only the selected
object. You cannot combine different objects in the same list. The
following figure shows a sample screen containing two Object Lists and a
Cursor List.

Figure 10.27
Two Objects Lists and a Cursor List on a Touch Screen Terminal
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The Object menu, shown above, allows you to configure the Object List.

IMPORTANT:  The Object Menus for the three types of Object Lists
contain many identical menus and functions. In the following section, we
outline these functions and point out any differences between the types of
Object Lists. For more detailed information on Object Menus and their
functions, please see the appropriate section in Chapter 3, Using
PanelBuilder.

List

The List menu is present in all three Object List types.

 Choose Move to move and position the Object List on the screen. The
default vertical position is the same as the vertical position defined for
the Cursor List object. If possible, try to keep each Object List aligned
with the Cursor List component.

 Choose Border to configure the border type for the Object List.

For color terminals you can choose the foreground and background
colors. For monochrome terminals you can choose between Reverse and
High Intensity.

 Choose Width to change the width of the Object List. The number you
enter determines the size of the objects to be displayed in the list. The
minimum width should be the longest state string defined for the Object
List.

For Numeric Display Data Object Lists, the minimum width depends on
the Number of Digits that you specified for the Numeric Displays, and
whether you chose a Numeric Data Display with Decimal Point and/or
Polarity Object List.

 Choose Highlight Bar if you want to enable the highlight bar for the
Object List. If you enable the Highlight Bar, the current state controlled
by the Cursor Control Address or the cursor buttons is highlighted in
reverse video.

 Choose Number of Visible States to define the number of list objects that
will appear in the visible region of the Object List on the screen. In
other words, this option lets you define the number of objects that the
operator will be able to see in the list.

The default is the Number of Visible States you defined for the Cursor
List object. The valid range is 1 to 24.



The Objects
Chapter  10

10-89

IMPORTANT:  You can change the value of the Number of Visible States
in the Object List. However, you cannot save the Screen until the Object
List’s Number of Visible States is the same as that of the Cursor List. If the
Number of Visible States is less than the number of defined Visible State
Addresses, a message warns you that the extra Visible State addresses will
be deleted.

IMPORTANT:  If the number you enter will cause the bottom of the
Object List to be off the screen, an error message appears. The Move
option in the List menu allows you to place the object higher on the screen
if there is enough room on the screen. This gives you room to fit more
visible states on the screen.

Look

The Look menu allows you to define the display attributes of the objects in
the entire Object List. These attributes include foreground color,
background color, underline, blink, character height, and character width.
This menu is available for the Local Message Object List and the Numeric
Data Display Object List.

IMPORTANT:  When you change the Character Height of the text, you
affect the height of the entire Object List. For example, if you change the
Character Height from Single to Double, the Object List height will
automatically be double.

Text and Outer Text

The Text menu allows you to create, modify, import, and export Local
Messages for the Local Message Display Object List.

The Outer Text menu lets you define outer text for the entire object list.

Format

The Format menu is an option for the Numeric Data Display Object List
types only. This menu is identical to the format menu for a single Numeric
Data Display.

 Number of Digits—This option lets you specify the maximum number
of digits that you want to be displayed in the Numeric Data display. The
maximum number is limited by the Width of the Object List you defined
in the List menu for the Object List, and the Character Width you
defined in the Look menu.
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 Fill Left with —This option allows you to specify the fill character for
the numeric display. “Spaces” is the default. Your other choice is
“Zeroes”.

If you choose a Numeric Data Display with Decimal Point, the Format
menu also lets you specify how the decimal point is to be handled.

 Fixed Position—This option lets you fix the decimal point for the
Numeric Data objects in the Object List. For this option, enter the
number of digits you want after the decimal. The maximum that you can
enter depends on the Number of Digits specified, and the width of the
Object List.

 PLC Controlled—This option lets you assign the control of the decimal
point to the PLC. If you select this option, you should also set the
Decimal Point Position Address from the Address Menu.

If you choose a Scaled Numeric Data Display Object List, the Format
menu allows you to specify the Scaling Factor, Offset Value, and how to
display the results.

 Scaling Factor—This option lets you define how much you want the
displayed value to be scaled. The valid range is from .0001 to 9999.

 Offset Value—This option lets you define how much you want the
amount of the value to be offset. The range is from –32768 to 32767.

 Display Results with—This option lets you define whether you want
the data displayed with a decimal point, or rounded off to the nearest
whole number.

States and Text

The States & Text menu is a Multi-State Indicator Object List menu. It
allows you to define up to 16 states, and define the text and display
attributes for each state.

The menus and sub-menus are identical to those of a single Multi-State
Indicator object, except that how you define the state text information for
the 16 states will apply to all Multi-State Indicators in the Object List. The
Character Height option in the State menu applies to all Multi-State
Indicators in the Object List, and also affects the total height or size of the
entire Object List.

 Character Height—This option lets you set the characters to single or
double height. If you change the attributes of a state by changing the
Character Height of the text, you affect the height of the Object List.
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If you set any Object List text string associated with the Multi-State
Indicator to Double, the Object List height will automatically be double.

For example, if you define the Character Height as Single in State 1 and
Double in State 2, the Object List height in State 1 changes to Double,
even though the Character Height remains Single. When you define
State 3, the Object List height will automatically be Double. In State 3
you can enter single height characters on every line of the Object List.

IMPORTANT:  If you change the Character Height in State 2 to Single,
the size of the Object List remains Double, because States 3 has text
entered in the second line of the Object List. To change the Object List
height back to Single, you must remove the text from the second line of
text in State 3.

Address

The Address menu is present in all three Object List types. It lets you
define a Visible State Address for each object of the object list.

 Visible State Address allows you to attach an address to each visible
object or “state” in the Object List.

To assign a Visible State Address to one of the visible objects or
“states”, enter the number of the state from the list you wish to define.
Define the address in the standard address menu that appears. The
following figure provides an example of how the Visible State Address
functions.
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Figure 10.28
Visible State Address

23717
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OBJECT MENU:   Move  Look  Buttons  List  Outer Text  Address  Utility   Exit

Cursor List

Object List with 5 Objects or �States"

Visible State Address Number

1

2

3

4

5

 Automatic Address Assignment—If you define an address for Visible
State 1 (the highest or top state), PanelBuilder checks the amount of
contiguous address space available. If there is enough address space,
you can choose to have Panel Builder automatically assign the address
of each remaining Visible State.

If you choose to use the Automatic Contiguous Assignment,
PanelBuilder updates all remaining addresses using the same data type
and communications type of state 1, and increments the Start Word and
Start Bit in a successive, sequential order.

IMPORTANT:  Automatic Address Assignment replaces any existing
addresses assigned to the Visible States. It does not check for overlaps of
existing objects that already use the new addresses.

If you choose not to use the Automatic Contiguous Assignment option,
or there is not enough contiguous address space, PanelBuilder updates
the state 1 address only. You must update the remaining Visible State
Addresses one at a time.

If you choose a Numeric Data Display Object List, you may have two
more address options:
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 Decimal Point Position Address—This address is available only for
Numeric Data Display with Decimal Point and Numeric Data Display
with Decimal Point and Polarity. Define this address if you want the
PLC to control the decimal as defined in the Format menu. Configure
this address as you would a single Numeric Data Display with Decimal
Point.

 Polarity Address—This address is available only for Numeric Data
Display with Polarity and Numeric Data Display with Decimal Point
and Polarity. Define this address if you want the PLC to control the
polarity of the data. Configure the address as you would a single
Numeric Data Display with Polarity.

Utility

The Utility  menu lets you attach a name to and update the default values of
the Object List.

Exit

The Exit menu allows you to “Exit and Save Object”, “Save the Object
Only” or “Don’t save, just Exit”.

Button Operation

The Scrolling List object supports these buttons as defined in the Cursor
List object for control of the cursor position.

Except for the Enter button, these cursor buttons are active only when the
value of the Cursor Control Address for the Scrolling List is set at 0. If this
value is other than 0, the PLC controls the cursor.

The Enter button is always active, regardless of the state of the Cursor
Control Address.

 Up Cursor moves the cursor to the previous state in the scrolling list. If
the cursor is at the top-most or first position in the list, pressing this
button has no effect.

 Down Cursor moves the cursor to the next state in the scrolling list. If
the cursor is at the bottom-most or last position in the list, pressing this
button has no effect.

 Page Up scrolls the list up by the number of Visible States defined. If
the cursor is at the top-most or first position in the list, pressing this
button has no effect.
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 Page Down scrolls the list down by the number of Visible States
defined. If the cursor is at the bottom-most or last position in the list,
pressing this button has no effect.

 Home positions the cursor at the top-most  or first position in the list.

 End positions the cursor at the bottom-most or last position of the list.

 Enter—If the Enter Key Control Address is defined, the terminal sets
this address 400ms after the Enter button is pressed. If the Enter Key
Handshake address is defined, the terminal resets the Enter Bit when the
Handshake address makes a 0 to 1 transition after the Enter Bit was set.
If the Handshake address does not make a 0 to 1 transition within four
seconds, the terminal informs the user, and automatically resets the
Enter Bit. If the Handshake address is not defined for this object, the
Enter bit is reset when the button hold time elapses.

Retentive Objects are those which retain their value when

 power is switched off and on

 the terminal is switched from Run mode to Configure mode and back

 the operator changes screens

The advantages of Retentive Objects are:

 PLC programming instructions are often eliminated

 PLC output addresses are often not needed

The following objects are retentive:

 Maintained Push Button

 Interlocked Push Button

 Control List Selector (with and without Enter key)

 Increment and Decrement Value Buttons

 Set Value Button

 Set Bit Cursor Point

 Numeric Input Cursor Point

 Numeric Keypad Entry Button

About Retentive Objects
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 Numeric Keypads (small and large)

 Scrolling List Object

A PLC Input address (discrete or block transfer) must be assigned to a
Retentive Object. These objects will function even if the PanelView
terminal isn’t connected to a PLC controller.

More than one retentive object can be assigned to the same PLC input
address. For example, control selectors on different screens could be
assigned to control the same PLC input address. When one selector
changes the PLC input state, the other selector will reflect this also.

Retentive Objects and Presets

Some Retentive Objects can have a preset value. When the application file
is downloaded and the terminal switched to Run mode, retentive objects
will take on these input states.

IMPORTANT:  Normally Closed Push Buttons’ default states are forced
by PanelView: after the download and before the PLC controller is
initialized, PanelView goes through the input table and forces all normally
closed PLC addresses to 1. Therefore the state of a Normally Closed Push
Button overrides the state of a presettable object that shares the same
address.

ATTENTION: Make sure that the preset values you define are
the same values that the PLC program considers as the Off or
default state.

The PanelView terminal’s Configuration mode allows you to:

 reset retentive objects to their preset states (which were assigned on the
development system)

 specify whether retentive objects will remain in their last states, or be
reset to the preset states, each time the terminal is powered up (Presets is
the default)

For more information on preset operation, refer to Chapter 2, PanelView
Terminal Functions, in the PanelView Operator Terminals User Manual.
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IMPORTANT:  All PLC input addresses can be preset except Time and
Date Transfer, Screen Number Transfer, Alarm Window Address, Set Bit
Cursor Point, Normally Open Push Button, Normally Closed Push Button,
and Latched Push Button. Since addresses can overlap, it is possible to
preset even these addresses, by sharing them with a presettable address.

Safety Considerations for Retentive Objects

Instead of using a Retentive Object to start a machine or process, use a
Momentary Input Object such as a Momentary Push Button. Also, make
sure that the PLC controller is programmed to stop any machines or
processes whenever the remote I/O communication is interrupted, so that a
machine or process can only be restarted by an operator.

ATTENTION: Never use a Retentive Object to initiate a
process or turn on a machine. Here’s why: Let’s say your PLC
controller was programmed to turn a machine on whenever a
Maintained Push Button was set to one. If remote I/O
communication were temporarily cut while the Maintained Push
Button was set to one, the machine would automatically restart
as soon as communication resumed. Similarly, since the
Retentive Object’s value is retained even after power is
removed, the machine could start up automatically when you
re-applied power to the terminal, if the Maintained Push Button
had been set to 1 when the terminal was powered down. In other
words, the machine could start up automatically, without the
operator being aware of it.
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Testing Your Application File

This section describes how to test screens, and how to test applications
with the complete system. Information is also provided on how to connect
a programmable controller to the terminal.

By the time you are ready to test the system you should have:

 created an application file

 installed the PanelView terminal

 downloaded the file to the PanelView terminal

Testing an application file is a three step process that involves:

1. Testing the screens.

2. Monitoring terminal and PLC interaction.

3. Testing the application with the complete system.

The first step in testing an application file is to download the file and set
the terminal in Run mode. At this point the PLC should not be connected.
You only want to ensure that the screens appear as you expected.

IMPORTANT:  When the PLC is not connected, the terminal will display
a flashing “PLC Communication Lost” message when you first switch to
Run mode. This will continue during the testing until PLC communication
is established.

ATTENTION: Do not connect a PLC to the terminal. You are
simply testing your application file’s screens, and don’t want to
monitor a PLC as well.

The application file won’t run faultlessly since there’s no PLC connected.
However, you will be able to confirm that your screens and objects look as
you expect.

Testing the Screens
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All PLC output addresses will be set to zero and, since no PLC is
connected, they will remain at zero. Thus, any object controlled by an
output address will always remain in state zero. Similarly, objects that
monitor output addresses will never see the value change.

Objects such as Push Buttons which use a PLC input address will appear to
work normally. However, if they use PLC feedback, that feedback will
never be received.

Static objects that don’t communicate with the PLC, such as Screen
Selectors and Background Text, will operate.

Once the screens are behaving as expected, connect a programming
terminal to the PLC and monitor the PLC’s I/O Data Table. At this stage,
you should connect the PanelView terminal to the PLC, but don’t have the
PLC control any machines or processes.

ATTENTION: Disable all the other I/O racks or modules that
could be affected by the PanelView terminal.

Once all PLC controlled machines and processes have been disabled, you
can put both the PLC and PanelView terminal into Run mode. You’ll need
the reports that the PanelBuilder Development Software generates so you
can correlate each screen and object to the correct PLC address.

Just as you would test a new control panel’s inputs and outputs before
starting up a new control system, so you must run through each screen in
the application file. Use the programming terminal to monitor what
happens inside the PLC as you use each object, and then change the values
within the PLC to see how the PanelView terminal responds.

Test Retentive Objects

Observe each object carefully if you are using any retentive input objects.
Switch the terminal off and on again, and switch it to Configuration mode
and back to Run mode. Watch the input addresses for each retentive object
to ensure that the values are initialized so that the program will respond
safely.

Connecting the Programmable
Controller



Testing Your Application File
Chapter 11

11-3

Once you’ve checked all PLC values and determined that all objects,
windows, and PLC controlled functions communicate properly with the
PLC, you’re ready to set both the PLC and the terminal into Run mode and
test your application file in action.

ATTENTION: If the PLC program can control any specific
machine action or process that could result in unsafe or critical
operation, temporarily disable these specific operations. Keep
people at a safe distance from any PLC controlled machine.
Finally, make sure emergency stop buttons are easily accessible
in the event of unexpected operation of the control system.

Step through each screen to make sure that valid states and values are
displayed. Test each object one at a time to ensure that the PLC system
responds as expected.

Turn the PanelView terminal off and on and switch the terminal to
Configuration mode and back to Run mode. You should also remove and
re-apply power to the PLC separately, and to the entire control system to
ensure that the system re-initializes as expected.

Testing the Whole System
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PLC Programming Considerations

PanelView objects and functions can be assigned block transfer addresses
as well as discrete I/O addresses. Block transfer files should only be used
when there are not enough discrete I/O image table addresses available.

When block transfer addresses are assigned to PanelView terminal objects
or functions, the following must be specified:

 PLC read or PLC write (input or output)

 block transfer file (1–5)

 word number (0–31)

 bit number (0–15)

You can make up to five block transfer assignments for a terminal. Each
assignment supports a PLC read and PLC write file, for a total of up to 5
read files and 5 write files. Each file’s size can be from 1–32 words. Block
transferring to a PanelView terminal is just like block transferring to
intelligent I/O modules in I/O racks.

For each block transfer assignment (1–5), assign a Rack Number, Module
Group (Word), Byte (Hi/Low), and Number of Words. The block transfer
instructions in the PLC program must be configured accordingly.

Rack Number

This can be any of the rack numbers which have been assigned to the
PanelView terminal. The terminal can be more than one rack number.

Module Group (Word)

This is also referred to as “group” or “word”. It can be any word (0–7)
within a PanelView terminal’s rack assignment.

Block Transfer Programming
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Byte (slot)

This is also referred to as “slot” or “module”. Low byte (module or slot =
0) or high byte (module or slot = 1) of the assigned “module group (word)”
can be designated. This discrete byte address in the PLC input and output
image table will be used for block transfer control, and cannot be used by
other objects or functions.

Number of Words

The block transfer instruction in the PLC program will dictate the number
of read or write words (file size) to be transferred. If “zero” words are
entered in the block transfer instruction in the PLC program, then the
terminal will both read and/or write the number of words specified on the
PanelBuilder development system. A read or write file can be from 1–32
words.

For each block transfer assignment configured on the development system,
both a read and write file will be allocated in the terminal. Each PLC block
transfer instruction can access one read or write file in the terminal, as long
as the instruction’s rack number, module group and byte (slot) assignment
matches that of a block transfer assignment in the terminal.

If only read data, or only write data is to be transferred, then single
direction block transfers can be programmed in the PLC controller. To
transfer both read and write data, program the PLC controller for
bi-directional block transfer communication, as described in this section. In
this case block transfer read and write instructions in the PLC program
must both be assigned the same rack, module group and byte (slot),  just
like bi-directional block transfers to an intelligent I/O module.

Remember that each block transfer assignment  in the terminal supports
both a read and write block transfer file (32 words each). Do not make
additional block transfer assignments unless more than this is required.
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When in the “scanner mode” the PLC-5/15 can block transfer to and from
connected PanelView terminals, as well as intelligent I/O modules in
remote I/O racks. The PLC-5/15 processor allows block transfers to be set
for either “non-continuous” or “continuous” operation. Refer to the
PLC-5/15 Processor User’s Manual for complete details.

IMPORTANT:  For PLC-5/15 block transfers to function properly, you
must use a PLC-5/15 Series B, rev. J or later.

�Non�Continuous" Block Transfer Mode

In this case, each time the block transfer instructions are complete, they are
re-enabled when the next program scan occurs. The program scan time is
normally short enough that block transfer timing will be more than
adequate. This method guarantees that the order of queuing follows the
order scanned in the PLC program.

If the PLC-5/15 program requests more than one transfer to and from the
same I/O chassis (or terminal) in the same program scan, the requests are
placed in queue (up to 17 requests per chassis) and executed in the order
requested.

Your PLC program should condition the use of block transfer data on
examination of the block transfer error bit. An error may occur when the
processor is switched from run mode, or when processor communications
are interrupted by excessive electrical noise or by disconnection of the
remote I/O cable.

Bi�Directional Block Transfer Example 
(PLC�5/15)

Figure A.1 shows the recommended PLC programming for bi-directional
block transfer communication with a PanelView terminal. The following
programming method will continually execute bi-directional block
transfers as quickly as the program and I/O scan allows in the
non-continuous mode.

PLC�5/15 Block Transfer
Programming Examples
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Figure A.1
Bi�Directional Block Transfer Example (PLC�5/15)

BTR
BLOCK TRANSFER READ
Rack: 3
Group: 2
Module: 0
Control Block:           N10:0
Data File:           N11:0
Length:                32
Continuous:                  N

Write
Enable
N10:5
    /

Read
Enable
N10:0
     /

15 15

(EN)

(DN)

(ER)

Write
Enable
N10:5
    /

Read
Enable
N10:0
     /

15 15

(EN)

(DN)

(ER)

20237

Read
Done
N10:0
 

13

(EN)

(DN)

(ER)

BTW
BLOCK TRANSFER WRITE
Rack: 3
Group: 2
Module: 0
Control Block:           N10:5
Data File:           N12:0
Length:                32
Continuous:                  N

FAL
FILE ARITHMETIC/LOGICAL
Control:            R6:5
Length:                32
Position:                                      0
Mode:                                      ALL
Dest:                                  #N13:0
Expression:
#N11:0

Move Read File to �Verified" Read File

Your PLC program should use the data in the “verified” read file. Because
read data is presented asynchronously to the program scan, data could
change during the program scan. Putting the above rungs at the beginning
of the program can assure that all ladder logic sees the same data in the
same program scan.
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The following rung will constantly block transfer write to a PanelView
terminal.

Figure A.2
Block Transfer Write Example (PLC�5/15)

BTW
BLOCK TRANSFER WRITE
Rack: 2
Group: 0
Module: 1
Control Block:             N7:5
Data File:              N7:500
Length:                32
Continuous:                  N

Write
Enable
N7:5
    /

15

(EN)

(DN)

(ER)

20238

The following rung will constantly block transfer read from a PanelView
terminal.

Figure A.3
Block Transfer Read Programming (PLC�5/15)

BTR
BLOCK TRANSFER READ
Rack: 2
Group: 0
Module: 1
Control Block:             N7:0
Data File:         N7:400
Length:                32
Continuous:                  N

Read
Enable
N7:0
     /

15

(EN)

(DN)

(ER)

Read
Done
N7:0
 

13

(EN)

(DN)

(ER)

20239

FAL
FILE ARITHMETIC/LOGICAL
Control:            R6:6
Length:                32
Position:                                      0
Mode:                                       ALL
Dest:                                 #N14:00
Expression:
#N7:400

Move Read File to �Verified" Read File

The PLC program should use the “verified” read data.
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IMPORTANT:  When moving data from one type of data table section to
another, the FAL instruction will convert the data format (such as integer
to Floating Point). Use the “File Copy” instruction if this is not desired.

The following rungs will provide constant bi-directional block transfer
communication with a PanelView terminal.

IMPORTANT:  If using a 1775-S4A Remote I/O Scanner, you must use
1775-S4A Series B or later.

PLC�3 Block Transfer
Programming Examples
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Figure A.4
Bi�directional Block Transfer Example (PLC�3)

XOR
    A XOR B = R
  A   :    WB001:0000
0000000000000000
  B    :    WB001:0000
0000000000000000
  R    :    WB001:0000
0000000000000000

BTR Error
WB0001:0000
       ]        [

1313

CNTL
(EN)
       12

20240

BTR
BLOCK XFER READ
Rack: 000
Group:     0
Module            0 = Low
Data:     FB002:0000
Length:   32
CNTL:     FB001:0000

BTW Error
WB0001:0000
       ]        [

03

Processor
Run Mode
1-shot
WB0000:0000
       ]    /   [

00

Processor
Run�Mode
1-shot
WB000:0000
         (   )

00

use any store bit for this

BTR Error
WB0001:0000
       ]        [

BTR Error
WB001:0000
       ]    /   [

13

BTR Done
WB001:0000
       ]    /   [

15
CNTL
(DN)
       15

CNTL
(ER)
       13

CNTL
(EN)
       12

BTW
BLOCK XFER WRITE
Rack: 000
Group:     0
Module            0 = Low
Data:     FB003:0000
Length:   32
CNTL:     FB001:0000

BTW Error
WB001:0000
       ]    /   [

03

BTW Done
WB001:0000
       ]    /   [

05
CNTL
(DN)
       05

CNTL
(ER)
       03

MVF
FILES FROM A TO R

A: FB002:0000
B: FB004:0000
COUNTER:          C0000
POS / LEN:           0 / 32
MODE:  ALL/SCAN

BTR Done
WB0001:0000
       ]       [

15

The PLC Program should
use the �verified" read
file data.

Move BT read file to
�verified" read file
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The following rungs will constantly block transfer write to a PanelView
terminal.

Figure A.5
Block Transfer Write Example (PLC�3)

XOR
    A XOR B = R
  A   :    WB001:0000
0000000000000000
  B    :    WB001:0000
0000000000000000
  R    :    WB001:0000
0000000000000000

BTR Error
WB0001:0000
       ]        [

1313

CNTL
(EN)
       02

20241

BTW
BLOCK XFER WRITE
Rack: 000
Group:     0
Module            0 = Low
Data:     FB003:0000
Length:   32
CNTL:     FB001:0000

BTW Error
WB0001:0000
       ]        [

03

Processor
Run Mode
1-shot
WB0000:0000
       ]    /   [

00

Processor
Run Mode
1-shot
WB000:0000
         (   )

00

use any store bit for this

BTR Error
WB0001:0000
       ]        [

BTW Done
WB001:0000
       ]    /   [

05
CNTL
(DN)
       05

CNTL
(ER)
       03
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The following rungs will constantly block transfer read from a PanelView
terminal.

Figure A.6
Block Transfer Read Example (PLC�3)

XOR
    A XOR B = R
  A   :    WB001:0000
0000000000000000
  B    :    WB001:0000
0000000000000000
  R    :    WB001:0000
0000000000000000

BTR Error
WB0001:0000
       ]        [

1313

CNTL
(EN)
       12

20242

BTW
BLOCK XFER READ
Rack: 000
Group:     0
Module            0 = Low
Data:     FB002:0000
Length:   32
CNTL:     FB001:0000

BTW Error
WB0001:0000
       ]        [

03

Processor
Run Mode
1-shot
WB0000:0000
       ]    /   [

00

Processor
Run Mode
1-shot
WB000:0000
         (   )

00

use any store bit for this

BTR Error
WB0001:0000
       ]        [

BTR Done
WB001:0000
       ]    /   [

15
CNTL
(DN)
       15

CNTL
(ER)
       13

MVF
FILES FROM A TO R

A: FB002:0000
B: FB004:0000
COUNTER:       C0000
POS / LEN:         0 / 32
MODE: ALL/SCAN

BTR Error
WB0001:0000
       ]        [

15

The PLC Program should
use the �verified" read
file data.

BTR Error
WB0001:0000
       ]        [

Move BT read file to
�verified" read file
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The following rung moves the block transfer read data into a “verified”
block transfer read file. The PLC program should only use data from the
“verified” read file.

Figure A.7
Bi�directional Block Transfer Example (PLC�2/30)

033
(EN)
       17

20243

FFM
FILE TO FILE MOVE
Counter Addr: 033
Position:              001
File Length:   20
File A: 300 - 323
File R: 400 - 423
Rate Per Scan:  20

BTR
Done
110
]    [

07
033
(DN)
       15

010
(EN)
       07

BTR
BLOCK TRANSFER READ
Data Addr: 030
Module Addr: 100
Block Length:   20
File:     300 - 323

110
(DN)
       07

010
(EN)
       06

BTW
BLOCK TRANSFER WRITE
Data Addr: 031
Module Addr: 100
Block Length:   20
File:     200 - 223

110
(DN)
       06

To block transfer in a single direction, program a rung similar to the
corresponding block transfer rung shown above. Each block transfer read
instructions data should always be “verified” with a “file to file move” as
shown above.

IMPORTANT:  If using a 1772-SD2 Remote I/O Scanner with a
PLC-2/30, you must use 1772-SD2 rev. 3 or later.

Use PLC-5 6200 software to configure a PLC-5/15 or 5/25 for
communication with remote I/O devices such as a PanelView terminal.

To use the following procedure your system must have this software:

 PLC-5 6200 software release 2.2 or later

As well, you must have one of these PLC controllers:

 PLC-5/15 Series B, rev. H or later

PLC�2/30 Block Transfer
Programming Example

Configuring a PLC�5 for
Multi�Chassis I/O Rack
Addressing
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 PLC-5/25 Series A, rev. D or later

Other PLC-5 processors released after the date of this publication also
support this function.

1. Put the PLC controller in the Program Mode or the Remote Program
Mode.

2. From the first screen of the software, press F1–Online Prg/Doc.

3. Press F8–Monitor File.

4. Create an Integer File for I/O Status—two words are required for
each rack.

Press F7–General Utility

Press F1–Memory Map

Press F6–Create DT (data table) File

Example: Entering N10:13 creates an Integer File 10 with words
(0–13). This is 2 words for each of the 7 remote racks that may be
connected to a PLC-5/25.

5. Assign the Integer File created in step 4 to the I/O Status.

From the General Utility screen, press F2–Processor Status.

Enter the Integer File number into the area called I/O Status
File—located in the lower center area of the screen.

Example: If you created File N10:13 as in the example in step 4, you
would enter 10.

6. Configure the processor to recognize all of the remote I/O devices
connected to the remote I/O link.

From the Processor Status screen, press F3–I/O Status.

Press F1–Autoconfigure.

This will check all of the devices connected to the remote I/O link, set
the proper bits in the I/O status file, and display the setup on the I/O
status screen.
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When using a PLC-2 (2/05, 2/15, 2/16, 2/17), the system must contain a
1771-SN subscanner module. The PLC-2 processors do not have built-in
remote I/O capabilities, but the 1771-SN subscanner module can
communicate with remote devices such as PanelView. The subscanner
must be located in the same rack as the PLC-2, and communicate to the
PLC controller by means of block transfers. The 1771-SN looks like an
intelligent I/O module to the PLC controller; it monitors discrete inputs
and controls discrete outputs.

The 1771-SN requires one PLC scan to receive the output data from the
output image table and another PLC scan to send discrete input data to the
input image table. Any devices connected to the subscanner are scanned
asynchronous to the PLC scan. The PLC controller then scans the
subscanner module during the I/O portion of the PLC scan.

You can connect up to seven remote I/O racks to the 1771-SN. Set
switches 1 through 7 on Switch bank 1 of the 1771-SN module to
correspond with the assigned remote I/O racks.

Your ladder program instructions should include read and write block
transfer instructions and a file move instruction (see Figure A.8). The
block length of each block transfer instruction is 24 words  (assuming
remote I/O rack numbers 1 and 2). It is recommended that you select the
default block length (00) for the module, which permits it to automatically
select the proper number of block transfer data words. Whether or not you
condition your block transfer rungs depends on your application
requirements. If you enable both the read and write block transfer
instructions in the same scan, the module performs bi-directional block
transfers starting with a read.

Using PLC�2s and a 1771�SN
Subscanner with PanelView
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Figure A.8
Block Transfer Programming Example for Local PLC�2 Family Processor

DATA ADDR:            0030
MODULE ADDR:              131
BLOCK LENGTH:                24
FILE: 300-     327

BLOCK XFER READ

Local Processor
013
(EN)
     17

Fault Bit
305
 ]   /  [

BTR
Done Bit
113
]    [

17 00

20218

113
(DN)
     17

COUNTER ADDR:            0040
POSITION:              001
FILE LENGTH:                19
FILE A:               0305-     0327
FILE R:               0405-     0427
RATE PER SCAN:                 0

FILE TO FILE MOVE
0040
(EN)
     17

0040
(DN)
     15

DATA ADDR:            0031
MODULE ADDR:              131
BLOCK LENGTH:                24
FILE: 200-     227

BLOCK XFER WRITE

Buffer File

CNTL
(EN)
     16

113
(DN)
     16

Input Data (Block Transfer Read)

The 1771-SN formats input data received from the PanelView terminals
and block transfers this data to the PLC processor when enabled by your
ladder diagram program. Eight words are reserved for I/O data from each
full remote I/O chassis (Figure A.9). Do not use the first eight words (0
through 7 octal) for data from input modules. The remaining words (10–
77 octal) correspond to Remote I/O rack numbers 1–7. For example, word
10 (octal) corresponds to module group 0 of rack number 1. The most
significant byte is slot 1, the least significant byte is slot 0.

The reason for the additional length of BTR and BTW files is addressing
convenience. Word addresses for assigned rack 1 are 10–17, assigned rack
2 are 20–27, assigned rack 3 are 30–37, etc., in both files.
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Figure A.9
Input and Output Data Files

Word

1

2

3

4

5

6

7

8

9

10

16

17

18

24

58

64

Word

1

2

3

4

5

6

7

8

9

10

16

17

18

24

58

64

20219

Read File
(Inputs)

Word

0

1

2

3

4

5

6

7

10

11

17

20

21

27

70

77

0

0

0

0

0

Fault Counter

0

0

0

0

0

0

0

0

Fault Table

0

Discrete Input Data
from Rack #1

Discrete Input Data
from Rack #2

Slot 1 Slot 0

Fault
Bit

17 0010 07 Bit

Write File
(Outputs)

Word

0

1

2

3

4

5

6

7

10

11

17

20

21

27

70

77

0

0

0

0

0

0

0

0

0

0

0

0

0

0

0

0

Discrete Output Data
to Rack #1

Discrete Output Data
to Rack #2

Slot 1 Slot 0

17 0010 07 Bit

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

.

Discrete Input Data
from Rack #7

Discrete Output Data
to Rack #7

.

.

.

.

.

.

.

.

.

.

.

.

Output Data (Block Transfer Write)

Use a format similar to input data (Figure A.9). Reserve eight words of
output data for each full remote I/O chassis. Do not use the first eight
words. Remote I/O addresses corresponding to rack numbers 1 and 2 start
at words 10 and 20 octal, respectively.

Block Transfer Write File

Assign write block transfer file for sending output data via the 1771-SN to
the PanelView terminal. Output data for rack 1 uses words 10 through  17
octal, and rack 2 uses words 20 through 27 octal. For example, you could
assign a write file at 200 through 227 (octal). Choose your own method for
moving output data into the BTW file.
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Ladder Program for Remote I/O

Remote I/O addresses correspond to the addresses in the block transfer
read and write files, with inputs to the read file and outputs to the write
file. For example, you would monitor an input in rack 1, module group 3,
bit 5, and energize an output in rack 2, module group 4 bit 12, as follows,
based on example block transfer files (Figure A.8) at 300 (read) and 200
(write).

Figure A.10
Ladder Program for Remote I/O

313
]    [

05
20220

224
(     )
     12

Although system response times are quite predictable, they are very
application dependent. Methods for determining response times differ,
depending on the type of PLC processor and the PLC system
configuration.

Discrete Data Response Time

The following formula can generally be used to determine the worst case
time (in ms) required to transfer data to or from the terminal. This includes
the terminal’s input or display processing time:

Program Scan Time + I/O Scan time + Terminal Process Time

Program Scan Time

This determines how quickly the PLC program can update or act on the
discrete data. Subroutine and/or “immediate I/O” instructions are
sometimes used to reduce the effective program scan time when necessary.

The program scan depends on the type of PLC processor and PLC program
size. Refer to your programmable controller user’s manual. Some typical
program scan times include the following:

System Response Times
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Table A.A
Typical Program Scan Times

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

PLC�2/30 ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

1772�LP1, LP2,  LP3 ÁÁÁ
ÁÁÁ

5 ÁÁÁÁ
ÁÁÁÁ

ms/k

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

PLC�3 ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

1775�L2 ÁÁÁ
ÁÁÁ

2.5 ÁÁÁÁ
ÁÁÁÁ

ms/k

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

PLC�3/10 ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

1775�LP4, LP8 ÁÁÁ
ÁÁÁ

2.5 ÁÁÁÁ
ÁÁÁÁ

ms/k

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

PLC�5/15 ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

ÁÁÁ
ÁÁÁ

2 ÁÁÁÁ
ÁÁÁÁ

ms/k

I/O Scan Time

This depends on the type of processor/scanner and number of I/O chassis
on the same scanner channel. Refer to the applicable PLC controller or I/O
scanner user’s manual. Typical Discrete I/O scan times are as follows :

Table A.B
Discrete I/O Scan Times

ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

PLC�2/30, (1772� SD, SD2)
1771�SN
PLC�5/15

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

7 ms / chassis

ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁ

PLC�3
PLC�3/10

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

6 ms / chassis
on same channel

For the PLC-2/30, also include the synchronous “program I/O scan time”
which is typically .5 ms per local I/O rack.

Terminal Process Time

The terminal process time is the display update time, and it depends on
which screen is being displayed. Typically, the update time will be less
than 2 ms per dynamic object on the screen being displayed. If the alarm
window is enabled and is scanning a large bit file, the display update time
may increase slightly.

Block Transfer Timing Considerations

Block Transfer timing depends on the specific processor type and I/O
configuration. Refer to your PLC user’s manual for specific block transfer
information.

Typically, the equations provided in this section will not be necessary.
However, when response time is critical, or many block transfer devices
are used in an application, this section can be used as a guideline.
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A typical remote I/O block transfer takes anywhere from 55 to 200 ms to
complete, depending on factors such as PLC processor type, program scan
time, I/O scan time, number of block transfers on the same channel, and
number of block transfers in the queue. These typical times could become
much greater if recommended practices are not considered.

Recommended Practices

The most significant factors determining block transfer times are as
follows:

Number of Block Transfers on the Same Scanner Channel

Remote I/O scanners generally will perform only one block transfer for
each chassis (Rack Assignment terminal) in a given I/O scan. Remaining
block transfer requests will be queued. Do not assign more PanelView
terminal block transfers than necessary—in other words a 32 word block
transfer is much faster than two 16 word block transfers.

If many other intelligent block transfer I/O modules are on the same
channel, consider enabling them sequentially and only as often as
necessary. This will improve the response times of those block transfers
that are more critical. PanelView terminal block transfers are normally
programmed for constant operation to meet operator interface needs.

If more than one I/O scanner channel is available, and many block transfer
devices are involved, block transfer times will be improved by distributing
those devices evenly among the channels. Alternatively,  non-critical block
transfers could be grouped separately on a less critical I/O channel.

Number of I/O Chassis on the Same Scanner Channel

I/O scan time is mainly determined by the number of chassis on the same
scanner channel, and is also a significant factor in block transfer timing as
well as discrete data transfer times. If more than one scanner channel is
available, it may be desirable to distribute I/O chassis (or terminals) evenly
among the available channels.

Program Scan Time

An excessively long program scan can be a limiting factor in block transfer
timing. This usually only applies to larger PLC-3 applications. In these
cases, the effective program scan can be cut in half by creating a
sub-routine which could be accessed from different points in the program.
The effective update times of the programming within the sub-routine
would be reduced.
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Real time interrupt programming is another alternative.

PLC�5 Block Transfer Timing

In this case, the worst case time to transfer input or display data to or from
the PLC controller can be determined by the following formula:

IE + WQ + TT + TP

IE = Instruction Execution Time
WQ = Wait time in Queue
TT = Transfer Time
TP = PanelView Terminal Process Time

To determine the terminal’s worst case display update time for PLC data
resulting from an operator input, multiply the above result by two,  and add
the PLC program scan time.

Instruction Execution Time (in microseconds)

Write: 310 + 11.2Q + 5.4W

Read: 250 + 11.2Q

Q = Number of Queued block transfer requests to the same I/O chassis
(terminal) with the continuous bit set.

W  = Number of Transfer Words 

Wait Time in Queue

This is the sum of the “transfer times” yet to occur, ahead of the subject
block transfer request to the same I/O chassis/terminal.

Transfer Time

The transfer time is the time required to actually transfer the data to or
from the terminal. This period of time starts when the read or write block
transfer instruction sets the start bit and ends when it sets the done bit. The
length of transfer time depends on whether the transfer is to/from a local
chassis or a remote chassis (such as a terminal).
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Table A.C
Transfer Times for PLC�5/10/12/15/25 at 57.6K Baud

Transfer Local Chassis Remote Chassis

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Read ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

0.9 + 0.1 W ms ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

9 + 21.3 C + 0.3 W ms

ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Write ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

0.9 + 0.1 W ms ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

13 + 30 C + 0.3 W ms

Table A.D
Transfer Times for PLC�5/40/60 at 57.6K Baud

Transfer Local Chassis Remote Chassis
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Read
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

0.9 + 0.1 W ms
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

4 + 8 C + 0.3 W ms
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

Write
ÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁ

0.9 + 0.1 W ms
ÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁ

4 + 8 C + 0.3 W ms

C = number of remote I/O chassis 
W = number of transfer words

Some typical transfer times with no requests in the queue are as follows:

Table A.E
Typical Transfer Times

Transfer Number of Words Local Chassis Remote /w 3 Chassis
on Channel

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Read ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

10 ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

1.9 ms ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

54 ms

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Write ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

10 ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

1.9 ms ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

79 ms

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Read ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

32 ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

4.1 ms ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

61 ms

ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

Write ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

32 ÁÁÁÁÁÁ
ÁÁÁÁÁÁ

4.1 ms ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ

86 ms

Terminal Process Time

Terminal process time is less than 2.0 ms (typical) per dynamic object on
the screen being displayed.

Program Scan Time

The block transfer timing formula does not include the PLC program scan
time (PS). The PLC-5 processor can execute block transfer instructions
asynchronously to the program scan, reducing the affect of the program
scan time. However, your program scan time will affect how quickly the
PLC data can be updated or acted on by other parts of the PLC program.
This can be calculated by  adding the program scan time to the
formula (IE + WQ + TT + TP ).  Sub-routines or “immediate I/O”
instructions can be used to reduce the effective program scan time.
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PLC�3 Family Block Transfer Timing

A typical PLC-3 application might have the following configuration:

 3 active I/O channels on one scanner

 4 block transfer device on each channel

 4 I/O chassis on each active channel

 10 dynamic objects on PanelView screen

In this case, the typical time required for block transfer data to be
transferred to or from a PanelView Terminal (including terminal’s display
or input processing time) would be approximately 883 ms.

Calculating PLC-3 Block Transfer Timing

To calculate the typical time required to transfer “block transfer data” to or
from a PanelView Terminal (including terminal’s input or display
processing time), the following formula can be used:

Time (read or write) = PS + 2[CT] + TP

PS = Program Scan Time
CT = Channel Time
TP = PanelView Terminal Process Time

The following pages explain how to determine the above parameters.

Program Scan Time

The PLC-3 program scan time is typically 2.5 ms per 1K, when using a
mix of examine on/off and block instructions (1 ms/K for examine on/off
instructions only).

Channel Time

The time required for the scanner to complete a read or write depends on
the number of other block transfer devices on the same channel that are
enabled simultaneously. Channel Time (CT) is the time required for the
scanner to complete all block transfers on a particular channel. This will be
the time intervals between block transfers. Use the following formula to
determine CT—“channel time”:

CT = [Nominal Time x Number of BT on Channel] + [Number of Chassis
in Rack List – 1] x 9 ms
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Nominal Time

Use the table below to determine your “nominal time”. This will depend on
the number of channels (1–4) supporting block transfers, and the number
of active channels on the scanner.

Table A.F
Determining Nominal Time

No. of Channels
with Block Xfer
Devices

1 Active
Channel

2 Active
Channels

3 Active
Channels

4 Active
Channels

1 40 52 54 58

2 �� 67 68 76

3 �� �� 98 99

4 �� �� �� 123

Number of BT on Channel

This is the total number of block transfer devices on the scanner channel
that are enabled simultaneously.

Number of Chassis in Rack List

This is the total number of chassis that are connected to the scanner
channel.

Terminal Process Time

Terminal process time is less than 2.0 ms (typical) per dynamic object on
the screen being displayed.

In the following example, a color Keypad PanelView terminal is used to
control a pump and display its ON/OFF status and pressure. The pump is
connected to an output module and a pressure gauge is connected to an
analog input module. The system consists of:

  a 1747–L524 processor (5/02) in slot 0

 a 1747–SN scanner (RIO Scanner) in slot 1

 an output module in slot 2

 an analog input module in slot 3

SLC 5/02 Programming
Example
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 a pump connected to the output module

 a pressure gauge connected to the input module

 a color Keypad PanelView terminal

Figure A.11
Hardware Programming Example

5/02 Processor

RIO Scanner

ÁÁÁ
ÁÁÁ
ÁÁÁ

PanelView Operator Terminal

Pump

Pressure Gauge

output module

analog input module

 As shown in the G file, which follows, the PanelView terminal is
configured as a one and three quarter device beginning at rack 2,
starting group 0. The scanner addresses the PanelView terminal as if it
were two devices, one full rack and another three quarter rack.
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Figure A.12
G File

1

0 000000010001000

000000001111110

RIO Rack 0
Starting Group

0246

RIO Rack 1
Starting Group

0246

RIO Rack 2
Starting Group

0246

RIO Rack 3
Starting Group

0246
Device Address, Word 1

Device Size, Word 2

 The scanner input file is shown below.  The output file is similar, it is
addressed O:1.16 to O:1.29.

Figure A.13
1747�SN I/O Image Table

Rack 3 Group 6

Rack 3 Group 7

Rack 1 Group 2

Rack 1 Group 3

Rack 1 Group 0

Rack 1 Group 1

Rack 1 Group 6

Rack 1 Group 4

Rack 1 Group 5

Rack 0 Group 6

Rack 0 Group 7

Rack 0 Group 4

Rack 0 Group 5

Rack 0 Group 2

Rack 0 Group 3

0123456789101112131415SLC Bit Number

Word 0

Word 1

Word 2

Word 3

Word 4

Word 7

Word 8

Word 9

Word 10

Word 11

Word 12

Word 13

Word 14

Word 5
Word 6

Word 30

Word 31

Rack 0 Group 0

Rack 0 Group 1

Rack 3 Group 1

Rack 3 Group 2

Rack 2 Group 7

Rack 3 Group 0

Rack 3 Group 5

Rack 3 Group 3

Rack 3 Group 4

Rack 2 Group 5

Rack 2 Group 6

Rack 2 Group 3

Rack 2 Group 4

Rack 2 Group 1

Rack 2 Group 2

Word 15

Word 16

Word 17

Word 18

Word 19

Word 22

Word 23

Word 24

Word 25

Word 26

Word 27

Word 28

Word 29

Word 20
Word 21

Rack 1 Group 7

Rack 2 Group 0

Rack 0

Rack 1

Rack 2

Rack 3

not used

not used

not used

not used

not used

not used

PanelView

not used

not used

0818283848586878108118128138148158168178PanelView Bit Number (octal)

not used

not used

not used

not used

not used

not used

not used

not used

not used

not used

Input File

I:1.0

I:1.1

I:1.2

I:1.3

I:1.4

I:1.5

I:1.6

I:1.7

I:1.8

I:1.9

I:1.10

I:1.11

I:1.12

I:1.13

I:1.14

I:1.30

I:1.31

I:1.15

I:1.16

I:1.17

I:1.18

I:1.19

I:1.20

I:1.21

I:1.22

I:1.23

I:1.24

I:1.25

I:1.26

I:1.27

I:1.28

I:1.29

Scanner Configuration

 The baud rate is 115.2K. Dip switch 1 should be in the ON position, dip
switch 2 should be OFF.
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 The G file size is set to 3 using the Specialty I/O Configuration
function. The M0 and M1 file sizes are set to 32 in the Advanced Set Up
function.

 Since only the first 30 words of the input and output files contain valid
information, the scanned input and output words can be set to 30.
Reducing the number of scanned input and output words decreases your
SLC scan time.

 Configuration information is entered in the Modify G File function.
Word 0 is reserved and therefore cannot be modified.  Word 1 indicates
the starting address of the device, word 2 indicates its size.

Figure A.14
Sample SLC Ladder Logic
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Pump ON
Conditions

If the ON push button is pressed, turn
the pump on. If the OFF push button
is pressed, turn the pump off.

When the pump is on, display the
pressure from the pressure gauge on
the PanelView terminal Numeric Value
Display.

When the pump is on, display the ON
state of the Multi-State Indicator on
the PanelView terminal.
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In this example you create a Scrolling List in a keypad terminal that allows
you to monitor an automobile luxury option assembly operation. This
example is part of the demonstration files that are provided with the
PanelBuilder software.

The Scrolling List object allows you to control a sequential assembly
operation with up to 999 individual steps. This example demonstrates an
assembly operation of 57 sequential station operations.

The Scrolling List object allows you to scroll through all 57 assembly
stations, five at a time. The table below lists the 57 luxury option stations.

Table A.G
Automobile Luxury Option Stations

1.   AM/FM Radio 20.  Mahogany Dash 39.  Deluxe Mud Flaps

2.   Cassette Player 21.  Tilt Wheel 40.  Front Spoiler

3.   CD Player 22.  Leather Seats 41.  Rear Spoiler

4.   Sound Equalizer 23.  Split Seats 42.  Cruise Control

5.   Speakers Plus 24.  Bucket Seats 43.  Air Ride

6.   Power Antenna 25.  Mileage Computer 44.  Gold Trim

7.   CB 26.  Pin Striping 45.  Door Guards

8.   Phone 27.  Sports Gauge 46.  Password Locks

9.   Television 28.  Window Speedo 47.  White Walls

10.  Power Windows 29.  Voice Computer 48.  Wire Wheels

11.  Power Locks 30.  Glove Bar 49.  Mags

12.  Power Seat Driver 31.  Rear Window Defrost 50.  Air Scoop

13.  Power Seat Passenger 32.  Scotch Guard 51.  Turbo Plus

14.  Tint Glass 33.  Sound Proofing 52.  Security Plus

15.  Vanity Mirror 34.  Headlight Retract 53.  Sun Roof

16.  Vanity Lights 35.  Headlight Washer 54.  Party Trunk

17.  Cup Caddy 36.  Fog Lights 55.  Luggage Rack

18.  Tape Storage 37.  Deer Alert 56.  Trailer Package

19.  Wet Bar 38.  Bumper Guards 57.  Search Light

Creating a Scrolling List with some additional button objects will allow
you to monitor and control the entire operation, using either manual or
automatic modes. To build the Scrolling List, you must first create a cursor
list. Then you will create three different types of object lists:

 Multi-State Indicator Object Lists

 Numeric Data Display Object Lists

 Local Message Object List

Scrolling List Example
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The following illustration shows how the screen for the Automobile
Luxury Option Assembly Scrolling List will appear in a keypad terminal
when you have finished it.

Figure A.15
Automobile Luxury Option Assembly Scrolling List Screen
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Step 1:  Create the Cursor List

As the previous figure shows, the cursor list includes the cursor and the
standard cursor list buttons.

When you define the cursor list, you also need to define the main scrolling
list parameters. How you define these determines the size of the scrolling
list, and how the cursor and buttons function with the object lists.

For this example, you will want to use the parameters and addresses shown
in the following two tables:
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Table A.H
Defining the Scrolling List Object Parameters

Scrolling List Object Parameters Quantity

Number of States 57

Number of Visible States 5

Number of Preview States 1

Table A.I
Defining the Cursor List Object Addresses

Cursor List Object
Addresses

Block Transfer
Address

Number of Bits PLC Address

Cursor Control
Address

BO50 16 N30:10

Cursor Indicator
Address

BI50 16 N30:1

Top Position Address BI51 16 N30:2

Enter Key Control
Address

Not used

Enter Key Handshake
Address

Not used

After you have defined the Cursor List object addresses, you are ready to
begin creating the object lists.

Step 2:  Create the Object Lists

To monitor and control all the stations of the Automobile Luxury Options
Assembly, you will create these five object lists:

 Two Numeric Data Display Object Lists

 Two Multi-State Indicator Object Lists

 One Local Message Object List

In this application, each object list serves a different function. These
functions are outlined below.

Assembly Stations

A Numeric Display Object List displays the station number of the
automobile assembly sequence. The station numbers range from 1 to 57.
Because there are five visible states configured, there will always be five
stations visible. The values displayed depend on where the cursor moves
and the number of preview states selected.
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Luxury Option

The Local Message List contains the luxury option descriptions for each
station from 1 to 57. The Local Message Object List for the Scrolling List
Object displays the appropriate luxury option description for each of the
five stations currently visible, based on the cursor position.

Station Status

A Multi-State Indicator Object List displays the status of each of the five
visible stations. The following table shows the eight different states that are
possible for each station, and the PLC value.

Table A.J
Status States and PLC Values

State Message PLC Value

0 0

1 Stand�by 1

2 On 2

3 Complete 3

4 Bypassed 4

5 Manual On 5

6 Manual Off 6

7 Alarm 7

Option Command

A Multi-State Indicator Object List displays command state text for each
of the five currently visible stations.

Table A.K
Command States and PLC Values

State Message PLC Value

0 0

1 Select 1

2 Bypass 2

3 Manual On 3

4 Manual Off 4
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In this example you can use a momentary button identified as TOGGLE
COMMAND to toggle and display between “Select” and “Bypass” for the
station currently selected by the cursor. Another momentary button, labeled
SET COMMAND, activates the toggled command.

You can also modify the command for the station currently selected by
pressing the standard momentary buttons “Manual On” or “Manual Off”.
The PLC uses the Cursor Indicator Address to change the selected station’s
command.

Option Style Number

A Numeric Display Object List displays the style numbers of the currently
visible stations. The values displayed in this list also depend on cursor
movement.

The Numeric Keypad Enable Button allows you to modify the style
number of the selected luxury option station in manual mode.

Assigning Addresses for Object Lists

These tables list the addresses and files used in the example PLC program
for each of the object lists.

The following table displays the addresses for each of the object lists.

Table A.L
Visible State Addresses for the Object Lists

Object List Visible State
BLK Transfer
Start Address

Number of
Contiguous
Addresses

Number of Bits
per Address

Visible State
PLC Start
Address

ASSEMBLY
STATION
Numeric Display

BO51 5 16 N30:11

LUXURY
OPTION
Local Message

BO56 5 16 N30:16

STATION
STATUS
Multi�State
Indicator

BO511 5 16 N30:21

OPTION
COMMAND
Multi�State
Indicator

BO516 5 16 N30:26

OPTION STYLE
NO.
Numeric Display

BO521 5 16 N30:31
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The following table displays the addresses for each of the additional
buttons.

Table A.M
Addresses for Additional Buttons in the Object List

Additional Buttons Command BLK
Transfer Address

Indicator State BLK
Transfer Address

PLC Address

AUTO MODE BI52/1 (Value = 1) N30:3/1 (Value = 1)

MANUAL MODE BI52/1 (Value = 0) N30:3/1 (Value = 0)

TOGGLE COMMAND BI52/3 N30:3/3

BI52/1 N30:3/1

SET COMMAND BI52/0 N30:3/0

BI52/1 N30:3/1

MANUAL ON BI52/4 N30:3/4

BI52/1 N30:3/1

MANUAL OFF BI52/5 N30:3/5

BI52/1 N30:3/1

NUMERIC KEYPAD
ENTER KEY FOR
STYLE NUMBER

BI52/6 N30:3/6

CHANGE STYLE NO.
CONTROL ADDR

BI53/0 	 3/15 N30:4

The following table displays the addresses for the Object List PLC files.

Table A.N
Addresses for Object List PLC Files

Object List PLC Files PLC File Addresses PLC File Data Presets

ASSEMBLY STATION N31:1 through N31:57 1 through 57

LUXURY OPTION N32:1 through N32:57 1 through 57

STATION STATUS N33:1 through N33:57 1

OPTION COMMAND N34:1 through N34:57 1

OPTION STYLE NO. N35:1 through N35:57 100

When you have assigned all the addresses for the Object List PLC files,
you are ready to begin programming the PLC.

Step 3:  Program the PLC

To program the PLC, follow the ladder diagrams shown in the following
pages.
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Create the Block Transfer Rungs

The illustration below shows the Rungs 2:0, 2:1 and 2:2. These three rungs
read and write Scrolling List data to and from the PanelView terminal. This
is a bi-directional block transfer. For more information, see the

Bi-Directional Block Transfer Example earlier in this chapter.

Figure A.16
Block Transfer Rungs
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Create the Auto Mode Rung

When Rung 2:3 is energized, the Auto mode bit latches and the sequencer
resets to its safe state (position 0). When the sequencer increments its
position above Step 0, the Scrolling List cursor will be controlled by the
PLC via the Sequencer Position Word Move to the Cursor Control
Address, and the Manual Cursor List buttons are disabled automatically.

Figure A.17
Auto Mode Rung
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Create the Manual Mode Rung

Rung 2:4 places the process in Manual mode. It moves a 0 to the Cursor
Control Address and permits the PanelView Cursor List buttons to control
the cursor. This rung also places the currently “On” station to “Stand-By”
when Auto mode is switched to Manual.

Figure A.18
Manual Mode Rung
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Create the Toggle Command Rungs

Rung 2:5 handles the toggle command variables when a cursor change or
mode change occurs.

Figure A.19
Toggle Command Rung (Rung 2:5)
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Rung 2:6 toggles the command between “Select” and “Bypass” for the
currently selected station.
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Figure A.20
Toggle Command Rung (Rung 2:6)
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Create the Set Command Input Rung

Rung 2:7 enables the Set Command function. When the Set Command
button is pressed, the currently displayed command value is placed in the
command variable address. This secures the new command value when the
cursor position or mode changes. This rung also sets the Station Status file
according to which command is set.

Figure A.21
The Set Command Input Rung
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Create the Option Style Number Input Rung

When the operation is in Manual mode and the numeric keypad enable
object Enter key is pressed, Rung 2.8 transfers the new Option style
number value to the currently selected station’s option style address. It uses
the Cursor Indicator address as its pointer.

Figure A.22
The Option Style Number Input Rung
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Create the Manual On / Manual Off Input Rung

Rung 2:9 allows you to change the command value for the selected station
to Manual On or Manual Off while in Manual mode. This rung uses the
Cursor Indicator Address to place the command value in the proper
command file (N34, word address 1 through 57). It also updates the Status
File (N33) accordingly.
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Figure A.23
The Manual On / Manual Off Input Rung
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Create the Visible State File Copy Rung

Rung 2:10 copies appropriate file data to the visible state addresses for
each object list. The data copied is based on the Top Position Address
value from the PanelView Terminal.
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Figure A.24
The Visible State File Copy Rung
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Create the Auto Mode Simulation Rungs

Rungs 2:11 through 2:14 simulate a sequential process. This is for example
demonstration purposes only.
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Rung 2:11 sets a variable N30:8 to 1 when an Auto mode restart occurs.
This sets up a station status reset in the next rung.

Figure A.25
The Auto Mode Simulation Rungs (Rung 2:11)
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Rung 2:12 resets all STATION status indicators to “Stand-By” whose
Station Commands are “Select”.

Figure A.26
The Auto Mode Simulation Rungs (Rung 2:12)
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Rung 2:13 includes the Simulation Sequencer driven by the timer in rung
2:14. Rung 2:13 also sets the currently selected station status to “On”, and
the previous station status to “Complete” as the sequencer increments
through the 57 steps.
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Rung 2:14 includes the timer that increments the simulation sequencer
each second.

Figure A.27
The Auto Mode Simulation Rungs (Rungs 2:13 and 2:14)
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Troubleshooting

This appendix describes how to diagnose and solve problems regarding
the PanelBuilder Development Software.

You can verify the configuration settings for computer setup, PLC
communication, messages, alarms, miscellaneous control options, and I/O
addresses, by using PanelBuilder to print reports. The types of reports
available are listed in Chapter 6, File Operations.

You can also view the configuration settings for I/O racks and block
transfers as defined by PanelBuilder by selecting Rack Assignments from
the PanelView terminal’s Configuration Menu.

Verifying Configuration
Settings
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Use the checklist in Table B.A to identify various problems you may
encounter using the software.

Table B.A
PanelBuilder Development Software Problems

Problem Cause What to do
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Program won't run.
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Insufficient RAM.
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Ensure the computer running PanelBuilder has a
minimum of 640k RAM.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

A RAM�resident program is interfering with
PanelBuilder.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Unload the RAM�resident program.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Long delay while trying to print. (PanelBuilder
does not respond to Abort key.)

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Printer is offline or out of paper. ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Put printer back online.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

does not respond to Abort key.)
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Reload paper and put printer back online.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Switch printer power off and on again, and put
printer back online.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Reports won't print. ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

The printer is not attached to the appropriate
port.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Attach the printer to the appropriate printer port.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

The printer is not turned on, is off�line or is out of
paper.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Turn on the printer, ensure the printer is on�line,
and supplied with paper.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

You have not configured the printer port.
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Ensure the serial port to which the printer is
connected, is properly configured for printing.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Application file won't download or upload. ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

*You are using the wrong serial cable. ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Check the serial cable.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

The application file is too large. ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Ensure the memory size of the application file
does not exceed the User Memory Limit (set
under Options in the File Menu)

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

*The computer is not connected to the
PanelView terminal.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Connect the computer to the PanelView
terminal.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

*The terminal's serial communication port is not
configured for upload/download.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Configure the serial communication port for
upload/download.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

*The PanelView terminal is turned off. ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Turn on the PanelView terminal.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

*The PanelView terminal is in Run mode. ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Ensure the PanelView terminal is in
Configuration mode.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

You have not selected Upload/Download from
the PanelView terminal's Configuration menu.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Choose Upload/Download from the
Configuration menu.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

*The computer's serial port does not work. ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Ensure the serial port is working by testing with
another device such as a printer.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Possible corrupt application file. ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Try backup file or demo file download and
upload.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Attempting to download later version file with
earlier version of PanelBuilder Software, i.e. V3
application file - V2 PanelBuilder. Application
files are not downward compatible with software.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Update PanelBuilder Software to same version
as application file.

* See also Table B.B, fourth error message
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Consult Table B.B to identify and respond to some of the common error
messages that can appear on the PanelBuilder screen.

Table B.B
Common PanelBuilder Error Messages

Message Cause What to do
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

PanelView Terminal Transmitting Too Fast.
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Upload speed too high.
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Slow down baud rate.
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Not Enough Development System Memory.
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Reports too large.
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Reduce report size.
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Available memory has been exceeded.
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

If error message occurs while memorizing and
recalling objects, try using the screen�copy utility
instead, or memorize and recall fewer objects.

Another option is to remove TSRs and drivers to
increase available memory.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Invalid Baud. ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

May not be accessing com port. ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Check other program or devices that use the
com port.

If there is one, check to see that the internal
modem is turned off.

Use the DOS MODE command to set up the
com port.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

No Response from PanelView Terminal. ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Baud rate too high. ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Reduce baud rate.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Other possible causes are the same as the

items marked * in Table B.A

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

See solutions for items marked * in Table B.A

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Possible corrupt application file. ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Try backup file or demo file.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Unknown Text Component. ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Application file may be corrupted. ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Use DOS CHKDSK command, and use a
backup copy of the application file.

PanelBuilder Error Messages
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Table B.C lists the most common messages that can appear on a PanelView
terminal.

Table B.C
PanelView Major Fault Error Messages

Major Fault Message Cause What to do

Stuck Cell detected or Stuck Button
detected.

A touch cell or Keypad button has been
depressed for longer than the Stuck Button
Timeout setting allows.

Restart the terminal. If this problem occurs
repeatedly due to an operator holding the button
down for too long, increase the Stuck Button
Timeout setting in the Configuration menu.
If a button or cell is permanently stuck, call your
A�B representative.

Watchdog Test Failed. Unit is disabled. Watchdog circuit is unable to reset the machine. Servicing by Allen�Bradley is required.

System ROM corrupted. Unit is disabled. The ROM containing the system firmware is
defective.

Servicing by Allen�Bradley is required.

RAM TEST failed. Unit is disabled. The non�backed�up RAM used by the terminal
firmware is defective.

Servicing by Allen�Bradley is required.

Video hardware initialization failed. Unit is
disabled.

There is a video hardware problem. Servicing by Allen�Bradley is required.

Mismatched application file. Unit is disabled. 1.) The application file is for the wrong type, i.e.,
a Keypad file on a Touch Screen terminal. 

2.) The jumper settings are wrong

1.) Download an application file of the 
appropriate type. 

2.) Check the setting of JP5 (JP4 for Series C or
earlier terminals):

FB = Keypad
TS = Touch Screen

Failed to configure the Comm card. Unit is
disabled.

The Communication circuitry is faulty. Servicing by Allen�Bradley is required.

Failed to stop PLC communication. Unit is
disabled.

The Communication circuitry is faulty. Servicing by Allen�Bradley is required.

Application file corrupted. The system has not stored the file correctly. Download the file again or install new EEPROM.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Excessive external power cycles, noise or
voltage fluctuations.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Monitor power to terminal and take appropriate
power regulation and suppression actions.

PanelView Error Messages
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Table B.D
PanelView Minor Fault Messages

Minor Fault Message Cause What to do

Retentive data initialization failed. There is no valid application file. Go off�line and download the file again.

Audio hardware initialization failed. There is an audio hardware problem. Servicing by Allen�Bradley is required.

Terminal can't keep up with activity. Too much incoming data. The operator should stop all input until the
PanelView Terminal can process data.

Invalid Powerup Screen. Powerup screen does not exist or is faulty. Reassign the Powerup Screen or check the
configuration data in the PanelBuilder
application file.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

User EPROM/EEPROM is not installed or is
corrupted.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Optional EPROM or EEPROM was not found or
is faulty.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

If no user EPROM or EEPROM is installed,
ignore this message. You can disable the test
and the message in the Configuration Mode
Menu.
If a user EPROM or EEPROM is installed,
replace it.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Battery test failed. User RAM will be lost on
power down.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

The battery for application file memory is dead.ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Upload the application file and save it on disk.
Servicing by Allen�Bradley is required.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Communication Self Test failed. ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

The communication card is defective or not
installed.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Servicing by Allen�Bradley is required.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Invalid Screen.
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

The PLC controller has selected a non�existent
screen number.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Reprogram the PLC controller or the application
file.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Unable to write downloaded data to the
EEPROM.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

The EEPROM or user memory configuration
jumpers are set incorrectly.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Check the EEPROM and user memory
configuration jumper settings.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Value Out Of Range. ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Address not sufficient for data transfer.

Current screen number transfer to PLC
controller is not sufficient.

Numeric entry or display address length is
insufficient for data.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Increase bit length of address so it's large
enough for screen transfer, including Alarm
History and Alarm Status screens.

Increase address length for data.

PLC currently controls screen change. PLC controller has control of screen change. Disable PLC Controlled Screen Change.
Clear PLC Controlled Screen Change register.
Reset to 0.

No screen change	Hold Time in effect or no
PLC Handshake.

Operator is trying to change screens while a
button's hold time is still in effect or before an
activated Latched Push Button has received a
handshake.

Wait until hold time is finished or Latched
handshake is received before trying to change
screens.
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Consult Table B.E to identify PLC communication problems.

Table B.E
PLC Communication Problems

Problem Cause What to do
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

�PLC Communication Lost" message on
PanelView terminal.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

PLC controller is in Program or Remote Program
mode.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Change PLC controller to Run mode.

Cable problem. Check termination and cable pinout.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Incorrectly defined terminal as Last Chassis. ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Set Last Chassis to No for that rack assignment.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Rack assignments in PanelView and PLC do not
match.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Make sure rack assignments in PLC controller
match those in PanelView.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Terminating resistor not installed properly. ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

The terminating resistor must be installed at the
PLC and at the end of the link:
150� 1/2 watt resistor for 57.6 or 115.2 kbaud
82� 1/2 watt resistor for 230 kbaud

PanelView terminal and Scanners Remote I/O
baud rate do not match.

Change the Remote I/O baud rate in PanelView
terminal or the scanner so they match.

�PLC Communication Lost" message when
using PanelView terminal with PLC�5.

PanelView terminal has been assigned to
multiple or partial racks when firmware revision
of PLC�5 does not support partial rack
addressing.

Configure PanelView terminal as a single full
rack.
Upgrade PLC�5/15 to Series B Revision H.
Upgrade PLC�5/25 to Series A Revision D.

PLC controller is not configured to recognize the
PanelView terminal's rack assignments.

Refer to your PLC�5 User's Manual regarding
Auto Configuration.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Periodic �PLC Communication Lost" when
using 1772�SD2 scanner with PLC�2s.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Must use 1772�SD2 scanner Rev. 3 or later.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Rapid blinking of �PLC Communication Lost"
when using 1775�S4A scanner with a PLC�3.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Must use 1775�S4A scanner series B or later.

�PLC Communication Lost" when using SLC
500 1747�SN Scanner Module.

The 1747�SN Scanner Module is not properly
configured.

Refer to 1747�RIO Scanner User's Manual
regarding Specialty I/O Configuration and how to
configure Mfiles and Gfiles. 
Verify that the PanelView terminal and the
1747�SN Scanner Module Remote I/O baud
rates are set the same.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Discrete I/O works but block transfer does
not. No �PLC Communication Lost"
message. Using PLC�5/15, partial rack
addressing.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Must use PLC�5/15 series B Rev. J or later.

Discrete I/O works but block transfer does
not. No �PLC Communication Lost"
message.

Block transfer assignments in PanelView do not
match block transfer instructions in PLC.

Make sure PLC block transfer instruction
parameters match PanelView parameters.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

PLC Controller rack fault on rack assigned to
PanelView.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Specified No for Last Chassis when the
PanelView is the last chassis in that rack.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Set Last chassis to Yes for that rack assignment.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

�PLC Communication Lost" message and
rack fault on rack assigned to PanelView.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Mis�matched baud rate on PanelView and PLC
controller.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Specify same baud rate for PanelView and PLC
controller.ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Multiple devices configured for the same rack
assignment.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Multiple remote I/O devices must have unique
rack assignments.

PLC Communication Problems
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Table B.F identifies some problems in uploading/downloading files via the
PLC-5 Pass-Through feature.

IMPORTANT:  Only specific models and revisions of PLC controllers are
capable of the Pass-Through download/upload. Refer to Table B.G for
compatible models and revisions.

Table B.F
Pass�Through Upload/Download Problems

Problem Cause What to do

While attempting a Pass�Through Download,
a mistake window appears with the message
"The Pass�Through utility was not found in
the specified Pass�Through Directory."

The Pass�Through utility was not installed in the
specified directory.

The Pass�Through utility is not automatically
installed with PanelBuilder. It is contained in a
separate disk. Verify that the utility is installed in
the directory indicated in the Programming
Terminal Configuration menu.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

While trying to download an application file,
PanelBuilder software appears to lock up,
with the message �Getting Terminal Data"
flashing on the screen.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

�Programming Terminal Configuration" is not set
up properly.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Wait a minute or two for the computer to display
a PROBLEM window with an Error code number.
(See below for what to do about the most
common Error Codes, 180 and 208.) Then
check that the Programming Terminal
Configuration is correct (see Chapter 6, File
Operations), and try the download again.
If no PROBLEM window appears, reboot the
computer, then make sure your Programming
Terminal Configuration is correct, and try the
download again.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

While trying to download an application file,
a PROBLEM window appears, stating: �Error
Code 180 was returned by the Pass�Through
Utility".

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

The PLC�5 is not communicating with the
PanelView terminal: the message �PLC
communication lost" appears at the top of the
PanelView screen.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Make sure the PLC�5 is in RUN mode and is
configured to recognize the PanelView on the
remote I/O link. (See �Auto Config" in the PLC�5
6200 Series software documentation).

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

The Pass�Through Block Transfer assignment at
the target PanelView has not been assigned or
is different than the assignment in the
application file selected.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

If the target PanelView has no Pass�Through
Block Transfer assignment, you must download
the selected application file via an RS-232
Upload/Download cable connected directly
between the computer and the PanelView
terminal.

If the Pass�Through Block Transfer assignment
at the target PanelView is different, change the
assignment in the selected application file to
match the assignment in the PanelView.

The model or revision of PLC does not support
Pass�Through Block Transfer.

Use a compatible model or revision of PLC.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Data Highway Plus cable is disconnected. ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Ensure that the cable is securely connected at
both ends; try the download again.

While trying to upload or download with rack
numbers 10 or greater, a PROBLEM window
appears, stating �Error Code 163 was
returned by the Pass�Through Utility."

The PLC is unable to find rack because of wrong
Pass�Through Utility.

Ensure that you are using Pass�Through Utility
3.0.1.

Pass�Through
Upload/Download Problems
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Problem What to doCause

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

While trying to download an application file,
a PROBLEM window appears stating: �Error
code 208 was returned by the Pass�Through
Utility."

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

The Pass�Through Utility has been unable to
establish DH+ communications with the PLC�5.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Make sure the �Programming Terminal DH+
Address"  and the �PLC DH+ Address" are
properly assigned.

Make sure that you have selected the proper
�DH+ Hardware Driver" for your system, and that
the �DH+ Driver Card Location" code is correct.ÁÁÁÁÁÁÁÁÁÁÁÁ

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Immediately after completing a PLC�5
Pass�Through Download, a Minor Fault
Status bit is set in the PLC�5.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

The rack assignment configuration of the
application file downloaded to the PanelView did
not exactly match the application file that was
overwritten.

ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁÁÁÁÁÁ

Use the PLC�5 6200 Series software to clear the
Minor Fault; then reconfigure the PLC�5 to
recognize the new rack assignment.

Table B.G
PLC Series/Revision Requirements for Pass�Through File Transfer

Processor Series Revision

PLC�5/11 All All

PLC�5/15 B N or later

PLC�5/20 All All

PLC�5/25 A J or later

PLC�5/30 A B or later

PLC�5/40 A
B

E or later
B or later

PLC�5/60 A
B

E or later
B or later

PLC�5/250 All All
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Sample Worksheets

This appendix contains six worksheets to help you plan your application
(see Chapter 4, Planning Your Application). Two copies of each worksheet
are provided for your convenience; make copies of the worksheets as you
need them and save the originals for future use.

Worksheets for both Touch Screen terminals and Keypad terminals are
included for you to sketch each screen you want to create. These will show
the location and size of each object on the screen.

Use the Object Address List to record the details for each dynamic object
you place on a screen. Use one worksheet for each screen you develop.
You should also use one Object Address List to record your Windows and
PLC Control Options.

The Discrete I/O Usage Worksheets will help you keep track of the PLC
addresses. Use one worksheet for each full or partial rack assignment.

The Block Transfer I/O Usage Worksheet allows you to keep track of the
Block Transfer addresses. Use one worksheet for each Block Transfer file.

Use the PLC Communications Worksheet to record your exact rack and
Block Transfer assignments. You’ll only be able to complete the PLC
Communications Worksheet after the addresses are assigned to all your
objects, Windows, and Control functions. Use one worksheet for your
entire application.
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ISA Symbols

Valves

Symbol Appearance Single Grid Size Double Grid Size

Horizontal
Valve with
Actuator

Horizontal
Valve with
Throttling
Actuator

Horizontal
Valve with
Manual
Actuator
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Symbol Appearance Single Grid Size Double Grid Size

Vertical
Valve with
Actuator

Vertical
Valve with
Throttling
Actuator
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Symbol Appearance Single Grid Size Double Grid Size

Vertical
Valve with
Manual
Actuator

Butterfly
Valve

Check Valve
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Symbol Appearance Single Grid Size Double Grid Size

Relief Valve

Filters

Symbol Appearance Single Grid Size Double Grid Size

Liquid
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Symbol Appearance Single Grid Size Double Grid Size

Vacuum

Electrical

Symbol Appearance Single Grid Size Double Grid Size

Motor
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Symbol Appearance Single Grid Size Double Grid Size

Transformer

Containers and Vessels

Symbol Appearance Single Grid Size Double Grid Size

Vessel
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Symbol Appearance Single Grid Size Double Grid Size

Reactor

Storage Bin
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Symbol Appearance Single Grid Size Double Grid Size

Distillation
Tower
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Symbol Appearance Single Grid Size Double Grid Size

Pressure
Storage
Vessel

Weigh
Hopper
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Rotating Equipment

Symbol Appearance Single Grid Size Double Grid Size

Pump

Turbine
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Symbol Appearance Single Grid Size Double Grid Size

Blower

Compressor
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Material Handling

Symbol Appearance Single Grid Size Double Grid Size

Agitator

Conveyor

Screw
Conveyor
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Symbol Appearance Single Grid Size Double Grid Size

Inline Mixer

Rotary
Feeder
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Heat Transfer Devices

Symbol Appearance Single Grid Size Double Grid Size

Exchanger

Furnace
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Symbol Appearance Single Grid Size Double Grid Size

Rotary Kiln

Miscellaneous

Symbol Appearance Single Grid Size Double Grid Size

Cyclone
Separator
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The Extended Character Set

This appendix contains the extended character set used to create alternate
text characters for display on the PanelView screen.

Press the Ctrl key and the keys specified in the next illustration to use the
alternate character set for typing object text.

Table E.A
Extended Character Set for Object Text Ctrl-Key Combinations

Key Character Key Character

Ctrl�A Ctrl�G

Ctrl�B
Ctrl�J
Ctrl�↵

Ctrl�D Ctrl�K

Ctrl�E Ctrl�L

Ctrl�F Ctrl�N

Ctrl�O Ctrl�X



The Extended Character Set
Appendix E

E-2

Key CharacterKeyCharacter

Ctrl�P Ctrl�Y

Ctrl�Q Ctrl�Z

Ctrl�R Ctrl�\

Ctrl�S Ctrl�]

Ctrl�T Ctrl�6

Ctrl�U Ctrl�	

Ctrl�W



The Extended Character Set
Appendix E

E-3

Press and hold the Alt key and type the appropriate number on the numeric
keypad to print the following characters.

Table E.B
Alternate Character Set for Object Text Alt-key combinations

Key Character Key Character

Alt�128 Alt�135

Alt�129 Alt�136

Alt�130 Alt�137

Alt�131 Alt�138

Alt�132 Alt�139

Alt�133 Alt�140

Alt�134 Alt�141



The Extended Character Set
Appendix E

E-4

Key CharacterKeyCharacter

Alt�142
Alt�149

Alt�143
Alt�150

Alt�144 Alt�151

Alt�145 Alt�152

Alt�146 Alt�153

Alt�147 Alt�154

Alt�148 Alt�155



The Extended Character Set
Appendix E

E-5

Key CharacterKeyCharacter

Alt�156 Alt�163

Alt�157 Alt�164

Alt�158 Alt�165

Alt�159 Alt�166

Alt�160 Alt�167

Alt�161 Alt�168

Alt�162 Alt�169



The Extended Character Set
Appendix E

E-6

Key CharacterKeyCharacter

Alt�170 Alt�177

Alt�171 Alt�178

Alt�172 Alt�179

Alt�173 Alt�180

Alt�174 Alt�181

Alt�175 Alt�182

Alt�176 Alt�183



The Extended Character Set
Appendix E

E-7

Key CharacterKeyCharacter

Alt�184 Alt�191

Alt�185 Alt�192

Alt�186 Alt�193

Alt�187 Alt�194

Alt�188 Alt�195

Alt�189 Alt�196

Alt�190 Alt�197



The Extended Character Set
Appendix E

E-8

Key CharacterKeyCharacter

Alt�198 Alt�205

Alt�199 Alt�206

Alt�200 Alt�207

Alt�201 Alt�208

Alt�202 Alt�209

Alt�203 Alt�210

Alt�204 Alt�211



The Extended Character Set
Appendix E

E-9

Key CharacterKeyCharacter

Alt�212 Alt�219

Alt�213 Alt�220

Alt�214 Alt�221

Alt�215 Alt�222

Alt�216 Alt�223

Alt�217 Alt�224

Alt�218 Alt�225



The Extended Character Set
Appendix E

E-10

Key CharacterKeyCharacter

Alt�226 Alt�233

Alt�227 Alt�234

Alt�228 Alt�235

Alt�229 Alt�236

Alt�230 Alt�237

Alt�231 Alt�238

Alt�232 Alt�239



The Extended Character Set
Appendix E

E-11

Key CharacterKeyCharacter

Alt�240 Alt�248

Alt�241 Alt�249

Alt�242 Alt�250

Alt�243 Alt�251

Alt�244 Alt�252

Alt�245 Alt�253

Alt�246 Alt�254

Alt�247 Alt�255
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Screen Worksheet for Touch Screen Terminal
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Screen Worksheet for Keypad Terminal
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Screen Worksheet for Keypad Terminal
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Application File Name:
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Object Address List

Screen Number:Application File Name:

Object Address

D/B I/O R/F Wrd
Blk Xfer

PLC Addr Preset
Ref
No. Type Name

No. of
states

Data
Type

No. of
BitsBit



Object Address List

Screen Number:Application File Name:

Object Address

D/B I/O R/F Wrd
Blk Xfer

PLC Addr Preset
Ref
No. Type Name

No. of
states

Data
Type

No. of
BitsBit



Discrete I/O Usage Worksheet
Application File Name: Rack Number:

PLC Output Bit Numbers
17 16 15 14 13 12 11 10 7 6 5 4 3 2 1
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PLC Input Bit Numbers

0

17 16 15 14 13 12 11 10 7 6 5 4 3 2 1
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0



Discrete I/O Usage Worksheet
Application File Name: Rack Number:

PLC Output Bit Numbers
17 16 15 14 13 12 11 10 7 6 5 4 3 2 1
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PLC Input Bit Numbers

0

17 16 15 14 13 12 11 10 7 6 5 4 3 2 1

0

1

2

3

4

5

6

7

0



Block Transfer I/O Usage Worksheet (Page 1 of 2)

Application File Name:

Block Transfer File Number: 1 2 3 4 5 (Circle One)

Number of Words:

READ (PLC Inp) or WRITE  (PLC Out) (Circle One)

PLC Bit Numbers

14 13 12 11 10 8 7 6 5 4 3 2 1 0

0

915

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15



Block Transfer I/O Usage Worksheet (Page 2 of 2)

Application File Name:

Block Transfer File Number: 1 2 3 4 5 (Circle One)

Number of Words:

READ (PLC Inp) or WRITE  (PLC Out) (Circle One)

PLC Bit Numbers

14 13 12 11 10 8 7 6 5 4 3 2 1 0

16

915

17

18

19

20

21

22

23

24

25

26

27

28

29

30

31



PLC Communications Worksheet
Application File Name:

PLC/Scanner Type:

Baud Rate: 57.6K (10,000 Ft) 115.2K (5,000 Ft) 230.4K (2,500 Ft)

Note: You must make at least one rack assignment. Additional rack assignments (up to a maximum of 8) are 
optional. Write in the Rack Number and circle appropriate Rack Size, Starting Module Group, and 
Last Rack designation.

Rack Assignments

Rack Number Rack Size Starting Module Group Last Rack

1/4 1/2 3/4 1 0 2 4 6 Y N

1/4 1/2 3/4 1 0 2 4 6 Y N

1/4 1/2 3/4 1 0 2 4 6 Y N

1/4 1/2 3/4 1 0 2 4 6 Y N

1/4 1/2 3/4 1 0 2 4 6 Y N

1/4 1/2 3/4 1 0 2 4 6 Y N

1/4 1/2 3/4 1 0 2 4 6 Y N

1/4 1/2 3/4 1 0 2 4 6 Y N

Note: Block Transfers are optional. Circle the Block Transfer File Number, write in one of the rack numbers 
from above, circle the appropriate Module Group and Byte, and fill in the Block Transfer file size.

Block Transfer Assignments

Block Transfer
File Number Module Group

0  1  2  3  4  5  6  7 Hi Lo

30

Byte
Rack

Number No. Words

0  1  2  3  4  5  6  7

0  1  2  3  4  5  6  7

0  1  2  3  4  5  6  7

Pass–Through

1

2

4

5

Hi Lo

Hi Lo

Hi Lo

Hi Lo

0  1  2  3  4  5  6  73



PLC Communications Worksheet
Application File Name:

PLC/Scanner Type:

Baud Rate: 57.6K (10,000 Ft) 115.2K (5,000 Ft) 230.4K (2,500 Ft)

Note: You must make at least one rack assignment. Additional rack assignments (up to a maximum of 8) are 
optional. Write in the Rack Number and circle appropriate Rack Size, Starting Module Group, and 
Last Rack designation.

Rack Assignments

Rack Number Rack Size Starting Module Group Last Rack

1/4 1/2 3/4 1 0 2 4 6 Y N

1/4 1/2 3/4 1 0 2 4 6 Y N

1/4 1/2 3/4 1 0 2 4 6 Y N

1/4 1/2 3/4 1 0 2 4 6 Y N

1/4 1/2 3/4 1 0 2 4 6 Y N

1/4 1/2 3/4 1 0 2 4 6 Y N

1/4 1/2 3/4 1 0 2 4 6 Y N

1/4 1/2 3/4 1 0 2 4 6 Y N

Note: Block Transfers are optional. Circle the Block Transfer File Number, write in one of the rack numbers 
from above, circle the appropriate Module Group and Byte, and fill in the Block Transfer file size.

Block Transfer Assignments

Block Transfer
File Number Module Group

0  1  2  3  4  5  6  7 Hi Lo

30

Byte
Rack

Number No. Words

0  1  2  3  4  5  6  7

0  1  2  3  4  5  6  7

0  1  2  3  4  5  6  7

Pass–Through

1

2

4

5

Hi Lo

Hi Lo

Hi Lo

Hi Lo

0  1  2  3  4  5  6  73



Numbers

1747�SN I/O Subscanner module,   4�15,  
4�22

1747-SN I/O Subscanner module,   1�13

1770�KF2,   6�25

1771�SN I/O Subscanner Module,   1�13,  
4�3,   4�22,   A�12

1772�SD2 Remote I/O Scanner,   1�13,  
A�10

1775�S4A Remote I/O Scanner,   1�12,  
A�6

1784 series industrial terminals and laptop
computers,   2�1

1784�KL,   6�25

1784�KTK1,   6�25

1784�KT/KT2,   6�25

1785�KE,   6�25

6008�SI IBM PC I/O Scanner,   1�13

6008�SQ DEC Q�BUS I/O Scanner,   1�14

6008�SV VME I/O Scanner,   1�13

6120 series industrial computers,   2�1

6160 series industrial workstations,   2�1

6200 Defaults File,   6�26

6200 Programming software,   6�25

A

Accum Time,   7�35

Accumulated Time (Accum Time) field,  
7�36

Acknowl Alarm button,   7�33,   7�35
See also Acknowledge Alarm button

Acknowledge alarm
full alarm window,   7�33
single line alarm window,   7�32

Acknowledge Alarm button,   7�30

Acknowledged Alarm Number address,  
7�27

Activate Audio,   7�17

Active Alarms,   7�42

Active Alarms mode,   7�35

Add Background Text,   5�42

Add Menu,   3�21,   5�15,   5�58,   10�3

Address,   3�27
Acknowledged Alarm Number,   7�27
Alarm window,   7�23
Assigning a PLC,   9�2
block transfer,   A�1
Block transfer control,   6�19
Bridge

Local,   6�20
Remote,   6�20

Button Control,   10�4,   10�5,   10�7,  
10�8

Control List Selector,   10�9
Cursor Point,   10�14
Decimal Point Position,   10�31,   10�36,  

10�39,   10�42,   10�45,   10�46
Enter Key Control,   10�35,   10�38,  

10�45,   10�77
Enter Key Handshake,   10�35,   10�38,  

10�45,   10�77
Indicator State,   10�4,   10�5,   10�6,  

10�7
menu,   10�24

indicator state,   10�24
Information window,   7�8
Keypad Control,   10�34,   10�37
menu,   9�1
Numeric Entry Keypads,   10�37
Numeric Keypad-Enable Button,   10�34
object's PLC,   4�15
PanelView/PLC DH+,   6�20
Rack, PLC�5,   1�12
Scaled Numeric Data Display,   10�32
Selector Control, menu,   10�10
SLC�5/02, I/O image table,   4�15
Standard Numeric Data Display,   10�30
Time and Date,   9�7
Time and Date Control,   9�7
Update,   9�2
window control,   7�8

Address Assignment menu,   7�31

Address Format, PLC Controlled Time and
Date,   9�8

Address List, Object,   4�11

Address Map,   5�28

Address Menu,   3�34,   3�35,   5�27,   5�32,
 5�35

Addressing and Formatting options
Scaled Numeric Data Display,   10�32
Standard Numeric Data Display,   10�30

Alarm History button,   7�14,   7�33

Index



 IndexI–2

Alarm History screen,   3�14,   7�14,   7�33,  
7�34,   8�4

Alarm messages,   6�2,   7�13
report,   6�7
triggering,   7�26

Alarm QTY/TIME Reset to PLC Controller,  
7�38

Alarm Quantity (Qty) field,   7�36

Alarm Quantity/Accum Time Reset,   9�8
PLC Controlled,   1�11

Alarm relay,   7�15,   7�17,   7�30,   7�33
PLC Controlled,   1�10

Alarm State,   7�35

Alarm Status screen,   3�14,   7�35,   7�37,  
8�4

buttons,   7�41
menu,   7�38

Alarm window,   1�3,   1�10,   3�14,   4�10,  
4�11,   4�12,   7�12

appearance,   7�22
Exit button,   7�30
Full,   7�12,   7�13
Single�line,   7�12

Alarm Window menu,   7�15,   7�29

Alarm Window report,   6�6

All Files,   3�10,   6�2

All Messages mode,   7�35

All Msgs,   7�43

All option,   3�24

Alternate Character Set,   10�63
Alt�Key combinations,   E�3

Amount per Decrement,   10�29

Amount per Increment,   3�39,   10�28

Application file,   P�1,   3�10,   6�1,   6�2
application file comment,   3�13,   6�24
application size,   6�12,   6�31,   6�33,  

6�34

Arc,   1�8,   10�53
Size and screen representation,   10�54

Arrows and lines,   10�51

ASCII character,   9�6
ASCII character set,   10�67
ASCII code,   6�6

ASCII Display,   1�9
control sequences,   10�66
object,   10�64
string format,   10�65

ASCII Input Object, configuring,   10�74

ASCII Input object,   1�9,   10�68

Assign Screen to State,   10�20

Assigning a PLC address,   9�2

Assigning function keys,   3�28

Assigning screen security levels,   3�13

Assigning Screen to State,   3�32

Audio, PLC Controlled,   1�10

Audio indicator. See Beeper

Auto�Repeat Rate,   10�28,   10�29,   10�44

Auto�Repeat Start Delay,   10�28,   10�29,  
10�44

Auto�Restart After Download,   6�21

AUTOEXEC file,   5�1

B

Background Alarms,   7�15

Background Color,   3�25,   3�29,   3�32,  
3�33,   5�34

Background text,   10�50
and graphics,   10�1

Bar graphs,   1�8,   10�56
data types,   10�57

Battery�Backed memory,   P�1

Battery�backed memory,   3�16

Baud Rate,   4�21,   5�7

BCD Data Type,   4�17,   7�10,   7�26

BCD Format,   4�18

Beeper,   9�4

Bi�directional block transfer,   A�3

Binary Data Type,   4�17,   7�10,   7�25

Bit Number,   4�16

Bit pattern,   10�23
BCD,   10�11
Binary,   10�11
Bit,   10�11

Bit Position Data Type,   4�19,   7�11,   7�26

Bits required for BCD digits,   4�19

Blink,   3�29,   3�32,   3�33

Block Transfer,   3�20,   4�4,   4�5,   4�15
assignments,   4�3,   4�22
bi�directional,   A�3
byte (slot),   A�2
control address,   4�22,   6�19
Data Table words and bits,   4�6
file number,   3�34,   4�22
module group,   A�1
number of words,   A�2
Pass�Through,   4�4
PLC address,   4�16
PLC�3 family timing,   A�20



 Index I–3

PLC�5 timing,   A�18
rack number,   A�1
read,   A�13
timing considerations,   A�16
window,   5�6,   6�19
write,   A�14

Block Transfer I/O Usage Worksheet,  
4�14,   C�1

Block Transfer Programming,   A�1
Local PLC�2 family,   A�13
PLC�5/15,   A�3
PLC�2/30,   A�10
PLC�3,   A�6

Border,   3�29,   3�31,   3�32

Box,   1�8,   5�57,   10�53

Bridge Address
Local,   6�20
Remote,   6�20

Burn EPROMs,   3�9,   6�30
Burn EPROMs menu,   6�31

Button
Acknowl Alarm,   7�33

See also Acknowledge Alarm button
Acknowledge Alarm. See Acknowl Alarm

button
Change Mode,   7�41
Cursor Down,   7�33
Cursor Up,   7�33
Decrement Value,   1�8,   10�28
Down Cursor (Incr Value),   10�12,  

10�13
Enter,   10�12
Exit,   7�26,   7�30,   7�33
Go To Screen,   1�7,   10�18
History,   7�33
Increment Value,   1�8,   10�27
Interlocked Push,   1�7
Latched Input Push,   1�7
Maintained Push,   1�7
Momentary Push (Normally Closed),   1�7
Momentary Push (Normally Open),   1�7
Numeric Keypad�Enable,   1�9,   10�34
Return To Previous Screen,   1�7,   5�56,  

10�18
Screen Keypad�Enable,   1�9,   10�21
Screen Print,   1�8
Set Value,   1�8,   10�26
Silence,   7�30,   7�33
Status,   7�33
Up Cursor (Decr Value),   10�12,   10�13

Button Control Address,   5�36,   10�4,  
10�5,   10�7,   10�8,   10�27

window,   5�26,   5�47

Button Control bit,   10�6

Button Text,   3�33
menu,   5�18

Buttons,   3�27
Alarm Status screen,   7�41
and Auto�Repeat,   3�38
and Keypad terminals,   3�36
and Touch Screen terminals,   3�37
ASCII Input object

common,   10�71
SEL,   10�72
unique,   10�72

Full Alarm window,   7�32
locating onscreen,   4�2
Scrolling List object,   10�93

Buttons menu,   3�30,   5�44

Byte,   A�2

C

Change Mode button,   7�41

Change Preset,   3�35,   9�3

Channel Time,   A�20

Character Height,   3�29,   3�32,   3�33

Character Width,   3�29,   3�32,   3�33

Circles,   10�53

Clear option,   3�24

Clear Window, PLC Controlled,   1�11

Clear Window to PLC Controller,   7�30,  
9�8

Clear Window, PLC Controlled,   7�30,   9�8

Colors,   3�10

Comment,   3�13

Communication Port Settings,   6�7

Communication Problems,   B�6

Communication Settings,   6�11

Communications,   3�34,   7�9,   7�24,  
7�31,   7�39,   9�2

Communications menu,   3�19,   5�3,   5�7

Compatibility Reports,   2�8

Compatibility Summary report,   6�5

Computer Setup report,   6�7

Configuration Mode Menu,   6�12,   6�15

Configure
Alarm Status Screen,   7�37
Information window,   7�2
Pass�Through Download Bits,   3�18
PLC Communications,   5�3
PLC�5,   A�10



 IndexI–4

Port,   6�31,   6�33,   6�34

Configure Pass�Through Download Bits
Window,   6�18

Configuring, Pass�Through parameters,  
6�17

Configuring the Alarm Window,   7�15

Configuring the Information Window,   7�2

Connecting the Programmable Controller,  
11�2

Connection points (Symbols),   10�55

Connector Characters,   10�51

Connector Characters and lines,   10�51

Continue Upload,   6�29

Control Byte (Hi/Low Byte),   4�22

Control List Selector,   5�42,   5�44
Addressing,   10�9
with Enter,   1�7,   10�11
without Enter,   1�7,   10�13

Control Selectors,   10�9
menu,   5�43

Control Sequences, Invalid,   10�68

Control Value,   10�8

Converting an application file into hex
file(s),   6�32,   6�33,   6�34

Conveyor Controls Screen Worksheet,  
4�29

Copy a File,   6�3

Copy Screen To,   8�2

Copy screens,   3�13

Copying a Screen from One Application File
to Another,   8�2

Create New File,   3�8

Create New Screen,   3�13

Creating Alarm Messages,   7�15

Creating an application file,   4�39,   5�1

Creating messages,   7�3

Creating screens,   1�2,   5�8

Critical Controls,   4�1

Current Screen Number to PLC,   9�4

Current Screen Number to PLC Controller,  
3�17,   9�4

Cursor,   3�27

Cursor Auto Repeat Rate (per Sec.),   3�17

Cursor Auto Repeat Start Delay,   3�39

Cursor Auto�Repeat Rate,   3�39

Cursor Auto�Repeat Start Delay,   3�17

Cursor control address,   10�84

Cursor List object,   10�79

Cursor Point,   10�14

Cursor Point Address,   10�14

Cursor Points, Default operation,   10�15

Cursor Up/Down buttons,   7�35

D

Data Entry Keys,   3�2

Data Type,   7�9,   7�24,   7�31,   7�39,   9�2

Data type,   3�34
BCD,   4�17
Bit position,   4�19
Control List Selector,   10�9
Decrement Value Button,   10�29
Increment Value Button,   10�28
List Indicator,   10�23
Multi-State Indicator,   10�22
Numeric Data Display,   10�32
Numeric Keypad-Enable button,   10�34
Numric Input Cursor Point,   10�45
Selector Control,   10�11
Set Value Button,   10�27
Signed Integer,   4�17
Top position value,   10�10

data type,   7�10,   10�9

Data Types,   4�16

Data types
bar graphs,   10�57
Increment Value Button,   10�28
Local Message Display,   10�61
Set Value Button,   10�27

Date Display,   1�8,   10�58

Decimal Formatting,   10�38

Decimal Key Controlled Decimal Position,  
3�34,   10�36,   10�39,   10�42

Decimal Point,   3�34,   10�31

Decimal Point Format,   10�35

Decimal Point Position Address,   10�31,  
10�36,   10�39,   10�42,   10�45,   10�46

Decrement Value Button,   1�8,   10�28
 Data Types and Values,   10�29
Data types and values,   10�29

Default Settings,   2�7

DEFAULTS File,   2�3

Define Block Transfer Files,   5�6

Delete Address,   3�35,   7�10,   7�25,  
7�32,   7�40,   9�3

Delete Message window,   7�7

Delete Screen,   8�1
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Delete screens,   3�13

Deleting Alarm Messages,   7�20

Deleting Information Messages,   7�7

Deselect option,   3�23

determining response times ,   A�15

Develop Menu,   6�1

Develop menu,   3�7,   5�2

DH+,   6�20

DH+ Hardware Driver,   6�25

Diagonal lines,   10�51

Direct Downloading and Uploading,   6�10

Directory,   3�8,   3�9

Discrete Address,   4�15

Discrete Data Response Time,   A�15

Discrete I/O scan times,   A�16

Discrete I/O Usage Worksheet,   4�13,   C�1

Discrete I/O Usage Worksheet ,   4�36

Display
ASCII,   1�9
Date,   1�8
Dynamic Memory,   1�2
Local Message,   1�9
Numeric Data,   1�8
Time,   1�8

Display Active Alarms Mode,   7�42

Display All Alarms Mode,   7�43

Display Menus for Terminal Version,   3�15

Display Objects,   10�25

display objects,   10�1

Display States,   3�32

Documentation, printed, see also Reports,  
1�2

DOS,   2�1

Down Cursor (Incr Value) Button,   10�12,  
10�13

Down Cursor (Incr Value) menu,   5�45

Download to PanelView menu,   6�13

download to the burner,   6�31,   6�34

Downloading,   1�1,   6�12
Downloading to Panelview Terminal,   3�8

Downloading over the Data Highway +,  
6�23

Downloading to Earlier Version Terminals,  
6�14

Dynamic Memory Display,   1�2

Dynamic Objects,   4�12

Dynamic objects,   1�5

E

e Application File Comment,   8�5

Edit Menu,   3�22

Edit Message Menu,   7�16

Edit Text,   3�31,   3�32,   3�33

Editing  Information Messages,   7�6

Editing Alarm Messages,   7�20

Editing Numeric Values,   10�47

EEPROM,   P�2
EPROM or EEPROM chip installation,  

1�4

emergency stop buttons,   11�3

Emergency Stops,   4�1

Ending Address menu,   6�5

Energize Relay,   7�17

Enter Bit Handshakes,   10�18

Enter Button,   10�12

Enter Key Control Address,   10�39

Enter Key Control address,   10�35,   10�38,
 10�45,   10�77

Enter Key Handshake Address,   10�39

Enter Key Handshake address,   10�35,  
10�38,   10�45,   10�77

EPROM,   P�2
EPROM or EEPROM chip installation,  

1�4

EPROM burner users manual,   6�30

Exit,   3�28

Exit button,   7�26

Exit Menu,   5�19,   5�59

Exit menu,   3�12,   3�26,   3�36

Export, Message text,   10�61

Export Message Text window,   7�6

extended application memory,   3�16

Extended Character Set, Ctrl�Key
combinations,   E�1

F

File,   3�34,   7�9,   7�24,   7�31,   9�3
file comment,   3�13
file menu,   3�12
files menu,   3�9

file extension CFG,   5�2

File menu,   5�2

File window,   6�7

Files Menu,   6�3
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Fill Left,   3�33

Firmware EPROM,   P�2

Firmware Version,   2�7

Fixed Position Decimal Point ,   10�36,  
10�38,   10�41

Foreground Color,   3�29,   3�32,   3�33,  
5�34

Format,   3�27
format menu,   3�33

format-date,   10�58

format-time,   10�57

Full Alarm Window, buttons,   7�32

Full Alarm window,   7�13

Full alarm window,   7�12

Function Key Table,   3�25

Function Key Usage report,   6�6

Function keys,   3�30,   5�16

G

Generate Hex Files,   6�32,   6�33,   6�34

Get 6200 Parameters,   6�26

Global Functions report,   6�5

Go To Screen Button,   5�15

Go to Screen button,   1�7,   10�18

Go To Screen Buttons.,   5�14

graphic characters,   10�63

Group 1 objects,   3�38,   4�10

Group 2 objects,   3�38

Group 3 objects,   3�38

Group option,   3�23

H

handshake,   10�6

Hardware Requirements,   2�1

Hardware, Firmware and Software
Requirements for Pass-through File
Transfer,   6�17

Help,   3�1

Hex Files,   3�10,   6�2

Hex files,   P�1,   6�32,   6�33,   6�34

High Intensity,   3�29,   3�32,   3�33

History button,   7�33,   7�41

Horizontal bar graphs,   10�56

Horizontal line,   10�50

I

I/O Address Cross Reference report,   6�5

I/O Image Table Words and Bits,   4�5

I/O Usage Table,   3�25

I/O Usage Table report,   6�5

I/O Usage Worksheets,   4�12

IBM XT, AT, PS/2 or 100% compatible,   2�1

Import, Information text,   10�59

Import Message Text window,   7�5,   7�19,  
10�60

Import/Export Alarm Messages,   7�17

Import/Export Information Messages,   7�3

Importing alarm text, format,   7�17

Increment Value Button,   1�8,   10�27
 Data Types and Values,   10�28
Data types and values,   10�28
default settings,   10�28

Indicator
List,   1�8,   10�23
Multi�state,   1�7
Multi�State,   10�22

Indicator State Address,   10�4,   10�6,  
10�22,   10�24

Indicator State address,   10�5,   10�7

Indicator State Address Menu,   5�50

Indicator State Address menu,   10�24

Indicators Menu,   5�48

Informatin window, menu,   7�3

Information,   3�11

Information Message List,   7�11

Information messages,   6�2

Information Messages report,   6�7

Information Messages triggering,   7�11

Information Window,   5�2,   7�1

Information window,   1�3,   1�10,   3�14,  
4�10,   4�11,   4�12,   7�2

configuring,   7�2

Information Window and Messages Menu ,  
7�7

Information Window report,   6�6

Information Window's Appearance,   7�8

Inner Text,   3�33

Input and Output Data Files,   A�14

Input Image Table,   5�28

Input objects,   10�25

Input or Output,   4�15
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Input/Output,    3�34,   7�9,   7�24,   7�31,  
7�39,   9�3

Installing PanelBuilder on a Hard Disk,   2�4

Instruction Execution Time (in
microseconds),   A�18

Intel Hex format,   1�4,   6�30

Interlocked Push Button,   1�7,   10�8

Invalid Screen,   9�6

ISA Industrial Symbols,   10�55

ISA Symbols,   10�51,   10�56

ISA symbols,   1�8,   3�30

K

Keypad Control Address,   10�34,   10�37

Keypad Screen Selector,   1�10,   10�20

Keypad Terminals,   1�5

Keys
Data entry,   3�2
Editing,   3�3
for Editing Objects and Lines,   3�3
Menu,   3�1

L

Label,   5�18

Ladder Logic,   10�48,   10�50

Ladder Program for Remote I/O,   A�15

Last Chassis Designation,   4�22

Latch Button PLC Handshakes,   10�18

Latched Input Push Button,   1�7

Latched Push Button,   10�6

Line,   1�8,   10�50

Line Crossings,   10�52

Line Down button,   7�41

line Draw,   10�51

line Erase,   10�51

line Relocate,   10�51

line segment,   4�25

List,   3�27

List ,   10�13

List (Control List Selector with Enter
component),   10�12

List Indicator,   1�8,   10�23

List Menu,   5�45

List menu,   3�31

List Selector buttons,   3�27

load an application file,   6�1

Load PanelView Location Data,   6�27

Load PanelView Location Data Window,  
6�28

loading application files,   6�10

Local Bridge Address,   6�20

Local Bridge Address and Remote Bridge
Address Selection,   6�21

Local Message Display,   1�3,   1�9,   10�58,
 10�65

data types,   10�61

Local Message Display List,   10�62

Local Message List,   10�58

Local Messages,   10�58

Local messages,   6�2

Local Messages object list,   10�86

Local Messages report,   6�7

Local Messages triggering for Bit Position
Data Type,   10�62

Look,   3�27

Look menu,   3�29,   5�11,   5�17,   5�22,  
5�39

M

Main Menu,   3�7

Main Screen,   4�27

Maintained Push Button,   1�7,   10�7

Margin Size,   3�30

Maximum Block Transfers on one Scanner
Channel,   A�17

maximum cable length,   3�20

maximum length of Alarm Messages,   7�16

Maximum length of messages,   7�3

maximum message characters,   10�58

maximum number of alarm messages,  
7�15

Maximum Number of I/O Chassis on the
Same Scanner Channel,   A�17

maximum number of messages,   7�3

maximum number of states,   10�23

Memorize,   3�22,   5�55

Memorize and Recall,   5�29

Memorize Prompt,   5�30

Memory Requirements,   2�6
estimating,   4�23
reducing,   4�26
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memory requirements of each element,  
4�23

Menu
Add,   3�21,   5�15,   5�58,   10�3
Address,   3�34,   5�27,   5�32
Address Assignment,   7�31
Alarm,   9�8
Alarm Status screen,   7�38
Alarm Window,   7�15
Burn EPROMS,   6�31
Button Control Address,   5�27
Button Text,   5�18
Buttons,   3�30,   5�44
Communications,   3�19,   5�3,   5�7
Configuration Mode,   6�12,   6�15
Control Selectors,   5�43
Develop,   5�2,   6�1
Download to PanelView,   6�13
Edit,   3�22
Edit Message,   7�16
Ending Address,   6�5
Exit,   3�12,   3�26,   3�36,   5�19,   5�59
File,   3�12,   5�2,   10�3
Files,   3�10,   6�3
Format,   3�33
Indicator State Address,   5�50,   10�24
Indicators,   5�48
Information Window,   7�3
List,   3�31
Look,   3�29,   5�11,   5�17,   5�22,   5�39
Messages,   7�3
Move & Edit,   5�13
Move & Size,   5�24
Move and Edit,   5�12,   5�22
Move and Size,   5�31,   5�48
Numerics,   5�53
Object,   3�22,   3�26,   5�11,   5�15,  

10�12,   10�13,   10�19,   10�25
Object List,   6�6
Object, for Text,   5�11
Options,   3�15,   3�25
Outer Text,   5�26
Outer text,   3�33
Pass�Through Download to PanelView,  

6�24
PLC address,   9�1
PLC Controlled Alarm Relay,   9�2
PLC Inhibit Bit Address,   3�19
Programming Terminal Configuration,  

6�25
Push Buttons,   5�23
Reports,   3�9,   6�4
Screen,   3�20,   5�9,   5�18
Screen Selector,   5�38
Screens,   3�13,   5�8,   5�21,   5�41,   8�4,

 10�3
Select File,   6�4

Select Reports,   6�5
Selector Control Address,   5�46,   10�10
Setup,   3�10
Starting Address,   6�5
State 0,   5�34,   5�49
States & Text,   5�34
States and Text,   5�25,   5�31,   5�49
Text,   3�33,   5�17,   5�40
Text/Draw,   5�10,   5�14,   5�21
Transfer,   6�13,   6�14,   6�23,   6�30
Utilities,   8�1
Utility,   3�35,   5�29,   5�32
Window Control Address,   7�9
Window Look,   7�8
Windows,   3�13,   7�1,   7�3

Menu keys,   3�1

Message,   7�35
displays,   1�3
triggering,   7�10

Messages,   7�5
creating,   7�3
Editing,   7�6
Import format,   7�4
Import/Export,   7�3

Messages Menu,   7�16

Messages menu,   7�3

Messages triggering for the Binary or BCD
Data Type,   10�61

Messages triggering on Multiple Local
Message Displays,   10�62

Messages window,   7�5,   7�18,   10�60

Minimum Push Button On Time,   10�4,  
10�5,   10�18

Minimum Push Button on Time,   3�17

Modify Block Transfer window,   5�6

Modify Rack Assignment window,   5�4

Module Group,   4�22,   A�1

module group,   4�4

module groups,   4�3

Momentary (Normally Closed) Push Button,
 1�7

Momentary (Normally Open) Push Button,  
1�7,   5�23

Momentary Normally Closed Push Button,  
10�5

Momentary Normally Open Push Button,  
10�4

momentary push buttons,   10�1

Momentary Push Buttons (Normally Closed)
,   5�33
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Mouse,   1�4,   3�11
damping factors,   3�11
driver software,   3�11

Move,   3�30,   3�31

Move & Edit,   3�27

Move & Edit Menu,   5�13

Move & Size,   3�26

Move & Size menu,   3�28

Move and Edit Menu,   5�12,   5�22

Move and Size,   5�16,   10�65

Move and Size Menu,   5�24,   5�31,   5�48

Move Menu,   3�23

Move Text,   3�31,   3�32,   3�33

Moving an object,   3�28

Moving Text,   5�13

Msg ,   7�35

Multi�State Indicator, object list,   10�86

Multi�state Indicator,   1�7

Multi-State Indicator,   10�22

Multi-state Indicators,   5�47

multiplexing,   4�6

N

Nominal Time,   A�21

Non-Continuous Block Transfer Mode,   A�3

Number of Bits,   3�34,   4�19,   7�9,   7�24,  
7�31,   7�39,   9�3

Number of BT on Channel,   A�21

Number of Chassis in Rack List,   A�21

Number of Digits,   3�33

Number of States,   3�31,   4�16,   10�12,  
10�13,   10�19,   10�25

Number of Words,   3�34,   9�3

Numeric and Security Entry Window,   3�14

Numeric Cursor Point, default settings,  
10�44

Numeric Data Display,   1�8,   5�52,   5�53,  
10�29,   10�30

Decimal Point,   10�31
Formatting,   10�31
object list,   10�86
Polarity,   10�32
Scaled,   10�32

Formatting and Addressing,   10�32
Standard,   10�30

Formatting and Addressing,   10�30

Numeric Data Display Displayed Value
Address,   10�30

Numeric Entry Keypad
Formatting and Addressing Options,  

10�37
Touch Screen only,   10�37

Numeric Input Cursor Point,   1�9,   3�27,  
10�40

data types,   10�45
disable,   10�40
enable,   10�40

Numeric Input Cursor Point Character,  
10�47

Numeric Keypad,   1�10,   10�34
decimal point format,   10�35

decimal key controlled,   10�36
PLC controlled,   10�36

Numeric keypad, keys,   10�22

Numeric Keypad�Enable Button,   1�9,  
10�34

Formatting and Addressing Options,  
10�34

Numeric Keypad, Touch Screen, decimal
point format

Decimal Key Controlled,   10�39,   10�42
Fixed,   10�38,   10�41
PLC Controlled,   10�38,   10�42

Numeric Objects, Decimal Point, Polarity
and Data Ranges,   10�26

Numeric objects,   10�25

Numerics Menu,   5�53

O

Object,   P�2,   4�14

Object Address List,   4�11,   5�26,   5�46,  
C�1

Object Address List Worksheet,   4�12

Object Address List Worksheet for Screen
2,   4�34

Object Address List Worksheet for Screen
3,   4�35

Object Characteristics,   10�1

Object List,   3�25,   10�85
Local message,   10�86
Multi�state indicator,   10�86
Numeric data display,   10�86

Object List menu,   6�6

Object List report,   6�6

Object Memorize Screen,   5�30
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Object Menu,   5�11

Object menu,   3�22,   3�26

Object Name,   4�14

Object text,   10�50

Object Type,   4�14

Objects,   1�2,   10�1
Dynamic,   4�12
maximum number on a screen,   10�1
Numeric,   10�25
numeric

display,   10�25
input,   10�25

retentive,   10�2
Static,   4�12

Objects and their Byte Requirements,   4�24

Options in the Alarm Menu,   9�8

Options menu,   3�15,   3�25

Outer Text,   3�27,   3�33

Outer Text Menu,   5�26

Outer Text menu,   3�33

P

Page Up/Down buttons,   7�41

PanelBuilder,   P�2

PanelBuilder Defaults File,   6�25

PanelBuilder Development Software, Using,
 3�1

PanelBuilder Development Software
Problems ,   B�2

PanelBuilder Error Messages,   B�3

PanelBuilder Features,   1�1

PanelBuilder Files,   2�2

PanelBuilder Menu Structure,   3�6

PanelView Display Type,   3�15

PanelView Error Messages,   B�4

PanelView Location Data,   6�19

PanelView Location Data ,   6�28

PanelView Objects table,   1�6

PanelView Terminal,   P�2

Pass�Through,   3�20
Block transfer control address,   6�19
Pass�Through Download Address

Source,   6�22

Pass�Through Download,   3�18

Pass�Through Download to PanelView,   3�8

Pass�Through Request Bit, Address,   3�18

Pass�Through Status Bit, Address,   3�18

Pass�Through Upload from PanelView,   3�9

Pass-Through Configuration Window,  
6�20

Pass-Through Download Bits,   6�17

Pass-Through Download Options Window,  
6�21

Pass-Through Download to PanelView
Menu,   6�24

Pass-Through Download to PanelView
window,   6�20

Pass-Through feature,   6�16,   6�23

Pass-Through Request Bit,   6�17

Pass-Through Status Bit,   6�18

Pass-Through Upload from PanelView,  
6�27

Pass-Through Upload/Download Problems,
 B�6,   B�7

Pass-Through Utility Directory ,   6�26

Past Alarms,   7�43

Past Alarms Mode,   7�43

Past Alarms mode,   7�35

pixel resolution.,   10�56

Planning an application, Steps,   4�1

PLC address menu,   9�1

PLC Alarm Message Triggering,   7�25

PLC communication problems,   B�6

PLC communication requirements,   5�3

PLC Communication Worksheet,   5�3

PLC Communications report,   6�5

PLC Communications Worksheet,   4�20,  
C�1

PLC Communications Worksheet ,   4�38

PLC Control Options,   4�12

PLC Controlled
Alarm Quantity/Accum Time Reset,   9�8
Alarm relay,   3�18
Audio,   3�18
Clear Windows,   9�8
Current Screen Number to PLC

Controller,   9�4
Screen Change,   10�18
Screen number,   3�18
Screen Print,   9�6
Screen print,   3�18
Silence Alarms,   9�8
Time and Date,   9�7

address format,   9�8
Time and date,   3�18
Time and Date to PLC Controller,   9�3
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PLC Controlled Clear Window,   7�30

PLC Controlled Decimal Point,   10�38,  
10�41

PLC Controlled Options,   1�10
Alarm Quantity/Accum Time Reset,   1�11
Alarm Relay,   1�10
Audio,   1�10
Clear Window,   1�11
Screen Number,   1�11
Screen Print,   1�11
Silence Alarms,   1�11
time and date,   1�11

PLC controlled options,   9�1

PLC Controlled Qty/Time Reset,   7�37

PLC Controlled Silence Alarms,   7�30

PLC DH+ Address Window,   6�20

PLC Inhibit Bit,   6�17
Address,   3�18
Address menu,   3�19

PLC Inhibit Bit Address Window,   6�18

PLC Message Triggering,   10�61

PLC Series/Revision Requirements for
Pass-through File Transfer,   6�16,  
B�8

PLC Type,   3�19,   5�3

PLC�2 family,   1�13

PLC�2/05,   1�13

PLC�2/15,   1�13

PLC�2/30,   1�13

PLC�2/40,   1�13

PLC�3,   1�12

PLC�3/10,   1�12

PLC�5 family, rack address ranges,   1�12

PLC-2,   A�12

PLC-3 Family Block Transfer Timing,   A�20

PLC-5 Block Transfer Timing,   A�18

PLC-5 Pass-Through feature,   3�18

PLC-5/15 Block Transfer Programming
Examples,   A�2

PLC/Scanner Type,   4�21

PLC�5/10,   1�12

Polarity,   10�32

Polarity Address,   10�32

positioning of push buttons,   4�2

Powerup screen,   3�13,   8�4

Preset,   3�35,   4�16

presets,   6�15

Print History button,   7�34

Print Message, ,   7�17

print reports,   6�3,   B�1

Print Status  button,   7�41

Printer,   1�5

printer port setting,   6�8

printing,   6�7

Program Scan Time,   A�15,   A�17,   A�19,  
A�20

Programming EEPROMs,   6�33

Programming Terminal Configuration,  
6�25,   6�28

Programming Terminal Configuration Menu,
 6�25

Programming Terminal DH+ Address,   6�25

PROMS, user,   6�10

Publications,   P�3

Pump Controls Screen Worksheet,   4�31

Push Button
Input Hold Time,   10�6
Interlocked,   10�8
Latched,   10�6
Maintained,   10�7
Minimum On Time,   10�4
Momentary Normally Closed,   10�5
Momentary Normally Open,   10�4

Push buttons,   10�4

Push Buttons Menu,   5�23

Push-On, Push-Off,   10�7

Q

Qty,   7�35

QTY/Time Reset button,   7�36

R

Rack,   3�34,   7�9,   7�24,   7�31,   7�39,  
9�3

Rack address range,   1�12

Rack Assignment,   3�20

Rack Assignment window,   5�4

Rack Assignments,   4�21

Rack assignments,   4�3
fractional,   4�3

Rack Assignments ,   5�36

rack fault bit ,   10�6

Rack Number,   4�22

Rack number,   A�1
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Rack or File Number,   4�15

Rack Size,   4�22

Rack size,   4�5

Rack Sizes,   4�4

RAM,   P�2

Recall,   3�24,   5�55

Recall Option ,   5�30

recovery from a faulted rack condition,   4�2

Reference Number,   4�14

Remote Alarm Window Processing,   7�29

Remote Bridge Address,   6�20

remote I/O scan time,   4�3

Rename Screen To,   8�2

rename screens,   3�13

Report
Alarm Messages,   6�7
Alarm Window,   6�6
Compatibility Summary,   6�5
Computer Setup,   6�7
function key usage,   6�6
Global Functions,   6�5
I/O Address Cross Reference,   6�5
I/O Usage Table,   6�5
Information Messages,   6�7
Information Window,   6�6
Local Messages,   6�7
Object List,   6�6
PLC Communications,   6�5
Screens,   6�6

Reports,   1�2
printing,   6�7
saving as ASCII test,   6�7

Reports menu,   3�9

Reports Menu ,   6�4

Reset Qty/Time button,   7�41

Retentive,   P�2

Retentive Objects,   10�2,   10�94
and Presets,   10�95
list of,   10�2,   10�94
Safety considerations,   10�96

Retentive objects,   10�94

retentive objects,   10�1

Retentive Objects and Presets,   10�95

Return To Previous Screen Button,   5�56

Return to Previous Screen button,   1�7

Return To Previous Screen" button,   10�18

Reverse Video,   3�29,   3�32,   3�33

RS�232 Serial Port,   2�2

Rubber Band Box,   3�24

rubber band box,   3�23

S

Safety Considerations for Retentive
Objects,   10�96

sample application,   4�26

Save the Application File,   5�59

Save the Screen,   5�59

Saving Application Files,   6�2

Scaled Numeric Data Display,  Formatting
and Addressing Options,   10�32

Scaling Formula- example,   10�33

Scan time,   A�16

scanner mode,   A�3

Scanner types,   4�21

Screen,   P�2,   3�27
Alarm History,   3�14
Alarm Status,   3�14

Screen 1,  The Main Screen,   4�28

Screen 2,  The Conveyor Controls Screen,  
4�30

Screen 3,  The Pump Controls Screen ,  
4�32

Screen Keypad-Enable Button,   1�9,  
10�21

Screen List Selector,   1�7,   10�19

Screen Menu,   5�18,   5�51

Screen menu,   3�20

Screen Menu ,   5�9

Screen Number, PLC Controlled,   1�11

Screen Print,   9�6
PLC Controlled,   1�11

Screen print,   6�6
manual,   9�7

Screen Print Active to PLC Controller,  
3�18,   9�4,   10�63

Screen Print Button,   1�8,   10�63

Screen prints,   10�63

Screen Selector Keypads,   10�20

Screen Selectors,   5�15

Screen selectors,   10�18

screen selectors,   10�1

Screen Selectors Menu,   5�38

Screen Title Text Object,   5�22
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Screen worksheets,   4�9

Screens Menu,   5�8,   5�21,   5�41

Screens menu,   3�13,   8�4

Screens Report,   6�6

Scrolling List
Byte Requirements,   4�25
example,   A�25

Scrolling List object,   1�9,   10�78
Cursor control address,   10�84
Cursor List,   10�79
example, PLC programming,   A�30
Object list,   10�85

local message,   10�86
Multi�state indicator,   10�86
numeric data display,   10�86

Scrolling list object, byte requirements,  
4�25

Secure Screen,   8�1

Secure Screen Menu,   8�3

Security,   1�2,   8�3

Security access code,   8�3

Select Directory,   6�29

Select File,   3�7,   3�9

Select File menu,   6�4

Select File window,   6�11

Select option,   3�23

Select PanelView Terminal Type window,  
6�2

Select Reports menu,   6�5

Select Screen,   3�13,   5�57,   8�1

Selecting Display Modes,   7�42

Selector
Control List, with Enter,   1�7
Control List, without Enter,   1�7
Keypad Screen,   1�10
Screen List,   1�7

Selector control address,   10�9

Selector Control Address Menu,   5�46

Selector Control Address menu,   10�10

Send User Mem High Byte,   6�31,   6�34

Send User Mem Low Byte,   6�31,   6�34

Set Bit Cursor Point,   1�9,   10�9,   10�14

Set Bit Cursor Point Character,   10�17

Set State ,   5�25

Set Value Button,   1�8,   10�26
 Data Types and Values,   10�27
Data types and values,   10�27

Setting Upload/Download Communications
on the PanelView Terminal,   6�10

Setup menu,   3�10

Signed Integer Data Type,   4�17

Silence Alarm to PLC Controller,   9�8

Silence Alarms, PLC Controlled,   1�11

Silence button,   7�30,   7�33

Single�line Alarm Window,   7�14

Size,   3�30

Sizing an object,   3�28

SLC 500 RIO connection,   1�13

SLC 500 via 1747�SN,   1�13

slot,   A�2

soft-key,   3�36

Software Requirements,   2�1

Special Characters,   10�66

Standard Numeric Data Display,   10�30

Start Bit,   3�34,   7�9,   7�24,   7�31,   7�39,  
9�3

Start up PanelBuilder,   5�1

Start Upload,   6�27

Start Upload Window,   6�29

Start Word,   3�34,   7�9,   7�24,   7�31,  
7�39,   9�3

Starting,   2�4

Starting Address menu,   6�5

Starting Module Group,   4�22

State 0 Menu,   5�49

State 0 menu,   5�34

State 1 menu,   5�35

States & Text,   3�27,   3�32
menu,   3�32

States & Text Menu,   5�34

States and Text Menu,   5�25,   5�31,   5�49,
 5�50

Static objects,   1�5,   4�12,   11�2

Status button,   7�33,   7�34

steps involved in creating the application
file,   4�39

Symbol Type,   3�30

Symbols,   10�55
size,   10�55
states,   10�56
type,   10�55

Symbols Used in the Address Map,   5�28
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System Response Times,   A�15

T

Terminal Failure,   4�2

Terminal Fault window,   3�14,   4�10,   4�11

Terminal Process Time,   A�19,   A�21

Terminal Process Time ,   A�16

Testing
Application file,   11�1
Retentive Objects,   11�2
Screens,   11�1
The whole system,   11�3

Testing an application file,   11�1

Testing the Screens,   11�1

Text,   1�8,   3�27,   10�50
Background,   3�33
Button,   3�33
Inner,   3�33
Outer,   3�33

Text Edit Mode,   5�12,   5�13

Text menu,   3�33,   5�17,   5�40

Text/Draw Menu,   5�10,   5�14,   5�21

Text/Draw objects,   10�50

Time & Date,   3�11
to PLC controller,   3�17

Time and Date to PLC Controller,   9�3
Format,   9�4

Time Display,   1�8,   10�57

Timing, Block transfers,   A�16

Top Position Value,   10�10,   10�24

touch cells,   4�11

Transfer Current Screen to PLC Controller,  
10�15

Transfer Menu,   6�14,   6�23,   6�30

Transfer menu,   3�8,   6�10,   6�13

Transfer Times,   A�19

trigger value,   7�26

tutorial,   5�1

types of alarm window,   7�12

types of Numeric Data Displays, ,   5�54

U

Underline,   3�29,   3�32,   3�33

Unprintable characters,   9�6

Up Cursor (Decr Value) Button,   10�12,  
10�13

Up/Down buttons(alarms),   7�33

Update Address,   3�35,   7�10,   7�25,  
7�32,   7�40,   9�2,   9�3

Upload /Download Cable,   6�10

Upload As,   6�29

Upload/Download,   P�2
Upload from PanelView Terminal,   3�8

Upload/Download cable,   2�2

Upload/Download Communication Settings
Available in PanelBuilder,   6�11

Upload/Download Communications on the
PanelBuilder Computer,   6�11

Uploading,   6�15

Uploading Over the Data Highway +,   6�27

User Memory Limit,   3�16

User PROM,   P�2

Utilities,   3�13

Utilities Menu,   8�1

Utility,   3�27
default,   3�35
name,   3�35

Utility Menu,   5�29,   5�32,   5�37

Utility menu,   3�35

V

Values Assigned to the Push Buttons,  
5�33,   5�38

verify the configuration settings,   B�1

Version compatibility,   2�5,   2�6,   5�8

Vertical bar graphs,   10�56

Vertical line,   10�50

Video adapters,   2�1

View Address Map,   3�35,   7�10,   7�25,  
7�32,   7�40,   9�3

view the configuration settings,   B�1

W

Wait Time in Queue,   A�18

Width,   3�31

Window,   P�3
Alarm,   1�10,   3�14,   4�11,   7�12
Alarm History Screen,   3�14
Alarm Status Screen,   3�14
Block Transfer,   5�6,   6�19
Button Control Address,   5�26,   5�47
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Configure Pass�Through Download Bits,  
6�18

Delete Message,   7�7
Export Message Text,   7�6,   10�61
Fault,   10�38
File,   6�7
Full alarm,   7�32
Import Message Text,   7�5,   7�19,  

10�60
Information,   1�10,   3�14,   4�11,   7�2
Load PanelView Location Data,   6�28
Messages,   7�18,   10�60
Modify Block Transfer,   5�6
Modify Rack Assignment,   5�4
Numeric and Security Entry,   3�14
Numeric Entry,   10�40
Numeric Keypad,   10�34
Pass�Through Configuration,   6�20
Pass�Through Download Options,   6�21
Pass�Through Upload from PanelView,  

6�27
PLC DH+ Address,   6�20
PLC Inhibit Bit Address,   6�18
Rack Assignment,   5�4
Select File,   6�11

Select PanelView Terminal Type,   6�2
Start Upload,   6�29
Terminal Fault,   3�14
Terminal fault,   4�11

Window Control Address,   7�9,   7�24

Window Look Menu,   7�8,   7�23

Window Type,   7�22

Windows Menu,   7�1

Windows menu,   3�13

Windows Window Menus,   7�3

Word,   A�1

Word Number,   4�16

Worksheet
I/O Usage

block transfer,   4�14,   4�37
discrete,   4�13

Object address list,   4�12
Screen

for keypad terminals,   4�9
for touch screen terminals,   4�10

Worksheets,   4�7
Screen,   4�9
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